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Getting Started

Welcome to mySewnet™ Digitizing, the software that helps you create wonderful
embroideries. Turn your favorite pictures into embroideries and see them on the screen
exactly as you will sew them. Work with images from the internet, a scanner or digital
camera, and use clipart or create your own pictures with the mySewnet™ Draw & Paint
drawing amd painting tools.

ExpressDesign Wizard
mySewnet™ Digitizing includes the ExpressDesign Wizard. Use it to automatically create
designs from a picture, load pictures for new designs, open an existing design or start a
new design with no picture. The ExpressDesign Wizard can create designs to fit a hoop, fit
a size you specify or fit an area you select. Choose from three design types:

Express Embroidery creates
a standard embroidery
design using satin, fill areas
and outlining.

Express Trace traces outlines
in a picture to create, for
example, redwork, quilt
stencils and so on.

Express Border creates satin border,
appliqué, running stitch, triple
stitch or motifs around the edges of
solid color areas in the picture.

Quick Create and Shape Features
The Quick Create features QuickStitch™ and QuickTrace are alternatives to the
ExpressDesign Wizard for creating sections of your design.
With QuickStitch™, click in an area and stitches are produced automatically in an instant!
Choose to embellish your designs with motifs, running, double or triple outline stitches,
motif lines, borders with any combination of straight lines and curves or appliqué,
creating a fill area, line, or satin area.
The QuickTrace feature automatically creates stitches that follow a continuous line. Create
a Double trace
, Quadruple trace , Satin line
or Motif line
trace.
Also in Quick Create, create one of 120 shapes automatically as a fill area or line.

Freehand and Point Create Features
The Freehand Create and Point Create features allow you to work with your stitches in
detail. Draw an outline, place points, or draw Bezier curves around an area of the picture,
and the stitches appear with your choice of pattern. Include a satin stitch or other line
border if you wish, and set the angle of stitching to any degree. Insert holes where you
choose.
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Choose Satin Column
(including over 250 patterns, and multigradient and multicolor
gradient options for color blending), Satin Areas
or constant width Satin Lines
and
emboss them with needle point highlights. Create Feathered Satin
and texture either
or both edges of a satin stitch for special embroidery effects on fur or flowers. Create
columns of Tapered Motifs
.
Make cutwork designs easily with Richelieu Bars
and Running Stitch with cutwork
needle lines. Use other features such as Double Zigzag stitch
, Crosshatch Fill
and
Curved Crosshatch Fill
to create free-standing lace.
Add individual stitches in straight or curved lines of Running, Double and Triple Stitch
from 1 to 12mm.

Design Choices
Adjust designs using easy editing features: Navigate around the design with the Filmstrip,
change easily between lines, fills, stitch types and patterns and so much more. Appliqué
options offer four stitchout methods including export for automatic needles or fabric
cutters.
Fill patterns and techniques are amazing – choose from over 250 fill patterns
or make
your own. Emboss patterned fill or satin areas, or columns, with personal highlights. Set
the start and end of fill areas if desired and use up to 500 holes. Use single gradient density
to produce beautiful shading effects, and multicolor gradient density to produce gradual
shimmering color changes.
Beautiful fill types include Radial
, Spiral
, Shape
Fill with 120 shape options and
motif options, QuiltStipple
, Contour
, Crosshatch
Fill. MultiWave
Fill creates
flowing waves of stitching with motif options. Echo
Fill repeats any area with shadow
effects. Curved Crosshatch Fill
provides wonderful intersecting patterns for threedimensional effects.
Choose from machine stitch Motifs or Universal Motifs such as the beautiful Hand Stitches
for Motif
Fill areas. Even create your own motifs!
Insert existing designs, embroideries, lettering or SuperDesigns into your project.
Grouping features allow you to keep smaller parts of your design together.

Finding Information
Reference Guide
The Reference Guide shows how to start the module and provide a quick tour of the main
screen. This is followed by information on key features, together with short ’How-To’
examples, which will help you learn how to use the module. It additionally contains full
reference information. The Reference Guide is supplied in PDF format
, ready for
printing.

Tooltips and Online Help
To learn about a function, position the arrow pointer over its icon. A tooltip with the
function name and some information will appear.
2
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The online help contains the ’How-To’ examples and full reference information. Use the
Help icon , press F1 or click the Help button. Where available, a help topic will appear
that is relevant to the item where help was requested.

Sample Guides
The Sample Guides show examples of the Fonts, Motifs and Stitch Types that are available
in the mySewnet™ Embroidery Software. The Sample Guides are supplied in PDF
format
, ready for printing.

Viewing and Printing PDF Guides
To find all the Reference and Sample Guides for your mySewnet™ Embroidery Software
software, in Windows® 10 select the Desktop tile on the start screen. Then in Windows® 10,
double-click the mySewnet™ Embroidery Software shortcut on your desktop, and doubleclick Reference Guides or Sample Guides. Select the desired PDF guide.
To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in
Windows® 10) or Adobe® Reader (available from adobe.com).

Readme
The most up-to-date details about the mySewnet™ Embroidery Software are in the
Readme.rtf file . (Double-click on a Readme file to open it in WordPad or Microsoft®
Word.)

Sample Files
Samples are provided for your use. Download the sample files from the Downloads page:
download.mysewnet.com. Copy the samples folder to the folder of your choice.
For the exercises in this manual, the mySewnet folder is used.
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Where to Start
Starting mySewnet™ Digitizing
Windows® 10 Start Screen
1
2
3

At the bottom left of your computer screen, open the Windows® 10 Start Screen.
In the Windows Start menu, scroll down to the mySewnet folder.
Click the mySewnet™ Digitizing icon
to launch it.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut
to mySewnet™ Digitizing.

Within mySewnet™ Embroidery
1
2

Launch mySewnet™ Embroidery
.
In the Create tab, click the Digitizer icon

1
2

Close or minimize any programs you have running.
Double-click on the Shortcut to the mySewnet™ Embroidery Software folder. A list of the programs
appears.
Double-click on mySewnet™ Digitizing icon
to launch it.

. mySewnet™ Digitizing will start.

Windows® 10 (Desktop)
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Closing mySewnet™ Digitizing
Exit
Ends the mySewnet™ Digitizing session. You can also use the Close command on the
mySewnet™ Digitizing Control menu.

Shortcuts
■
■

Mouse: Click the Close icon
Keys: Alt + F4

on the title bar or double-click the Control menu box.

About mySewnet™ Digitizing
Access via the Help tab. The version number of mySewnet™ Digitizing is given here. You
will need this if you contact technical support at any time.

Shortcut
■

4

Keys: Alt, L, A
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Parts of the Software Window
Title Bar
The title bar at the top of the window is
highlighted if mySewnet™ Digitizing is
active. The Quick Access toolbar gives icons for the following frequently used features:
Insert, Save, Save As, Export, Print, Change Hoop, Undo, Redo, Life View and Design Player.
If more than one instance of mySewnet™ Digitizing is open, each open window will show
the name of the embroidery file.

Ribbon Bar
There are 8 tabs on the ribbon: File, Home, Quick Create, Freehand Create, Point Create,
Edit, View and Help.
An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab,
followed by the highlighted letter of the tab item, e.g. Alt, H, M, S to resize the design to fit the current hoop.
Some functions are available by pressing the Ctrl key and another key at the same time. These shortcuts
are shown in the tooltip for the relevant function.

Use the Home tab to select, copy, Group, move, resize and rotate parts of a design; to add,
change and remove points in object outlines; to insert designs, embroideries, letters,
ExpressDesigns and SuperDesigns; to change the hoop, and to display embroideries with
Life View and Design Player.
Resize and rotate the selected block
Use a selection tool to select objects

View the design as it will be stitched out
Insert a design

Choose a hoop
Group and Ungroup objects
Cut, copy, paste or delete selected objects Move, add, delete & convert the points for an object

Use the Quick Create tab QuickStitch™ and QuickTrace features to create fills, lines and
satin areas automatically by clicking color areas in the picture. Use the Shape features to
create fill or line shapes instantly in the design area, ready for resizing.
Use the Freehand Create tab to draw the outlines for lines, satin and fill areas with a pen on
a graphics tablet, or by dragging with the mouse. Draw to add holes, emboss lines and
MultiWave lines to fill areas. Place points to create Satin Columns, Feathered Satin,
Richelieu Bars and Tapered Motif columns.
Use the Point Create tab to place a series of points or Bezier curves that define the outline
of lines, fills and satin areas. Place points or Bezier curves to add holes to fill areas, and to
create Satin Columns, Feathered Satin, Richelieu Bars and Tapered Motif columns. Place
points to add emboss lines and MultiWave lines to fill areas.
Use the View tab to adjust the Grid, measure the design, show and fade the background
picture, show the FilmStrip, and change the view mode or hoop.
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Design Window
Use the Design window to add new areas, lines and columns of stitching, as well as
commands, to your design, and to change the properties of stitching that you have
already created.
Quick Access Toolbar Ribbon Bar Tabs

FilmStrip

Work Area

Title Bar

Ribbon Bar

Status Bar

Design Panel

Create stitch areas and lines using the QuickStitch™, QuickTrace, Freehand and Point
Create features on the ribbon bar tabs. Choose colors, and select a line or fill type for stitch
lines or borders such as single, running, double, double zigzag, triple, satin or motif lines;
for fills such as pattern fill, motif fill, shape fill and crosshatch fill; for Richelieu bars and
tapered motifs, and for satin columns and areas. The Design window shows a 3D, 2D or
Object outline representation of the stitches in the design. To see the stitches with no
objects selected, use Life View
or Design Player .
The points are shown on the work area for the currently selected object. Fill areas, satin
areas and columns have markers that show where they start
and end
. Some types
of fill areas also have an origin
that affects the position of the stitch effects. There are
also markers for Color Changes , Stop Commands
and Alignment Stitches
.
To the left of the Design window work area is the FilmStrip, and to the right of the work
area is the Design Panel. Use the Create tabs to create stitches, and the Edit tab, the
FilmStrip and the context (right-click) menu to edit your design.

6
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FilmStrip
Use the FilmStrip to view the numbered sequence of
objects, select objects, change the sequence of objects,
select objects to display, delete objects, insert Color
Changes and Stops, view and change the properties of
selected objects and globally change the properties of
objects.

Create Tabs
Use the Create tabs Quick Create, Freehand Create and
Point Create to create stitch objects.
At the left of each Create tab are the color change tools,
and the Fill Area and Line section for selecting lines, fills
and their borders.
Use the Create tools QuickStitch™, Quick Trace, Shape,
Freehand and Point Create, to create lines and fills.
Create satin areas with QuickStitch™, Freehand or Point
tools. Use Column in the Freehand Create and Point
Create tabs to create Satin Column, Feathered Satin,
Richelieu Bars or Tapered Motifs. Set the properties for Thread Object Object
Color
your stitch types in the Options area.
Type

Scroll
Bar

Bar

Emboss lines on fill and satin areas and columns, create
MultiWave lines in MultiWave fill areas, and cut holes in fill areas.
Use the Edit tab to select objects to edit, manage fill patterns, and delete Emboss lines,
MultiWave lines and holes.

Design Panel
The Design Panel contains the color worksheet, notes and settings for the design, and the
Clipboard and Overview window.

Title Bar
The title bar at the top of the window is highlighted if mySewnet™ Digitizing is active. The
title bar shows the module name and the name of the currently loaded design or picture.

Work Area
The work area is the area where the picture is displayed and edited, and the design is
created and edited.

Clipboard Block
The Clipboard Block shows the selected objects that may be pasted into the work area.
Click in the clipboard to remove the current Clipboard Block.

Overview Window
The overview window gives a small overview of the whole work area for the design.

mySewnet™ Digitizing Getting Started
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Status Bar
The status bar is found at the bottom of each window. Starting from the left, the status bar
shows:

Design Window
■
■

■
■
■
■
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The selection tools.
The horizontal and vertical distance of the mouse pointer from the center of the
embroidery.
The hoop size.
The thread color for the next object(s) to be created.
The current creation tool or selected type of object.
The zoom tools and Zoom Bar.

mySewnet™ Digitizing Getting Started

mySewnet™ Digitizing Terms and Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow

on the screen.

If it is positioned over a text box it changes to an I-bar
Notes dialog box in the Design Panel.

and you can type, such as the Edit

If Zoom To Rectangle
is chosen, the Zoom In pointer
appears. If the Pan feature is
used to move around the screen, the Pan cursor appears. If Get Length
is chosen the
Measure pointer
appears.
In the ExpressDesign Wizard Rotate and Crop Picture page, the pointer becomes a doubleheaded arrow
when you move the crop lines or a four-headed arrow
when you
move the crop area. Also, for an Express Embroidery, the pointer becomes an
eyedropper
to pick colors from a picture for thread colors or pick a background color.
In the Freehand Create tab, if the Freehand Create functions are used the pointer becomes
a pen
.
In the Point Create tab, if the Point Create functions are chosen the pointer becomes a
circle , and in Bezier Mode when lines are drawn the pointer becomes a Bezier Mode
pointer . In Bezier Mode, when points are converted to Symmetric the pointer becomes
the Convert Points to Symmetric pointer , when points are converted to Smooth the
pointer becomes the Convert Points to Smooth pointer , and when points are
converted to Corner points the pointer becomes the Convert Points to Corner pointer .
When node points on Point Lines or Bezier Lines are adjusted, or the Fabric handle
used to adjust a fabric, the pointer becomes a small cross
(a Move pointer).
If Insert ExpressDesign
When a Pick Color

is chosen, the Draw Rectangle pointer

function is selected, the eyedropper pointer

The Box Select pointer , Freehand Select pointer
when the associated Select function is chosen.

is

appears.
appears.

or Point Select pointer

appears

There are several pointers indicating functions in the selection box. The Rotate pointer
appears when the mouse pointer is over the Rotate handle . The cross-hair pointer
appears when the mouse is over the center of rotation
.
The diagonal double-headed arrow pointer appears when the mouse pointer is over a
square corner handle . The horizontal double-headed arrow
pointer appears when
the mouse pointer is over the Flip Horizontal handle
. The vertical double-headed
arrow pointer appears when the mouse pointer is over the Flip Vertical handle
. The
pointer becomes a four-headed arrow
(a move pointer) when it is over a selection box.
The Create Cursor
is not a mouse pointer, but is a marker that shows the position
where the next object will be added if it is at the end of the design. These cursors only
appear when at least one object has been digitized on the current character or
SuperDesign, and one of the Create tools is selected.
■

When objects will be added at the end of the design, the cursor is pink
mySewnet™ Digitizing Getting Started
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■

When objects are to be inserted (i.e. the selected object is not the last object in the
design), the marker showing the final point of the selected object is orange
.

■

When objects are to be inserted, a blue marker
the next object in the design.

shows the position of the first point in

Touch Gestures
Touch gestures are used when viewing and moving embroideries in the mySewnet™
Embroidery Software. They are available when using a touch-sensitive screen.

General
Select and move
One finger touch and one finger slide are equivalent to click and drag with a mouse. Use
to move embroideries, select, draw or create stitches with freehand features, and so on.

Autoscroll
When you drag within a document, the autoscroll feature moves the pointer
automatically, changing the view of the work area.
This is useful when zoomed in. Use autoscroll while moving or resizing a selected
embroidery.
■

Use a two finger swipe on the work area.

Pinch to zoom
Pinch two fingers to zoom in, and spread two fingers to zoom out.

Context menu
Press and hold and a context-sensitive menu will appear if available (similar to a rightclick).

File Formats
Picture Files
mySewnet™ Digitizing can load any of the following picture file formats as a background
picture: Windows or OS2 Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), Portable
Network Graphics (.png), Tagged Image File Format uncompressed (.tiff, .tif ), 4QB (.4qb),
QuiltSewClever / Quilt Artist / Shirley Stitcher QCC (*.qcc), Windows Meta File (.wmf ),
Windows Enhanced Meta File (.emf ), CorelDraw (.cdr version 7-13, .cmx), Encapsulated
PostScript File (*.eps), Scalable Vector Graphics (.svg), HPGL (*.hp and *.plt), PC Quilter
(*.txt), Statler Stitcher (*.qli), AutoCAD (*.dxf ), CompuQuilter (*.cmd and *.cqp), Handi
Quilter (*.hqf ), IntelliQuilter (*.iqp) and Windows Icon (.ico). In addition, the ExpressDesign
Wizard can load .4dq files produced by the Grace Company PatternCAD module.
The picture or drawing is also saved as part of the design outline (.edo) file.
mySewnet™ Digitizing can upload pictures and videos of embroidery designs from Design
Player and Life View.

10
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Design Files
mySewnet™ Digitizing loads and stores embroidery designs (design outlines) in files with
the extension .edo. When a design is saved, the picture is saved with it.
mySewnet™ Digitizing can insert a .can outline file (from 5D™ Design Creator). If the .can file contains a
picture, the picture will not be loaded.

Embroidery File Formats
mySewnet™ Digitizing can insert any of the following embroidery file formats: Bernina
(.art version 1, 2, 3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES
(.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and
.vip), Husqvarna (.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs),
Tajima (.dst) and Toyota (.10*).
mySewnet™ Digitizing exports any of the following embroidery file formats: Husqvarna
Viking / Pfaff (.vp4 and .vp3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/
Bernina PES (.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff
(.vip), Husqvarna (.hus, .shv), Janome (.jef, .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and
Toyota (.10*).
The preferred file format for exporting embroideries is .vp4 format as this will preserve the separate parts of
multipart designs. It also preserves hoop, background and appliqué information, thread colors and notes.

mySewnet™ Digitizing Getting Started
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Hoop Selection
Use Hoop Selection
to choose the hoop size you wish to use in mySewnet™ Digitizing.
Set the hoop size according to the size of your embroidery or the hoop you wish to use for
stitching out, or enter any other desired size. Add hoops to your My Hoops group.
Select the hoop size

Choose a machine or hoop group

Add the hoop
to My Hoops

Enter a size for a custom hoop

Select the hoop orientation

Use the hoop as a guide to check the final size of the embroidery. If there is a warning about the
embroidery being too large for the hoop, you may save the embroidery anyway, then change to a larger
hoop.
When you change hoop, you can change the size of the design in the work area automatically to fit the
new hoop with Scale to Fit Hoop in the Modify Block menu on the Home tab.

Shortcuts
■
■

Quick Access Toolbar; Home Tab; View Tab, Hoop:
Keys: Ctrl + H; Alt + 6; Alt, H, H; Alt, V, H

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use
the My Hoops list to create a list of your favorite hoops.
The selected hoops will be displayed in the My Hoops group in the order that they were selected.
12

mySewnet™ Digitizing Getting Started

Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you
sit in front of your machine; note the position of the bracket.
It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size
box so that it is selected (checked). The Width and Height boxes will become available.
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop
you enter.
If you position the arrow pointer over the box without clicking, the alternative units and range will be
shown.

mySewnet™ Digitizing Getting Started
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The Design Creation Process

2

mySewnet™ Digitizing is used to create designs for embroideries.
You can use a design made in mySewnet™ Digitizing to create an embroidery at any time, and can use the
same design to create otherwise identical embroideries for different hoops.

There is no need to directly manipulate individual stitches.

Start with a picture.

View and create objects in the design in
the Create tabs.

Use the ExpressDesign Wizard to create a
design.

View and edit objects as 3D, 2D or outlines.

Add areas, for example tapered motifs or
Richelieu Bars, or insert new elements.

14
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Edit areas, for example to specialty fills.

Use File, New
, or File, New Window
to start a new design with the ExpressDesign
Wizard. In the wizard you can create a new design automatically, load a picture for a new
design, load an existing design or start a new design with no picture.
On the main screen, you can Insert
a design, or in the File menu Open
a design,
Open Recent or Load a Design with Drag and Drop. Use Insert to load a .can design outline
file.
When starting from a blank design, you may simply choose a hoop, and start creating your
design with the Freehand, Point, Command and Column features. However, it is more
common to follow a picture when creating a design. Load a or create picture from the
Choose Design Type page of the ExpressDesign Wizard, or use Edit Background in the
View tab to open a picture in mySewnet™ Draw & Paint.
To open an embroidery as a design, use File, New
picture, and Insert Embroidery

or File, New Window

to start a design with no

to convert an embroidery to a design.

After loading, creating or editing your picture as desired, go to the Design window and
start creating your design with QuickStitch™, Freehand and Point features.
Insert existing designs, embroideries, lettering or SuperDesigns into your project.
Save finished designs with Save
Export
.

or Save As

, then create an embroidery with

How to Create New Designs
There are three ways to make a new design:
■

■

■

Create a design automatically with the ExpressDesign Wizard. The wizard requires a
picture to convert to a design.
Load or draw a picture, then make a design by following the picture automatically with
the QuickStitch™ and QuickTrace features in the Quick Create tab. Additional design
elements can be added using the Freehand Create (drawing outlines with a mouse or on a
tablet) or Point Create (placing points or drawing Bezier lines) functions, as well as Shapes
and columns.
Create a free-form design with no background picture, mainly using the Freehand Create,
Point Create, column, Shape and command features.

mySewnet™ Digitizing The Design Creation Process
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The ExpressDesign Wizard
Use the ExpressDesign Wizard to create new designs automatically from pictures. There
are three design types that can be created in the ExpressDesign Wizard: Express
Embroidery, Express Trace and Express Border.

From a picture...

... to a complete design and embroidery.

There are three ways to start the ExpressDesign Wizard to create a new design.
■

■

Use File, New
, or File, New Window
, to clear the mySewnet™ Digitizing screen and
create a new design.
Use Insert ExpressDesign
to create a new design in the ExpressDesign Wizard that fits
proportionally in a rectangle you draw, or to fit the current hoop.
Additionally, when started with File, New , or File, New Window , the ExpressDesign
Wizard can be used to load a picture for a new design, load an existing design or start a
new design without a picture.

Using Existing Designs
Any design can be used as the starting point for a new design. This includes a design you
may have just created with the ExpressDesign Wizard, which you can modify and
embellish as desired.
For example, a design might be changed dramatically by adding or removing a border,
changing the fill type, or changing the pattern in a fill area. Also, for a design that you wish
to use at a different size, you could change line types from satin to running, triple or motif
stitch. Any line or area can be changed to appliqué.
Use existing designs, and designs created in the ExpressDesign Wizard, to create new
designs and design collages.

What Makes a Design
A design in mySewnet™ Digitizing is composed of areas, lines, columns and commands.
■

Fill Areas and Lines
The area features are used to create many different types of filled or stitch areas in which
fills, for example Pattern fill
, (and holes) can be placed. Also create Running stitch
,
Double stitch , Double zigzag
, Triple stitch
may be created alone or to border an area.

, Satin

or Motif lines

. Lines

Lines are defined by points, which can be moved to change the shape of the line, or an area it encloses.
16
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■

■

Columns
The column features are used to create Satin Column
Bars
and Tapered Motifs
Commands

, Feathered Satin

.

Commands are instructions such as a change of thread Color
or a Stop

, Richelieu

, an alignment stitch

,

.

The term ’object’ is used to refer to any or all of these.

When an embroidery is created from a design, each line or area is converted to stitches,
and the stitch order is controlled by the order of the objects in the design.
You can see the order of objects in the FilmStrip.

There are several ways to add objects to a design:
• Use the ExpressDesign Wizard to create a whole design, with all the necessary lines,
areas and commands. Edit or add to the design as desired.
• Use the Create tabs to add new objects to a design which can be based on a picture
shown in the background, and to change the properties of those objects.
• Use the Home tab to insert complete design elements, embroideries
characters

, SuperDesigns

, font

, or to copy and paste selections.

Pictures
Most designs are based on pictures, either by using the ExpressDesign Wizard or by using
the functions of the Create tabs to follow a picture. You can use mySewnet™ Draw & Paint
to edit existing pictures and create new pictures.
When a picture is loaded by the ExpressDesign Wizard, the colors may be reduced. This is to make it easier
to use the QuickStitch™ features. If you wish to avoid this, in the View window use Edit Background
load a picture.

to

Changing a Picture During Design Creation
You can change a picture during the design process. For example, you may wish to break
up or merge color areas so they produce the desired result with QuickStitch™ or
QuickTrace. You can also draw new features, insert pictures, move, copy and resize
selected areas and so on.

mySewnet™ Digitizing The Design Creation Process
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Choosing and Optimizing Pictures for the
ExpressDesign Wizard
To modify a picture before using it in the ExpressDesign Wizard, you can use mySewnet™
Draw & Paint. For more information see the mySewnet™ Draw & Paint Reference Guide and
Help.
Lines are converted to running (0.5 or 1mm), triple (2mm), or satin (3mm or above) depending on their
width. Filled areas are converted to pattern fill.
Running stitch and Triple stitch length is 2mm and Satin density is 4 initially. Fill is pattern 3 and density 2.
It is recommended to keep your original picture in case you wish to adjust it again with different options.

General Considerations
The ExpressDesign Wizard works best with pictures that have well defined color areas and
outlines.
You may also wish to tidy up a picture before using it in the ExpressDesign Wizard, by
deleting elements that are not required. Some pictures have stray or irregular lines and
shapes that are not part of the main picture. For example, lines that add emphasis or
suggest movement, speech or thought bubbles, decorative symbols, undesirable text,
date marks, and so on.

Before tidying: there are sections of text and
emphasis lines in the picture

After tidying: the essential part of the
picture is retained

In the example, the border has also been removed. Alternatively, this could be done in the Rotate and Crop
Picture page of the ExpressDesign Wizard. However, this rough crop has left white space around the edges
of this picture. The Rotate and Crop Picture page of the ExpressDesign Wizard will now automatically
remove the extra white around the edges, without requiring further adjustment.

Picture Proportions
To fill the hoop or rectangle, the picture proportions should be similar to the proportions
of the hoop or rectangle you draw. The Rotate and Crop Picture page of the ExpressDesign
Wizard can be used to crop the picture to the desired proportions.
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Cleaning a Picture
Some pictures may have random marks, speckles or excess details. If desired, use the
Picture window to clean up your picture before using it in the ExpressDesign Wizard. For
example, you may have an outline in a picture that is serrated on one side. Smoothing
such an outline will usually give better results, particularly from Express Trace and Express
Border.

Before cleaning: the line has shading
serrations and there are dust marks from
the scan

After cleaning: the line is smooth and the
dust marks have been removed

Enhancing Details
The significance of details in a picture is dependent on the overall size of the picture after
it is cropped, so small details are more significant in a small picture. Also, small details are
enlarged as the size of the created design increases, so extra detail may appear if you
simply make a larger design with the same picture.
However, very small details in a picture may sometimes be ignored, as they may not have
enough significance to be created as an area or outline in the embroidery. To enhance
details, select Picture Options in the ExpressDesign Wizard, ensure Expand Pixel-Thin Lines
is selected and set the Area Sensitivity to High. If this does not work, either enlarge the
details in a picture editor, or, for outline details, connect small details together so they are
created as a single outline.
Thick lines in a picture may be created as satin border when you would prefer regular
outlining for a more detailed effect. To automatically reduce thick outlines, select Reduce
Thick Lines in the Picture Options.

Patching Gaps in Paintings
Some paintings may have unwanted gaps in outlines that are too small to pick out easily.
This can affect all the ExpressDesign Wizard design types. Outlining for an Express
Embroidery and tracing for an Express Trace may not work as desired. Also, it may not be
possible to make properly enclosed areas for Express Border. If you suspect your picture
may have gaps, you can test your picture with flood fill in your picture editor, then patch
up any gaps that are found.

mySewnet™ Digitizing The Design Creation Process

19

Patch the Gaps in a Drawing of a Lion
1
2

3
4
5

Open the painting in the Paint tab of mySewnet™ Draw & Paint.
Choose contrasting foreground and background colors, so that it
will be easy to see which color is being used. Try to choose bright
colors that are not already used in the picture. If the picture is a
black and white line drawing you wish to colorize, simply choose
the color you desire for the area.
Select Flood Fill
.
If adjacent areas are different colors, then right-click in the adjacent
areas to fill them with the background color.
Click in one of the areas to fill with the foreground color. If there are
gaps in the outline around the area, more than one area of the
picture will be flood filled.

Click in an area to fill it
6
7
8
9

10
11

Draw lines to patch the gaps

The outline is now complete

Click Undo
until the flood fills have been undone and the picture is in its original state.
Use Pick Color
to select the color used for the outline around the area.
Click Paintbrush
and select the first line thickness.
Zoom In
to the outline to find the gaps, then draw lines to fill any gaps in the outline.
In the example, only gaps in the outline around the body have been patched. There are other outlines that
need patching.
Select the foreground color again, test with Flood Fill
and Undo
. When only the expected area
is flood filled, that part of the picture is ready for the ExpressDesign Wizard.
Repeat for other areas of the picture where you suspect there may be gaps.

Pictures for Express Embroidery
Many types of picture are suitable for creating an Express Embroidery. The primary factor,
however, is to use pictures with well defined color areas and/or well defined outlines.
Pictures that have complex color areas, such as photographs or scanned pictures that
have not been cleaned up, can be used to create and Express Embroidery, but you may
not get the best result unless some time is spent modifying the original picture.

Keeping and Removing Parts of the Background
In some pictures, you will want to use the option to remove all of the background color.
However, this may also mean that some parts of the picture you wish to keep will not be
included in the design. For example, if you have a cartoon character, the whites of the eyes
or teeth might be removed if you remove all of the background color. To prevent this, use
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a false color, such as gray, to flood fill the white parts you want to keep, then change the
gray thread color to white after finishing the ExpressDesign Wizard.

The eyes are white, and so are the gaps
between body and legs

The eyes are gray and will no longer be
removed with all background areas

Some pictures may have graduated backgrounds, but you need to remove all of the
background. In this case, use Pick Foreground Color , in the Paint tab of mySewnet™
Draw & Paint to select the main background shade, then Flood Fill
all the other shades
in the graduated background so that the background is a single color. This will also
prevent the multiple colors in the graduated background from interfering with color
optimization on the Choose Thread Colors page of the ExpressDesign Wizard.

Pictures for Express Trace
Pictures are converted to black and white using the Monochrome Threshold in the
ExpressDesign Wizard. The objective is to end up with a black and white line drawing, that
can be traced using only one color. If there are large solid areas that cannot be removed
with the Monochrome Threshold, it may be best to edit the picture before loading it so
that the solid areas are removed.
If a picture does not have its own outlines, use Find Outlines on the Outline Finder and
Expander page. This works best with clearly defined color areas with sharp edges.
Pictures that have gradual color changes, such as photographs or previously scanned pictures saved in
JPEG format, may not have strong color boundaries that can be detected by Find Outlines.

Connected Outlines
When editing or creating a picture for Express Trace, check how the outlines are
connected to each other and, where possible, look for unobtrusive places to connect
outlines. When the outlines are more connected, there will be fewer movement stitches in
the final embroidery and the embroidery will also stitch out more efficiently. Also, for
smaller embroideries, adding connections between outlines will be less noticeable and
will also prevent small sections of stitches that might be less secure.

Pictures for Express Border
Express Border uses Monochrome Threshold to separate shapes from the background.
This leaves black shapes on a white background. Any solid or fully enclosed shapes in the
mySewnet™ Digitizing The Design Creation Process
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picture will then have a border added around them. If there are shapes within shapes, the
inner shapes will be ignored.

Pictures with Dark Borders and Backgrounds
A picture that has a black or very dark border or background may simply create a
rectangular border. This is especially the case if the background or border cannot be
removed with Monochrome Threshold.
For pictures with a dark border, it may be possible to remove the border on the Rotate and
Crop Picture page of the ExpressDesign Wizard. If this is not possible, edit the picture to
remove the border or change the border color.
For pictures on a dark background, use the Paint tab in mySewnet™ Draw & Paint to reverse the colors in
the picture with Flood Fill

, or change the background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

Stippled Pictures
Stippled pictures are not suitable for creating an Express Embroidery. This is because the
color areas approximate solid colors with dots of two or more colors in a stipple pattern.
Stippled pictures may be used for Express Trace or Express Border, if they have solid
outlines or areas that can be extracted using Monochrome Threshold.

Pictures for Quick, Freehand and Point Create
Picture Size
The best size for a background picture for mySewnet™ Digitizing is approximately
1500x1500 pixels (or greater). When using pictures significantly smaller than this
mySewnet™ Digitizing will magnify it, but lines may appear jagged rather than smooth.
For example, if a picture is loaded that is less than 500 pixels in both height and width it
will automatically be tripled in size. The best way to produce a smooth effect is to rescan
the picture.

Cropping a Picture
If you only wish to use a small part of the picture that has been loaded, use Box Select to
select the desired area and then Crop to remove the rest of the picture.

Pictures for QuickStitch™
The QuickStitch™ features use defined color areas to place areas and lines. Use the Color
Tolerance function to merge different color shades to change the size of this area.
The Effects functions in the Paint tab of mySewnet™ Draw & Paint may be useful to create color areas. For
example, use Despeckle to remove small spots of color that are often found on scanned pictures.

Some scanned or clipart pictures have thick outlines so there may be gaps between the
areas that are larger than desired. Use the Outline Thinner to reduce the thickness of
outlines to one pixel automatically.
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Pictures as Backgrounds
Use Embroidery to Enhance a Picture
Using mySewnet™ Digitizing with pictures allows you to choose different stitches to
highlight the desired features in a picture printed on fabric. For example, outline a shape
in complementary or contrasting thread colors, use metallic threads to add sparkle, create
three-dimensional effects with shading and add embellishments with motifs.
To help see stitches against a picture, use the Background mode slider bar in the View tab
to change the picture display between On , Fade
and Off .
Use Alignment Stitches
fabric.

to align the embroidery on a picture that you have printed on

Printing Pictures on Fabric
It is recommended to test the printouts of pictures onto the final fabric, as the colors may
not be reproduced onto fabric in the same way as on the screen.
The picture can be printed with the colors faded by 50%. This is an effective technique for
making the embroidery stand out over the picture.

mySewnet™ Digitizing The Design Creation Process
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Creating Design Elements

3

Creating Designs
A design in mySewnet™ Digitizing is composed of areas, lines, columns and commands
(objects).
After creating any fill or satin area, or column, emboss it by placing needle points to
enhance the pattern.
Use lines as individual stitch lines or borders around an
area or appliqué.
Lines are defined by points, which can be moved to change the
shape of the line, and any area it encloses.

Choose a fill type (e.g. pattern fill, motif fill and so on),
and a line type (e.g. satin line or running stitch) for
each area, and add an appliqué fabric and placement
stitches.
Set the Fill, Line and Appliqué buttons as desired by
clicking to turn that area type on or off. Then choose
line and fill types from the drop-down menu below the
button. In the Options for Fill Area and Line, set the
properties for your line and fill. After selecting the stitch types, use one of the Create
functions to make a new stitch object.
Any line type can be converted to another line type after creation, and most area types can be directly
changed to any other area type.

Create columns by placing alternate points.
Commands are instructions such as a change of thread color, an alignment stitch, or a
stop.
Right-click to deselect a Create function when you have finished, or simply select another Create tool.

When an embroidery is created from a design, each line or area is converted to stitches,
and the stitch order is controlled by the order of the objects in the design.
You can see the order of objects in the FilmStrip in the Design window.

There are several ways to add objects to a design:
■

■

■
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Use the ExpressDesign Wizard to create a whole design, with all the necessary lines, areas
and commands. Edit or add to the design as desired.
Use the Home and Create tabs to add new objects to a design which can be based on a
picture shown in the background, or to insert complete design elements, embroideries,
SuperDesigns or font characters.
Use the Edit tab, the FilmStrip and the context (right-click) menu to select objects to copy
and paste, and to reshape object outlines.
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Creating Areas and Lines
Areas and lines are created using the QuickStitch™, QuickTrace, Shape, Freehand Create
and Point Create features, or automatically with the ExpressDesign Wizard.
Draw a line with the Freehand and Point Create features, or follow a line in a picture with
QuickStitch™, QuickTrace and the ExpressDesign Wizard.
You can change an open line to a closed one, or vice versa using the Closed Border switch on the Line tab of
the Fill Area and Line Properties dialog box. This allows you to create a fill area with a closed or open
border.
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Quick Create
Use the features of the Quick Create tab (QuickStitch™, QuickTrace and Shape) to create
design areas automatically.

Creating with QuickStitch™, QuickTrace and Shape
Add Color changes
Select a Shape and create it as a line or fill area
Create a fill area or line automatically

Set the properties for the stitch types
Trace a picture as a line of stitches

Select stitch types and appliqué
Cut a hole in a fill area
Emboss a line on a fill area or column
Draw a wave line in a MultiWave Fill area

Create a Satin Area

Click in a defined color area, or on a defined color line, in the background picture to create
a QuickStitch™ or QuickTrace line or fill. The area outline is filled or the line is followed
automatically.
Use Color Tolerance to choose the color shades used when defining the area.

Select the desired QuickStitch™ or QuickTrace function, according to the type of stitches
you want over the picture area you are about to select. Then, click in the desired area of
the picture for QuickStitch™ functions or on the desired line for QuickTrace functions.

Using Color Tolerance with QuickStitch™ and QuickTrace
1
2

3

4

5
6
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Select your stitch types, then select the desired QuickStitch™ or QuickTrace function, according to the
type of stitches you want over the picture area you are about to select.
Click in the desired area (for example, on the cat’s left side) of
the picture for QuickStitch™ functions or on the desired line for
QuickTrace functions.
If Color Tolerance is enabled, the Color Tolerance dialog box
will appear.
A red and cyan highlight shows the area of the picture that will
be filled or traced. If you have chosen to detect holes, any
holes in the area will be highlighted by green and yellow lines.
Using Color Tolerance is recommended.
Use the slider to adjust the Color Tolerance value until the
required part of the picture is selected.
The Color Tolerance dialog box has a slider control, which is
initially set to 0. This is the tolerance control. As the tolerance
value is increased, this increases the possible range of colors, by
similarity to the color clicked, that may be selected by the red and
cyan highlight.
For example, if you have an area of your picture that is shaded in different shades of green, you can use
color tolerance to select all the shades and make a single area.
Even when the tolerance is left at 0, the blue and white pattern gives a useful preview of the area that will
be used for the new object.
Select the number of points to use for the outline; High will show more detail, while Low will be
smoother.
Click OK to confirm the desired area is highlighted, and the line or area is created.
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Color Tolerance Off
When Color Tolerance is not enabled, the stitch object(s) are created immediately, using
only the color area that was selected. You can use the Color Tolerance option in
Preferences
to turn Color Tolerance off, but this is only advisable if your picture has
well defined flat color areas, and you have no need to select more than one color area to
create new objects.

Creating Shapes
Use Shape
to place a selected shape in the work area. Then resize the shape, and set its
properties. Select a fill and line to draw a fill area surrounded by a border, or select a line
type only to draw a closed line with no fill.

Creating with Freehand Create and Point Create
The Freehand and Point Create tabs’ functions are used to make new stitch objects by
creating object outlines directly on the design. The outlines may follow a background
picture, if desired, but the Freehand and Point Create functions do not require a picture.
Most of the Freehand Create functions are used by drawing an outline, and most of the
Point Create functions are used by placing points or drawing Bezier lines to define an
outline.

Freehand Create
When using the Freehand Create functions, lines and areas
are created by drawing
outlines on the design with a pen on a graphics tablet, or by dragging with the mouse.
All of the Freehand Create tools work in the same way, except for Commands and Columns.
Add Color changes, Single & Alignment stitches, and Stops Set the properties for the stitch types
Select stitch types and appliqué Draw a fill area or line
Place points for a Column

Cut a hole in a fill area
Draw a Satin Area
Emboss a line on a fill area or column Draw a wave line in a MultiWave Fill area

Draw a Fill Area with Freehand Create
1
2
3
4
5
6

Select the stitch types.
In the Freehand Create tab, click Create Freehand Area or Line
.
Draw one continuous line to create a line or area.
Lift the pen or release the mouse button to complete the line or area.
Repeat to draw as many new areas or lines as desired.
Right-click to deselect the Freehand Create function when you have finished, or simply select another
tool.
The Freehand Create functions provide a natural drawing experience and are generally recommended.
When zoomed in, use the Scroll Bars to assist in drawing new objects.
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Point Create
With the Point Create functions, lines and areas
points that define the outline.

are created by placing a series of

All of the Point Create tools work in the same way, except for Commands and Columns.
Add Color changes, Single & Alignment stitches, and Stops Set the properties for the stitch types
Select stitch types and appliqué Create a fill area or line
Create a Column

Cut a hole in a fill area
Create a Satin Area
Use Bezier Mode
Emboss a line on a fill area or column Draw a wave line in a MultiWave Fill area

Place Points with Point Create
1
2
3

4
5
6
7
8

Select the stitch types.
In the Point Create tab, click Create Point Area or Line

. The Point pointer

appears.

To create an area with Bezier lines, use Bezier Mode
. See “Bezier Mode” on page 149.
Place each point with a single click.
Hold down the Shift key to place square points for the precise positioning of corners and straight line
sections.
Click and drag
to reposition an existing point.
Click Delete to remove the last placed point.
Right-click when the area is complete.
Repeat to place as many new areas or lines as desired.
Right-click to deselect the Point Create function when you have finished, or simply select another
tool.

Bezier Mode
Use Bezier Mode
to draw shapes with finely graduated curves. Control the exact shape
of the line using the black handles to either side of the points you place.
Click to place Corner points, or click and drag to place curve points with
handles.
For information on Control Points and the other Bezier Line editing tools, see “Convert
Points and Bezier Lines” on page 295.
The Point Create functions may be easier to use for the exact positioning of corners, straight lines and
curves than the Freehand Create functions.

Area Types
Any area can have a border, or no border. The border can be closed or open, and it can use
any line type. Holes can be defined inside any fill area. Appliqué properties may be set for
any area or line. Use Break Apart on the Edit tab to change an area with a border into
separate fill area and line objects.
Any fill area can be converted into a Satin Area, however any holes in the fill area will be lost. (Any Border
lines will be retained, including the borders of the holes.)
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Pattern Fill
Pattern Fill areas
contain small stitches with repeating patterns. Select from one of the
themed categories, or import a picture as a My Fill pattern. A pattern fill area can have
holes defined inside it. The stitches can be at any angle and the density can be constant,
gradient or multicolor as desired. Constant density fill areas can also have automatic
underlay, which is turned off automatically for gradient density areas.

Fill Area with Satin border and holes Pattern Fill Area with Multicolor
using Pattern Fill 109 from Hearts
Gradient

Motif Fill Area with two motifs, 13
and 19, from Hand Stitches 2

If you change a gradient density fill back to standard, then you should also select the desired underlay.

Shape Fill
Shape Fill areas
use one of 120 different shapes. Vary the stitch density, use running
stitch or motif lines for the fill and add holes.

Shape Fill Area using Shape 66 Radial Fill with origin moved to top
and Motif 1 from Hand Stitches 1
of heart

Spiral Fill using Gradient Density

Motif Fill
Motif Fill areas
contain repeated small stitches placed using one of the Universal or
machine motif patterns. A motif fill area can also have holes defined inside it. The motifs
can be at any angle and at different sizes, and different motifs can be used on alternating
lines.

Radial Fill
Radial Fill areas
use a pattern of radiating lines from an origin point that can be moved.
Vary the stitch density and add holes.
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Spiral Fill
Spiral Fill areas
use a spiral pattern from an origin point that can be moved. Use
constant or gradient density, and add holes.

QuiltStipple Fill
QuiltStipple Fill areas
use stipple stitch in curved or straight lines. Vary the gap
between stitch lines, use running or triple stitch, and add holes.

QuiltStipple Fill using a curved
style

Contour Fill, using Triple Stitch and
a 3.0mm gap

Crosshatch Fill, using Diamond
style and an Angle of 75 degrees

Contour Fill
Contour Fill areas
use contour stitch lines. Vary the gap between stitch lines and the
length of the stitches, use running, double or triple stitch, and add holes.

Crosshatch Fill
Crosshatch Fill areas
use diamond, square and parallel crosshatch patterns, or select
the angles for the crosshatch. Set the gap, style, line angle, stitch type and stitch length for
the crosshatching, and add holes to the fill.
Crosshatch fill is often selected for lace designs, typically using a Double Zigzag stitch type.

MultiWave Fill
MultiWave Fill areas
use a wave pattern defined by a line, or lines, drawn on the fill
area. Vary the density, or use a motif for the stitch lines.

Echo Fill
Echo Fill
places echo lines within and/or around a shape. Choose from rounded, square
and diagonal corners, set the gap between the echo lines and the number of lines, and
select the stitch type and length.
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Curved Crosshatch Fill
Curved Crosshatch Fill areas
use curving lines in the crosshatch, which can be used to
create a feeling of depth. They are used in quilting, and to create free-standing lace.

Curved Crosshatch Fill, using
Square style and a Gap of 5mm

MultiWave Fill, using a density of 15,
a MultiWave Line, and a Hand
Stitches 1, Pattern 1 motif

Echo Fill using Internal and
External Lines, and rounded
corners

Satin Areas
Satin Areas
contain zigzag stitches that fill the area from one
end to the other at the same density. The stitch angle changes
with the shape of the area, and can be adjusted as desired.
Choose automatic edge walk and/or zigzag underlay, and if
desired select a pattern.
Satin Areas can be converted into any type of fill area. They cannot be
created with a border, but a border can be placed around them using the
Fill Area and Line properties dialog.

Columns
Create Columns by placing points, or on the Point Create tab by drawing Bezier lines. The
Column functions are found both on the Freehand and Point Create tabs. Place alternate
points to define a column of any length.
Columns may be converted into Satin Areas using the Convert to Satin Area
cannot be converted into any type of column.

option, but Satin Areas

Satin Column
Use Satin Column
to create a straight or curving column of
parallel stitches. The column may be of any length. If desired, add a
pattern. Choose from over 250 patterns, similar to Pattern Fill, or
create your own My Fill patterns. The density can be constant,
gradient or multicolor as desired.
The recommended maximum length for satin stitches is around 8-10mm,
otherwise the stitches may be loose and not lie flat. To create satin wider than
this, use a pattern, overlap satin columns, or use a satin area.
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Feathered Satin
For lifelike realistic feathers or fur, use Feathered Satin , where
the start and end points of the stitches are random rather than all
parallel. Feathered satin may also be created with only one side
feathered – the side where the first (A) or second (B) point was
placed.

Feathered Both Sides

Feathered Side A

Feathered Side B

Richelieu Bars
Use Richelieu Bars
to create a column of short sections of satin
perpendicular to the direction of the column. Choose the number of
bars, and the width of the satin.
Richelieu bars are typically used for cutwork designs.

Tapered Motifs
Use Tapered Motifs
to create a line of motifs that vary in size
according to the width of the column.
Tapered motifs are often used in lace designs.

Line Types
Choose a line type before drawing the line, or change it afterwards in Fill Area and Line
properties.

Running, Double and Triple Stitches
Set Running Stitch
from 0.3-12.0 mm in 0.1mm steps (standard, or cutwork needle
lines with secure points). Set Double
, Double Zigzag
and Triple
Stitch to any
length from 1mm to 12mm.

Running
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Double
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Triple

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag
pattern to create a mesh.

Motif Line
Motif Lines
are lines of the chosen Universal or machine
motif patterns.

Satin Line
Create Satin Lines
where a line or border of satin stitches of
constant width is desired. The line will be created along the center of the chosen line.

Individual satin lines and the satin borders used around fills or appliqué are identical.

Appliqué
Select Appliqué
to use appliqué fabric and placement stitches with a fill area that you
create. Select an appliqué fabric in the Appliqué Selection dialog box, and choose a
placement method in the Fill Area and Line options Appliqué tab.

Commands
Commands are instructions such as the Color Change
that changes the thread at the
start of a new color block. The Stop
tells an embroidery machine to stop without a
color change.
Color changes, stops and alignment stitches are indicated by special blue, red and pink
markers when in 2D or Object mode.

Color Change

Stop

Alignment Stitch

Alignment Stitches
Use Alignment Stitches
to add stitches at the beginning of an embroidery that you can
use to align the embroidery, for example if it is being stitched over a background picture.
Alignment Stitches are typically placed at the beginning of an embroidery. They will be
inserted after the currently selected object, but may be moved if desired. Alignment
Stitches are created as a cross, but may be altered after placement.
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Single Stitch
Use Single Stitch
to create single stitches that will be
embroidered at whatever length they are made.
Alternatively, if you select to Break Up into Smaller Stitches
they will be broken up into stitches of Running Stitch at any
length from 1mm to 12mm.
Single stitches cannot be converted to any other line type.

Objects Created in the ExpressDesign Wizard
Lines and areas created in the ExpressDesign Wizard may be modified in the same way as
those created by any other method. When the ExpressDesign Wizard is used to create a
new design or load a picture, the design will fit the hoop or use the selected design size.
Columns are not created by the ExpressDesign Wizard. Any satin will be a Satin Area or a Satin Line.
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Fill Area and Line Properties
Use the Fill Area and Line properties dialog box to change the fill and line type for a
previously created area. Then edit the properties using the tabs in the dialog.
Choose a fill type
Choose a line type
Change the line or fill properties
Set options for your favorites
Set the appliqué method
Set underlay, angle and compensation

Select a fill category and pattern
Use a Gradient fill

Set the properties for a gradient fill

Click Apply to preview and OK
to finalize your changes

The options available in the two drop-down lists vary, depending upon the selected fill and line type.
You can change a previously created area to any other fill or line type in the drop-down lists, including No
Fill or No Border Line.

To access the Fill Area and Line properties dialog, click the Fill Area and Line button in the
Options area of one of the Create tabs. Alternatively, right-click an existing line or fill on
the FilmStrip or in the work area.
If accessed from the Options button, you cannot change the fill and/or line type.

Fill
Select the Fill type from the drop-down list:
No Fill

Spiral Fill

MultiWave Fill

Pattern Fill

QuiltStipple Fill

Echo Fill

Motif Fill

Contour Fill

Satin Area

Shape Fill

Crosshatch Fill

Radial Fill

Curved Crosshatch Fill
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Line
Select the Line type from the drop-down list:
No Border Line

Triple Stitch

Running Stitch

Satin Line

Double Stitch

Motif Line

Double Zigzag

Click the Line tab and select Insert Color Change for a different color for a fill area border.
See “Secondary Colors” on page 94.

Appliqué
Select the appliqué method before or
after creating an area or line. Choose
from:
•
•
•
•
•

None
Standard Appliqué
Pre-cut Piece
Pre-placed Piece
Cut-out

Standard Appliqué
Stitch a running line to show where
appliqué fabric should be placed,
then stop to position the fabric. Stitch down the appliqué fabric with double stitch, then
stop so the fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork
needles.
Stitch a running line to show where the pre-cut appliqué piece should be placed, then
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch,
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.
Place the appliqué layer in position, then stitch down the appliqué fabric with double
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border
stitching.

Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example
for reverse appliqué.
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Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the
stitched outline. Finish the edges with the selected border stitching.

Select Fabric
Use Select Fabric to choose a fabric for your appliqué in the Appliqué Selection dialog box.
Click Select Fabric and the Appliqué Selection dialog box appears. See “Appliqué
Selection” on page 159.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to
10mm. The initial value is 1.0mm.
Use a positive value when trimming the appliqué fabric before the border is stitched, for example with
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin
has been applied.
This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated
cutter, to ensure the placement line is visible.

Favorites
Use the Favorites tab of the Fill Area and Line properties dialog to make the chosen
settings into favorites, to change your defaults for a stitch type, or to return to the original
settings.

Save these options as my favorite
Use ’Save these options as my favorite’
this area or line type.

to save the chosen options as the favorite for

The favorite option must always be applied from the Favorites tab. It is not the same as the current settings,
used to create new areas.

Apply my favorite to these options
Use ’Apply my [stitch type] favorite to these options’
the area or line type instead of the settings shown.

to use your favorite settings for

Select multiple objects with the same fill type in the work area or FilmStrip, right-click and select Properties.
Then in the Favorites tab use ’Apply my favorite to these options.’. All of the selected objects are changed.

Set these options as the current settings
Use ’Set these options as the current settings’
for new areas of this type.
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to use the chosen options as the default
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Reset these options to the system default
Use ’Reset these options to the system default’
area or line type to the system default.

to change the settings for the selected

Show a text summary for these options
Use ’Show a text summary for these options’
area or line settings.

to display details of the currently selected

Save a Fill and Line Type as a Favorite
1
2

3
4

5

To open the Fill Area and Line properties dialog, right-click an existing line or fill, or click the Fill Area
and Line Options button in the Quick Create, Freehand Create or Point Create tab.
For an existing fill, select a Fill type from the Fill drop-down list at the top.
The Fill and Line type menus will only be available if you opened an existing line or fill.
The settings will be saved for the fill and the line type in an object with both.
For an existing line, select a Line type from the Line drop-down list at the top.
Edit the details in tabbed pages below as desired.
For details on the options available, for Line types see “Using Lines” on page 265, for Fill types see “Using Fill
Areas” on page 183, and for Appliqué see “Appliqué Selection” on page 159.
Click the Favorites tab, then click ’Save these options as my favorite’ .
This will save your settings as a favorite in case you want to use these settings frequently. Click ’Show a text
summary for these options’ to view your settings.

Save a Fill and Line Type as your Current Settings
1
2
3
4
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Right-click an existing line or fill object to open the Fill Area and Line properties dialog.
Make any desired adjustments to the line and fill types in the Options and Line tabs.
Click the Favorites tab.
Click "Set these options as the current settings".
In future when you use that fill type, the settigns that you chose here for the fill and line types will be used.
To use the system defaults for the fill type in future, click "Reset these options to the system default" on this
tab.
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Column Properties
Use the Column properties dialog to change the column type for a previously created
area. Then edit the properties for the selected column type using the Options tab. Use the
Favorites tab to select favorites, or to return to the original settings.
Choose a column type

Change the properties as desired

Click Apply to preview and OK
to finalize your changes
You can change a previously created column to any other column type in the drop-down list. Use Convert
to Satin Area

to change to a satin area.

To access the Column properties dialog before creation, select one of the Column options
in the Options section of the Freehand Create or Point Create tab. After creating stitches,
right-click an existing selected column on the FilmStrip or in the work area.
If accessed from the Options button, you cannot change the column type.

Convert to Satin Area
Click Convert to Satin Area
to change the column to a Satin Area. The Fill Area and Line
Properties dialog for Satin Area is displayed. See “Satin Area Options” on page 243.
Click Undo

to change back to a column.

Favorites
Use the Favorites tab of the Column properties dialog to make the chosen settings into
favorites, or to return to the original settings.

Save these options as my favorite
Use ’Save these options as my favorite’
this column type.

to save the chosen options as the favorite for
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The favorite option must always be applied from the Favorites tab. It is not the same as the current settings,
used to create new areas.

Apply my favorite to these options
Use ’Apply my favorite to these options’
type instead of the settings shown.

to use your favorite settings for the column

Set these options as the current settings
Use ’Set these options as the current settings’
for new areas of this type.

to use the chosen options as the default

Reset these options to the system default
Use ’Reset these options to the system default’
column type to the system default.

to change the settings for the selected

Show a text summary for these options
Use ’Show a text summary for these options’
settings.

to display details of the chosen column

Object Properties
The following settings can be changed for stitch objects before or after they are created:
■
■
■
■
■
■
■
■
■
■
■

Density
Compensation
Underlay
Stitch Length
Satin Line Width
Fill and Satin Patterns
Gap and Shape
Start, End and Origin
Motif
Feathered Side
Alignment Stitch Type
The settings for new areas and lines are set by selecting a stitch type in the Options area of
the Create tab and adjusting them in the properties dialog for that stitch type.
Alternatively, select an area with the desired properties and save them as your Favorite
or Current
settings.
Not all settings can be changed for all stitch types.
Options that set properties for new objects are only applied when using the Create tabs to make stitch
objects. Objects created in the ExpressDesign Wizard do not use the current settings, but may be changed
after finishing the wizard.
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Density
Density of stitching may be set from 2 to 40, except for Pattern Fills
, Spiral Fills
Satin Column
and Satin Area
(2 to 80), and Richelieu Bars
and Satin Line
to 15).

Pattern Fill Area with Multicolor
Gradient

,
(2

Pattern Fill Area with Gradient
Density Fill

Pattern
and Spiral
Fill areas and Satin Columns
may also have density gradients,
or variable multi-density. The higher the number, the farther apart the stitches and the
fewer stitches are produced. Pattern fills and Satin Columns may also have multicolor
gradient density.
Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting.
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like
linen or satin.

Compensation
All stitches have a tendency to pull in. The pull varies according to fabric weight and type.
Compensation is used to make a whole design or areas within it 'bolder' by increasing
their relative size. The higher the number, the bolder the areas appear. You can also alter
compensation for any individual area of satin or fill.

Satin Compensation

Pattern Fill Compensation

Embroidery on thicker fabrics usually looks better with higher compensation, while on thin materials such
as satin or twill a lower value or zero setting is usually more appropriate. As you create a design, use
overlaps to prevent pulling from creating gaps between blocks of stitches that have different stitch
directions. This provides 'built-in' compensation.

Compensation may be set from 0 to 30 for satin and 0 to 20 for fill areas. The setting for any
Satin Column , Satin Area
and Pattern Fill
in the design is shown in the Area and
Line properties for that satin or fill.
mySewnet™ Digitizing Creating Design Elements
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Compensation does not apply to feathered satin, satin line, or any fill other than pattern fill.

Underlay
Underlay is used to stabilize an area of fabric before stitching over it. Automatic underlay is
optionally available for Pattern Fill areas, Satin Areas, Satin Column, Richelieu Bars and
Satin Line. To create underlay for other object types, use running stitch or single stitches.
Embroidery designs created with the ExpressDesign Wizard have an option to create underlay for the
whole design.

Stitch Length
Stitch Length can vary according to the object type as follows:
■

Single Stitches : each stitch may be set from 1-12mm in 1mm steps, or embroidered
without breaking up into smaller stitches.
The current maximum stitch length for new Single stitches, if it is desired to break them up into smaller
stitches, is shown in the Preferences

■

Running Stitch

.

may be set from 0.3-12.0mm in 0.1mm steps.

Cutwork needle lines are automatically set to 0.3mm.
■

■
■

■

■

■

Double Stitch
, Double Zigzag
and Triple Stitch
may be set from 1-12mm in
0.1mm steps.
Motif Line
stitches may be set from 1-20mm in 0.1mm steps.
Motif Fill
: the length of the running or triple stitches making the motif shapes can be
set from 1-12mm in 0.1mm steps.
Feathered Satin
(feathered both sides or one side): the maximum length of the stitches
may be set from 2-30mm in 1mm steps.
Shape Fill : where Motifs are used, the length of the running or triple stitches making
the motifs can be set from 1-12mm in 0.1mm steps.
QuiltStipple , Contour
, Crosshatch
, Curved Crosshatch
and Echo
Fill: the
length of the running or triple stitches making the fill can be set from 1-12mm in 0.1mm
steps.
Check the current setting by clicking the Options button in one of the Create tabs.

Satin Line Width
Satin line or border width may be set from 1 to 12mm in
0.1mm steps.

Fill and Satin Patterns
Choose from over 250 system patterns or any imported My Fill
pattern for Pattern Fill areas, Satin Areas and Satin Columns.
Choose any available motif for motif fill areas, lines and tapered
motifs columns. Check the current setting by clicking the Fill
Area and Line button in the Options area of one of the Create
tabs. See “Fill and Satin Patterns” on page 318.
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Patterns in categories other than Standard are recommended for use in relatively
large fill areas, as they have repeating patterns which work well when 'tiled'
together. Pattern 36 produces a 'satin effect' fill stitch. The first four patterns in the
Gradient & Lace category (253-256) are recommended for multicolor gradient. The
other eight (257-264) are suitable for a weave pattern combined with parallel
crosshatch, as used for lace designs.

Set the angle of orientation for the stitches in Pattern, Motif and
Crosshatch and Curved Crosshatch fill areas to any degree. Check the current setting by
clicking the Fill Area and Line button in the Options area of one of the Create tabs.

Gap and Shape
The QuiltStipple
, Contour , Shape
, Crosshatch
,
Curved Crosshatch
and Echo
styles of fill have additional
properties that are unique to these fill styles. QuiltStipple fills
can have curved or straight stipple stitching, and a gap setting
controls the spacing of the lines of stipple stitch. Contour fill also
uses a gap setting that controls the spacing of the lines of
Contour stitch. Shape fills have a choice of 120 shapes, which
control the path of the stitching. Crosshatch and Curved
Crosshatch fills can use diamond, square and parallel styles.
They have a gap setting that controls the spacing between the lines in the crosshatch.
Echo fills can use internal or external lines, varying the number or spacing. They also have
a choice of three styles, with curved, square or diagonal corners.
Richelieu Bars may have a minimum gap or number of bars specified.

Start, End and Origin
Fill and satin areas have adjustable green start
and red end
points, which can be
moved to any point defining the shape of the area. Use this to control the connection
between an area and the objects that precede or follow it. For example, this is useful for
shortening or hiding movement stitches so the need for trimming is reduced.
Pattern, Shape, Radial and Spiral fill areas also have an orange origin
the origin marker also has an adjustment handle
.

. For Pattern Fill,

In a pattern fill area, the origin is the start point for the repeating pattern. In Shape, Radial and Spiral fills,
the origin is the point from which stitches radiate. For a pattern fill area, move the origin to change the
position of the pattern, and rotate the handle to change the angle. For Shape, Radial and Spiral fills, move
the origin to move the radiation point of the fill. The origin may be moved anywhere on the work area.
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Motif
Choose any available motif for Motif Fill areas
and Lines
.
Motifs can also be used in Shape , MultiWave
and Curved
Crosshatch
fills, and tapered motifs columns
. The size of
motifs can be changed, and they can be stitched in either
running or triple stitch. For motif fill areas, a second motif can be
chosen for alternating lines, and the spacing, offset and angle of
lines can be changed. Check the current setting by clicking the
Fill Area and Line button in the Options area of one of the Create
tabs.

Feathered Side
Individual areas that were created as both sides feathered, Feather Side A or Feather Side B
may have their feathered edges changed. See “Feathered Satin” on page 32.

Feathered Both Sides

Feathered Side A

Feathered Side B

Alignment Stitch Type
Alignment stitches are added at the beginning of an
embroidery to align it, for example, with a background picture
on fabric.
Alignment stitches are initially placed as a cross . Use the
Alignment Stitches properties dialog to change the stitch type.
Select the desired stitch and right-click to choose from cross
, top left
, top right
, bottom left
, bottom right
and point .

Global Properties
The properties of all visible objects of a chosen type can be changed with Global
Properties.
Global Properties is not used for Stops, and has no effect on Color Changes.

Shortcut
■
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Keys: Alt, E, G; Right-click FilmStrip, B
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Change Object Settings with Global Properties
1
2

3
4

Use the Edit tab and the Design Panel to hide any objects you do not wish to affect.
For example, hide objects by color, or use the Hide Object Types filters.
Right-click an object of the desired type in the FilmStrip and select Global Properties from the context
menu.
The properties dialog box for the object will appear, with the current settings taken from the selected
object.
Adjust the properties as desired.
Click OK.
All the settings in the dialog box will be applied to all visible objects of the same type.
When you click OK, the settings are applied globally even if you did not change anything. For
example, if you have a fill area that already has the desired settings, select the fill area then select
Global Properties and click OK to replicate the settings on all visible fill areas.
Global Properties is only available if a single object is selected.

Change Properties for Selected Objects
The properties of all selected objects of a chosen type can be changed at once.
You cannot change properties for multiple Stops or Color Changes at the same time.

Change the Settings for Selected Objects
1
2
3
4

Hold the Ctrl key and in the FilmStrip click each of the objects that you want to affect.
With the desired objects selected, right–click one of your chosen objects.
Select Properties from the context menu. The properties dialog box for the object will appear, with
the current settings taken from the selected object.
Adjust the properties as desired, then click OK.
All the settings in the dialog box will be applied to all selected objects of the same type.

When you click OK, the settings will be applied to all selected objects, even if you did not
change anything. For example, if you have a fill area that already has the desired settings,
select the objects you want to change, right-click the fill area with the desired settings and
select Properties from the context menu. In the Fill Area and Line properties dialog click
OK to replicate the settings on all selected fill areas.
If more than one type of object is selected, only the object selected first will have its properties changed.
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Changing Stitch Types
To change a stitch type to another stitch type, select the line or fill area, then right-click.
(Alternatively, right-click on the object in the FilmStrip of the Design window and select
Properties.) In the Fill Area and Line properties dialog select the desired Line or Fill type
from the drop-down menus at the top.
Stitch types in the following two groups may be changed to any other stitch type in either
of these groups:

Lines
Running Stitch

Satin Line

Double Stitch

Motif Line

Double Zigzag

No Border Line

Triple Stitch

Areas
Pattern Fill

QuiltStipple Fill

Echo Fill

Motif Fill

Contour Fill

No Fill

Shape Fill

Crosshatch Fill

Satin Area

Radial Fill

Curved Crosshatch Fill

Spiral Fill

MultiWave Fill

When converting to a Satin Area, any holes in the fill area will be lost.

Objects in the following groups may be changed to any other stitch type in that group:

Columns
Satin Column

Richelieu Bars

Feathered Satin

Tapered Motifs

Any Column can be changed into a Satin Area using the Convert to Satin Area
changed back.

option, but it cannot be

The following object types cannot be changed into another type of object:
■
■
■
■
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Single Stitch
Stop Command
Color Change
Alignment Stitch
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Design Size and Creating Embroideries
The purpose of creating a design is to generate an embroidery from the finished design.
Before creating an embroidery you may wish to consider how the design size will affect
the finished embroidery.
The size of a design is mainly controlled by the hoop size used.
You can create a design for many different hoop sizes from the same design outline (.edo) file. However,
you need to consider how this will affect the size of individual parts. For example, a satin line for an
embroidery size of 150mm may look better as a running stitch line if the embroidery size is 80mm. The
recommended maximum length for satin stitches is around 8-10mm, otherwise the stitches may be loose
and not lie flat. To create a satin sections wider than this, either overlap satin sections, or use one of the fill
patterns to create smaller alternating stitches

When creating designs, remember the outside edge of some stitch types may extend
beyond the hoop. For example, satin borders have stitches generated on both sides of the
center line and feathered satin sections have stitches that go beyond the points placed to
define the feathered satin. The design size is measured according to the distance between
the outermost control points. However, the embroidery may be larger than the desired
design area or hoop size if stitches are created that extend beyond the outermost points,
as in the example. This is easy to see in 3D View, but in Object View you could create areas
that are too large without realizing.

The stitches created go outside the hoop.

The points for both the satin line and
feathered satin are inside the hoop.

You will be able to save the design outline file, but if you select Export Embroidery a
message will appear: Embroidery is too large or will not fit in hoop. Click OK to continue.
Change to a larger hoop
to stitch out the design, or in the Modify Block menu on the
Home tab, select Scale Fit to Hoop
to automatically adjust the actual size of the design
to fit in the hoop.
Use Change Design Size
to alter a design automatically to a new size, allowing for the
stitch objects used such as satin borders.
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ExpressDesign Wizard

4

Use the ExpressDesign Wizard to create new designs automatically from pictures. There
are three design types that can be created in the ExpressDesign Wizard: Express
Embroidery, Express Trace and Express Border.mySewnet™ Draw & Paint
Additionally, when started with New , the ExpressDesign Wizard can be used to load a
picture for a new design, load an existing design or start a new design without a picture.

Express Embroidery
Create a new design by converting color areas in a picture to fill and
satin areas, using running stitch or satin border outlines where
necessary.
Express Embroidery works best when using pictures that have well
defined, flat color areas and outlines.

Express Trace
Create a new design by tracing outlines in the picture. Use light or
heavy running stitch to create redwork or blackwork style designs,
create quilt stencils and so on. Use satin border of constant width for
designs that demand broader outlines.

Express Border
Create a new design by creating borders around
shapes in a picture. The border can be created as a satin
border, an outline of running, double or triple stitch, or
a border of motifs; all, optionally, with appliqué.

Load or Create a Picture
Create a new design by loading a picture, and optionally
rotating and cropping the picture. Select a hoop or design size,
then the wizard finishes. The picture is loaded as a background
into the mySewnet™ Digitizing design window.
You can also create or edit a picture in mySewnet™ Draw & Paint.

Load Existing Design
Open an existing design to preview it in the wizard, then close the wizard and load the
design in mySewnet™ Digitizing. The Design window of mySewnet™ Digitizing is shown.

Start a New Design with no Picture
Select a hoop, then close the ExpressDesign Wizard and start with an empty work area in
mySewnet™ Digitizing.
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New
Use New
to clear the mySewnet™ Digitizing screen and start a new design. You are
prompted to save the current design if changes have been made. The ExpressDesign
Wizard will start and the Choose Design Type page will appear.

Shortcuts
■
■

File Menu:
Keys: Ctrl + N

New Window
Use File, New Window in the Design window to open an additional mySewnet™ Digitizing
window so that you can start a new design with the ExpressDesign Wizard, insert an
embroidery or design, or paste a block to start a new design.
To move between open mySewnet™ Digitizing windows, hover over the mySewnet™ Digitizing icon on the
taskbar, and select the desired window.

Shortcuts
■
■

File Menu:
Keys: Ctrl + Shift + N

Insert ExpressDesign
Use Insert ExpressDesign
to create a new design in the ExpressDesign Wizard. Insert
ExpressDesign is used to add new design elements to an existing design, but can also be
used to create the first part of a new design, or used repeatedly to compose a design from
elements created in the ExpressDesign Wizard.
Use ExpressDesign into Rectangle to create a new design that is a best-fit to a rectangular
area you draw, and use ExpressDesign into Hoop to create a new design that is a best-fit to
the currently selected hoop and orientation.

ExpressDesign into Rectangle
Use the ExpressDesign into Rectangle
option to create a new design in the
ExpressDesign Wizard that is a best-fit to a rectangular area you draw.
In the Insert ExpressDesign
drop-down, click ExpressDesign into Rectangle
and the
mouse pointer will change to the draw rectangle pointer
. Click and drag on the work
area to draw a rectangle of the desired size. When you release the mouse button, the
Choose Design Type page of the ExpressDesign Wizard will appear.
If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears.
Then click ExpressDesign into Rectangle again.

Choose the desired design type, then choose a picture and step through the rest of the
ExpressDesign Wizard. When you Finish, the new design will be placed where you drew
the rectangle, and will fit the rectangle proportionally, depending on the picture shape.
Use Save
to keep the new design. Use Export
to save in other formats, and optimize
for stitching.
mySewnet™ Digitizing ExpressDesign Wizard
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Shortcuts
■
■

Home Tab, ExpressDesign Wizard Drop-Down:
Keys: Alt, H, IR, IR

Insert an ExpressDesign in the Work Area
1
2

3
4

5
6

In the Home tab, click Insert ExpressDesign
, and Into Rectangle
. The mouse pointer will
change to the draw rectangle pointer
.
Click and drag on the work area to draw a rectangle of the desired size. When you release the mouse
button, the Choose Design Type page of the ExpressDesign Wizard will appear.
If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears,
then select Insert ExpressDesign again.
Choose the desired design type and click Next.
Choose a picture then step through the rest of the ExpressDesign Wizard. The pages will appear
according to the chosen design type.
The rectangle you drew is used to automatically set the size of the new design, according to the portion of
the design area you selected with the rectangle and the current hoop. Hence, the Design Size page of the
wizard will not appear.
At the end of the wizard click Finish. The new design will be placed where you drew the rectangle,
and will be a best fit to the rectangle depending on the picture shape.
Move, resize, mirror, rotate, copy and cut the new design as desired. When the new design is
positioned and sized as desired, right-click to deselect it.

ExpressDesign into Hoop
Use the ExpressDesign into Hoop
option to create a new design in the ExpressDesign
Wizard that is a best-fit to the currently selected hoop and orientation.
If desired, click Change Hoop

and choose a different hoop size before using ExpressDesign into Hoop.

In the Insert ExpressDesign
drop-down, click ExpressDesign into Hoop
and the
Choose Design Type page of the ExpressDesign Wizard will appear. Choose the desired
design type, then choose a picture and step through the rest of the ExpressDesign Wizard.
When you Finish, the new design will be placed in the center of the hoop. Use Save
or
Save As
to keep the new design, together with any other designs in the work area. Use
Export
to save in other formats, and optimize for stitching.

Shortcuts
■
■
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Home Tab, ExpressDesign Wizard Drop-Down:
Keys: Alt, H, IR, IH
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Choose Design Type

Create an embroidery
automatically
Load or create a picture
Load a design
Start with an empty work area

Express Embroidery
Create a new design by converting color areas in a picture to fill and
satin areas, using running stitch or satin border outlines where
necessary.

Express Trace
Create a new design by tracing outlines in the picture. Use light or
heavy running stitch to create redwork or blackwork style
embroidery, create quilt stencils and so on. Use satin border of
constant width for larger designs or when a bolder outline is more
pleasing.

Express Border
Create a new design by simplifying a picture into solid color areas.
Borders are created around these shapes as satin, appliqué, running
stitch, double stitch, triple stitch or motifs.

Load or Create a Background Picture
Create a new design by loading a picture, and optionally rotating
and cropping the picture. Select a hoop or design size, then the
wizard finishes. The picture is loaded as a background into
mySewnet™ Digitizing design window.
You can also create or edit a picture in mySewnet™ Draw & Paint for a
background.

This option is only available when starting the ExpressDesign Wizard with File, New
File, New Window .
mySewnet™ Digitizing ExpressDesign Wizard

, or

51

Load Existing Design
Open an existing design to preview it in the wizard, then close the
wizard and load the design in the mySewnet™ Digitizing design
window.
This option is only available when starting the ExpressDesign
Wizard with File, New
, or File, New Window
.

Start a New Design with no Picture
Select a hoop, then close the ExpressDesign Wizard and start with a
blank work area in mySewnet™ Digitizing.
This option is only available when starting the ExpressDesign
Wizard with File, New
, or File, New Window
.
Use this option if you wish to create your own picture with stitches, or load a
picture later.
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Choose Picture
Select a picture file on
your computer
Paste a copied picture
Import a file from a
scanner or camera
Create in Draw & Paint
Edit a picture in Draw & Paint
The picture is previewed

Use the Choose Picture page to select the picture you wish to convert to a design. Select a
picture from clipart, or one you have previously scanned or created in an image editor.
Alternatively, paste a captured picture.

Load a Picture
Click Load a Picture
to open a picture from clipart, or one you have previously scanned
or created in an image editor. After selecting a picture, the preview box will show the
selected picture with its name underneath. Click Next to continue.

Choose a picture folder

Click to select a picture
Scroll to view more folders
Load the selected picture
Change the icon size

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged
Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf ), Windows Enhanced
Meta File (.emf ) and Windows Icon (.ico).

Select a Picture file
1
2
3

Click Load a Picture
and the Picture Viewer dialog box appears.
Double-click to expand the folders until the desired folder is highlighted.
Click on a picture to select it.
mySewnet™ Digitizing ExpressDesign Wizard
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4
5

Click OK to open the picture in the Choose Picture page.
Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture
preview area.

to load the picture in the Clipboard Block. The picture is shown in the

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera
to display the program that is used to acquire pictures
from a scanner, a digital camera or another suitable device. Only devices that use Windows
Image Acquisition (WIA) can be used to obtain pictures.
WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s
scanning or downloading program to another program, in this case the mySewnet™ Digitizing module of
the mySewnet™ Embroidery Software. If the manufacturer provides the appropriate software components
needed for WIA compliance, these should have been installed when the device was installed.

Each scanner or digital camera has its own program that is used to scan or download
pictures. Refer to the manual or online help provided with the program for instructions, if
required. When the device and its software finish processing the Picture, it will be shown
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture

or edit an existing picture

in mySewnet™ Draw & Paint.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned
image then the box will contain the words Scanned Picture.

Back
Return to the Choose Design Type page.

Next
Go to the Rotate and Crop Picture page.
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Rotate and Crop Picture
Zoom in and out
Adjust the crop lines as desired

Change the angle of the picture
Select the whole picture or
use the default crop settings
Correct the perspective in the picture

Save the edited picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used
to create the design, and to rotate the picture to any angle from 0 to 359 degrees. The
picture is automatically cropped to remove excess background color. If required, adjust
the crop lines to select the desired part of the picture. Use Perspective Correction to adjust
for perspective or skew.
Sometimes, the automatic crop area may not appear to remove as much background color as possible.
This can happen when the background color appears to be a plain color, such as white, but actually has
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF
Compliant (*.jpg, .jif, .jpeg) picture format.

Click and drag anywhere inside the crop box to move the crop box. Click and drag outside
the crop box to draw a new crop box.

Rotate
Rotate the picture to any angle from 0 to 359 degrees. When the picture is rotated
between the 90 degree steps, the picture is made larger and the detected background
color is added. If there is no distinctive background color, white is used.

Select All
Click the Select All button to select the whole picture. Alternatively, double-click the
picture to select the whole picture.

Reset
Click Reset to set the crop lines back to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective
Correction . When using Perspective Correction, the crop handles are red.
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Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view
the outline of the picture more clearly. Drag the Stretch Picture
slider to make the
picture in the Preview wider or narrower. Use Save Picture
to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Next
Go to the:
• Design Size page for an Express Embroidery, and when loading or creating a
background picture
• Outline Finder and Expander page for an Express Trace
• Monochrome Threshold page for an Express Border.
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Outline Finder and Expander

Find the outline in the picture

Increase the thickness of the line
Preview your changes

The Outline Finder and Expander page of the ExpressDesign Wizard only appears if you
are creating an Express Trace design. If the picture consists of mainly solid color areas, use
this page to create outlines appropriate for tracing.

Find Outlines
Select this option to find the outlines in your picture and show them in the preview area.
Find Outlines looks for distinctive boundaries between color areas in the picture. Pictures that have
gradual color changes, such as photographs or previously scanned pictures saved in JPEG format, may not
have strong color boundaries that can be detected by Find Outlines.

It is usually not necessary to Find Outlines in a picture that already has black outlining.
However, if there are additional color boundaries that do not have outlining in the picture,
you may still wish to use Find Outlines.

Expand
This is only available when Find Outlines is selected. Use this option to increase the
thickness of outlines that have been found, by adding up to 5 pixels on each side of the
lines. It is initially set to 1. Lines are traced down the center by Express Trace, so setting
Expand to at least 1 will allow curves to be traced more smoothly and continuously.
If Expand is set to 0 (zero), the outlines found in the picture will be only one pixel wide. When a line changes
direction, this may cause a break in the line where pixels only meet at the corner. This may cause a line to
be traced in multiple sections, or not at all. Therefore, it is recommended to set Expand to at least 1.

If desired, use higher Expand values to merge outlines when parallel outlines are close
together. Alternatively, you may be able to exclude unwanted lines by using Monochrome
Threshold on the next page.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
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or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Preview
The preview shows the picture. If Find Outlines is selected, the preview shows the outlines
that have been found, and the effect of using Expand.

Back
Return to the Rotate and Crop Picture page.

Next
Go to the Monochrome Threshold page.
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Monochrome Threshold
Preview monochrome version

Original picture

Adjust the color sensitivity

The Monochrome Threshold page of the ExpressDesign Wizard appears if you are creating
an Express Trace or Express Border design.
The Monochrome Threshold turns all shades or colors in the picture into either black or
white. It acts on the whole picture. The Monochrome Threshold creates defined areas that
are suitable for creating the final designs.
Interior details, within enclosed shapes in the picture, will not be preserved when creating Express Border.

Move the Monochrome Threshold slider bar to the desired setting, or enter a value directly
in the box, then click Next.
Adjust the Monochrome Threshold between 0 and 255 by typing in a number, clicking on
the left or right of the slider bar or by clicking and dragging the slider bar. To make more of
the image black, move the slider to the right or type a higher number in the box. To make
more of the image white, move the slider to the left or type a lower number in the box.

Original Picture
The thumbnail on the left shows the original picture. This allows you to see which colors in
the picture have been turned black or white.

Preview
The preview picture shows the result of applying the Monochrome Threshold.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
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Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Back
Return to the Rotate and Crop Picture page for an Express Border design, or to the Outline
Finder and Expander page for an Express Trace.

Next
Go to the Design Size page.
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Design Size
Fit the design to the hoop
Enter a size for the design

Preview the hoop

Select a different hoop
Set the size of the design

The Design Size page only appears when creating a new design, from New or New
Window.
To specify the design size, either select Fit Design to Hoop to ensure the design fits the
desired hoop, or choose Enter Design Size to specify the width or height of the design.

Fit Design to Hoop
The current hoop name and hoop size are shown, with a thumbnail of the hoop. The
selected hoop is remembered, next time you use the ExpressDesign Wizard.
Click Change Hoop to choose a different hoop in the Hoop Selection dialog box. The new
design will be a best fit to the selected hoop and orientation.
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Select the hoop size

Choose a machine or hoop group

Add the hoop
to My Hoops

Enter a size for a custom hoop

Select the hoop orientation

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use
the My Hoops list to create a list of your favorite hoops.
The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you
sit in front of your machine; note the position of the bracket.
It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size
box so that it is selected (checked). The Width and Height boxes will become available.
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop
you enter.
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If you position the arrow pointer over the box without clicking, the alternative units and range will be
shown.

Enter Design Size
Select the dimension you wish to set (the Width or Height of the design), usually the
longest side, then enter the size of the design.
Enter Design Size is not available if one of the Start a New Design with no Picture options was selected in
the Choose Design Type page.

Back
Return to the:
• Rotate and Crop Picture page for an Express Embroidery and when loading or creating a
background picture
• Monochrome Threshold page for an Express Trace or Express Border
• Choose Design Type page when starting a new design with no picture.

Next
Go to the:
• Choose Thread Colors Page for an Express Embroidery
• Express Trace Options or Express Border Options for those design types

Finish
For Start a New Design with No Picture, and for Load or Create a Background Picture close
the ExpressDesign Wizard and open the main screen.
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Express Embroidery Options
There are two wizard pages used to set additional options for creating an Express
Embroidery.

Choose Thread Colors
Zoom in and out
Return to the original color list
Set the number of colors
Select a Thread Range
Choose a thread

Remove the background color
Move colors up & down the list
Change a thread color
Delete a color
Delete all colors
Choose a color from the picture
Pick a background color from the picture
Enhance detail in the picture

The Choose Thread Colors page of the ExpressDesign Wizard only appears when you are
creating an Express Embroidery. Use the Choose Thread Colors page to match thread
colors to colors in the picture, to set the number of colors, and to choose the color order.
Select whether or not to keep the background and, if desired, pick a different background
color. Optionally, choose whether or not to expand thin lines and set the sensitivity to
small areas in the picture.

Color Selection
Number of Colors
The Number of Colors is initially set to the Recommended number of colors. The
ExpressDesign Wizard determines the optimal number of colors for converting the picture
into thread colors. When this number is changed, the list of colors and the preview are
updated.
The maximum Number of Colors is 256. For pictures with less than 256 colors, the
maximum is the total number of colors in the picture.
The total number of colors in photographs and other complex color pictures may be shown as 256+. This
may mean that there are a lot of small color areas in the picture. This can also happen with clipart in JPEGJFIF Compliant (.jpg, .jif, .jpeg) format, as this format introduces minor color variations that may not be
visible.

Apply
Click Apply to recalculate the threads with the new number of colors.
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Reset
Use Reset to return the color list to the initial set of colors. The colors are also re-ordered
from light to dark. The colors in the picture will be matched to thread colors from the
thread range shown in the Change All To box. Any custom thread matches that are
required must be re-selected with Change Thread.

Change All To
Click the drop-down arrow to choose a different thread range. When a thread range is
chosen, each picture color in the list will be assigned the nearest matching thread color
from the chosen thread range.
When a new thread range is chosen, all custom thread matches set by Change Thread will be lost.

Picture and Thread Color List
The color list shows the colors that have been automatically selected. The colors are
picked to give the closest representation of the original picture with the current Number
of Colors. Each time the number of colors is changed, this list is updated.
Sometimes, when the Number of Colors is reduced to a low number, colors will be chosen that are averages
of two or more prominent colors in the picture. This can give a posterized appearance to the Reduced
Colors Preview. If this effect is not desired, increase the Number of Colors.

The list shows a sample of each color currently selected from the picture. Initially, the
colors are shown from light to dark, with each picture color automatically matched to a
thread color from the thread range shown in Change All To. The color order can be
changed. This affects the order that colors are used in the final design.
The basic color order is set by this list. However, the order for stitch types is satin, then fill, then outlines
(running stitch or satin border). Hence, if black is moved so that it is first in this list, it will still be last in the
final design if it is only used for outlining.

The same thread color may be matched to two or more colors in the picture. Each thread
color can be individually changed with Change Thread. When thread colors are changed
in the list, the Thread Color Preview is updated.
When more than one color in the picture is matched to the same thread color, the number of color changes
in the final embroidery is reduced.

Move Up and Move Down
Use Move Up and Move Down to change the order of colors in the list.

Change Thread
Click a color in the list, then click the Change Thread button. The Color Selection dialog
box will appear so that a different thread color can be chosen. Alternatively, double-click a
color in the list and the Color Selection dialog box will appear.
It is recommended only to use Change Thread after the main thread range has been selected.

Pick
Click Pick to add thread colors to the list by clicking the desired colors in the Source
Picture.
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When Pick is selected, the pointer changes to an eyedropper
over the source picture.
Click the picture to pick up the color under the tip of the eyedropper, and the nearest
matching thread color from the selected Thread Range will be automatically selected and
added to the thread color list. The Thread Color Preview will be updated to show any other
areas that can use the selected thread color.
The thread color is picked for the clicked color according to the RGB (red, green, blue) value at the point
clicked. If there is already a thread color assigned to that exact RGB value, it will be highlighted in the list
instead of adding a thread color to the list.

Delete
Delete the picture color currently highlighted in the list. The deleted color is replaced with
the nearest remaining picture color in the list. The Thread Color Preview is re-displayed,
with the reduced set of thread colors.

Delete All
Click Delete All to remove all the thread colors from the list if you wish to use Pick to
choose colors from the Source Picture.

Background Color
The background color is automatically determined. It is the color which is used the most
along the edges of the picture. If desired, select a different background color.

Current Background Color
The large color square shows the current background color.

Pick Background Color
Click Pick Background Color
to choose a different color from the Source Picture as the
background color. When Pick Background Color is selected, the pointer changes to an
eyedropper
over the source picture. Click the picture to pick up the color under the tip
of the eyedropper. The sample of the current background will change. Depending on the
choice for Automatically Remove Background Color, the Thread Color Preview may show
the effect of removing the selected color.

Automatically Remove Background Color
When this is selected, the Thread Color Preview will show any areas that will be removed
as a checkerboard pattern.
When removing the background color, choose between:
• Remove main background only
Any areas of the background color that are connected to the edges of the picture will
not be used in the final design. Use this option when there are significant design
elements in the background color within the design.
• Remove all background color areas
Any areas of the background color will not be used in the final design. Use this option
when the background shows through gaps in the composition. Also choose this if you
wish to remove a background color that is not connected to the edges of the picture.
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Removing Multiple Background Colors
Some pictures may have more than one background color, even after color reduction. To
remove additional unwanted background colors, change the thread color so that all the
background colors use the same thread color.
If the thread color used for the background color is the same as for a color area that you wish to keep,
change the background thread color to a 'false color' that is not needed for this design.

Picture Options
Click the Picture Options button to see the Picture Options dialog box, which is used to set
the Black Lines option and set the Area Sensitivity.

Black Lines
There are three options for handling black lines in your picture. Expand Pixel-Thin Lines is
chosen by default.
Select No Change if you feel that outlines in the picture do not need to be expanded or
reduced.
Select Expand Pixel-Thin Lines to make black lines thicker, to prevent broken lines where
pixels join at corners. This option is on by default, to ensure that outlines in the picture are
continuous.
Select Reduce Thick Lines if your picture has very heavy outlines, and you prefer to have
markout stitching in your picture rather than satin outlines.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the
ExpressDesign Wizard is used.
Use High sensitivity to increase the detail extracted from the picture. This is useful, for
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to
decrease the detail extracted from the picture. This is useful, for example, when unwanted
details are retained in the design at Medium.

Previews
Source Picture
This shows the original picture, after being rotated and cropped, in full color.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This
gives an approximate indication of where thread blocks will be in the final design.
If variegated threads have been selected, only the first color is shown in the preview.

Zoom
Use the Zoom functions to change the view of the picture. The same area of the picture is
shown in both previews when the zoom level is changed.
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Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Back
Return to the Design Size page.

Next
Go to the Fabric and Stitch Type Options page.
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Fabric and Stitch Type Options

Preview the embroidery
Choose a fabric type

Add underlay to the design
Create more satin or
more fill areas
View the design information
Place on the work area
Make further edits

The Fabric and Stitch Type Options page of the ExpressDesign Wizard only appears when
you are creating an Express Embroidery. Use the Fabric and Stitch Type page to choose the
typical fabric that the design will be stitched onto, and the preference for fill areas or satin
areas.

Fabric Advisor
Fabric
Choose the fabric on which the design will be stitched. Adjustments are made in the
embroidery creation process to suit the chosen fabric, such as the type of underlay chosen
for individual areas of satin or fill.

Design Underlay
Choose Design Underlay to provide stitching below the whole embroidery, in addition to
automatic underlay in different areas.
When Design Underlay is turned off it is easier to convert pattern fill areas to lightly stitched specialty fills.

Preferred Stitch Type
This affects whether areas are likely to be created as satin or fill. If you prefer satin, move
the slider to the right. If you prefer fill, move the slider to the left. The design size also
influences whether areas are created as satin or fill, as this affects the size of individual
areas.
To see the effect of different options, click Refresh Preview to regenerate the design.

Refresh Preview
Refresh the preview with your new settings.
If a change is made to the options, you must click Refresh Preview before you can click Finish.
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Design Information
The design information boxes show the dimensions (Width and Height ), Stitch
Count , and number of colors
for the embroidery. The design information may
change when the embroidery is exported, depending on the Optimize for Sewing
Options.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This
allows you to view and check the final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.
If a change is made to the options, you must click Refresh Preview before you can click Finish.
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Express Trace Options
Preview the embroidery

Choose a stitch line type
Set the properties for the line
Select the thread color
Enhance detail in the picture
View the design information
Place on the work area
Make further edits

The Express Trace Options page of the ExpressDesign Wizard only appears if you are
creating an Express Trace design. Select whether lines in the picture will be traced with
light running stitch, heavy running stitch or constant width satin. Also select the thread
color.

Trace Method
Double Trace
Trace the picture with Double Stitch where possible, with a layer of Running Stitch where
necessary.

Quadruple Trace
Trace the picture with Triple Stitch where possible, with an additional layer of Running
Stitch where necessary.

Satin Line Trace
Trace the picture with satin line, using the same width and density for the satin line
throughout.

Stitch Options
Click the Stitch Options button to see the options for the selected QuickTrace Method.
• If Double Trace or Quadruple Trace are selected the Trace Options dialog box is
displayed.
• If Satin Line Trace is selected the Satin Line dialog box is displayed. See “Satin Line” on
page 274.

Trace Options
Use the Trace Options dialog box to set the Stitch Length of the running stitch to use for
Double Trace and Quadruple Trace, from 1 to 12mm in steps of 0.1mm. The initial setting is
2mm.
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Thread Color
Set the Thread Color for the stitches. Click the Color Change button
to choose a
different color in the Color Selection dialog box. The thread sample is updated with the
selected color.

Picture Options
Click the Picture Options button to see the Picture Options dialog, which is used to set the
Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the
ExpressDesign Wizard is used.
Use High sensitivity to increase the detail extracted from the picture. This is useful, for
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to
decrease the detail extracted from the picture. This is useful, for example, when unwanted
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width and Height ), Stitch
Count , and number of colors
for the embroidery. The design information may
change when the embroidery is exported, depending on the Optimize for Sewing
Options.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Preview
The preview shows the lines in the picture that will be traced. If desired, use the Zoom
controls to change the view of the preview.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify
settings before previewing the design again.
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Finish
Accept the final design and close the ExpressDesign Wizard.
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Express Border Options

Choose a stitch type
for the border
Set the properties for the border
Add appliqué to the design
Select the thread color
Enhance detail in the picture
View the design information
Place on the work area
Make further edits

The Express Border Options page of the ExpressDesign Wizard only appears if you are
creating an Express Border design. Use the Border Options to select the type of stitching
used for the borders, appliqué settings, and to choose the thread color.

Border Type
Select the type of border to create around areas of the picture from one of the following:
■

Satin Line

■

Running Stitch

: see “Satin Line” on page 274.

■

Double Stitch

■

Triple Stitch

■

Motif Line

: see “Running Stitch” on page 266.
: see “Double Stitch” on page 268.
: see “Triple Stitch” on page 272.

: see “Motif Line” on page 275.

When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Stitch Options
After selecting the type of border, click the Stitch Options button to show the properties
for that border type. If desired, adjust the properties and click OK.

Appliqué
Select Appliqué
■
■

to use appliqué within the borders of the design.

Click Select Fabric to change the appliqué fabric. See “Appliqué Selection” on page 159.
Click Appliqué Options to select the appliqué type. See “Appliqué Options” on page 76.
When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Thread Color
Set the Thread Color for the stitches. Click the Color Change button
to choose a
different color in the Color Selection dialog box. The thread sample is updated with the
selected color.
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Picture Options
Click the Picture Options button to see the Picture Options dialog, which is used to set the
Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the
ExpressDesign Wizard is used.
Use High sensitivity to increase the detail extracted from the picture. This is useful, for
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to
decrease the detail extracted from the picture. This is useful, for example, when unwanted
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width and Height ), Stitch
Count , and number of colors
for the embroidery. The design information may
change when the embroidery is exported, depending on the Optimize for Sewing
Options.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Preview
The preview shows where the borders will be created. It allows you to view and check the
final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.
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Appliqué Options
Select the appliqué method, and set the appliqué piece margin.

Appliqué Method
When appliqué is created, additional stitches are added at the beginning of the appliqué
piece for placing the appliqué fabric. Use these options to determine how these stitches
are added.
Select the appliqué method before or after creating an area or line. Choose from:
•
•
•
•
•

None
Standard Appliqué
Pre-cut Piece
Pre-placed Piece
Cut-out

Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the
fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork
needles.
Stitch a running line to show where the pre-cut appliqué piece should be placed, then
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch,
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.
Place the appliqué layer in position, then stitch down the appliqué fabric with double
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border
stitching.
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Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example
for reverse appliqué.
Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to
10mm. The initial value is 1.0mm.
Use a positive value when trimming the appliqué fabric before the border is stitched, for example with
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin
has been applied.
This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated
cutter, to ensure the placement line is visible.
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Open Existing Design
This page only appears if you choose the Load Existing Design option on the first page of
the ExpressDesign Wizard.

Select a design file on
your computer

The design is previewed

Load a Design
Click the Load a Design
icon. The Open dialog box will appear. After selecting a design,
the preview box will show the selected design with its name underneath. Click Next to
continue.
Browse to a different folder
Search for a design
Change the view or icon size
Click on a design to select it
Hover to view the selected
design’s details

Click Open to load the
selected design

Preview
The preview area shows the objects in the selected design, with the name of the design
underneath.

Back
Return to the Choose Design Type page.

Finish
Close the ExpressDesign Wizard and load the chosen design on the main screen.
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Using the ExpressDesign Wizard
Create a Petal Design with the ExpressDesign Wizard
1

Click File, New
, or File, New Window
Wizard will appear.

2

Leave Create Express Embroidery selected
and click Next. The Choose Picture page will
appear.
Click Load a Picture
and the viewer will
appear.
In the Picture Viewer, browse to
Documents\mySewnet\Samples\Digitizing
\Pics. The pictures in the folder will be
shown.
If you position the arrow pointer over a
thumbnail without clicking, the name of the
picture will be shown. The picture to be used is
called ’Petals.svg'. Alternatively, select an icon
display that shows the names.
Click the 'Petals.svg' thumbnail,
and then click OK. The picture is
loaded onto the Choose Picture
page, with its name shown
below the preview area.
Click Next and the Rotate and
Crop Picture page will appear.
Notice that the picture has no
background color yet. This is
because pictures in Scalable
Vector Graphics (svg) format can
have an empty background.
However, after the picture is
cropped, white is used by the
ExpressDesign Wizard to replace
empty areas.

3
4

5

6

7

and the Choose Design Type page of the ExpressDesign

When white thread is not desired in the background of an Express Embroidery, it may be removed on the
Choose Thread Colors page. The white background is ignored by Express Trace and Express Border.
No adjustment of the crop area is required, so click Next and the Design Size page will appear.
mySewnet™ Digitizing ExpressDesign Wizard

79

8
9
10
11
12

13

14

15

16

17

18
19
20
21

22
23

In Design Size, select Fit Design To Hoop.
Click Change Hoop and the Hoop Selection dialog box appears.
Under Enter Size, ensure that Enter Hoop size is not selected (checked).
Select the Universal Hoop Group, then set Hoop Size to 240mm x 150mm - Universal Large Hoop 2.
Ensure the Orientation is Rotated, and click OK. The chosen hoop is previewed.
Click Next and the Choose
Thread Colors page will appear.
Notice that all 5 of the 5 possible
colors have been automatically
picked.
If the thread range in the
Change All To box is not set to
Robison-Anton Rayon 40, click
the drop-down arrow at the end
and select Robison-Anton Rayon
40.
Under Background Color, the
large white square shows that
white is the detected
background color. The white
background is not required, so
ensure Automatically Remove
Background Color is selected. A
check pattern in the Thread Color Preview shows where there will be no stitches.
Click Next. Stitches will be
created, then the Fabric and
Stitch Type Options page will
appear.
Ensure that the Fabric is set to
Woven.
Notice that the design is
previewed on the selected fabric.
This may differ from the fabric
selected in mySewnet™ Configure,
but the background color chosen
in mySewnet™ Configure is
always used.
Ensure the Design Underlay
option is turned off and leave
the Preferred Stitch Type slider
all the way to the left.
Some of the petals will be
changed to lightly stitched fill patterns that would reveal the underlay if it is left on.
Click Finish and the final design and its picture are shown on the work area.
If you have changed any of the settings, you must click Refresh Preview before using Finish.
Click the Edit button
next to the Notes box on the Design Panel.
In the Notes dialog box enter 'Floral'.
Use the quick keyword selector to add the keywords ’Flowers and Gardens’. Then click OK.
Notes entered for the design will also be saved in the embroidery when it is exported in .vp4 format. Notes
are used to search for embroideries by key words in Windows® Explorer.
Click Save
and browse to the folder Documents\mySewnet\My Designs.
Change the File name to 'PetalsBasicFill' and click Save.
This saves your project as a design file in .edo format.

Use this design to create a variety of filled petals. See:
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■

■

■
■

Pattern Fill Petals: “Change a Fill Area to a Leaf Pattern” on page 186, “Create a Single Color
Gradient Fill in a Petal” on page 190 and “Use a Bee for a My Fill Pattern” on page 234.
Density Effect Petals: “Fill a Petal with a Multicolor Gradient Density Fill” on page 192, “Use
a Radial Fill in a Petal” on page 206 and “Fill a Petal with a Spiral Fill with Gradient Density”
on page 210.
Shape Fill Petals: “Use Shape Fills in Three Petals” on page 204.
Motif Line and Fill Petals: “Use Motif Fills in Two Petals” on page 198 and “Create a Flower
with Motif Lines” on page 278.

Create Appliqué Areas with Express Border
1

2
3
4

5
6

7
8
9

10
11
12
13
14

Click New
or File, New
Window. The Choose Design
Type page of the ExpressDesign
Wizard will appear.
Click Create Express Border
.
Click Next and the Choose
Picture page will appear.
Click Load a Picture
. In
Documents\mySewnet
\Samples\Digitizing\Pics, click
the 'Petals.svg' thumbnail, then
click OK. The picture will be
loaded onto the Choose Picture
page.
Click Next and the Rotate and
Crop Picture page will appear.
No rotation or adjustment of
crop lines is required, so click
Next and the Monochrome
Threshold page will appear.
Only the thick outlines are dark
enough to show at the default
Monochrome Threshold. They
make three fully enclosed shapes
that will become solid shapes later
in the ExpressDesign Wizard.
Move the slider to view which
parts of the picture are selected at
different Monochrome Threshold
levels, then return the slider to its
original position.
Click Next and the Design Size
page will appear.
Select Fit Design To Hoop.
Click Change Hoop, and in the Hoop Selection dialog box,
select 240mm x 150mm - Universal Large Hoop 2 with
Rotated Orientation. Click OK.
Click Next. The picture will be processed and the Express
Border Options page will appear.
In Border Type, ensure that Satin Line
is selected.
Click Stitch Options.
In the Satin Line dialog box set Width to 4.0mm, and ensure
that Underlay is selected (checked).
Click OK to close the Satin Line dialog box.
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15
16
17
18
19
20

21

22

23

24
25

26

Ensure that Appliqué
is selected. The preview shows the
areas where appliqué fabric will be stitched.
Click Appliqué Options and the Appliqué Options dialog
box will appear.
Ensure that Standard Appliqué is selected.
Click OK.
Click the Thread Color icon
and the Color Selection
dialog box will appear.
Ensure the Thread Range is set to Robison-Anton Rayon 40.
Type 2275 in the Find Thread box to select 2275 (Slate Blue).
This matches the border color that was automatically selected
for the Express Embroidery in “Create a Petal Design with the ExpressDesign Wizard” on page 79.
Click OK. The border lines in the
preview are updated to show
the new thread color.
Click Finish. The new design is
shown on the work area.
Notice that the petals in the
background picture are solid
areas of color, indicating it is an
appliqué section.
In the Design Panel, click the
Edit button
next to the
Notes and Settings box.
In the Notes dialog box enter
'Floral'.
Use the quick keyword selector
to add the keywords ’Flowers
and Gardens’. Then click OK.
Click Save
. Browse to the
folder Documents\mySewnet\My Designs. Change the File name to 'PetalsBasicApplique' and click
Save to save the design as an .edo file.

Use this design to create a variety of appliqué petals. See:
■

■
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PetalsAppliqué1: “Change Satin Line to Motif Line in an Appliqué Petal” on page 281 and
“Insert QuiltStipple Fill in a Petal” on page 213.
PetalsAppliqué2: “Change Satin Line to Picot Motif Line” on page 281, “Insert Motif Fill in
an Appliqué Petal” on page 199 and “Create a Contour Fill Flower” on page 215.
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Load PetalsBasicApplique in the ExpressDesign Wizard
1
2
3
4
5

Click File, New
, or File, New Window
Wizard will appear.
Select the Load Existing Design
option.
Click Next and the Open Existing
Design page will appear.
Click Load a Design
.
Browse to the folder
Documents\mySewnet\Samples
\Digitizing \Edo.
Alternatively, use the file you
created in “Create Appliqué Areas
with Express Border” on page 81.

6

Click OK and the designs in the
folder will be shown.

7

Click the 'PetalsBasicApplique'
thumbnail. The viewer will close
and the design will be loaded
onto the preview area.
The full name of the design is
shown below, it is called
'PetalsBasicApplique.edo'.
Click Finish and the design will
be loaded onto the work area.

8

and the Choose Design Type page of the ExpressDesign
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Load a Fleur de Lys as a Background Picture
1
2
3
4
5
6
7

8
9

10

11
12
13
14
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In the Quick Access toolbar, click Change Hoop
and the Hoop Selection dialog box appears.
Ensure that Enter Hoop Size is not selected.
Ensure the Hoop Group is set to Universal. Click the drop-down arrow for Hoop Size and select
100mm x 100mm - Universal Square Hoop 1. Click OK.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click File, New
, or File, New Window
and the Choose Design Type page of the ExpressDesign
Wizard will appear.
Click Load or Create a
Background Picture, then click
Next.
Click Load a Picture
and the
viewer will appear.
In the Picture Viewer dialog box,
browse to
Documents\mySewnet
\Samples\Digitizing\Pics.
Click to select 'Fleur de lys.svg',
then click OK. The picture will be
loaded onto the Choose Picture
page, with its name shown
below the preview area.
Click Next and the Design Size
page will appear.
Click Enter Design Size.
Change the Size to 90mm and
click Width.
Click Finish. The picture will be
shown on the work area.
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Viewing Pictures and Designs

5

Use the View tab to set how you view the design, background picture, and hoop.
Measure an object or design

Change the view mode View the Design Panel & FilmStrip

Show & fade the background picture
Show & resize grid Create or edit a background picture

Choose a different hoop

View Mode
Use View Mode to switch between 3D
, 2D , and Object
representation of
stitches. 3D View
shows how the embroidery will be stitched out with threedimensional shading. 2D View
shows the individual stitches with no shading. Stitches
using multicolor threads are drawn using only the first color. Object View
shows the
outline of the objects in the design.

3D View

2D View

Object View

3D View
3D View
shading.

shows how the embroidery will be stitched out with three-dimensional

Shortcuts
■
■

View Tab, View Mode:
Keys: Ctrl + T; Alt, V, 3

2D View
2D View
shows individual stitches with no shading. Stitches using multicolor threads
are drawn using only the first color.

Shortcuts
■
■

View Tab, View Mode:
Keys: Alt, V, 2
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Object View
Object View

shows the outline of the objects in the design.

Shortcuts
■
■

View Tab, View Mode:
Keys: Ctrl + R; Alt, V, O

Show Grid
Use Show Grid
to turn the background grid on and off. The grid may be used to help
align stitch objects and control points.
The grid size is initially set to 10mm. Adjust its Size between 1 and 50mm, depending on
what setting is most suitable for your screen resolution and designs. Type in a figure and
press ENTER (or use the up and down arrows to change the number). Turn the background
grid on or off using Show Grid.
The grid size is measured in pixels of the background picture, so the apparent grid size will vary according
to the dimensions of the picture stored in a design.

Shortcuts
■
■

View Tab:
Keys: Alt, V, G

Background
Use the Background slider bar to show, fade or hide the background picture in the Design
window. Change the view of the background picture to make it easier to see the stitch
objects for the design.

Use Background On
to show Use Fade
to show the picture Use Background Off
picture.
the picture in the background. in the background with the colors
faded by 50%.

to hide the

Edit Background
Use Edit Background
to load, create or edit a background picture in mySewnet™ Draw
& Paint. For more information see the mySewnet™ Draw & Paint Reference Guide and Help.
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Shortcuts
■
■

View Tab, Background:
Keys: Alt, V, E

Design Panel
Use the Design Panel to view the design information, to view and change colors, to view
and change the Notes and Settings, and to view the Clipboard and Overview window.

Check the design information
View and change the threads and effects for the design
Puffy foam effect
Secondary thread colors for fills with borders, or color gradients
Dual thread effect
Change a thread color
Show and hide secondary thread colors
Select the Notes or Settings information
Edit the Notes or Settings information
View the current window position in the work area
View the contents of the Clipboard

Color Change and Pick Color
Use Color Change
and Pick Color
on the Create tabs, or Insert Color Change
in
the FilmStrip to select a new thread color for the stitch objects you are about to add to the
design. The first Color Change is initially set to medium blue. A Color Change command is
shown by a small blue circle with a C
.
To change an existing color, double-click the desired color in the color worksheet on the
Design Panel, or select the color in the worksheet and click Change Color
.
Alternatively, right-click the color in the FilmStrip and select Properties. The Color
Selection dialog box opens.
To delete a color change, select the Color Change in the FilmStrip or on the work area,
then click the Delete icon
, use the Delete key, or right-click in the FilmStrip and select
Delete. The first Color Change in a design may not be deleted.
To insert a color, select the object after which the color change is desired, and click Color
Change
on one of the Create tabs, or right-click in the FilmStrip and select Insert Color
Change from the context menu. Alternatively, select Pick Color
and choose a color
from the background picture.
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Select a color from the Color Selection box that appears. You may choose any thread
shade from the available thread manufacturers' palettes (for instance, Sulky Rayon 40 or
Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select colors by
visual selection or by typing in a shade number. Alternatively you can choose a ’Quick
Color’ Theme and then select one of the 32 Quick Colors. See “Quick Color Themes” on
page 174. Optionally, add a thread or needle effect to the selected thread. Once the
desired color is selected, click OK.
Extra design property colors for some objects can be set in the properties dialog for that
object, for example multigradient fills and the border for a fill area. They then appear as
secondary colors in the color worksheet, and can be adjusted from there. See “Secondary
Colors” on page 94.
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Color Selection
The Color Selection dialog box appears when you click Add Color Change , right-click a
color change marker , or right-click an object in the FilmStrip and select Insert Color
Change. Alternatively, on the Design Panel select a color in the worksheet and click Color
Change , or double-click a color in the color worksheet.
You may choose any thread shade from the available thread manufacturers' palettes (for
instance, Robison-Anton Rayon 40 or Sulky Cotton 30) or a thread you have added to
MyThreads. Select colors by visual selection or by typing in a shade number. Alternatively,
click one of the Quick Colors to select the nearest matching thread color. Once the desired
color is selected, click OK.
Open Thread Cache
Show chosen thread ranges

Puffy Foam height

Select a thread range
Search for a thread number
Choose a Quick Color Theme

Twin needle gap
& second color

Click a Quick Color to select
a matching thread color

Second thread
color
Wing needle

Click a thread color
to select a thread
View the thread information

Felting needle
Cutwork needle
angle

When you select a new thread color, the color worksheet will show the change and the
work area will show the block of stitches in the new color.
To keep the full color information including thread shade numbers, export your
embroideries as file type .vp4.

Using the Color Selection Dialog
1

2

3

On the Design Panel, select a thread color and click Color Change
. Alternatively, on one of the
Create tabs, click Color Change
or pick a Quick Color. Alternatively, click Pick Color
, and the
pointer changes to an eyedropper
. Click the desired color area in the picture, and the Color
Selection dialog box opens with the selected color displayed.
The Color Selection dialog box also appears when you double-click a color in the color worksheet, when
you right-click with a color change marker
selected, or when you right-click a color in the FilmStrip and
select Properties.
If required, change the thread range. Select the desired thread range from all thread ranges or only
MyThreadRanges. The available shades for the thread range will be shown in the list.
The Abbreviation shows the reference used for the thread range when threads from that range are added
to MyThreads.
You can use the Manage button to add new threads and Thread Ranges in mySewnet™ Thread Cache. The
Color Selection dialog box will close. See the mySewnet™ Thread Cache Reference Guide for more
information.
Click a color in the list to select a thread shade visually. Use the scroll bar to browse through the list of
threads.
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4
5

6

If you know the shade number, click in the Find Thread box then type the required shade number.
Alternatively, choose a Quick Color Theme then click the desired Quick Color. The nearest shade that
is available from the current thread range will be selected. This is also a quick way to jump to threads
of that color (for example, click light yellow in the Standard Theme to jump to light yellow thread
shades).
If desired, add a thread or needle effect. Then click OK to confirm the color selection. The dialog box
closes, and your changes are displayed in the work area.

Effects
Use the Effects area of the Color Selection dialog box to show the results of using thread
effects or special needles.
Puffy Foam

Show the effect of stitching over embroidery foam

Dual Thread

Show the effect of using two threads in one needle

Twin Needle

Show the effect of using a twin needle

Wing Needle

Show the effect of using a wing needle for hemstitch or
heirloom designs

Felting Needle

Show the effect of using a felting needle with a roving fiber

Cutwork Needle

Select a cutwork needle in one of four angles

Only one thread effect can be used on any thread.

Choose an effect. If you choose Puffy Foam, set the foam height. If you choose Twin
Needle, set the Twin Needle size. Click the color icon for the Second Color if you wish to
use a different thread color. For Dual Thread, it is recommended to change the Second
Color. For Twin Needle, this choice depends on the desired result. For Felting Needle select
a color for the roving fiber for felting. For Cutwork Needle, choose the angle for your
needles.

Puffy Foam
Use Puffy Foam to show the three-dimensional effect of stitching over embroidery foam.
Click the drop-down arrow and select the height of the puffy foam, between 2.0mm and
6.0mm. The height is initially set to 3.0mm.

Dual Thread
Use Dual Thread to show the effects of stitching out two threads
through the same needle. This is particularly suited to blending
threads for special effects, such as mixing a rayon thread with a
metallic thread, as in the center of the star.
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Twin Needle
Use Twin Needle to show the effect of stitching out the color
block with a twin needle. This creates a horizontal offset between
the original thread color in the left-hand needle, and a second
thread color in the right-hand needle.
There are several ways that the Twin Needle effect can be used,
including:
• Use with running stitch to create a ribbon effect, typically
using the same thread color in both needles
• Use with a low density fill area to blend two different thread
colors and also have a lightly shadowed effect
• Use with a dense fill area to create a shadow effect
It is recommended to use natural hoop orientation for designs with Twin
Needle colors.

Twin Needle Size
This is only available if the Twin Needle effect is selected for the
current color block. Click the drop-down arrow and select the
size of the gap between the twin needles. This is initially set to 3.0mm.
Preview the effect of changing the twin needle size to help decide which needles to buy.
Ensure that the desired size is recommended for embroidery on your machine.

Second Color
The second color is initially set to the same color as the original color block. Click the color
change button
to choose a different thread for the second color. The Color Selection
dialog box appears. Select the desired thread and click OK. The thread sample will change,
and the thread range and thread number are shown.

Wing Needle
Use Wing Needle
to show the effect of stitching out the
color block with a wing needle and the chosen thread.
The wing needle creates holes in the fabric, for hemstitch and
other heirloom techniques.
To see the holes more than the stitch, use a fine thread such as Poly 60
weight. To see the actual stitching, Rayon 40 weight is ideal.
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Felting Needle
Use Felting Needle
to show the effect of embellishing
the selected color block using a felting needle and a
contrasting roving fiber.
Choose a color for the roving fiber for the felting in the Color
Selection dialog box. In projects without a roving fiber,
choose a felting needle color similar to the back of the
fabric.
If a system font or SuperDesign with Felting Needles is inserted, or if you
select Felting Needle in mySewnet™ Digitizing, the stitching will be
adjusted using the settings in Preferences. By default, stitching using the Felting Needle color effect is
broken up into very short stitches of 0.4mm. In other modules the effect is purely visual; for example, to see
how felting will look in a pre-made design.
When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse
embroidery" is initially selected in the Export dialog box. See “Export” on page 118.

Cutwork Needle
Use Cutwork Needle
to show the line that would be used by cutwork needles to
automatically cut holes in your fabric areas, or create appliqué areas. Use cutwork needle
lines for reverse appliqué embroideries and free-standing lace, or simply to cut out a
shape or design.
Choose the cutting angle for the cutwork needle.
(When creating cutwork needle lines in mySewnet™
Digitizing or mySewnet™ Stitch Editor, or converting
running lines to cutwork needle lines in any mySewnet™
module, you may use two needles, or for more precise work use four needles.)

Show and Hide Objects
Use the color worksheet in the Design Panel, and the Hide Object Types filter buttons in
the Edit tab to show and hide the desired blocks of colors and object types in the design.
You can also use the Draw Range slider bars on the Edit tab and the FilmStrip to change
the view of the design.
Use any combination of color block display, object filters, draw range and FilmStrip
options to hide objects. Hiding objects leaves the visible objects available for other
functions without affecting the hidden objects. Use this to help when you need to select a
particular set of objects that might be difficult to isolate directly with the Select functions.
For example, you may wish to change the pattern in all fill areas of one type using Global
Properties, or select a number of objects to copy them.
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Color Worksheet
The thread colors are shown
in the color worksheet on
the Design Panel, in the
order in which they are
used.

Use the color worksheet to
display or hide a color
Click a color block to select it
Thread effect symbol
Pause over a thread color
to see its name

The objects using a
particular thread color are
called a color block. The
Secondary thread color
color worksheet can be used
to change thread colors and Show or hide secondary colors
to hide and show the
Change the selected color
objects in any of the color
blocks. Displaying the objects according to their color is an easy method of showing
sections of a design. The functions for viewing objects by color are on the Edit tab.
When you pause the arrow pointer over a thread color in the worksheet, the corresponding objects in the
embroidery are highlighted. Also, a popup description of the thread color appears.

If you have set a Draw Range, then only the objects in the color blocks that are visible
within the range will be displayed. Similarly, any objects hidden by object filters are
hidden even if the color is visible.
The first color in the design is at the top of the list, followed by all the thread color blocks.
The check boxes show which color blocks are hidden. The numbers show the order in
which the colors are used, and the samples show solid blocks of each thread color in 3D.
Click a thread sample to access the Color Selection dialog box for selecting a different
thread color, or adding a thread effect. Click a check box to show or hide a color block,
together with any secondary colors, for example the other colors in a multigradient
object. When a color is hidden, its check box in the Color Worksheet is not selected, as
shown here:

Hidden

Visible

The number of color blocks shown in the color worksheet varies with the size of the
window. If there are many colors, use the scroll bar to see the desired section of the list.
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Secondary Colors
Extra design property colors for some objects are set in the properties dialog for that
object, for example multigradient fills and the border for a fill area. They then appear as
secondary colors in the color worksheet, and can be adjusted from there.

Pattern Fill with a border

The FilmStrip and
worksheet show both
colors

Set a separate border color in the
Line tab of the Properties dialog

A multicolor gradient fill or satin column will show a hatched pattern in the FilmStrip. To
view these colors in the worksheet, ensure that Design Property Colors
below the
color worksheet in the Design Panel on the right of the Design window is selected.

Multigradient Pattern Fill
with a border
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The FilmStrip and
worksheet show all
colors
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Set the colors for the multigradient
fill in the Properties dialog

Display Range
The Display Range functions on the Edit tab are used to hide and show the objects in the
design by color block sequence.
The Display Range functions are: Draw Previous Color Block , Draw Next Color Block ,
Display All Objects , the Draw Range, Only Selected , Only from Start
and Only To
End
.

Draw Previous Color Block
Use Draw Previous Color Block

to step through the color blocks in reverse order.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, P

Draw Next Color Block
Use Draw Next Color Block

to step through the color blocks one at a time.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, N

Display All Objects
Use Display All Objects

to display all objects and commands in the design.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, A; Right-click FilmStrip, A

Draw Range
The Draw Range is set with the Start and End slider bars,
which determine the range of visible objects. Each step when
you click a + or - button is one distinct object or command,
similar to stepping through objects with the arrow keys.
Use the Draw Range to isolate objects that you want to select with Select All Visible. Also,
for complex designs, use the Draw Range to make objects easier to select when changing
their properties. For instance, you could isolate a fill area so that it is easier to click, and
then right-click to change its pattern in the Fill Properties.
Changes in the Draw Range are matched by the range of visible objects in the FilmStrip.
Similarly, using Display Only Selected, Display Only From Start and Display Only To End on
the FilmStrip context menu will automatically change the slider bar positions. The Draw
Range sliders also help to show which part of the design is visible when the FilmStrip is
used to hide objects.
Display All Objects on the FilmStrip context menu and Display All Objects
the Draw Range to show all objects.
mySewnet™ Digitizing Viewing Pictures and Designs

both reset

95

Also, turn off colors and object types with the color worksheet and object filters to hide or
show almost any set of objects in combination with the Draw Range. For instance, you can
hide any alignment stitches that you place, so that you never adjust part of the design by
accident.
The upper slider bar sets the first object at the Start of the visible objects. The lower slider
bar sets the End object. Use the Draw Range to set the Start or End object in any of the
following ways:
1

Click and drag the slider box along the slider bar.

2

Click the plus or minus at the ends of the slider bar to progress by
one object at a time. Click and hold to progress more rapidly.

3

Click in the space on the slider bar on either side of the slider box to
move in that direction and jump through the objects rapidly. You
can also click and hold, but the slider box will stop when it reaches
the arrow pointer.

In all cases, the work area will show the range of objects as the Start or End object
changes.
When you set a Draw Range, only the objects in the color blocks that are visible within the range will be
displayed.

Only Selected
Use Only Selected
to show only the currently selected object. Use this if you wish to
isolate a single object. For example, once the object is isolated, you can easily select it with
Select All Visible
to move, resize, flip and rotate the object.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, Y; Right-click FilmStrip, S

Only From Start
Use Only from Start
to show only the currently visible objects from the start to the
selected object. That is, hide all objects after the selected object.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, S; Right-click FilmStrip, F

Only To End
Use Only To End
to show only the currently visible objects from the selected object to
the end of the design. That is, hide all objects before the selected object.

Shortcuts
■
■
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Edit Tab:
Keys: Alt, E, E; Right-click FilmStrip, E
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Hide Object Types
The Hide Object Types (filter) buttons are used to
hide and show the objects in the design according
to the type of object and/or by color block
sequence. When a filter is used to hide objects, the
objects are hidden in the work area and the
FilmStrip.
The filters are: Lines
, Fills
, Satin Areas
, Columns
and Colors
, Groups
and Appliqués
.

, Single Stitches

, Stops

If there are no objects of the relevant type in the design, or they are all already hidden by other means, the
filter button cannot be clicked down.

Lines
Use the Lines filter
and Tapered Motifs.

to hide and show Running, Double and Triple Stitches, Motif Lines

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HL

Fills
Use the Fills filter
fill areas.

to hide and show all Fill Area types, including any border lines around

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HF

Satin Areas
Use the Satin Areas filter

to hide and show Satin Areas.

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HA

Columns
Use the Columns filter
and Satin Lines.

to hide and show Satin Column, Richelieu Bars, Feather Satin

The Columns filter will hide any fill areas with a satin border.

Shortcuts
■

Edit Tab, Hide Object Types:
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■

Keys: Alt, E, HC

Single Stitches
Use the Single Stitches filter
to hide and show Single and Alignment Stitches in the
design. Single Stitches are generally used for traveling stitches within the design, and for
underlay. They often do not affect the appearance of a design, so you may find it useful to
hide them.

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HS

Stops and Colors
Use the Stops and Colors filter

to hide and show Color Changes and Stops.

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HP

Groups
Use the Groups filter

to hide and show Groups.

Shortcuts
■
■

Edit Tab, Hide Object Types:
Keys: Alt, E, HG

Appliqués
Use the Appliqués filter

to hide and show Appliqué areas.

Shortcuts
■
■

98

Edit Tab, Hide Object Types:
Keys: Alt, E, HQ
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FilmStrip
Use the FilmStrip to view the numbered sequence of objects, select an object, change the
sequence of objects, select objects to display, delete objects, insert Color Changes and
Stops, view the properties of the selected object and change the properties of objects
globally or in a selection.
The first object is a color or group

View the object color in
the Thread Color Bar

Line between chains of linked objects

Both fill and border colors are shown
Multicolor gradient fill area

No line between linked objects
Scroll up and down the FilmStrip

Objects are shown by their
shape or a marker

Use the Layout Order buttons
to move objects in the FilmStrip

View the name of the object type

Display the contents of Groups
Select the last visible object

When you pause the arrow pointer over an object or group in the FilmStrip, the corresponding object
outline(s) are highlighted in the work area.

FilmStrip Items
Starting at the top, the FilmStrip shows the numbered sequence of objects in the design.
When all objects are visible, the first object at the top of the list is a Color, or a Group
starting with a Color, then any other objects that make up the design.
The last object in the design is at the bottom of the list, together with the Layout Order
and display functions. The currently selected object is also highlighted in the FilmStrip,
and objects can be selected directly in the FilmStrip.
When objects are hidden, using the color worksheet, object filters, slider bars or FilmStrip
options, they are also hidden in the FilmStrip.
Each item in the FilmStrip shows four pieces of information: the number, color, object and
object type.
For Pattern Fill, the fill number is also shown.
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Thread Color Bar
The color bar shows the color of each object, together with an icon representing any
thread effect, even when the Color Changes are hidden.
A fill area with a differently colored border will show two colors. A multicolor gradient fill or satin column
will show a hatched pattern. To view these colors in the worksheet, ensure that Design Property Colors
below the color worksheet in the Design Panel on the right of the Design window is selected.

Object
Each object is represented graphically. Markers are shown for
Colors and Stops. A Color Change also shows a thread sample.
Alignment stitches show the type of stitch. All other object types
show the shape of the objects as black outlines.

Object Type
The name of the object type is shown.

Scroll Bar
Use the scroll bar to move rapidly up and down the FilmStrip.

Showing Groups in the FilmStrip
Groups are shown in the FilmStrip with an orange header. The
Group header is a solid orange block when selected, and an orange
outline when not selected. The objects within the group have a
pale gray background in the FilmStrip, as opposed to the white
background for objects that are not part of a group. When the
header for a group is selected, all other items in the group are also
selected, and are highlighted.
Use Reveal Groups

to view the objects within groups in the Filmstrip.

Select Objects in the FilmStrip
Until an object is deliberately selected, the last visible object is selected automatically in
the work area. To select the desired object, click it in the FilmStrip. It is also selected on the
work area. If necessary, use the scroll bar on the side of the FilmStrip so that you can see
the desired object in the FilmStrip. Also, when you click an object on the work area, the
object is highlighted in the FilmStrip.
If you have zoomed in, the selected object may not be shown on the visible part of the design. To see the
object, either Zoom To Fit
or use the scroll bars on the edges of the work area.
Only visible objects may be selected. If the view is changed so that the selected object is no longer visible,
the last visible object is selected automatically.

To select a sequence of objects, click the first object and hold the Shift key. Then select the
last object in the sequence.
To make a custom selection of objects, click the first object, then hold the Ctrl key and click
each of the other desired objects in turn. You can also add objects to a sequence in this
way.
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Change the Sequence of Objects
Single objects or a selection of objects may be moved up and down the FilmStrip with
click and drag. This changes the order of the objects, and hence changes the order in
which the stitches are created for the final embroidery.
To move an object, click and drag the desired object up or down the FilmStrip. A bar
moves up and down the list to show the new list position. Release to drop the object at
the desired point. Movement stitches are automatically inserted or removed as needed.
To move a selection of objects up or down the FilmStrip, hold the Ctrl key and click one of
your selected objects. A bar will show where the objects can be inserted in the FilmStrip.
Move the bar up or down the FilmStrip to the desired insertion point. To insert the objects,
release the mouse button.
If objects are dragged or inserted between two items in a group they will become part of that group, except
if they are inserted immediately after the group header. To insert at the beginning of the group, drag into
the middle, then move up.

If desired, use the color worksheet and Hide Object Types buttons to hide other objects.
This can make it quicker to move the desired object.
Hidden objects will not be moved.

To move to a part of the list that is not visible, move the pointer above the top or below
the bottom of the list and the list will scroll automatically. To scroll faster, move the pointer
further above or below the list. Move the pointer back into the list to stop scrolling.
Moving the pointer onto the scroll bar has no effect when dragging an object up or down the FilmStrip.

Moving an object up and down the FilmStrip does not change the position of the object
on the work area. However, it may change the appearance of the design according to
whether or not it changes the overlap with adjacent objects.
The first visible object may not be moved in the FilmStrip. Also, objects may not be moved above the first
visible object in the FilmStrip. This ensures that, when it is visible, the initial color change in the design
cannot be moved and nothing can be moved before it.

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.
You can also select multiple objects in the work area with Select Last Visible. See “Select Last Visible” on
page 300.

Move Forwards
Move Forwards

brings the object one step down the FilmStrip.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl + [; Right-click FilmStrip, L, F

Move Backwards
Move Backwards

brings the object one step up the FilmStrip.
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Shortcuts
■
■

FilmStrip:
Keys: Ctrl + ]; Right-click FilmStrip, L, B

Move to Front
Move to Front

places the object at the bottom of the FilmStrip or Group.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl + Shift + [; Right-click FilmStrip, L, N

Move to Back
Move to Back

places the object at the top of the FilmStrip or Group.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl +Shift + ]; Right-click FilmStrip, L, C

FilmStrip Options
Right-click on an individual item in the FilmStrip to see a menu of options relating to the
currently selected object.
Alternatively, use the Edit tab.

Display Only Selected
Use Display Only Selected
to show only the currently selected object or group of
objects. (It will show all objects between any that are selected.) Use this if you wish to
isolate a single object. For example, once the object is isolated, you can easily select it with
Select All Visible
to move, resize, flip and rotate the object.

Display Only From Start
Use Display Only from Start
to show only the currently visible objects from the start to
the selected object. That is, hide all objects after the selected object.

Display Only To End
Use Only To End
to show only the currently visible objects from the selected object to
the end of the design. That is, hide all objects before the selected object.

Display All Objects
Display all objects and commands in the design.
Use Reveal Groups
to switch between viewing the objects within Groups in the
FilmStrip, and seeing only the Group heading rows in the FilmStrip. See “Reveal Groups” on
page 289.

Cut
Cut the selected object(s) and place on the clipboard.
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Copy
Copy the selected object(s) to the clipboard.

Paste
Paste the object(s) on the clipboard back into the design.

Duplicate
Make a copy of the selected object(s) which is automatically pasted into the work area.

Delete
Delete the selected object(s) from the design.

Insert Color Change
Insert a Color Change after the currently selected object. The Color Selection dialog box
appears so you can choose the new color.
mySewnet™ Digitizing remembers the last thread color added to the design. This thread color will be
initially selected in the Color Selection dialog box.

Insert Stop
Insert a Stop command after the currently selected object.

Group
Group the selected objects together.

Ungroup
Split the currently selected group into the objects which make it up.

Select Similar from Visible
Select all visible objects with similar properties.

Select Similar from Group
Select all objects with similar properties that are in the same Group.

Properties
Show the properties dialog box for the selected object. This is the same as using right-click
on the work area.

Global Properties
Show the properties dialog box for the selected object. When the settings in the dialog
box are confirmed with the OK button, all visible objects of the same type will also have
their properties changed to match the settings.

Layout Order
Use Move Forwards and Move Backwards to move an object one step up or down the
FilmStrip, and use Move to Front and Move To Back to move an object to the bottom or
top of the FilmStrip or Group.
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FilmStrip Options for Multiple Selected Objects
Select several objects of the same type in the Filmstrip and right-click on one of them to
see a menu of options relating to multiple selected objects. The options displayed are:
Display Only Selected, Display Only From Start, Display Only To End, Display All Objects,
Cut, Copy, Paste, Duplicate, Delete, Group, Ungroup, Properties and Layout Order.

Display Functions
Use the Display functions to display the objects selected in the FilmStrip. You can then
further refine your selection.
Use Reveal Groups
to switch between viewing the objects within Groups in the FilmStrip, and seeing
only the Group heading rows in the FilmStrip. See “Reveal Groups” on page 289.

Properties
Show the properties dialog box for the selected object type. From here you can change all
objects of the currently selected type in your selection. To select an object type, click the
FilmStrip and check your selection in the Status bar.
All objects of the selected type will be modified, including any previously customized.

Layout Order
Use Move Forwards and Move Backwards to move the selected objects one step up or
down the FilmStrip, and use Move to Front and Move To Back to move the selected objects
to the bottom or top of the FilmStrip or Group.

Get Length
Use Get Length
to measure the distance between any two points on the work area.
Click the Get Length icon
and the mouse pointer changes to the Measure pointer
.
Then click and drag a line across the design. The length of the line is displayed.
For example, use this to obtain the width of a picture or design, or the distance between
two sections.
The length is shown in millimeters or inches, according to the setting for Show Measurements in
mySewnet™ Configure. The alternative units are shown in parentheses.

Shortcuts
■
■
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View Tab:
Keys: Alt, V, L
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Measure a Distance with Get Length
1
2

3
4

In the View tab, click the Get Length
icon. The pointer changes to
the measure pointer
.
Click and drag across the part of the design you want to measure. A line
will show the length you are measuring, and a tooltip displays the
distance.
If desired, make a note of the number.
Repeat the click and drag to measure any other distances, as required.
Right-click to deselect the function.
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Design Player
Use Design Player
to play through the stitches in the design as if they were being
stitched from an exported embroidery. All parts of the embroidery that are within the
hoop area are shown, whether or not they are selected.
The current Optimize for Sewing settings from mySewnet™ Configure are used.

Control play with
the slider

Jump to first stitch
Rewind

Start or pause play
Design Information

Jump to last stitch
Play at double the
current speed
Share the animation online

The Design Player will not open if part of the design is outside the hoop.

Share
Use Share
to save a still picture or video of your design. See “Share Picture” on
page 109 and “Share Video” on page 110.

Shortcuts
■
■

Quick Access Toolbar or Home Tab:
Keys: Ctrl + J; Alt, 0; Alt, H, J

Using the Design Player
1
2
3
4
5
6
7
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Click File, New
, or File, New Window
and the Choose Design Type page of the ExpressDesign
Wizard will appear.
Select the Load Existing Design option, then click Next and the Open Existing Design page will
appear.
Click Load a Design
, and in the Open dialog box browse to the folder
Documents\mySewnet\Samples\Digitizing\Edo, select the design ’Bicycle.edo’, and click Open.
Click Finish to load the design onto the work area.
Click Design Player
.
The Design Player dialog opens.
Use the Play button
at the bottom left to start playing through the stitches in the design.
Use the controls to play forwards or backwards through the embroidery at different speeds, jump to
the start or end of the stitches, and stop at any time.
Press Ctrl and use the mouse wheel to zoom in and out.
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Life View
Use Life View
to show how an embroidery exported from the project will look. Use Life
View
at any time when you want to see the design with no objects selected in 3D with
real-world perspective, and when you want to see the effects of glow in the dark and solar
reactive threads. Zoom in to see detail, and move and rotate the embroidery in a threedimensional view.

Change the 3D viewing angle
Move around the window
Zoom in and out
Light and dark effects
Reset
Animate the preview
Share your animation online
Design Information
Life View will not open if part of the embroidery is outside the hoop.

Shortcuts
■
■

Quick Access Toolbar or Home Tab:
Keys: Ctrl + L; Alt 9; Alt, H, L

Position
Use the position

slider to move to another part of the Life View window.

Click and drag the cross marker in the center of the box to view the desired part of the
embroidery, using the zoom slider to control the magnification.

Rotation
Use the rotation

slider to view the stitching in the embroidery in 3D.

Click and drag the cross marker in the center of the box to change the angle at which the
embroidery is viewed, and allow you to visualize the project in varying real-world views.
Alternatively, click and drag directly in the embroidery preview area to change the angle of view.
Use the zoom and position sliders to select the part of the embroidery to view.
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Zoom
Use the zoom slider to change the magnification of the embroidery.
Drag the slider bar to the right to magnify the view of the embroidery, and to the left to
shrink the view of the embroidery. The box below the zoom bar displays the current
magnification.
Click the marker in the center of the zoom bar (100%) to view the embroidery at a
magnification as close as possible to the Real Size setting you chose in mySewnet™
Configure.
When zoomed in, use the position slider to move around the embroidery.

Design Information
Life View shows the dimensions (Width
and Height
the number of colors in the embroidery.

), the number of stitches

and

Glow in the Dark
Use Glow in the Dark
to view the effect of using glow in the
dark threads. The preview will darken to simulate the lights
dimming, and the glow in the dark threads will be shown in their
luminescent colors.
Glow in the Dark
used in the design.

is only available if glow in the dark thread colors are

Solar Reactive
Use Solar Reactive
to view the effect of using photochromic threads. The preview
simulates the sun shining on the design, and the photochromic threads change shade to
show the colors they become in sunlight.

Photochromic threads change color in sunlight.
Solar Reactive

is only available if photochromic thread colors are used in the design.

Play Demo
Use Play Demo
to animate the preview and show the embroidery at different angles
automatically. Click to start and stop the animation.
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Play My Demo
Use Play My Demo
to animate the preview using your own demo.
Use the menu options to add the current position as a point in the
demo, or reset to create a new demo.
The My Demo animation will be used for Life View in all modules. It is stored in the
AnimationPath.txt file in the folder:
\User\AppData\Local\mySewnet\Embroidery1\LifeView
Copy this file to another location as a backup before creating additional My Demo animation paths for
Life View.

Reset
Use Reset

to set Rotation, Position and Zoom back to the default settings.

Share
Use Share
to save a still picture or video of your design. See “Share Picture” on
page 109 and “Share Video” on page 110.

Share Picture
Save a picture of your design. Select a size for the picture,
then save the picture to your computer.

Size
Select a size for your picture. Choose from Standard, 2x, 3x,
and 4x. Standard size is the size of the picture in Design
Player or Life View.

Save
Click Save
to save the picture to your computer. The Save As dialog appears for you to
save the picture, with the default file name being the same as the design. Change the
name as desired.

The following file formats may be saved: JPEG Low Quality (.jpg), JPEG High Quality (.jpg),
Tagged Image File Format uncompressed (.tif ) and Portable Network Graphics (.png).
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Share Video
Save a video of your design.
Name the video and select its size, quality and speed. Then save it to your computer. A
progress bar is displayed while the video is created.
The higher the image quality, the slower the speed of upload and download.

Video Title and Created By
The video title and the name of the creator are used on the opening frames of the video.
Enter the name of the video, and the name of the creator.

Size
The size of the moving image in pixels. The higher numbers create a higher quality video.
Choose from 1080p (HD), 720p (HD), 480p and 360p. The initial setting is 480p.

Quality
The bit rate, or speed of data transfer. Choose between Low, Medium and High. The initial
setting is Medium.

Speed
Set the speed of the Design Player for the video. Choose from Standard, 2x, 4x, 8x, 16x,
32x, 64x, and 128x. The initial speed is 16x.
This option is only available for videos created from Design Player.

Video Information
The Total Duration of the video in minutes and seconds, and the estimated file size in MB
are displayed. The duration and size vary according to the Size, Quality and Speed of the
video.
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File Name
Select a folder and name for the video file. Click Select to browse to a different folder on
your computer.

Start and Cancel
Click Start to create your video, using the settings that you chose above. A progress bar
shows during the creation of the video, with an estimate of the creation time. Click Cancel
to stop the video creation.
All other functions in the dialog box are unavailable (grayed out) during video creation.

Zoom Commands
A number of functions are available to make it easier to navigate around designs. These
include the Zoom functions and the Overview Window. By default, each design is shown
at a size so that the hoop fills the window, the same as if you click Zoom To Fit
after
zooming in or out.
Click and drag to zoom in on an area

Click to zoom out instantly
Click to zoom in instantly

Zoom to Fit
Select or input percentage zoom

100% zoom
Drag to zoom in and out

Shortcuts
Zoom Out

Keys: Ctrl + -

Zoom To Rectangle

Keys: Ctrl + 0

Zoom In

Keys: Ctrl + =

Zoom To Fit

Keys: Ctrl + 9

You can also navigate around a design by selecting the colors to see and changing the range of stitches
that are displayed.

Zoom To Rectangle
Use Zoom To Rectangle

to enlarge the view of an area of the design.

Click the Zoom To Rectangle icon
to the right of the status bar, and the mouse pointer
changes to the zoom in pointer
. Then either click a point on the design you want to
zoom in towards, or click and drag a rectangle around the area you want to enlarge and
release the mouse button to zoom.
Zoom To Rectangle is automatically deselected after you have used it.

Shortcuts
■
■

Status Bar:
Keys: Ctrl + 0
If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.
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Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are
Zoomed In on part of the screen, making the scroll bars visible at the right and bottom of
the work area.
Hold the Shift key down until the pan cursor

appears, then click and drag.

The pan occurs in real time, that is you see the work area move as you drag across the
screen.
Alternatively, use the Overview Window to move around the screen when Zoomed In.

Pan Around the Work Area
1
2
3
4
5

Click Zoom To Rectangle
and the arrow pointer changes to the zoom in pointer
.
Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around
the screen at this higher zoom level.
Hold the Shift key down, then start to click and drag. The pan cursor appears.
Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you
can click the wheel to pan around the screen.)
Lift the pen or release the mouse button.

Zoom To Fit
Use Zoom To Fit
to view the whole work area. Click the Zoom To Fit icon
view will zoom in or out to show the work area in the window.

and the

Shortcuts
■
■

Status Bar:
Keys: Ctrl + 9

Zoom by Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in from 10% up
to 800%. Alternatively, enter a number in the percentage text box.
Select 100% to display the design at a magnification as close as possible to the Real Size setting you chose
in mySewnet™ Configure.

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the picture or design.

The Zoom Bar is on the right side of the Status Bar.
Use the slider to zoom in or out of the picture or design, or click on the Zoom Out
Zoom In
icons.
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A new design can be started with File, New , or File, New Window . This will start the
ExpressDesign Wizard. Use the ExpressDesign Wizard to create a new design
automatically, load a picture for a new design, load an existing design or start a new
design with no picture.
In the Design window, you can use the File menu to Open
Load a Design with Drag and Drop.
Use the Insert functions to insert new
or existing designs
SuperDesigns
or text
into an existing design.
To open an embroidery as a new design, use File, New
no picture, and then use Insert Embroidery

a design or Open Recent, or
, embroideries

, or File, New Window

,

, to start a design with

to convert an embroidery to a design.

When starting from a blank design, you may choose a hoop, and start creating your design
with the Freehand, Point, Shape, Command and Column features. However, it is more
common to follow a picture when creating a design. Open an existing drawing or picture
in the ExpressDesign Wizard, or use Edit Background
to edit and load a background
picture with mySewnet™ Draw & Paint.
After creating or editing your picture as desired, it is recommended to save it. Then either
send the picture to the ExpressDesign Wizard, or start creating your design with
QuickStitch™, Freehand and Point Create features.
Save finished designs with Save
Export
.

or Save As

, then export the final embroidery with
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Open Designs
Open
Use Open
to load an existing design outline file (extension .edo). mySewnet™
Digitizing displays the Open dialog box so you can choose a design to open.
Browse to a different folder
Search for a design
Change the view or icon size
Click on a design to select it
Hover to view the selected
design’s details
Previewed design

Click Open to load the
selected design
Open Recent with File, Recent or Load a Design with Drag and Drop from Windows® Explorer.

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the .edo extension.

Files of Type
This is set to EDO Files (*.edo) and may not be changed, so that only design outline files
can be opened.

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list
or details
view to icons with thumbnail images of the design
outline files. For example, Extra Large icons .

Preview Pane
Preview the design outline file before opening

.

Shortcuts
■
■

File Menu:
Keys: Ctrl + O

Insert
Use Insert
to insert existing outline designs (.edo or .can files) into the current design.
The Open dialog is displayed so that you can choose a design to insert.
The design is inserted after the selected object or the last visible object in the design on
the work area. The inserted design is automatically selected so that it can be moved,
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resized, mirrored, rotated, copied or cut. Designs are inserted at the size they were created,
or automatically made small enough to fit the current hoop.
Use Insert to load a .can design outline file (from 5D™ or 4D™ Design Creator). Thumbnail image previews
are not available for .can files. If the .can file contains a picture, the picture will not be loaded.
Browse to a different folder
Search for a design
Change the view or icon size
Click on a design to preview it

Previewed design

Hover to view the selected design’s details

Click Open to load the selected design

Shortcuts
■
■

Quick Access Toolbar; File Menu; Home Tab, Insert:
Keys: Ctrl + I; Alt, 1; Alt, H, IN

Load a Design
1
2
3
4

5
6

In the File menu, click New
.
In the Quick Access toolbar, click Insert
.
Alternatively, click Insert in the Home tab.
In the Open dialog box, browse to the folder Documents\mySewnet\Samples\Digitizing \Edo.
If desired, click Change Your View
to view icons of the designs.
Scroll down to show the thumbnail of the sleigh.

Click the picture of the sleigh and the design will be selected.
Click Open to load the design onto the screen.
You can use Insert to transfer design elements between design files. Simply delete all the objects from a
design except the desired design element (for instance, in a floral design delete everything except one
flower that you want to use somewhere else). Save the isolated design element as a new outline design file
(.edo).

mySewnet™ Digitizing Creating & Managing Designs

115

Open the design where you want to insert the isolated design element, then browse and insert it with
Insert. If you do this several times then you will gradually build up your own library of design elements.

Load a Design with Drag and Drop
To drag and drop a design outline (.edo) file onto the screen, use Windows® Explorer.

Drag a Design to the Work Area
1

2
3
4
5

In Windows®, open an Explorer window. If required, resize the Explorer window so you can see both
Explorer and mySewnet™ Digitizing.
In Windows® 10 click File Explorer on the Status Bar.
Browse through the drives and folders of your computer to find the
Documents\mySewnet\Samples\Digitizing\Edo folder.
Click on the desired design name or icon to highlight it.
Use the mouse to drag and drop the design onto the mySewnet™ Digitizing screen. The design will be
displayed on the screen.
Close Explorer.

Recent
Open previously used design outline (.edo) files via the file names in the Recent section of
the File menu. Select the name of the desired design file.
Recently used designs may only be chosen from the File menu in the Design window. There is no recent files
list for pictures.

Shortcut
File Menu: Recent

Copy Embroidery
Use Copy Embroidery
to make a copy of the design as an embroidery and place it on
the clipboard, where it can be pasted into another mySewnet™ Embroidery Software
module. The whole design is copied as an embroidery, regardless of whether only part or
all of it is selected.
Use Copy to copy the selected objects. See “Copy” on page 310.

Copying to the clipboard replaces the contents previously stored there.

Shortcuts
■
■
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Home Tab, Copy:
Keys: Ctrl + Shift + C; Alt, H, CO, CE
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Save Designs
Save
Use Save
to save the design file under its current name and folder. When you save a
design for the first time, mySewnet™ Digitizing displays the Save As dialog box so you can
name the design file. To change the name and folder of an existing design file, use Save As.

Shortcuts
■
■

Quick Access Toolbar; File Menu:
Keys: Ctrl + S; Alt, 2

Save As
Use Save As
to save and name the design file. mySewnet™ Digitizing displays the Save
As dialog box so you can name your design. To save a design with its existing file name
and folder, use the Save command.

Shortcuts
■
■

Quick Access Toolbar; File Menu:
Keys: Ctrl + Shift + S; Alt, 3
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Export
Use Export
to save the design outline file in the current window as a flattened .vp4 file,
or in an alternative embroidery format. The embroidery must fit in the currently selected
hoop. Use the Design Player to see how the embroidery will be exported according to the
current Optimize for Sewing options.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff .vp4, as
this will preserve background and appliqué information, thread color information and
notes.
You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby
Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna (.hus ,.shv), Husqvarna
Viking /Pfaff (vp4, .vp3 and .vip), Janome (.jef and .sew), Melco Expanded (.exp), Pfaff (.pcs),
Tajima (.dst) or Toyota (.10o).
The initial name will be the current file name with "Exported" added. The text "Exported" may be changed
in mySewnet™ Configure.

Shortcuts
■
■

Quick Access Toolbar; File Menu:
Keys: Ctrl + E; Alt, 4

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other format.
You can customize the initial Optimize for Sewing Options in mySewnet™ Configure.

Combine: Merge the embroideries into a single embroidery during Export.
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Combine is not enabled if there is only one design, and for embroidery formats that are automatically
combined.

Remove Overlap: Prevent areas of stitches building up where embroideries overlap.
Remove Overlap is not available when Combine is not enabled.
Only deselect this option if, for example, your embroideries are low density and you wish to have a blend
effect where they overlap.

ColorSort: Reduce the number of thread colors during Export.
Optimize Stitch Length: Automatically remove small and insignificant stitches. See
“Stitch Length Optimizer Options” on page 122.
Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle colors in the Inspira
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in mySewnet™
Embroidery, or remove all decorations and their associated placement stitches.
Center or Line placement stitches are created automatically for decorations according to
the options set in mySewnet™ Configure, which may be altered when you export the
embroidery. Alternatively, create templates for cutters.
Center placement stitches are recommended when most decorations are individual and
symmetrical. Line placement stitches are recommended when most decorations are
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or
sequins.
Create Center placement stitches: Create a small cross shape in stitches to show where
the decoration is to be placed.
Create Line placement stitches: Create a single stitch that runs along the length of the
decoration.
Remove all decorations and placement stitches: Remove all decorations and placement
stitches from the exported version. This may be desired to create an embroidery with a
complementary crystal transfer template (made using the Export Decoration Template
dialog box in mySewnet™ Embroidery).

Hoop Orientation
Set the hoop orientation.
Rotate to fit natural hoop position: Rotate the embroidery if needed to fit with the
default hoop orientation for the machine. This option is only available if the hoop on the
main screen is in the rotated orientation. It is useful if you prefer to create a "landscape"
shaped project in the rotated orientation.
Flip design for felting or reverse embroidery: Flip the embroidery for being stitched in
reverse. If an embroidery contains a Felting Needle color effect this option is selected
initially. See “Felting Needle” on page 92.
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Splitting options
Click the button to open the splitting options dialog box. See “Splitting for Multipart
Hoops” on page 120.
Splitting for Multipart Hoops is available if .vp4, .vp3, .pes or .jef is chosen.

Additional Sections
Additional dialog sections are available, depending on the chosen file format.
■
■

If .pes is chosen, you can select your machine type, file version, hoop size and rotation.
If .jef is chosen, you can select your machine type, hoop size and rotation.

OK
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1
2
3
4
5
6
7
8

Create an embroidery design.
Save the design. See “Save As” on page 117.
Click Export
. The Export dialog box appears.
Select an embroidery format from the drop-down list.
Select your optimization options.
If you are using a multipart hoop, set Intelligent or Straight Line split.
Click OK.
The Save As dialog will appear. Save the embroidery as desired.
When exporting an embroidery, the message 'Design is too large or will not fit in hoop.' may appear. This
means that some part of your embroidery is not entirely within the hoop. Move the design so that it fits
inside the hoop. If desired, use the arrow keys to nudge the embroidery in small steps.

Splitting for Multipart Hoops
This dialog is available if .vp4, .vp3, .pes or .jef is selected as the file format.

Embroideries for Multipart hoops are split automatically, according to your Export
settings. Use an Intelligent or Straight Line Split.
Note: There is no need to ensure embroideries are in one stitch area of the hoop; just place
your embroideries in the most pleasing arrangement.

Split Method
You can use one of two split methods:
■

■

120

Intelligent Split automatically calculates a split line that is routed through gaps or across
movement stitches, cuts the minimum number of stitches, and minimizes cuts through
solid sections of embroidery. Where possible, use Intelligent Split.
Straight Line Split cuts the embroidery straight across the center line of the overlap zone.
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Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and
minimizes cuts through solid sections of embroidery. For example, a large embroidery is
split at a narrow section, and an embroidery that fits in one stitch area of the hoop is left in
one piece even if it is part of a larger design.
Tolerance ensures that the Intelligent Split line stays a short distance from the edges of
the overlap. This allows for play in the hoop when going from one hoop area to another,
such as when aligning a hoop that has been turned to stitch out the other side of an
embroidery.
You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.
To use Intelligent Split with Tolerance, select the "Intelligent with Tolerance" checkbox, then enter a number
in the Tolerance number box, or use the arrows to increase or decrease the Tolerance.

Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line Split
will only split an individual embroidery if, before it is combined with everything else, it
does not fit entirely into one stitch area of the hoop.
Lettering is split straight down the middle, as with any other type of embroidery. This may cut through
characters rather than gaps and spaces. In such cases, it is recommended to use Intelligent Split instead.

Compensation adds overlapping stitches along the edges where the embroidery is split.
This compensates for pull on the fabric.
None

Use None if you can split an embroidery without cutting through any of the design
elements. Compensation is initially set to None.

Low

Use Low when cutting through a lightly stitched embroidery or when the split lines go
through only a few stitch areas.

High

Use High when the embroidery is dense, when the split lines make long splits through
stitch areas, or when stitching onto materials such as knitted or stretchy fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of each embroidery section when
using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® creative Grand Dream™,
Universal Multipart hoop, or Brother Jumbo Frame. A hoop movement to the alignment
cross is added at the beginning of the next section. The next embroidery section can then
be correctly aligned, or alignment can be confirmed.
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Stitch Length Optimizer Options
Use the Stitch Length Optimizer Options dialog box to automatically remove small and
insignificant stitches. You can adjust the stitch removal sensitivity, or the minimum
significant stitch length.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.
■

Choose from Low, Medium or High.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below this
length are removed during the optimization process. The default stitch length is 0.8 mm.
Cutwork Needle lines are unaffected by the Minimum Significant Stitch Length.
■
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Choose from 0.6 mm, 0.8 mm or 1.0 mm.
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Export Appliqué Pieces
Use Export Appliqué Pieces

to save or print appliqué outlines ready for cutting.

Export an SVG, DXF or FCM file
for use in a fabric cutter

Use 2 or 4 cutwork needles
Add secure points for fabric stability
Export a .vp3 or .vp4 stitch file

Print as an outline template for cutting out

Print onto printable fabric or an iron-on transfer

Save as a PNGfile for use with a graphics package

There are five appliqué piece export methods:
■
■

■
■

■

Export for Cutter: Save as SVG, DXF or FCM files for use in fabric cutters
Export for Cutwork Needles: Save as VP4 or VP3 stitch files that can be used with
INSPIRA™ Cutwork Needles
Print Templates: Print as an outline template to stick or pin to fabric and then cut out
Print Appliqué Pictures: Print directly onto printable fabric or an iron-on transfer; this
also prints the image of the appliqué piece
Export for Custom Layout: Save as PNG files with the fabric image placed as the fill for
each shape. This is designed for use with fully customized layouts.

Export for Cutter
Export the appliqué piece as an SVG, DXF or FCM image file for use in a fabric cutter.
Set the units of measurement (millimeters or inches), and select a file type. Click Export to
save the file.
The maximum size for the Brother ScanNCut FCM format is 12" x 12" (305mm x 305mm).
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Recommended file formats for cutters:

Cutter

Software

Export Format

Cricut Explore®

Cricut Design Space 3.1512

SVG (points)

KNK Zing Air®

Make the Cut! 4.6.1 (Zing Plugin 2.1.0)

SVG (points)

Silhouette Cameo®

Silhouette Studio 3.6.57 ss
(Use "As Is" import settings)

DXF (millimeters)

Brother ScanNCut® (2)

Direct to USB stick or machine

FCM

Sizzix Eclips2

eCal2 2.203

SVG (points)

Export for Cutwork Needles
Export the appliqué piece for cutting with INSPIRA™ Cutwork Needles. Select 2 or 4
needles, choose whether to use secure points for fabric stability and their length, and use
a .vp3 or .vp4 stitch file.

Print Templates
Print the appliqué piece as an outline template to stick or pin to fabric and then cut out.
Select a printer and paper size in the Print Setup dialog box. See “Print Setup” on
page 327.

Print Appliqué Pictures
Print directly onto printable fabric or an iron-on transfer; this also prints the image of the
appliqué piece.
Flip the picture for an iron-on transfer, and select a printer and paper size in the Print
Setup dialog box. See “Print Setup” on page 327.

Export for Custom Layout
Save as PNG files with the fabric image placed as the fill for each appliqué piece shape.
This is designed for use with fully customized layouts, for example if you wish to arrange or
adjust the appliqué shapes in a graphics package.

Shortcuts
■
■

File Menu:
Keys: Ctrl + Shift + E

Sending Embroideries
Send designs to your mySewnet™ enabled embroidery machine via mySewnet™ from
within the mySewnet™ Embroidery Software, or directly from your mySewnet™ account.
Use mySewnet™ Connect to change your mySewnet™ settings, and to send embroideries
directly to some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.
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Send
Use the Send dialog to send the selected embroidery to the mySewnet™ Cloud, or to your
machine.

Send the design to the mySewnet™ Cloud
Send directly to a mySewnet™ device
Select the machine or computer for sending to
Send to a machine using a Direct USB cable

Start the mySewnet™ Connect utility
Change the design name before sending

Send to mySewnet™ Cloud
Send the selected embroidery design to the mySewnet™ Cloud.

Send Express to mySewnet™ Device
Send the selected embroidery design direct to the mySewnet™ enabled machine or
computer.
Select the computer or machine from the list below.

Direct USB Cable
Send or Send Express to a machine with a direct USB connection.

Filename
You can change the name of the design before sending it.

Sending via mySewnet™
Sending from a Machine to mySewnet™ Embroidery
You can send an embroidery from a mySewnet™ enabled embroidery machine to
mySewnet™ Embroidery on your computer. Adjust the embroidery, then return it to your
machine for stitching.
To be able to send from your machine to mySewnet™ Embroidery, and to send to your
machine with Send Express to mySewnet™ Device:
■

mySewnet™ Connect must be running on the computer
mySewnet™ Digitizing Creating & Managing Designs
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■

■

You must use a mySewnet™ enabled embroidery machine with the most recent updates
installed
The computer and embroidery machine must be signed in to the same mySewnet™
account.
An embroidery moved from a machine to mySewnet™ Embroidery will include no special features from the
embroidery machine, for example changing the words for lettering. This is also true of designs sent in the
other direction.

Send from an Embroidery Machine
1
2
3
4
5
6

Go to the embroidery machine.
Tap the Cloud button at the top and ensure that you are signed in to mySewnet™.
Select embroidery mode, and then load an embroidery.
In the machine screen, choose the send to software option.
Select the computer to send to, then send the embroidery.
The embroidery will open in a new mySewnet™ Embroidery window.
When you have adjusted the embroidery, save the changes to your computer.
You can name your computer in the mySewnet tab of mySewnet™ Configure.

You can then use Send Express to mySewnet™ Device to return the edited embroidery to
your machine for stitching out.
When you send from your embroidery machine to mySewnet™ Embroidery, the embroidery may be sent to
a window beneath the active maximized window. The mySewnet™ button in the taskbar flashes to
indicate that a design has been sent.

Using Send Express to mySewnet™ Device
1
2
3
4

In the File menu, select Send.
In the Send dialog box, select your machine name from the list.
A message tells you that the design was sent.
On the machine, tap to accept the design from your computer.
Stitch out the design.
You can use Send to mySewnet™ in the Explorer Plugin to send embroideries to mySewnet™. See the
mySewnet™ Configure Reference Guide and Help.

Sending to a Machine via Direct USB Connection
Use mySewnet™ Connect to send embroideries directly to your embroidery machine
screen, or to the embroideries folder on your embroidery machine with Direct USB
Connection.
■

■

mySewnet™ Connect must be open to transfer files directly to and from the embroidery
machine when it is connected to your computer.
Use the file manager on your embroidery machine to browse your computer and copy
embroideries to any folder on your machine.
When Direct USB Connection is established, the machine name will be shown in the Machine menu.

Using mySewnet™ Connect with Direct USB Connection
Before using Direct USB Connection, ensure that your drivers are up to date at
mysewnet.com
1
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First, check your Direct USB connection.
Switch off your embroidery machine.

mySewnet™ Digitizing Creating & Managing Designs

2

3

4
5
6

7

8
9
10

Open mySewnet™ Configure , and if the mySewnet™ Connect icon cannot be seen in the system
tray, click Start Machine Communication
on the Utilities tab.
The mySewnet™ Connect icon can be seen in the system tray, however it is flagged as inactive
.
Switch on your embroidery machine, and wait for it to initialize. The mySewnet™ Connect icon is now
flagged as active
.
You can now send embroideries to your embroidery machine’s screen or designs folder.
Communication will also be shown as established if a connection exists with mySewnet™.
Open mySewnet™ Embroidery, then use Insert
to load an embroidery design.
In the File menu click Send.
In the Send dialog box, select Send Express to USB connected machine, then click Send. The
embroidery appears on the embroidery machine screen.
You can now stitch it on your embroidery machine.
In the Send dialog box, select Send to USB connected machine. Then click Send to send the
embroidery to the MyFiles or Personal Files folder on your embroidery machine.
You can also send embroideries to your directly connected machine via the mySewnet™ Embroidery
Software Explorer Plugin. See the mySewnet™ Configure Reference Guide and Help.
Right-click the mySewnet™ Connect system tray icon. A context menu appears.
Ensure that Start Automatically is selected, to start mySewnet™ Connect whenever your computer is
started.
Click About mySewnet™ Connect to view the version number.
You will need this version number if you contact technical support at any time.

mySewnet™ Connect
Use the mySewnet™ Connect module in the mySewnet™ Embroidery Software to access
your mySewnet™ settings in mySewnet™ Configure, and to send embroideries directly to
some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.
To change your mySewnet™ settings, see the mySewnet™ Configure Reference Guide and Help.

Use the mySewnet™ Connect menu to check the status of your mySewnet™ or Direct USB
Connection.

The System Tray Icon
When mySewnet™ Connect is running, it appears as an icon in the system tray
at the
bottom right of your computer screen. The icon will show whether or not communication
is established with your machine as follows:

Communication established
■

No communication

Click or right-click the icon to see the mySewnet™ Connect Menu.
Communication is shown as established when a connection exists with either mySewnet™ or with your
embroidery machine via Direct USB Connection.

Starting mySewnet™ Connect
mySewnet™ Connect is set to start automatically when you restart your computer. If it is
not open, use the following steps.
1
2
3

Open mySewnet™ Configure .
On the Utilities tab, click Start mySewnet™ Connect
. The mySewnet™ Connect icon
can now
be seen in the system tray.
To close mySewnet™ Connect, click the icon in the system tray and in the mySewnet™ Connect menu
click Exit.
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mySewnet™ Connect Menu
Click the mySewnet™ Connect icon in the system tray to see a menu of options.

The menu tells you whether you are signed in to mySewnet™, and if Direct USB
connection is active.
For mySewnet™ the current status in mySewnet™ Configure is listed, for Direct USB your machine name or
Not Connected are present. If you have more than one machine, the first found is used.
■
■
■
■
■
■

Select About mySewnet™ Connect to see the version number and copyright.
Select Start Automatically to select or deselect the automatic start when Windows® starts.
Select mySewnet™ Options to view the mySewnet tab in mySewnet™ Configure.
Select Direct USB Settings to view the shared drives list.
Select Help to display help pages about mySewnet™ Connect.
Select Exit to close mySewnet™ Connect and remove it from the system tray.

Shared Drive Selection
Click the icon in the system tray, and select Direct USB Settings in the popup menu that
appears.

The Shared drives list shows all the drives on the computer. Drives that are selected with
check marks can be browsed from your embroidery machine. All available drives are
selected when mySewnet™ Connect is installed. If you add new drives after installing
mySewnet™ Connect, such as a USB stick, you will need to click the drive so it is checked.
Click the check boxes to uncheck drives that you do not want to browse from your
embroidery machine.
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The mySewnet™ Cloud Sync Tool
Use the mySewnet™ Cloud Sync Tool to manage the content of your mySewnet™
compatible embroidery machine from your PC.
The mySewnet™ Cloud Sync Tool is available from: www.mysewnet.com
Select your machine brand, Register or Sign In, and in the Home page select mySewnet™
Cloud to download and install the Sync Tool.

The System Tray Icon
When the mySewnet™ Cloud Sync Tool is running, there is an icon on the bottom right of
your computer screen. The icon will show whether or not the Sync Tool is running:

Sync Tool Active

Sync Tool Inactive

■

Left-click the icon to view your mySewnet™ folder and the mySewnet™ website.

■

Right-click the icon to see the mySewnet™ Cloud Sync Tool menu.
For more information, click Getting Started in the mySewnet™ Cloud Sync Tool menu.
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Creating Fills and Lines

Create Fills and Lines with the QuickStitch™, Freehand Create, Point Create and Shape
functions. Set stitch options before creation, or edit them afterwards.
To edit a line or fill, right-click it in the FilmStrip or on the work area and change its properties in the Fill
Area and Line Properties dialog. See “Fill Area and Line Properties” on page 35.

Creating with Quick Create
The Quick Create functions QuickStitch™ and QuickTrace are used to create new stitch
objects (lines, fills or holes) by using color areas in the background picture.
Select the desired QuickStitch™ or QuickTrace function, then click your chosen part of the
picture. Adjust Color Tolerance (if enabled), then click OK to create the object.

Using QuickStitch™ and QuickTrace
1
2
3
4

Select the desired QuickStitch™ or QuickTrace function in the Quick Create tab, according to the type
of object you want.
Then, click in the desired area of the picture for QuickStitch™ functions or on the desired line for
QuickTrace functions.
If Color Tolerance is enabled, the color area will be highlighted. Adjust tolerance, if desired.
Click OK to create the object(s).
If Color Tolerance is not enabled, the object(s) will be created immediately.

Color Tolerance
Color Tolerance is available for all the QuickStitch™ and QuickTrace functions. It allows
parts of a picture to be selected for filling or tracing according to how similar they are in
color to the chosen color. Also, use Color Tolerance to preview the shape of the new stitch
object, and to select the relative number of points in the line or border.
Turn Color Tolerance on and off with the Color Tolerance option in Preferences

.

Select an Area with Color Tolerance
1
2

3

4
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Set stitch options, then select the desired QuickStitch™ or QuickTrace function in the Quick Create
tab.
Click on the color area or outline you wish to fill, border or
trace. The Color Tolerance dialog box will appear. The
tolerance value is always zero when the dialog box appears.
Set the number of points used in the outline for the object.
High creates a more detailed, but less smooth, outline than
Medium or Low.
Move the slider bar to the required Color Tolerance value.
There are four ways to move the slider:
i) Click either side of it to move the slider by 20% in the
relevant direction
ii) Click and drag the slider to any value
iii) Press the left and right arrow keys to change the Color Tolerance value in 1% steps
iv) Enter a Color Tolerance value directly in the number box
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A red and cyan highlight on the design area shows the
area that will be filled or traced. If you have chosen to
detect holes, any holes in the area will be highlighted by
green and yellow lines. Adjust the Color Tolerance value
until the required part of the picture is selected.
Click OK when you have selected the desired part of the
picture. The fill or trace will be generated as usual.
Alternatively, if you want to start from a different point
(e.g. a different band of color) click Cancel and nothing
will happen. Then click the picture at the new point and
set the Color Tolerance as required.

QuickStitch™ and Color Tolerance
Color Tolerance helps you to create new objects with QuickStitch™ across and/or around
shaded or variegated areas of color, reducing or eliminating the need for placing areas by
hand. Color Tolerance can be used with the following QuickStitch™ functions:
QuickStitch™

QuickStitch™ Satin

QuickStitch™ + AutoHole

QuickStitch™ Multiple Satin

QuickStitch™ Hole

QuickTrace and Color Tolerance
Preview the outline that will be traced with Color Tolerance. This means you can see if
there are any breaks in the outline, possibly caused by slight variations in shade in the
outline which you can overcome by increasing the Color Tolerance. Color Tolerance can be
used with the following QuickTrace functions:
Double Trace

Satin Line Trace

Quadruple Trace

Motif Line Trace

Creating with Freehand and Point Create
Use the Freehand and Point Create functions to create new lines, fill areas or holes (stitch
objects) by creating outlines directly on the design.
The outlines may follow a background picture, if desired, but the Freehand and Point Create functions do
not require a picture.
If the curve produced does not match the background picture as closely as desired, you can move, delete
and insert points using the tools in the Home tab.

These functions are used either by drawing an outline as if using a tablet (the Freehand
Create functions) or by placing and adjusting points to define an outline (the Point Create
Bezier Line or Point Line functions).
Ties and movement stitches are added automatically between objects, when the option is selected in
Preferences

.
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After a line or fill area has been created, right-click the area to change its properties in Fill Area and Line
properties.
Alternatively, make a selection of fill areas visible and change them all with Global Properties, or hold the
Ctrl key and click the desired fill areas in the FilmStrip, then right-click one of them and select Properties to
change the properties for the selected objects.

Freehand Create
When using the Freehand Create, or tablet drawing functions, the stitch objects are
created by drawing outlines on the design.
Outlines can be drawn by using a pen on a graphics tablet or by using click and drag with a mouse.

Freehand Create (tablet) mode provides a more natural drawing experience and is
generally recommended.
Freehand Create (Tablet) functions:
Create Freehand Area or Line

Freehand Emboss Line

Freehand Hole

Freehand MultiWave Line

Freehand Satin Area

Select the desired line or fill and border type, then draw each individual object by drawing
a continuous line. When the pen is lifted, or the mouse button is released, the object is
completed. The next line drawn creates another new object. This continues until the
function is deselected.

Point Create
When the Point Create functions are selected, stitch objects are created by placing a series
of points that define the outline, or by drawing Bezier lines.
Placing points and Bezier lines allows precise positioning of curves, corners and straight
line sections.
Point Create functions:
Create Point Area or Line (Point and Bezier
mode)

Point Emboss Line (Point mode only)

Point Hole (Point and Bezier mode)

Point MultiWave Line (Point mode only)

Point Satin Area (Point mode only)

Select the desired fill and/or border type, then each point is placed by a single click (or
click and drag for Bezier lines). The outline is completed with a right-click. Right-click again
to deselect the function.
Hold down Ctrl to place square (angular) points, instead of round (curved) points.
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Creating Shapes
Use Shape
to place a selected shape in the work area and adjust its size and properties.
Draw a ring, a square, a frame or other shape using Shape.

Shape
Use Shape
to draw a fill area with or without a border, or a line on the work area. Then
adjust its size and properties. Select a fill and line to draw a fill area surrounded by a
border, or select a line type only to draw a closed line with no fill.
Draw a ring, a square, a frame or other shape using Shape.

Shortcuts
■
■

Quick Create Tab:
Keys: Alt, Q, S

Draw a Filled Shape with a Border
1
2
3
4
5
6

7

8

9

In the Quick Create tab, ensure that Fill and Line are selected.
Select a fill and border type, setting the Options for Fill Area and Line as desired.
Add a color change, or adjust the color in the worksheet. This sets the color for the fill.
Click Fill Area and Line, and in the Line tab select (check) Insert Color Change. Then click Line Thread
Color and set the color for the border.
Select the type of shape you wish to draw from the drop-down list.
Click the Shape icon
. The shape is placed in the center of the work area
as a selected block.
The dimensions of the box surrounding the shape are shown in the status bar.
Click and drag the shape to the preferred position, and resize it as desired
using the square corner handles.
Hold down Ctrl as you click and drag to resize proportionally. Hold down Shift
to resize from the center.
Right-click the shape and select Properties to change the stitch type and
settings for the line and fill.
Note that the second color in the worksheet (the secondary color without a number by it) is the color for
the border. You can also see it in the FilmStrip.
If desired, draw another shape or click Undo
and draw the shape again.

Draw an Unfilled Shape
1
2
3
4
5

6

7
8

Click the Fill button to deselect it, and ensure that Line type only is selected.
Choose stitch type for the line.
Add a color change, or adjust the color in the worksheet. This sets the color for the line.
A border without a fill uses the primary color.
Select the type of shape you wish to draw from the drop-down list.
Click the Shape
. The shape is placed in the center of the work area as a
selected block.
The dimensions of the box surrounding the shape are shown in the status bar.
Click and drag the shape to the preferred position, and resize it as desired
using the square corner handles.
Hold down Ctrl as you click and drag to resize proportionally. Hold down Shift
to resize from the center.
Right-click the shape and select Properties to change the stitch type and
settings for the line.
If desired, draw another shape or click Undo
and draw the shape again.
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Quick Create from Background
Use Quick Create from Background
to create a design using the current background
picture. If the picture is a vector drawing in .ecq format, it can be loaded directly as an .edo
design file, using Bezier lines. Other picture formats can be used to create an Express
Embroidery, Express Trace or Express Border design.
Quick Create from Background

will remove all existing objects from the work area when used.

Shortcuts
■
■

Quick Create Tab:
Keys: Alt, Q, B

Create a Design from a Vector Graphic File
1
2
3

4
5
6
7
8
9
10
11
12
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In the Quick Access toolbar, click Change Hoop
and in the Hoop Selection dialog box select
100mm x 100mm - Universal Square Hoop 1. Click OK.
Click File, New
, or File, New Window
and the Choose Design Type page of the ExpressDesign
Wizard will appear.
Click Create New Picture
, then click Next. This opens mySewnet™ Draw & Paint.
Vector images in .ecq format can be loaded with Load a Picture
. Other vector formats such as .svg
cannot be loaded, but may be opened in mySewnet™ Draw & Paint and used in .ecq format.
In the Quick Access toolbar, click Insert Picture
and the Insert dialog will appear.
In the Insert dialog box, browse to Documents\mySewnet \Samples\Digitizing\Pics.
Click to select 'Fleur de lys.svg', then click OK. The picture is very large.
Click Select All
, then click Transform
, to open the Transform dialog box.
Ensure that Proportional is selected (checked).
Set the Horizontal size
to make the design fit just inside the work area, then click OK.
The image size will be automatically adjusted to fit the size of your selected hoop.
Close mySewnet™ Draw & Paint and your picture is loaded into the Choose Picture page or the
wizard.
Click Next twice and the Design Size page will appear.
Click Enter Design Size.
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Change the Size to 95mm and click Width.
Click Finish. The picture will be shown on the work area.
Ignore any warning message that tells you that all existing objects in the work area will be removed.
Click the Quick Create tab.
Click Quick Create from Background
.
In the Quick Create from Background dialog you are asked if you want to Retain all individual objects,
Remove overlap, or Send entire image to Express Design.
Click Retain all individual objects or Remove overlap, to load the picture into the Design window as
an .edo (design) file.
The design created uses Bezier curves. You can see the objects in the FilmStrip.
If you choose Send entire image to Express Design, the Choose Design Type page of the ExpressDesign
Wizard will appear. See “ExpressDesign Assistant” on page 98.

Quick Create from Background Dialog
If Quick Create from Background
is used with a vector drawing in .ecq format, a dialog
asks if it all objects should be retained, if overlap between objects should be removed, or if
the image should be send to the ExpressDesign Wizard.
If there are no vector (Draw) objects in the .ecq file, or a raster image such as a .png file is loaded, the top
two options are dimmed (unavailable).

If the objects are retained, or overlap is removed, the image it is loaded directly into the
Design window as an .edo (design) file.

Retain all individual objects from Draw
The drawing is treated as a complete design, and is loaded as an .edo (design) file into the
mySewnet™ Digitizing window.
Lines are converted to running (0.5 or 1mm), triple (2mm), or satin (3mm or above) depending on their
width. Filled areas are converted to Pattern Fill.

Remove overlap of objects from Draw
Any overlap in the image is removed, and an .edo (design) file is created from this version
of the image.

Send entire image to Express Design
The layers in the drawing are flattened and the Choose Design Type page of the
ExpressDesign Wizard appears. See “Choose Design Type” on page 108.
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QuickStitch™ Functions
Use the QuickStitch™ functions QuickStitch™
, QuickStitch™ + AutoHole
and
QuickStitch™ Hole
to automatically fill clicked on color areas of the picture with fill
areas of small stitches surrounded by a border, a line, or holes in fill areas. QuickStitch™ can
create lines and fill areas with or without automatic holes.
Set stitch options before creation, or after a fill area has been created, you can right-click it in the FilmStrip
or work area to change its properties in Fill Area and Line properties.
Using the Edit tab tools, you can make a number of fill areas of the same type (e.g. Pattern Fill) visible and
change them all with Global Properties. Alternatively, hold the Ctrl key and click the desired fill areas in the
FilmStrip, then right-click one of them and select Properties; the properties for all selected areas will be
changed.

Create a QuickStitch™ Area
1
2
3

4
5
6
7

Set stitch options, then click the QuickStitch™ icon
or the QuickStitch™ + AutoHole
icon.
Click in the color area you wish to fill with stitches.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. If you
selected a function with AutoHole, any holes in the area will be shown. Click OK to confirm.
Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the
area. For QuickStitch™ + AutoHole, any holes detected will be cut out.
Repeat to place as many fill areas as desired.
Right-click to deselect the function, or simply select another Create tool.
To edit the fill or the border, click the fill area to select it, then right-click it and change the properties
in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 35.

QuickStitch™
Use QuickStitch™
to click in a color area to create a fill area
with or without a border, or a line automatically. If required,
use Color Tolerance to select a larger area according to the
similarity of adjacent colors.

éShortcuts
■
■

Quick Create Tab, Fill Area and Line:
Keys: Alt, Q, Q

Create a QuickStitch™ Fill Area
1
2
3
4

5
6
7
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Select your fill and border type.
Click the QuickStitch™ icon
.
Click in the color area you wish to fill with stitches.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to
confirm.
Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the
area.
Repeat to place as many fill areas as desired.
Right-click to deselect, or simply select another Create tool.
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To edit the fill or the border, click the fill area to select it, then right-click it and change the properties
in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 35.

1
2
3
4

Select your line type, ensuring that Fill is not selected.
Click the QuickStitch™ icon
.
Click in the color around which you wish to create a border.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to
confirm.
A border will appear around the area.
Repeat to place as many borders as desired.
Right-click to deselect, or simply select another Create tool.
To edit the border, click it to select it, then right-click and change the properties in the Fill Area and
Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 35.

Create a QuickStitch™ Line

5
6
7
8

QuickStitch™ + AutoHole
Use QuickStitch™ + AutoHole
to fill an area with small
stitches in alternating patterns automatically, while also cutting
out 'holes' in the area, by clicking in a color area of the picture. If
required, use Color Tolerance to select a larger area according
to the similarity of adjacent colors.

Shortcuts
■
■

Quick Create Tab, Fill Area and Line:
Keys: Alt, Q, H

Create a QuickStitch™ Area with a Hole Automatically
1
2
3
4

5
6
7
8

Select your fill and border type.
Click the QuickStitch™ + AutoHole
icon.
Click in the color area you wish to fill with stitches.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed, and any
holes in the area will be shown. Click OK to confirm.
Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the
area, and any holes detected will be cut out.
Repeat to place as many fill areas as desired.
Right-click to deselect, or simply select another Create tool.
To edit the fill or the border, click the fill area to select it, then right-click it and change the properties
in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 35.
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QuickStitch™ Hole
Use QuickStitch™ Hole
to cut out holes within the currently
selected fill area automatically, by clicking in the required color
areas of the picture. If required, use Color Tolerance to select a
larger area according to the similarity of adjacent colors.
This is useful to cut out holes in an existing fill area with a background
picture.

Also use QuickStitch™ Hole
to create specific holes that were
not previously removed. For example, some holes you wanted
may have been included in the fill area because of the Color
Tolerance setting.

Shortcuts
■
■

Quick Create Tab, Enhance:
Keys: Alt, Q, U

Create a Hole in a Fill Area Automatically
1
2
3
4
5
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Click in the fill area in which you want to create a hole.
Click QuickStitch™ Hole
.
Click in a defined color area within the fill area to cut out a hole.
Repeat to create more holes, as desired.
Right-click to deselect, or simply select another Create tool.
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QuickTrace
Use the QuickTrace
functions Double Trace
, Quadruple Trace
, Satin Line
Trace
, or Motif Line Trace
to place double or quadruple lines of stitches, satin
borders or motif lines by clicking lines in the picture. The traced design is created as a
group.
All connected lines will be traced.

Double Trace

Quadruple Trace

Satin Line Trace

Motif Line Trace

You can set stitch options before creation, or after.
Double Trace and Quadruple Trace use the stitch length setting for Running Stitch in Fill Area and Line
properties, as does Running Stitch used in Satin Line Trace. The Running Stitch sections for Motif Line trace
use a fixed length of 1.5mm. The Satin Line and Motif Line for tracing use the settings in Fill Area and Line.
To change stitch settings after the stitches have been created, right-click an object to change the
properties in the Fill Area and Line dialog box.
To change multiple objects, click a single object in the Group for the traced design, then right-click and
choose Select Similar from Group . Right-click the object again, and select Properties to choose settings
for all objects of that type, e.g. Running Stitch, in the design. See “Select Similar from Group” on page 305.
Alternatively, change all visible objects of one type with Global Properties, or hold the Ctrl key and click the
desired objects in the FilmStrip, then right-click one of them and select Properties to change the properties
for the selected objects.

Using QuickTrace
1
2
3

Zoom In so that you can clearly see the line where you wish to create the QuickTrace. This will help
with thin outlines that are difficult to select.
Set stitch options, then in the Trace
drop-down menu on the Quick Create tab, select Double
Trace
, Quadruple Trace
, Satin Line Trace
, or Motif Line Trace
.
Click the outline you wish to trace.
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4

5

6
7

If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to
confirm.
The stitch lines or satin border will be created as a Group, and the function is automatically
deselected. For satin border, a running stitch is used underneath the border to stabilize and connect
border sections.
Repeat as desired.
To edit the border, click an object in the group to select it, then right-click and choose Select Similar
from Group . Right-click again and change the properties in the Fill Area and Line Properties dialog.
Click OK to save the changes. All stitch lines of the selected type will use the new settings.
See “Fill Area and Line Properties” on page 35.

Double Trace
Create two layers of stitches following the selected line
automatically, by clicking on it. Double Trace produces a layer of
double stitch, with some running stitch where needed. The
trace begins and ends at the closest point on the selected
outline to the previous object, and is created as a Group. If
required, use Color Tolerance to select a larger area according to
the similarity of adjacent colors. Stitch length may be from 1.0 to
12mm. Set it beforehand, or if desired, alter it afterwards in the
properties dialog.
Double Trace uses the stitch length setting for Running Stitch in Fill Area and Line
properties.
For complex outlines, a group of double and running stitch lines is created to make up the trace. To alter
the length of all the stitches, click a single object in the Group for the traced design, then right-click and
choose Select Similar from Group . Right-click the object again, and select Properties to choose settings
for all objects of that type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all
objects before and after the trace, then use Global Properties to adjust the stitch lengths, or hold the Ctrl
key and select the desired stitches then right-click one and select Properties to adjust the stitch lengths for
the selected lines.

Repeat to trace more lines, and right-click to deselect.

Shortcuts
■
■

Quick Create Tab:
Keys: Alt, Q, T, D

Quadruple Trace
Create four layers of stitches following the selected line
automatically, by clicking on it. Quadruple Trace produces a
layer of running and a layer of triple stitches. The trace begins
and ends at the closest point on the selected outline to the
previous object, and is created as a Group. If required, use Color
Tolerance to select a larger area according to the similarity of
adjacent colors. Stitch length may be from 1.0 to 12mm. Set it
beforehand, or if desired, alter it afterwards in the properties
dialog.
140
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Quadruple Trace uses the stitch length setting for Running Stitch in Fill Area and Line
properties.
For complex outlines, a group of running and triple stitch lines is created to make up the trace. To alter the
length of all the stitches, click a single object in the Group for the traced design, then right-click and choose
Select Similar from Group . Right-click the object again, and select Properties to choose settings for all
objects of that type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all objects
before and after the trace, then use Global Properties to adjust the stitch lengths, or hold the Ctrl key and
select the desired stitches then right-click one and select Properties to adjust the stitch lengths for the
selected lines.

Repeat to trace more lines, and right-click to deselect.

Shortcuts
■
■

Quick Create Tab:
Keys: Alt, Q, T, Q

Satin Line Trace
Create a satin border that follows the selected line
automatically, by clicking on it. If required, use Color Tolerance
to select a larger area according to the similarity of adjacent
colors. The border width can be from 1 to 12mm. Set it
beforehand, or if desired, alter it afterwards in the properties
dialog. The Satin Line Trace is created as a Group.
The Satin Line uses the settings for Satin Line in Fill Area and
Line
properties, and the Running Stitch uses the stitch
length setting there for Running Stitch.
For complex outlines, a group of satin borders is created to make up the trace. To alter properties of all the
borders, click a single object in the Group for the traced design, then right-click and choose Select Similar
from Group . Right-click the object again, and select Properties to choose settings for all objects of that
type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all objects before and after
the satin trace, then use Global Properties to adjust width, density and underlay, or hold the Ctrl key and
select the desired satin borders then right-click one and select Properties to adjust width, density and
underlay for the selected lines.

Repeat to trace more lines, and right-click to deselect.

Shortcuts
■
■

Quick Create Tab:
Keys: Alt, Q, T, S
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Motif Line Trace
Create a motif line that follows the selected line automatically,
by clicking on it. If required, use Color Tolerance to select a
larger area according to the similarity of adjacent colors. The
Motif Line Trace is created as a Group.
The Motif Line uses the settings for Motif Line in Fill Area and
Line
properties. The Running Stitch sections for Motif Line
trace use a fixed length of 1.5mm.
For complex outlines, a group of motif lines is created to make up the trace.
Set options beforehand, or to alter properties of all the borders click a single object in the Group for the
traced design, then right-click and choose Select Similar from Group . Right-click the object again, and
select Properties to choose settings for all objects of that type, e.g. Running Stitch, in the design.
Alternatively, in the Edit tab either hide all objects before and after the trace, then use Global Properties to
adjust motif options, or hold the Ctrl key and select the desired motif lines then right-click one and select
Properties to adjust motif options for the selected lines.

Repeat to trace more lines, and right-click to deselect.

Shortcuts
■
■
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Quick Create Tab:
Keys: Alt, Q, T, M
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Freehand and Point Create Functions
Use the Freehand Create tablet drawing functions Create Freehand Area or Line ,
Freehand Hole , Freehand Emboss Line , Freehand MultiWave Line
and Freehand
Satin Area
, to create stitch objects by drawing outlines on the design.
See “Freehand Create” on page 132.

Use the Point Create point placing and Bezier line functions Create Point Area or Line ,
and Point Hole , and the point placing functions Point Satin Area
, Point MultiWave
Line
and Point Emboss Line
to create stitch objects by placing a series of points or
Bezier lines that define the outline.
See “Point Create” on page 132.

Create Freehand Area or Line
Use Create Freehand Area or Line
to draw a line to define
the edge of an area filled with small stitches in repeating
patterns with or without a border, or an unenclosed line.

Shortcuts
■
■

Freehand Create Tab, Fill Area and Line:
Keys: Alt, R, R

Create a Line or Fill Area with Create Freehand Area or Line
1
2
3
4

5
6

In the Freehand Create tab select your line and/or fill type.
Click the Create Freehand Area or Line icon
.
Draw a line along or around the desired area.
When the line is complete, lift the pen from the tablet (or release the mouse button). If a fill was
selected, the area is closed with a straight line back to the start point, and filled with stitches using the
chose border and fill type.
You can change the border and fill in Fill Area and Line Properties.
When creating a fill area it is recommended to draw back to the start point. However, you can also adjust
the shape on the work area, if the area is not the exact shape desired.
Continue to draw as many lines or fill areas as desired.
Right-click to deselect the function, or simply select another tool.
To change the object properties, right-click the line or fill area and edit the properties in the Fill Area and
Line Properties dialog. See “Fill Area and Line Properties” on page 35.
To edit the object, or change the properties for more than one object at a time, use the FilmStrip. See
“Editing a Design” on page 284.

Change Line or Fill Properties
■

Right-click the line or fill area and change its properties. Then click OK.
See “Fill Area and Line Properties” on page 35.

■

Alternatively, to change the properties of a number of lines or fills at one time, in the
FilmStrip hold the Ctrl key and click each of the objects to be changed. Then right-click
one of the selected objects and select Properties. The Fill Area and Line dialog box will
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■

appear. All settings in the Fill Area and Line dialog box will be applied to your selected
objects when you click OK.
If desired, move the start , end
and/or origin
for selected fill areas.
After moving the origin, use Life View

or Design Player

to see the effect.

Create Point Area or Line
Use Create Point Area or Line
to place points to create a line
to define the edge of an area filled with small stitches in
repeating patterns with or without a border, or an unenclosed
line.
To draw the outline for a Line or Fill Area with Bezier Lines instead of Point
Lines, click Bezier Mode
to enable drawing Bezier curves, then draw
your Line or Fill Area. See “Bezier Mode” on page 149.

Shortcuts
■

Point Create Tab, Fill Area and Line:
Keys: Alt, P, R

1
2

In the Point Create tab select your line and/or fill type.
Click the Create Point Area or Line icon
.

■

Create a Line or Fill Area with Create Point Area or Line

3
4
5

6
7
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To draw the outline for a Line or Fill Area with Bezier Lines instead of Point Lines, click Bezier Mode
to
enable drawing Bezier curves, then draw your Line or Fill Area. See “Bezier Mode” on page 149.
Click to place the first point. It appears as a small hollow yellow circle.
Click to place a second point. The new circle is now yellow, and the previous circle is white.
Continue placing points around the desired area, such as a chosen section of the background picture.
If you are following the picture, place a point every time the direction of the picture outline changes.
Curved lines are created automatically, unless fewer than three points are placed, in which case the lines
will be straight. For corners and straight edges, hold down the Shift key. To delete the last point placed, use
the Delete key.
Right-click to complete the area. Stitches will appear in the current thread color showing the line or
fill area and border.
Continue to place as many objects as desired.
To change the line and fill properties, right-click the line or fill area and edit the properties in the Fill Area
and Line Properties dialog. See “Fill Area and Line Properties” on page 35.
To edit the line or fill, or change the properties for more than one area at a time, use the FilmStrip. See
“Editing a Design” on page 284.
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Mitered Corners and Closed Shapes
When creating satin line by placing points, the corners of a satin
border are mitered automatically when you hold down Ctrl and
click to place a corner point. If you wish to make a closed shape
with mitered corners, such as a square or rectangle, join the shape
in the middle of one of the sides, as shown in the example. If the
shape is joined at a corner, that corner will not be mitered as it will
simply be two straight end points in the same place, rather than a
true corner.
When drawing this type of satin line shape, overlap the start and end points
slightly to ensure a neat join.

Freehand Hole
Use Freehand Hole
to cut out holes within the selected fill
area, by drawing outlines to define the holes.
This function only affects the currently selected fill area.

Shortcuts
■
■

Freehand Create Tab, Enhance:
Keys: Alt, R, H

Create a Freehand Hole in a Fill Area
1
2
3
4

5
6

Select the area in which you want to cut the hole.
Click the Freehand Hole icon
.
Draw a line around the edge of the desired area for the hole.
When the area is complete, lift the pen from the tablet (or release the mouse button). The area is
closed with a straight line back to the start point.
It is recommended to draw back to the start point. However, you can also adjust the shape of the hole
afterwards, if it is not the exact shape as desired.
Continue to cut as many fill holes as desired.
Right-click to deselect the function, or simply select another tool.

Point Hole
Use Point Hole
to cut out holes within the currently selected
fill area, by placing points or drawing Bezier Lines to define the
holes.
This function only affects the currently selected fill area.
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Shortcuts
■

Point Create Tab, Enhance:
Keys: Alt, P, H

1
2
3

Select the area in which you want to cut the hole.
Click the Point Create tab.
Click the Point Hole icon
.

■

Create a Point Hole in a Fill Area

4
5
6

7
8

To draw the hole with a Bezier Line, click Bezier Mode
, then draw your hole. See “Bezier Mode” on
page 149 for information on drawing Bezier Lines.
Click to place the first point. It appears as a small hollow yellow circle.
Click to place a second point. The new circle is now yellow, and the previous circle is white.
Continue placing points around the desired area, such as a chosen section of the background picture.
If you are following the picture, place a point every time the direction of the picture outline changes.
Curved lines are created automatically, unless fewer than three points are placed, in which case the lines
will be straight. For corners and straight edges, hold down the Shift key. To delete the last point placed, use
the Delete key.
Right-click to complete the hole. The hole will appear in the fill area.
Continue to cut as many holes as desired.

Emboss Line
Use the Emboss Line functions Freehand Emboss Line
and Point Emboss Line
create an embossed line on a fill area, satin area, or column.

to

Freehand Emboss Line
Use Freehand Emboss Line

to draw a line to emboss on a fill area, satin area, or column.

Shortcuts
■
■

Freehand Create Tab, Enhance:
Keys: Alt, R, E; Alt, Q, E, F

Create a Freehand Emboss Line
1
2
3

In the Freehand Create tab select a fill area, satin area, or column.
Click the Freehand Emboss Line
icon.
Draw a line on the selected area. The emboss line will appear on the fill, with the first point as a square
and later points as circles, except for a square final point.
To follow a background picture, select 2D View

4

in the View tab, and zoom in as necessary.

You can move points after the line has been created. To delete points, use Delete Points
in the Home
tab.
Repeat to place as many embossed lines as desired. Right-click to deselect the function.
To change an embossed line, move its points, or use Insert Points
Use Delete Emboss Line
page 298.

or Delete Point

in the Home tab.

in the Edit tab to remove an embossed line. See “Delete Emboss Line” on

Point Emboss Line
Use Point Emboss Line
column.
146

to place points to emboss a line on a fill area, satin area, or
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Shortcuts
■

Point Create Tab, Enhance:
Keys: Alt, P, E; Alt, Q, E, P

1
2
3
4
5

Select a fill area, satin area, or column.
Click the Point Create tab.
Click the Point Emboss Line
icon.
Click to place the first point. It appears as a small hollow yellow circle.
Click to place a second point. The new circle is now yellow, and the previous circle is white.

6
7

To follow a background picture, select 2D View
in the View tab, and zoom in as necessary.
Continue placing points along the desired path.
Curved lines are created automatically. For corners and straight sections, hold down the Shift key.

8
9

You can move points after the line has been created. To delete points, use Delete Points
in the Home
tab.
Right-click to end the line. The emboss line will appear on the selected fill or other area.
Repeat to place as many embossed lines as desired.

■

Create a Point Emboss Line

To change an embossed line, move its points, or use Insert Points
Use Delete Emboss Line
page 298.

or Delete Point

in the Home tab.

in the Edit tab to remove an embossed line. See “Delete Emboss Line” on

MultiWave Line
Use the MultiWave Line functions Freehand MultiWave Line
and Point MultiWave
Line
to create a line that shapes the wave patterns in a MultiWave Fill.

Freehand MultiWave Line
Use Freehand MultiWave Line
MultiWave Fill.

to draw a line that shapes the wave patterns in a

MultiWave Fill, using two long MultiWave lines to
shape the flow of the fill within a leaf

MultiWave Fill, using a short MultiWave
Line to add texture to an embroidery

Use a long line to position the stitch lines in an embroidery, or use a short line to add texture to the
stitching. The lines do not have to be within the fill area, however they should not cross each other. Vary the
density or use a motif to change the effect.

Shortcuts
■

Freehand Create Tab, Enhance:
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■

Keys: Alt, R, W; Alt, Q, W, F

Create a Freehand MultiWave Line
1
2
3
4

Select a MultiWave Fill area.
Click the Freehand Create tab.
Click the Freehand MultiWave Line
icon.
Draw a line over or near the selected area.
The MultiWave line will appear on the fill, with the first point as a square and later points as circles,
except for a square final point. The wave patterns in the fill will follow this line.
To follow a background picture, select 2D View

in the View tab, and zoom in as necessary.

You can move points after the line has been created. To add or remove points, use Insert Points
5

Use Delete MultiWave Line
page 298.

148

or

Delete Points
in the Home tab.
Repeat to place as many MultiWave lines as desired. Right-click to deselect the function.
in the Edit tab to remove a MultiWave line. See “Delete MultiWave Line” on
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Point MultiWave Line
Use Point MultiWave Line
in a MultiWave Fill.

to place points to form a line that shapes the wave patterns

Shortcuts
■
■

Point Create Tab, Enhance:
Keys: Alt, P, W; Alt, Q, W, P

Create a Point MultiWave Line
1
2

Select a MultiWave Fill area.
Click the Point Create tab.

3
4
5
6
7
8

To follow a background picture, select 2D View
in the View tab, and zoom in as necessary.
Click the Point MultiWave Line
icon.
Click to place your first point. The point appears automatically as a small hollow circle.
Click to place a second point.
Continue placing points along the desired path.
Curved lines are created automatically. For corners and straight sections, hold down the Shift key.
Right-click to end the line. The MultiWave line will appear on the fill, and the wave patterns in the fill
will follow this line.
You can move points after the line has been created. To add or remove points, use Insert Points

9

or

Delete Points
in the Home tab.
Repeat to place as many MultiWave lines as desired.
Use Delete MultiWave Line
page 298.

in the Edit tab to remove a MultiWave line. See “Delete MultiWave Line” on

Bezier Mode
Use Bezier Mode
to draw shapes with finely graduated curves. Control the exact shape
of the line using the black handles to either side of the points you place.
Click to place Corner points, or click and drag to place curve points with
handles.
For information on Control Points and the other Bezier Line editing tools, see “Convert
Points and Bezier Lines” on page 295.

Creating Bezier Lines
When creating Bezier lines, press the Delete key to remove the last placed point.
• Click without dragging to create a Corner point (no handes)
• Click and drag to create a Smooth point (the handles are initially symmetric)
Use the Ctrl key while drawing to affect how the handles are placed:
• Hold down the Ctrl key while dragging to place the first handle opposite the position
where the key was pressed, and the second handle where the mouse button was
released (the handles are asymmetric and can be angled
).
• Hold down the Ctrl key before clicking, then drag and release. A single handle is placed
where the mouse button was released.
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Editing Bezier Lines
When a point is dragged, its handles move with it, keeping the same angle and distance.
• The handles on a Smooth point can be moved independently along the straight line
between the point and handles.
• The handles on a Symmetric point stay the same distance from their point when moved
along the straight line between the point and handles.
• Hold down the Ctrl key while dragging a handle to create an angle at the
point between the two handles.
• Use Insert Points
and Delete Points
on the Home tab to add and
remove points from the Bezier line.

Shortcuts
■
■

Point Create Tab, Options:
Keys: Alt, P, BM

Draw a Circle in Bezier Mode
1
2
3
4
5
6
7
8
9
10
11
12

13

14

15
16

17
18
19
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In the Quick Access toolbar, click Change Hoop
, and set the hoop to Universal, 100mm x 100mm Universal Square Hoop 1.
Click the View tab, and ensure that Grid size is set to 10mm.
Click the Point Create tab.
Ensure that Fill and Appliqué are not selected (not highlighted).
Set the Line Type to Triple Stitch
.
Click Bezier Mode
to select (highlight) it.
Click Create Area or Line
to select it. The Bezier Mode pointer appears
.
Click to place a point, then click to place three more of these square points in a rough curve.
Right-click to finish the line. The points are joined by straight lines.
These are Corner Points, in Bezier Mode they are joined by straight lines.
Click Undo to remove the line.
Starting 2 squares above the center of the hoop, click and drag to the
right one square, to the crosshairs of the next grid square.
Release the mouse button.
A white square (a Point) appears at the placed where you clicked, and a
black handle appears at the place where you released the button. This is
the forward handle.
Note that a second handle has appeared the same distance behind
the white point.
This is the backward handle, it is the same distance from the white point
as the forward handle (it is symmetrical).
Starting 2 squares to the right of the center of the hoop, click and
drag downwards one square, then release the mouse button.
A curved line appears between the two square white points.
Starting 2 squares below the center of the hoop, click and drag one
square to the left to place the next section of the curved line.
Then, starting 2 squares to the left of the center of the hoop, click
and drag one square upwards to place another section of the curved
line.
You should now have three quarters of a circle.
Move the pointer over the square white point on the right. The
pointer changes to the Move pointer
.
Drag the point and place it exactly where the grid lines cross.
Move the pointer over the forward handle for that point (the black
handle below the point that you just moved).
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21
22

23
24
25
26

Drag the handle a about half a square downwards. The backward handle for this point moves the
same distance upwards.
While you are still placing points, if you adjust the handles they behave symmetrically. You can also drag to
add symmetrical handles to a Corner point.
Move the handle to the right and left.
Note that the curved line changes shape as you move the handle.
Move the forward handle so that both handles are over the cross
hairs of the squares above and below the point, and so that the line
between the handles runs along the grid line.
If needed, adjust the other points and handles so that you have a
smooth three quarters curve.
Right-click to place the line.
In the FilmStrip, right-click the Triple Stitch line that you just drew,
and select Properties from the Context menu.
In the Line tab of the Fill Area and Line dialog box, select (check)
Closed Border Line, then click OK. The line becomes a circle.

Edit a Bezier Line
27
28
29
30

31

32
33
34
35

36

37
38
39

Click the Home tab.
Click Edit Points
. The points and their handles are displayed.
Move the pointer over the handle above the point on the right (the
backward handle for the second point in the line).
Drag the handle a short distance downwards. This time the handle
below (the forward handle) does not move, and the shape of the
circle distorts.
When editing a line the points are Smooth, and not Symmetric. The
handles can be moved independently along the straight line.
In the Convert Points
drop-down menu in the ribbon bar, select
Convert Points to Symmetric
.
Edit Points
is no longer highlighted.
Move the pointer over the point whose handles you just changed.
The pointer changes to the Convert Points to Symmetric pointer
.
Click on the point. The handles become symmetrical, and the shape
you drew becomes a circle again.
Right-click to deselect Convert Points to Symmetric.
Edit Points is highlighted again.
Move the pointer over the handle above the point on the right and
move it downwards. The handle below the point moves with the
handle above the point.
Using Convert Points to Symmetric locks the handles into Symmetric
mode while editing.
In the Convert Points
drop-down menu in the ribbon bar, select
Convert Points to Smooth
. Edit Points is no longer highlighted.
For more information on Control Points and the other editing tools, see “Convert Points and Bezier Lines”
on page 295.
Move the pointer over the point whose handles you just changed.
The pointer changes to the Convert Points to Smooth pointer
.
Click on the point.
Right-click to deselect Convert Points to Smooth. Edit Points is
highlighted again, and you can now move the handles
independently.
If you move a handle very close to its point and release the mouse
button, the handle will vanish. The section of the line without a handle
becomes straight. Use Convert Points to Smooth to regain use of both
handles.
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40
41
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43
44

In the Convert Points
drop-down menu in the ribbon bar, select Convert Points to Corner
.
Move the pointer over one of the points in your line. The pointer changes to the Convert Points to
Corner pointer
.
Click on the point. It now has no handles, and the sections of the line by it are straight.
There are no handles to drag, so you can only change the line by moving this Corner Point. Use Corner
Points for straight lines.
Right-click to deselect Convert Points to Corner, and then in the Convert Points drop-down menu
select Convert Points to Smooth
and click that point again to return to handle adjustment.
Right-click to deselect Convert Points to Smooth.
To create a corner point with full control over the angle of the lines, hold down Ctrl and click the point. You
can then move the handles independently.
To create a flower design from a motif using Bezier lines see “Draw a Flower using Bezier Curves” on
page 154.

How to Create Lines with Point Create
Outline the Fleur de Lys With a Satin Line
1

2
3
4
5
6
7
8
9
10
11
12
13
14
15

16
17

18
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Click File, New
or File, New Window
and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'Fleur de lys with bars’. Click Finish.
Alternatively, use the design from “Create the Band and Feathers for a Fleur de Lys” on page 260.
Click the Point Create tab.
Ensure that Fill and Appliqué are not selected (not highlighted).
Click Create Area or Line
to select it. The Create Cursor appears
.
Note the position of the Create Cursor
. This marks the end of the last object in the design.
If it is not on the left side of the base of the left feather, follow steps 6 to 9. Otherwise see step 10.
Ensure that Line is selected, and in the Line drop-down list select Running Stitch
.
Move the pointer towards the Create Cursor, until it changes to the diagonal pointer
and click to
place a point over the Create Cursor.
Place a second point to draw a straight line to the left side of the base of the left feather.
Right-click to end the line.
If desired, use 2D and zoom in to see more clearly.
In the Line drop-down menu, select Satin Line
.
Placing the first point on top of the Create Cursor
, place points to draw a line around the left
feather to the base on the right. Use Ctrl to place square points at the tip.
Right-click twice to finish the line, and to deselect Create Point Area or Line.
Right-click the satin line to open the Fill Area and Line dialog box.
Ensure that Density is set to 4 and that Underlay is selected (checked). Set Width to 2.5mm.
Click the Favorites tab. Click ’Set these options as the current settings’
. Then click OK to close Fill
Area and Line dialog box.
When you next use Satin Line, the settings that you have just set up for satin line will be used. This is an
alternative way to set the Options.
In the Line drop-down menu select Running Stitch
.
Use Create Point Area or Line
to create a straight line from the Create Cursor to the left side of the
base of the middle feather, and right-click to finish the line.
A satin line is not placed along the side of the band as the whole of the band will be outlined in satin later.
In the Line drop-down menu, select Satin Line
.
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Create Point Area or Line
is still selected.
Draw a line around the middle feather from the
Create Cursor
to the base on the right. Use
Ctrl to place square points at the tip.
Place roughly the same number of points on
similar curves so that the feather borders have the
same appearance.
Right-click to finish the line.
In the Line drop-down menu select Running
Stitch
and then use Create Point Area or
Line to create a straight line from the Create
Cursor to the left side of the base of the right
feather.
In the Line drop-down menu, select Satin
Line
. Then use Create Point Area or Line to
draw a line around the right feather from the
Create Cursor
to the base on the right. Use
Ctrl to place square points at the tip.
Right-click to finish the line.
Click Life View
to see the border around the feathers. Click Cancel.
In the Line drop-down menu select Running Stitch
. Starting at the Create Cursor, use Create Point
Area or Line
to create angled lines around the right side of the band and down to the base of the
fleur de lys.
Right-click to finish the line.
In the Line area, select Satin Line
. Then use Create Point Area or Line
to draw a line around the
base of the fleur de lys.
Use Ctrl to place square points where the base joins the band, and at the tips and angles of the base.
Click to place a square point where the base of the fleur de lys meets the band on the left.
Click to place a square point at each corner of the band, finishing back where you started at the left
side of the base of the fleur de lys.
Right-click twice to finish the line, and to deselect Create Point Area or Line.
Click Life View
to see the border around the complete
fleur de lys. Click Cancel.
In the FilmStrip, scroll up to the top. This takes you to the
start of the design.
Select the Satin Line circle. This should be object number
3 in the FilmStrip.
Click Move to Front of Design
.
The circular satin line will be placed at the front of the design
(the bottom of the FilmStrip), below the satin line for the
base of the fleur de lys. It will be stitched out last.
In the FilmStrip, scroll up to the top.
Select the blue thread color in position 1.
Right-click the thread and select Properties. The Color
Selection dialog box opens.
Ensure that the thread range is set to Robison-Anton
Rayon 40, and enter 2232 in the Find Thread box. Thread
2232 (Ecru) will be selected. Click OK.
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In the Design Panel, click the Edit
button
next to the Notes box.
In the Notes dialog box use the quick keyword
selector to add the keyword ’Heirloom’. Click
the plus sign next to the heading to see more
options and add the keywords ’Free Standing
Lace’ and ’Cutwork Richelieu’ from the list.
Then click OK.
Click Life View
to view the finished design.
Click Cancel.
Click Save
and browse to
Documents\mySewnet\My Designs.
Set the file name to 'Fleur de Lys' and click
Save.
Click Export
, and set the file format to .vp4,
then click OK.
The preferred file format for saving embroideries
is .vp4 format as this will preserve the separate
parts of multipart designs. It also preserves
thread color information and notes.
In the Save As dialog box, browse to Documents\mySewnet\My Designs and export the embroidery
as Fleur de Lys_Exported.
Click Print
to print the embroidery worksheet.
For free-standing lace, embroider your design on heavy-weight water-soluble stabilizer. When finished,
rinse the embroidery in lukewarm water to remove the stabilizer. Let dry and press the lace flat.
Alternatively, embroider the design with cutwork for the fleur de lys feathers. Hoop up with linen fabric and
water-soluble stabilizer underneath. When you embroider the design, trim out the cutwork areas.

Draw a Flower using Bezier Curves
1
2
3
4
5
6
7
8
9
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Open mySewnet™ Digitizing and in the Choose Design Type page of the ExpressDesign Wizard, select
Load or Create a Background Picture. Click Next.
In the Choose Picture Window, click Load a Picture
, browse to the folder
Documents\mySewnet\Samples\Digitizing\Pics, and load the file 'Motif Flower.png’. Click Next.
In the Rotate and Crop Picture page, click Select All, then click Next.
In the Design Size page, select Enter Design Size, click Change Hoop, and set the hoop to Universal,
100mm x 100mm - Universal Square Hoop 1. click Next.
In the Reduce Colors page, click Finish.
Click the View tab, and ensure that Grid size is set to 10mm.
In the FilmStrip, right-click the color block and select Properties from the Context menu.
in the Color Selection dialog box, click the pink in the Quick Colors (the second color in the bottom
row) and then click OK.
Click the Point Create tab.
Ensure that Fill and Appliqué are not selected (not highlighted).
Set the Line Type to Satin Line
.
Click Fill Area and Line
to open the properties dialog box.
Set the Line width to 1.5mm, then click OK.
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Click Bezier Mode
to select (highlight) it.
Click Create Area or Line
to select it. The Bezier Mode
pointer appears
.
See “Draw a Circle in Bezier Mode” on page 150 for the
essentials of drawing Bezier lines.
At the left side of the base of the petal at the top, click and
drag up and slightly to the left, then release the mouse
button.
Starting where the petal to the left meets the petal you are
drawing, click and drag upwards a short distance to where
the next set of grid lines cross.
Click (without dragging) to place a point at the tip of the
petal. This is a Corner point.
Move the pointer over the second square white point. The
pointer changes to the Move pointer
.
Drag the point a short distance up and to the left, along the
outline of the petal until the curved line underneath fits the
outline of the drawing.
Click and drag downwards a short distance from the mid
point of the right side of the petal.
Click to place a single point where the the line touches the
next petal.
As you become more skilled, try clicking and dragging to place
a curved line using a single point at the base of the petal.
Right-click to place the line.
The curve of the line will probably need some adjustment, but
this is better done later, after you have placed lines for the other
petals.
At the left side of the base of the petal to the right of the one
that you just drew, click and drag upwards a short distance,
then release the mouse button.
Starting where the petal to the left meets the petal you are
drawing, click and drag diagonally towards the top right
corner of the hoop.
Release the mouse button when you reach the grid line
above.
Click (without dragging) to place a point at the tip of the
petal.
From the mid point of the right side of the petal, click and
drag diagonally towards the bottom left corner of the hoop.
Click to place a single point where the the line touches the
next petal.
Use the Move pointer to adjust the position of the white
squares so that the curved line fits the picture behind.
You can further adjust the Bezier line using the black handles.
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Right-click to place the line.
Starting at the bottom left of the third petal, click and drag a
short distance diagonally to the right to place the first point.
Where the outline of the petal meets the grid, click and drag
a horizontal line a short distance to the right to place the
next part of the curve.
Click to place a point at the tip of the petal.
Mid way down the other side of the petal, click and drag to
the left and slightly down to place the next point.
At the base of the petal, click to place a final point, then
right-click to place the line.
Place Bezier curve lines to draw the other petals, finishing at
the petal to the left of where you started.
If you move the black handle to the left or right as you draw,
you can place the curve to follow the outline, often with no
need for later editing.
In the ribbon bar, click Add Color Change
.
Click the yellow at the bottom right corner of the Quick Colors, then click OK to select the yellow
thread.
Set the Fill Type to Pattern Fill
(it will be highlighted).
Starting at the top of the center of the flower, click and drag a short distance to the right, then release
the mouse button.

Click and drag vertical and horizontal lines of similar lengths to place the other three points creating
the circle.
Right-click to place the center of the flower.
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Click the Home tab, then click Edit Points
seen.
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In the FilmStrip, click on each petal in turn, and make a note of the ones you will need to adjust.
Click the View tab.
Click Object View
, to see the outline of the Bezier lines clearly.
Drag the Background slider to fade the background so that the Bezier lines can be seen over the
original picture.
Adjust the handles on the points to make the Bezier line follow the
background.
If the handles from two different points overlap, move both nearer to
their own point, to smooth the curve.
Switch between Object View
and 3D View
to check the effect
of your changes on the Satin Line.
For more information on editing, see “Edit a Bezier Line” on page 151.
When you have made your changes on one petal, select the next
petal in the FilmStrip and adjust that one.
If you find that one of corner points actually has very short handles,
either use Convert to Corner
in the Home tab to change it to a corner,
or drag the handles sufficiently close to their point that they vanish.
Save your flower. You can adjust it further when you open the file again.

49

50
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52

. The points you drew for the center of the flower can be

Editing Fills and Lines
Edit a fill or line in the Fill Area and Line properties dialog.

Edit a Line or Fill
■

Select the desired fill area or line, and right-click it. The Fill Area and Line properties dialog
appears.
See “Fill Area and Line Properties” on page 35.

Alternatively, to change the properties of selected fills or lines at one time, do as follows:
1
2

In the FilmStrip, hold the Ctrl key and click each of the fills or lines to be changed.
Right-click one of the selected areas and select Properties. The Fill Area and Line dialog box will
appear. All settings in the Fill Area and Line dialog box will be applied to your selected fills and lines
when you click OK.
You can also move the green start

, red end

and/or orange origin
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marker for selected fill areas.
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Creating Holes
Use the Hole functions QuickStitch™ Hole
create holes in existing fill areas.

, Freehand Hole

and Point Hole

to

QuickStitch™ Hole
See “QuickStitch™ Hole” on page 138.
Freehand Hole
See “Freehand Hole” on page 145.
Point Hole
See “Point Hole” on page 145.
Alternatively, use QuickStitch™ + AutoHole
“QuickStitch™ + AutoHole” on page 137.

to add holes automatically during fill creation. See

Fill Area with holes using Pattern Fill 111
from Hearts

Fill Area with holes using Motif Fill Pattern
6 from General Motifs 1

Fill Area with Satin border and holes using
Motif Fill Pattern 6 from General Motifs 1

Fill Area with Satin border and holes using
Pattern Fill 109 from Hearts

Create Holes in a Fill
1
2

Click the desired area to select it.
In the Fill Area of the Create tab, click the desired Hole function.

3
4

Choose from QuickStitch™ Hole
, Freehand Hole
and Point Hole
.
Cut the hole using the selected hole function.
Repeat to create more holes, as desired. Right-click to deselect, or simply select another Create tool.
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8

Appliqué
Add appliqué when creating an area or line, with the ability to choose your preferred
fabric or picture and an appliqué placement method.
Select Appliqué
when creating an area or line, choose an appliqué fabric or picture in
the Appliqué Selection dialog box, and choose a placement method in the Appliqué tab
of the Fill Area and Line options. See “Appliqué” on page 36.
Click Select Appliqué Fabric in the Appliqué drop-down menu to choose an appliqué
fabric in the Appliqué Selection dialog box. See “Appliqué Selection” on page 159.

Shortcuts
■

■

Quick Create Tab, Fill Area and Line; Freehand Create Tab, Fill Area and Line; Point Create
Tab, Fill Area and Line:
Keys: Alt, Q, A; Alt, R, A; Alt, P, A

Appliqué Selection
Use the Appliqué Selection dialog box to select a fabric or picture to use for appliqué. Click
OK to use the selected appliqué fabric.
Preview the appliqué fabric
Select a Quick Color & texture
Choose an appliqué type

Choose a system fabric
or add a new one

Print a sheet of appliqué fabric
Load an individual picture
for printed appliqué
Reuse a recent fabric

Appliqué Type
Choose an appliqué type (or simply select one of the recently used swatches). Select from:
■

Quick
Select a color and texture for your fabric. See “Quick Appliqué Options” on page 160.
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■

■

■

Fabric
Select a background fabric, or add a new background fabric from a picture. Set the angle
for the fabric. See “Fabric Options” on page 160.
Picture
Create in individual non-tiling appliqué from a picture. For instance, use a photo for a
printed appliqué memory piece. See “Picture Options” on page 161.
Cut-out
Create an appliqué placement line as a guide to where the fabric should be cut to form a
hole; for example, for reverse appliqué.

Quick Appliqué Options
The Quick Appliqué Options are available when Quick is selected in
Appliqué Type.

Select a color and texture for your fabric.

Color
Click the color sample to change the color in the Colors dialog
box. See “Colors Dialog Box” on page 176.

Quick Colors
Click one of the Quick Colors to select a color for the fabric. Use the drop-down menu to
choose a different Quick Colors theme, or to create your own theme. See “Quick Color
Themes” on page 174.

Texture
Select the texture to use for the fabric. Click on the down arrow and choose the desired
fabric type.

Fabric Options
The Fabric Options are available when Fabric is selected in
Appliqué Type.

Load Previously Saved Fabric
Use Load Previously Saved Fabric
to load a sample fabric, or a fabric from My Fabrics,
in the Picture Viewer. See “Background Picture Viewer” on page 161.

Add New Background Fabric
Use Add New Background Fabric
to create a new fabric background in the
Background Wizard. See “Background Wizard” on page 162.

Angle
Use Angle to change the angle at which the pattern will be displayed.
You may also change the angle and position of the fabric pattern directly by selecting the appliqué piece in
the work area.

Enter an Angle from 0 to 359 degrees. The initial setting is 0. Alter the Angle by entering a
number in the box, or use the up and down arrows to change the number. Changes in
Angle are visible in the preview pane.
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Print Sheet
Print a sheet of appliqué fabric from the selected Quick Appliqué or Fabric pattern. Flip the
picture for an iron-on transfer, and select a printer and paper size in the Print Setup dialog
box. See “Print Setup” on page 327.

Picture Options
The Picture Options are available when Picture is selected in Appliqué Type.

Click Select Picture to create a picture background in the Load Picture Wizard. See “Load
Picture Wizard” on page 168.

Fabric Preview
The chosen fabric is previewed on the right.

Recent Swatches
Select a recently used fabric to use again.
■

Keys: Alt, Q, A, F; Alt, R, A, F; Alt, P, A, F

Background Picture Viewer
Use the Picture Viewer to select a fabric from the system fabrics, or from the My Fabrics
folder with fabric backgrounds you have added.

Choose a fabric folder
Scroll to view more folders
Click to select a fabric
Scroll to view more fabrics
Load the selected fabric
Change the icon size

To open the Picture Viewer, in the Appliqué Selection dialog box select Fabric, then click Load Previously
Saved Fabric

.

Open a folder, and scroll down and click a fabric to select it. Click OK to load the fabric in
the Appliqué Selection dialog box.
To create a new fabric in the Background Wizard, in the Appliqué Selection dialog box select Fabric, then
click Add New Background Fabric

. See “Background Wizard” on page 162.
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Background Wizard
Use the Background Wizard to create a new appliqué fabric from a picture.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new
appliqué fabric.
Select a picture file on
your computer
Paste a copied picture
Import a file from a scanner
or camera
Create or edit a picture in
mySewnet Draw & Paint
The picture is previewed

From Scanner or Camera will not be available if you do not have a WIA compliant scanner or digital
camera attached to your computer.

Load a Picture
Click Load a Picture
to open a picture from clipart, or one you have previously saved,
scanned or created in an image editor. Click to select a picture, then click OK to continue.
Hover the pointer over a picture to see a tooltip showing its name. The name may also be displayed below
the picture, depending on the chosen icon size.

Choose a picture folder
Click to select a picture

Scroll to view more pictures
Scroll to view more folders
Load the selected picture
Change the icon size

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format
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uncompressed (.tiff, .tif ), Windows Meta File (.wmf ), Windows Enhanced Meta File (.emf )
and Windows Icon (.ico).

Load a Picture for a Background
1
2
3
4
5
6

Click Load a Picture
and the Picture Viewer dialog box appears.
Double-click to expand the folders until the desired folder is highlighted.
If desired, change the icon size to see more or fewer pictures.
Click on a picture to select it.
Click OK to open the picture in the Choose Picture page, with its name underneath.
Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture

to load the picture in the Clipboard Block.

Paste Picture is not available if the Clipboard block is empty.

From Scanner or Camera
Use From Scanner or Camera
to display the program that is used to acquire pictures
from a scanner, a digital camera or another suitable device. Only devices that use Windows
Image Acquisition (WIA) can be used to obtain pictures.
WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s
scanning or downloading program to another program, in this case the mySewnet™ Digitizing module of
the mySewnet™ Embroidery Software. If the manufacturer provides the appropriate software components
needed for WIA compliance, these should have been installed when the device was installed.

Each scanner or digital camera has its own program that is used to scan or download
pictures. Refer to the manual or online help provided with the program for instructions, if
required. When the device and its software finish processing the Picture, it will be shown
in the Choose Picture page.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned
image then the box will contain the words Scanned Picture.

mySewnet™ Digitizing Appliqué and Colors

163

Rotate and Crop Picture
Use the Rotate and Crop Picture page to select the section of the picture that is to be used
to create the background, and rotate the picture. If required, adjust the crop lines to select
the desired part of the picture.
■

■

■

To adjust the crop area, position the mouse over the crop boundary until a double-headed
arrow
appears, then click and drag to move the boundary line.
To move the crop area, position the mouse inside the crop boundary until a four-headed
arrow
appears, then click and drag to move the whole rectangle.
To redraw the crop area, click and drag outside the crop boundary to draw a new
rectangle, which can then be adjusted as required.
Initially, about half the area of the picture is selected from the middle of the picture, as
shown by the dashed box in the picture on the left. The preview on the right shows four
copies of the selected fabric area tiled together.
Show divider lines for tiled area
Zoom in and out

Drag crop lines to select area
Drag inside area to move it
Click outside area to redraw it
Select the whole picture
Change the angle of the picture
Use the default crop settings
Correct the perspective in the picture

Save the picture

The tiled preview will change dynamically as you change the crop area.
To see where the four sections of the background are joined,
select the Show Divider option. Dashed lines show where
the tiled sections will be joined. This is useful for patterned
fabric, to ensure the pattern repeats as desired.
When the desired area is selected, click Next.

Rotate
Rotate
the picture from 0 to 359 degrees. Adjust the
picture angle as desired. This is often necessary with
scanned pictures.
Enter the desired Rotation angle
preview will show the effect.
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or use the up/down arrows to change the angle. The
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When the picture is rotated between the 90 degree steps, the picture is made larger and
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective
Correction . When using Perspective Correction, the crop handles are red.

Drag the red handles
to select an area

Enable perspective correction
Adjust the proportions of the picture

Save the edited picture

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view
the outline of the picture more clearly. Drag the Stretch Picture
slider to make the
picture in the Preview wider or narrower. Use Save Picture
to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.
The fabric preview on the right is not affected by zoom.

Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

mySewnet™ Digitizing Appliqué and Colors

165

Set Size
Use Set Size to enter a real measurement of the fabric so that it will be displayed at real
size when it is used as the appliqué fabric.

Input the length of the line
Drag the arrows to place the line

The cropped section of fabric is shown in the preview. Click and drag the arrows at either
end of the yellow line to place a line across the picture. This should match a measurement
you have made across the same area of the real fabric.
Then enter the length of the line in the ’Length of displayed line’ text box, or use the up/
down arrows.
The length can be from 1mm to 300mm. However, the fabric tile must not be larger than
300mm x 300mm, so if the line does not span the whole picture it must be shorter than
300mm.
If the length would make the fabric tile larger than 300mm in either dimension, a message will appear.
Repeat the process so that the tile is smaller.

Click OK and the measurement you entered will be shown next to the picture. Check that
the line and the length matches the measurement you made of the real fabric. If desired,
click and drag the arrows to place a new line and re-enter the line length.
When the line is measured correctly, click Next.
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Set Background Name
Use Set Background Name to save the finished appliqué fabric in a category and give it a
name. The categories are the folder names you will see when browsing for existing
backgrounds.

Enter a background name
Select an existing category

Create a new category

Background Name
If you started with an existing picture, the picture name will be shown by default as the
name for the new background. If you scanned a new picture, it will not have a name so
you will need to enter a name.

Fabric Category
The default category is My Fabrics. To choose a different category, browse among the
folders in Fabrics.
Select from existing categories, or click Make New Category to provide the name of a new
category.

Make New Category
To make a new category, click Make New Category, and enter a new folder name. Click OK
to create the category.
The new category will be created as a subfolder for the currently selected type.

When make a new category, it will be available as a Fabric Category next time you use the
Background Wizard.

Finish
Click Finish to save the new background with the specified name in the specified Fabric
Category and close the Background Wizard. The selected or new background will be
displayed in the work area.
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Load Picture Wizard
Use the Load Picture Wizard to use a picture as an individual non-tiled appliqué
background, for example for a printed appliqué memory piece.

Choose Picture

Use the Choose Picture page to select the picture you wish to use as a background.

Load a Picture
Click Load a Picture
to open a picture from your My Pictures folder. Alternatively,
browse to a folder elsewhere on your computer.
Hover the pointer over a picture to see a tooltip showing its name. The name may also be displayed below
the picture, depending on the chosen icon size.
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The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged
Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf ), Windows Enhanced
Meta File (.emf ) and Windows Icon (.ico).

Load a Picture with the Viewer
1
2
3
4
5
6

Click Load a Picture
and the Picture Viewer dialog box appears.
Double-click to expand the folders until the desired folder is highlighted.
If desired, change the icon size to see more or fewer pictures.
Click on a picture to select it.
Click OK to open the picture with its name underneath.
Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture
the preview area.

to load the picture in the Clipboard Block. The picture is shown in

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera
to display the program that is used to acquire pictures
from a scanner, a digital camera or another suitable device. Only devices that use Windows
Image Acquisition (WIA) can be used to obtain pictures.
WIA is a standard method for transferring pictures from the device’s scanning or downloading program to
another program. If the manufacturer provides the appropriate software components needed for WIA
compliance, these should have been installed when the device was installed.

Each scanner or digital camera has its own program that is used to scan or download
pictures. Refer to the manual or online help provided with the program for instructions, if
required. When the device and its software finish processing the picture, it will be shown
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture

or edit an existing picture

in mySewnet™ Draw & Paint.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned
image then the box will contain the words Scanned Picture.

Next
Go to the Rotate and Crop Picture page.
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Rotate and Crop Picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used
to create the appliqué background. If required, rotate the picture, and click and drag the
boundary line of the crop area to select the desired part of the picture.
Click and drag anywhere inside the crop box to move the crop box.
If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop
it expanding.

When the desired area is selected, click Finish.

Rotate
Rotate
the picture from 0 to 359 degrees. Adjust the picture angle as desired. This is
often necessary with scanned pictures.
Enter the desired Rotation angle
preview will show the effect.

or use the up/down arrows to change the angle. The

When the picture is rotated between the 90 degree steps, the picture is made larger and
white background is added.

Crop
Select the section of the picture that is to be used to create the appliqué background. If
required, rotate the picture, and click and drag the handles on the boundary line of the
crop area to select the desired part of the picture.
Click and drag anywhere inside the crop box to move the crop box.
If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop
it expanding.

When the desired area is selected, click Finish.
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Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective
Correction . When using Perspective Correction, the crop handles are red.
Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view
the outline of the picture more clearly. Drag the Stretch Picture
slider to make the
picture in the Preview wider or narrower. Use Save Picture
to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.
Use Zoom In
to magnify the view. Move the pointer over the picture and the pointer
changes to the zoom in pointer . Then either click a point you want to zoom in towards,
or click and drag a rectangle around the area you want to zoom in to and release the
mouse button to zoom. When zoomed in, use the scroll bars to move around.
Use Zoom Out
to shrink the view. Move the pointer over the picture and the pointer
changes to the zoom out pointer
. Then click a point you want to zoom out from.
Click Zoom To Fit

to fit the picture to the preview area.

Click Real Size
to view the picture at its real size in pixels. This means that one pixel of
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Finish
Use the selected image for the appliqué.
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Appliqué Method
Use the Appliqué tab of the Fill Area and Line properties dialog box to select an Appliqué
Method for appliqué placement, and set the Appliqué Piece Margin. See “Fill Area and Line
Properties” on page 35.

Appliqué Placement
When appliqué is created, additional
stitches are added at the beginning
of the appliqué piece for placing the
appliqué fabric. Use these options to
determine how these stitches are
added. The border used to finish the
appliqué is the chosen line type in
the Line tab of the Fill Area and Line
properties dialog box.

Appliqué Method
Select the appliqué method before or after creating an area or line. Choose from:
•
•
•
•
•

None
Standard Appliqué
Pre-cut Piece
Pre-placed Piece
Cut-out

Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the
fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork
needles.
Stitch a running line to show where the pre-cut appliqué piece should be placed, then
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch,
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.
Place the appliqué layer in position, then stitch down the appliqué fabric with double
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border
stitching.

Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example
for reverse appliqué.
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Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the
stitched outline. Finish the edges with the selected border stitching.

Select Fabric
Use Select Fabric to choose a fabric for your appliqué in the Appliqué Selection dialog box.
Click Select Fabric and the Appliqué Selection dialog box appears. See “Appliqué
Selection” on page 159.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to
10mm. The initial value is 1.0mm.
Use a positive value when trimming the appliqué fabric before the border is stitched, for example with
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin
has been applied.
This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated
cutter, to ensure the placement line is visible.

Export Appliqué
Use Export Appliqué Pieces
for cutting.

in the File menu to save or print appliqué outlines ready

There are five export methods: save as SVG, DXF or FCM files for use in fabric cutters, save
as VP4 or VP3 stitch files for use with Inspira Cutting Needles, print as an outline template
to cut around, print directly onto printable fabric or an iron-on transfer (this prints the
image of the appliqué piece), or save as SVG files with the fabric image placed as the fill for
each shape (for use with fully customized layouts).
See “Export Appliqué Pieces” on page 123 for more information.
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Quick Color Themes
Use Quick Color Themes for quick selection of thread colors using a related set of colors.
Create your own Quick Color Themes, which are available for selecting thread colors in
mySewnet™ Digitizing, and in the Color Selection dialog box in other modules. Also use
Quick Color Themes to set fabric colors in the Appliqué Selection dialog box.

Select a Theme
Create a new custom Theme

Delete a custom Theme

Give your Theme a name

Choose a color block to edit
Copy a color to the sample box
Paste the sample box color

Edit the selected color
Apply your changes
Color sample box

Replace all colors with the
sample box color

Select a Quick Color
1
2
3

Open a dialog box with the Quick Colors area.
Click the drop-down menu below, or to the right of the Quick Colors to choose a Quick Color Theme.
In this menu you can also select Edit Themes to create a new theme, or edit a Custom theme.
Click the desired Quick Color. The nearest shade that is available from the current thread range will be
selected.
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard
Theme to jump to light yellow thread shades).

Add a Quick Color Theme
You can add or customize your own Quick Colors themes in the Color Selection or
Appliqué Selection dialog box in most mySewnet™ Embroidery Software modules.
1
2

3
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Open a dialog box with the Quick Colors area such as the Color Selection dialog box.
Click the drop-down menu to the right of the Quick Colors and select Edit Themes. The Edit Quick
Color Themes dialog box opens.
Note that if one of the system Themes is selected, the editing options will be unavailable (grayed out).
Select a Theme from the drop-down menu at the top.
Your new Theme will be based on the colors in this theme.
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4
5

6
7
8
9
10
11
12
13

Click the Add New button. A new theme ’Untitled’ appears.
Give your new theme a name, then click Apply.
You can now select your new theme from the drop-down list at
the top.
Select a color in the palette.
Click the Edit Color button. The Colors dialog box appears. See
“Colors Dialog Box” on page 176.
Choose a new color from the Standard or Custom tab, then click
OK. Your chosen color will replace the original color.
To copy a color, select a color in the palette, then click Copy
Color. Your selected color will appear in the Color Box.
To paste the color in the Color Box, select a color in the palette,
then click Paste Color. The color in the palette will be replaced.
To replace all colors in the palette, click Paste To All.
Click Apply to save the changes to your new Quick Color
Theme.
Click Close to finish editing your new Theme.
To make further edits to your theme, select Edit Themes in the Quick Colors Theme menu.

Edit Quick Color Themes
Theme
Select a Theme from the drop-down list.
Any new Theme will be based on the colors in this theme.

Add New
Click Add New to create a new theme.

Delete Theme
Click Delete Theme to remove a custom Theme.
You cannot delete system Themes.

Name
Enter the desired theme name.

Theme Colors
Click a color in the grid and a box will appear around the selected
color.

Edit Color
Click Edit Color to change the currently selected color in the Colors
Dialog Box. Alternatively, double-click a color to change it in the Colors Dialog Box.

Apply
Click Apply to save the changes you have made.

Copy Color
Click Copy Color to place the color in the color sample box, to the right of the button.
Use the color sample box to copy a color from one theme to another.
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Paste Color
Click Paste Color to replace the color in the currently selected grid position with the color
in the sample box.

Paste To All
Click Paste To All to place the color in the sample box in all the grid positions. This is useful
when starting a new Theme if you wish to vary the Theme around a single initial color.

Close
Click Close to finish editing the new theme. The new them is added to the end of the
Theme list.
You will be asked if you want to save any changes you have made, if you have not clicked Apply.

Change a Quick Color Theme
Select an existing Quick Color Theme you wish to change from the Theme drop-down list,
then click Edit Theme.
The predefined Quick Color Themes may not be edited. However, you may use any predefined theme as the
basis for a new theme.

The options are the same as when you Add a Quick Color Theme. See “Edit Quick Color
Themes” on page 175.

Delete a Quick Color Theme
1
2
3

In the Edit Quick Color Themes dialog box, use the Theme drop-down list to select the Theme you
wish to remove.
Click Delete Theme. A message will appear to remind you that this action may not be reversed.
Click Yes and the theme will be deleted.
The predefined Quick Color Themes may not be deleted.

Colors Dialog Box
The Colors dialog box is used to choose or change
a color for a thread, or modify any color in a Quick
Colors Custom theme.
When the Colors dialog box appears, it shows the
Standard color selection. If desired, click one of
the Standard colors. A highlight shows the
selected color. The New/Current box shows the
difference between the newly chosen color and
the color currently used.
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Click the Custom tab to be able to select any of
the 16 million RGB colors.
Click in the blended color palette to choose a
basic color, then use the slider at the side to
choose the desired brightness level. The HSL and
RGB values are updated as you change the color
and the color is previewed in the New/Current
box.
You can also directly enter Hue, Sat(uration),
Lum(inance) (HSL) and/or Red, Green, Blue (RGB)
values. Alternatively, use the up/down buttons on
each of the HSL and RGB value boxes to make fine
adjustments to the color.

Color Models
Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue.
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color.
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has
three primary colors — red, green, and blue — that it creates by emitting light. These
three colors are combined in various proportions to produce all the colors displayed on
your screen. They are referred to as additive because they combine to produce white.
Primary colors are measured as a value from 0-255. The colors produced by combining the
three primaries are a result of the amount of each of those shades present. For example,
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to
zero, the color is black; if all three are 255, they produce white.
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177

9

Using Commands

Commands are instructions such as the Color Change
(marker
) that changes the
thread at the start of a new color block. The Stop
(marker
) tells an embroidery
machine to stop without a color change. Use Alignment Stitches (marker
) to add
stitches at the beginning of an embroidery to align the embroidery, for example to a
background picture.

Color Change and Pick Color
Use Color Change
, Add Color Change
, Pick Color , or the Quick Colors palette
to select a new thread color for the stitch objects you are about to add to the design. The
first Color Change is initially set to medium blue. A Color Change command is shown by a
small blue circle with a C
.
To change an existing color, double-click the desired color in the color worksheet on the
Design Panel, or select the color in the worksheet and click Color change
.
Alternatively, right-click the color in the FilmStrip and select Properties. The Color
Selection dialog box opens.
To delete a color change, select the Color Change in the FilmStrip or on the work area,
then click the Delete icon
, use the Delete key, or right-click in the FilmStrip and select
Delete. The first Color Change in a design may not be deleted.
To insert a color, select the object after which the color change is desired, and click Add
Color Change , click in the Quick Colors, or right-click in the FilmStrip and select Insert
Color Change from the context menu. Alternatively, click one of the Quick Colors to select
a new color.
Select a color from the Color Selection box that appears. You may choose any thread
shade from the available thread manufacturers' palettes (for instance, Sulky Rayon 40 or
Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select colors by
visual selection or by typing in a shade number. Alternatively you can choose a ’Quick
Color’ Theme and then select one of the 32 Quick Colors. See “Quick Color Themes” on
page 174. Optionally, add a thread or needle effect to the selected thread. Once the
desired color is selected, click OK.

Shortcuts
■

Quick Create Tab; Freehand Create Tab; Point Create Tab, Command:

■

Tab:
Keys: Alt, Q, C, C; Alt, Q, C, P; Alt, R, C, C; Alt, R, C, P; Alt, P, C, C; Alt, P, C, P; Right-click
FilmStrip, H

&

; Edit

Color Selection
The Color Selection dialog box appears when you click Add Color Change , right-click a
color change marker , or right-click an object in the FilmStrip and select Insert Color

178

mySewnet™ Digitizing Using Commands

Change. Alternatively, on the Design Panel select a color in the worksheet and click Color
Change
, or double-click a color in the color worksheet.
Open Thread Cache
Show chosen thread ranges

Puffy Foam height

Select a thread range
Search for a thread number
Choose a Quick Color Theme

Twin needle gap
& second color

Click a Quick Color to select
a matching thread color

Second thread
color
Wing needle

Click a thread color
to select a thread

Felting needle

View the thread information

Cutwork needle
angle

You may choose any thread shade from the available thread manufacturers' palettes (for
instance, Robison-Anton Rayon 40 or Sulky Cotton 30) or a thread you have added to
MyThreads. Select colors by visual selection or by typing in a shade number. Alternatively,
click one of the Quick Colors to select the nearest matching thread color. Once the desired
color is selected, click OK. See “Color Selection” on page 89.
When you select a new thread color, the color worksheet will show the change and the
work area will show the block of stitches in the new color.
To keep the full color information including thread shade numbers, export your
embroideries as file type .vp4.
Use the Manage button to open mySewnet™ Thread Cache to manage your threads.

Design Property Colors
Use Design Property Colors
to show or hide thread colors in the Color Select area that
are part of an object’s property, for example an alternative border color or color gradients.

Color Change Properties
The Color Change command is shown by a small blue circle with a C

.

To delete an existing color, select it in the FilmStrip, or click a nearby object and use the
left and right arrow keys to move to the Color Change, then click Delete. To change a color,
click the color block in the color worksheet on the Design Panel, or right-click the color
change in the FilmStrip and select Properties.
For full details, see “Color Change and Pick Color” on page 178.
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Stop
Use Stop
to create a Stop command that is used to tell the embroidery machine to
stop without a color change, and use the Stop properties dialog box to add a message to
the Stop command. The Stop command is shown by a small red circle with an S
.
A common use for the Stop command is to pause the machine while a piece of appliqué fabric is placed in
the hoop, then again after it is tacked down with running or double stitch so the excess material can be
trimmed before satin borders are used to cover the edge of the fabric.

To delete a Stop, select the Stop command, then click the Delete icon
key or right-click in the FilmStrip and select Delete.

, use the Delete

To select a Stop, click near it and use the left and right arrow keys to select it, or select it directly in the
FilmStrip. It will be highlighted in the FilmStrip.
To view Stop commands with their messages, use the Design Player, or view them in the printed worksheet.

Shortcuts
■
■

Freehand Create Tab; Point Create Tab, Command:
Keys: Alt, R, P; Alt, P, P; Right-click FilmStrip, O

Insert a Stop Command
1
2
3
4

5
6

Open a design, then click the Freehand Create or Point Create tab.
Move to the position in the FilmStrip where you want to place the
Stop command.
Click Stop
. A Stop command is inserted at the selected
position. It is shown by a small red circle with an S
.
Right-click on the Stop command in the work area, and the Stop
properties dialog box opens.
Alternatively, right-click the Stop command in the FilmStrip and
select Properties.
Use the Quick Text drop-down menu to insert a stitchout hint, or
enter a message. See “Stop Properties” on page 180.
Click OK to save the text.

Stop Properties
Add a stitchout hint to a Stop Command in the Stop
properties dialog box.
Select a Quick Text comment from the drop-down menu, or
enter text in the Comment text field. Click OK to save the
text. Up to 200 characters may be entered.
To view Stop commands with their messages, use the Design Player, or
view them in the printed worksheet.

Quick Text
Select one of the following texts:
■
■
■
■
■
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Place the appliqué fabric now
Cut around the appliqué
Place the appliqué shape onto the placement line
Cut the hole in your fabric
Place the puffy foam on the fabric now
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■
■

Remove any excess puffy foam
Check alignment now.

Single Stitch
Use Single Stitch
to create a Single Stitch or series of Single Stitches, according to the
length set in Preferences or the properties box. The length may vary. A Single Stitch may
be broken up into stitches from 1mm to 12mm in 1mm steps.
Typically it would be set to a relatively long length of around 10mm in order to produce an effect from a
long stitch.

Single stitches are represented by a line in the currently selected color. Depending on the
default Stitch Length set in Preferences , more than one stitch may be generated
between two points when a stitch is placed.
Single Stitches are useful as short traveling stitches, and to achieve various hand stitching effects.

Shortcuts
■
■

Freehand Create Tab; Point Create Tab, Command:
Keys: Alt, R, N; Alt, P, N

Single Stitch Properties
Set the Length of single stitches from 1 to 12mm in steps
of 1mm. The initial setting is shown in Creating Stitches
Preferences
.

Break up into smaller stitches
Break up stitches longer than the selected length into
stitches of this length.

Alignment Stitches
Use Alignment Stitches to add stitches at the beginning of an
embroidery that you can use to align the embroidery, for
example with a background picture on fabric.
An Alignment Stitch is shown by a small purple circle. In Object View, an
A

can be seen.

Five types of alignment stitch are available: Cross, Top Left
Corner, Top Right Corner, Bottom Left Corner and Bottom Right
Corner. When first placed, a Cross is used.

Alignment Stitch
Use Alignment Stitch
stitch.

to insert a cross-shaped alignment

Click to place alignment stitches, which are shown as crosses in the current color. Each
cross is 10mm wide. Two or three alignment crosses should be sufficient in most
circumstances.
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Use the Alignment Stitches dialog to select a corner alignment stitch. These alignment
stitches are corner shaped, so they can be used even if your design goes up to the edge of
the chosen hoop. Choose from: Top Left Corner
, Top Right Corner , Bottom Left
Corner , Bottom Right Corner
or Point
.

Shortcuts
■

Freehand Create Tab; Point Create Tab, Command:
Keys: Alt, R, G; Alt, P, G

1
2

In the Freehand Create, or Point Create, tab select Alignment Stitch
.
Click the point on the picture where you want to add an alignment stitch.

3
4

A cross-shaped stitch and a pink marker, or an Alignment Stitch marker
in Object View, are added at
the point where you click.
Click Undo
to remove any unwanted alignment stitches.
To open the Alignment Stitches dialog, select an alignment stitch in the FilmStrip, right-click it and
select Properties, or select and right-click an alignment stitch in the work area. Here you can select
another alignment stitch type.
Click OK to close the dialog.

■

Place an Alignment Stitch

5
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Using Fill Areas

Fill Areas are areas of fill surrounded by a border. The fill can be any of the fill types, or ’No
Fill’. The border can be any of the line types, or ’No Line’.

Pattern Fill Area with Pattern 39
from Animals 1

Pattern Fill Area with Multicolor Motif Fill Area with two motifs,
Gradient
13 and 19, from Hand Stitches 2

Motif Fill Area with motif 6 from
General Motifs 1, QuickStitch
Autohole and a 1.5mm Satin
Border

Shape Fill Area using Shape 66 MultiWave Fill, using a density
of 15, and a short Freehand
and Motif 1 from Hand
MultiWave Line to add texture
Stitches 1

You can change any fill type into another fill type, or into a Satin Area.

Fill Types
Select the Fill type from the drop-down list in the Quick Create, Freehand Create or Point
Create tabs, or in the Fill Area and Line properties dialog:
Pattern Fill

QuiltStipple Fill

MultiWave Fill

Motif Fill

Contour Fill

Echo Fill

Shape Fill

Crosshatch Fill

Satin Area

Radial Fill

Curved Crosshatch Fill

No Fill

Spiral Fill
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Creating Fill Areas
Create Fill areas with the QuickStitch™, Freehand and Point Area or Line, or Shape
functions.
Set the Fill, Line and Appliqué buttons as desired by clicking to turn that area type on or off. Then choose a
fill type from the drop-down menu below the button, and set the properties in the Fill Area and Line
options. Use one of the Create functions to make the new fill area.
See “Creating with Quick Create” on page 130, “Creating with Freehand and Point Create” on page 131,
and “Creating Shapes” on page 133.

Either add holes at the time of fill creation using QuickStitch™ + AutoHole, or add holes to
an existing fill. See “Creating Holes” on page 158.
You can select your fill type, and the line type for the surrounding border, in one of the
Create tabs before creating the fill.
Alternatively, change either the fill or border type afterwards using Fill Area and Line properties. Use the
Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into the
current settings, to use as default for new areas of this type.

Pattern Fill
Pattern Fill areas use small stitches in repeating patterns that cover an area completely
using typical density values. The density and color can also be changed with single
gradient density and multigradient density.
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Pattern Fill Area with Pattern 3
from Standard 1

Pattern Fill Area with Single
Color Gradient Density

Pattern Fill Area with Multicolor
Gradient

Fill Area with Pattern 114 from Fill Area with Satin border and
holes using Pattern Fill 109
Hearts and a 4.0mm Satin
from Hearts
Border.

mySewnet™ Digitizing Using Fill Areas

Pattern Fill Area with Pattern 39
from Animals 1

The Fill Area and Line properties for Pattern Fill has sections for setting all the properties
on a pattern fill area. It appears when you click a pattern fill area so that the points
defining its shape are shown, and then right-click. It also appears when you click the Fill
Area and Line button in the Options section on one of the Create tabs.
Use the Pattern Fill properties dialog box to change the pattern, density and stitch angle
used for fill areas.
Alternatively, adjust the angle of the fill pattern with the handle on the Origin marker

.

Set the pattern Angle
Search for a Pattern
by number
Use a My Fills pattern

Choose Underlay
density

Choose a Category
and Pattern

Adjust the area’s size

Set Standard density

Use gradient density

Settings for Single &
Multicolor gradient

Pattern Fill — Pattern
Patterns
Use the Pattern area to select the desired
pattern category and number.
Select the desired pattern number. There are
several ways to select patterns:
• Click the drop-down arrow below the pattern
sample and scroll down to choose a pattern
Category, and a pattern. Click the desired
pattern sample and the Pattern number is
shown.
• Enter a favorite Pattern number directly in
the Pattern box. As you type the number, the
correct pattern sample is selected
immediately.
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• Use a My Fill pattern created with Manage My Fills. See “Manage My Fills” on page 232.
The pattern number can be seen in the FilmStrip.

View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 318.

Change a Fill Area to a Leaf Pattern
1

2
3
4

5
6
7

8

9

10

11

12
13
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79.
Click File, Preferences
and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and set the Grid size to 5mm.
In the color worksheet on the Design Panel, click the check box for the
fourth color (slate blue) to hide objects, mainly satin borders, using that
thread color. This will make it easier to select the fill areas.
When you pause the arrow pointer over a color in the worksheet, a popup
description of the thread appears.
Click the Home tab.
Ensure that Edit Points
is selected.
Click inside the left petal near the edge. The points defining the shape
of the fill area will appear. It will be shown as a Pattern Fill on the status bar and in the FilmStrip.
If the Status Bar says Box Select, this is selected instead of Edit Points
Right-click on the work area
and the Fill Area and Line
dialog box will appear showing
the properties for Pattern Fill.
The Fill Area and Line dialog box
enables you to change the fill
and line types in your design,
and set the properties for the
lines and fills.
Click the down arrow below
the fill sample in the Pattern
area.
The fill Category is currently set
to Standard 1. Scroll up the fill
gallery to the 'Plants & Flowers
1' Category.
Place the pointer over the
pattern sample in row two,
column two. The pattern
number is 164.
Patterns may also be selected
directly by entering the desired
pattern number in the Pattern
box.
Click to select pattern 164.
Check that Density is set to 2,
as desired.
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. Click Edit Points and look again.
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Change the angle to 45. Click Apply to see the new pattern
in the left petal, then click OK. The pattern has changed in
the petal, and you can see the fill number in the FilmStrip.
Even if you click Cancel, Apply has changed the stitches.
Therefore, to return to the original pattern you would need to
click Undo
.
You could also change the angle of the pattern with the handle
on the Origin marker
.
To change the middle petal to a single gradient fill, see “Create
a Single Color Gradient Fill in a Petal” on page 190.

Pattern Fill — Options
Use the Options area to see and change the settings for fill angle, underlay and
compensation.
Set the pattern Angle
Choose Underlay density

Set Compensation

Angle
The angle of the fill pattern, as shown by the arrow. The thread is at a
right angle to the fill pattern. Set the Angle from 0 to 359 degrees.
The initial setting is 0.
The fill angle will also affect the orientation of the gradient. You can also change
the fill angle with the handle on the Origin marker

.

Underlay
Choose from None, Low, Medium or High density underlay. Underlay is a low density fill
that is perpendicular to the stitches of the actual fill area. Underlay is useful for stabilizing
large fill areas. Underlay is initially set to Low.
Underlay stitches are not generated for areas using gradient density, although the property can be
selected in case you switch the area back to a standard density area.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set
Compensation from 0 to 20. The higher the number, the bolder the area appears. The
initial setting is 0.
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Pattern Fill — Density
Use the Density area to see and change the density settings and the color Gradient of the
fill.
The color on a fill area can change over a range, or have multiple color changes across the
fill. This is ideal for gradual color changes such as sunsets, subtle shadow effects and so on.
Gradient is not initially selected.
Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting.
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like
linen or satin.

Standard Density

Set the standard Density from 2 to 80. The lower the number, the
closer together the stitches and the more stitches are produced.
The initial setting is 2.

Single Color Gradient
Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker
Set the stitch density for
the chosen value marker

Use Single Color Gradient to change the density across a fill
with only one color. Set a value for the start and end density
markers for the fill, and the density gradually changes between
the two values. Add multiple markers for a more complex
pattern.
The markers can each take a value of 2 to 80, which means you can reverse
the gradient simply by swapping the start and end values.
If you change a gradient density fill back to standard, then you should also
select the desired underlay.

The example shows a Gradient of 2 to 15, with a fill angle of 90°.
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Delete the selected
marker

Use Density Gradient for loosely stitched areas so that the traveling stitches will go around the outside of
the fill area. Set the start and end densities to the same number. If the Density Gradient option was not
used the traveling stitches would cross the fill area and show through.

Use the adjustment marker above the gradient bar to change the gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a value marker below the gradient bar, and an adjustment marker
above the gradient bar. The initial value for the marker will be between the existing
markers. Edit the density value, and move the value and adjustment markers as desired.

This means that you can have any combination of density values across the fill area.
Remember, a higher value means the fill is less dense.

Density
Density is used to change the density of the stitching. Set Density from 2 to 80. The higher
the number, the less dense the fill. The initial start marker setting is 2, and end marker
setting is 8.

Remove
Click Remove to delete the highlighted marker.

Change a Fill to Single Color Gradient
1
2
3
4
5

Open the Fill Area and Line properties dialog.
In the Density area, click the Gradient option. The Gradient box will become available.
Select (check) the Single Color Gradient box.
Click a value maker (the marker below the gradient bar) and change the value in the Density box to
the required density value.
Click Apply to view your changes.
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6
7
8

Move the adjustment marker above the gradient bar to vary the change in density across the fill.
Click Add Marker to add another value marker and adjustment marker.
Change the density of the fill as desired.

9

Click OK to close the Fill Area and Line properties dialog.
If you change a gradient density fill back to standard, then you should also select the desired underlay.

1

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79, and added a leaf pattern to in “Change a Fill Area to a Leaf Pattern” on page 186.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
In the color worksheet in the Design Panel click the check box for the fourth color (slate blue) to hide
the satin borders using that thread color. This will make it easier to select the fill areas.
Click inside the middle petal. The points defining the shape of the fill area will appear, and the Pattern
Fill area will be selected in the FilmStrip.
Right-click on the work area and the Fill Area and Line
dialog box will appear, showing Pattern Fill.
Enter 109 in the Pattern Box. In the Pattern gallery, this
is the design in row 1, column 1 of the Hearts category.
Click Apply to see the pattern.
If needed, move the Fill Area and Line dialog box to one
side to see this.
Click the Gradient checkbox. The Gradient options
become available.
Ensure that Single Color Gradient is selected. A bar with
a marker at either end becomes available.
Click Add Marker. A third marker is placed in the middle
of the bar, highlighted in blue.
All three markers initially use the stitch density set above
(this should be 2).
Click the marker box on the left. It is highlighted in blue.
In Density, use the up arrow to change the number to
35. The number and position of the lines in the density
bar changes.
The lines in the density bar represent the density of the stitching.
Leave the Density for the middle marker at 2.
Click the marker box on the right.
Change the density for the marker on the right to 35.
This will create lightly stitched areas at the edges of the fill area, and a heavily stitched area in the middle.

Create a Single Color Gradient Fill in a Petal

2
3
4
5
6
7
8

9
10
11

12
13

14
15
16
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Change the Angle to 0, then click OK. The heart pattern fill is densely stitched in the center and lightly
stitched at top and bottom.

Notice that underlay has been automatically set to None. This occurs when Single Color Gradient or
Multicolor Gradient density is selected.
To fill the right petal with a bee pattern that you create, see “Use a Bee for a My Fill Pattern” on page 234.

Multicolor Gradient
Set the stitch density
for the whole fill
Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the
highlighted marker

Delete the selected
marker

Use Multicolor Gradient to change the color across a fill with
only one density. Set colors for the start and end markers for the
fill, and the color gradually changes between the two values.
Use the marker above the gradient bar to change the color
gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a color marker below the gradient bar, and an adjustment marker
above the gradient bar. The initial color for the marker will be the same as the currently
highlighted marker. Change the color and move the color and adjustment markers as
desired.
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This means that you can have any combination of colors across the fill area.

Thread Color
Use Thread Color
to change the color of the currently highlighted marker. The Color
Selection box will be displayed.
See “Color Selection” on page 178.

Remove
Click Remove to delete the highlighted marker.

Create a Multicolor Gradient Fill
1
2
3
4

5
6
7

8
9
10

Open the Fill Area and Line properties dialog.
In the Density area, click the Gradient option. The Gradient box will become available.
Select (check) the Multicolor Gradient box.
Click a color maker (the marker below the
gradient bar) and click Thread Color to open
the Color Selection dialog box.
Change the color to the required color and
click OK.
Click Apply to view your changes.
Move the adjustment marker above the
gradient bar to vary the change in color
across the fill.
Click Add Marker to add another color marker
and adjustment marker.
Change the color of the fill as desired.
Click OK to close the Fill Area and Line properties dialog.

Fill a Petal with a Multicolor Gradient Density Fill
1

2
3
4
5
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79.
Click File, Preferences
and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
In the color worksheet in the Design Panel, click the check box for the fourth color (slate blue) to hide
the satin borders using that thread color. This will make it easier to select the fill areas.
Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
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7
8
9
10

11
12
13
14

15

16
17

18
19

Enter 255 in the Pattern Box. In the Pattern gallery, this is the design in row 1, column 3 of the
Gradient & Lace category.
The top four patterns in this category are recommended for multicolor gradient (the other eight are
suitable for a weave pattern combined with parallel crosshatch, as used for lace designs).
Change the Angle to 0.
Ensure that the Gradient checkbox is
selected.
Click Add Marker to place a third marker in
the middle of the bar, highlighted in blue.
Click Multicolor Gradient. The gradient bar
is now colored, as are the markers.
The selected marker has a dark blue outline,
and the pointer is highlighted in blue.
Click the marker box on the left.
Click Thread Color
. The Color
Selection dialog box is displayed.
Ensure that Robison-Anton Rayon 40 is
displayed in Thread Range.
Click in the Find Thread box and enter
'2502'. Thread color 2502 (Memphis Belle)
will be found in the list. Click OK to change
the color.
Double-click the marker box in the middle.
The Color Selection dialog box opens.
This is a quick way of displaying the dialog.
In the Color Selection dialog box change the color to 2259 (Wild Pink), then click OK.
Double-click the marker box on the right and change the color to 2286 (Tulip).
The bar is now shaded from pale pink, to dark pink, to purple. The stitches for each color are calculated
from the original density value.

Click Apply. The design will show how the colors will be blended when stitched out.
If needed, move the Fill Area and Line dialog box to one side to see this.
Click OK to close the Fill Area and Line dialog box.
To fill the left petal with a Radial Fill with gradient density, see “Use a Radial Fill in a Petal” on page 206.
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Motif Fill
Motif fill areas
contain repeated small stitches placed using one of the Universal or
machine motif patterns. Motif patterns typically have spaces between the stitches. A motif
fill area can also have holes defined inside it. The motifs can be at any angle and at
different sizes, and different motifs can be used on alternating lines.

Motif Fill Area with default
motif 5 from General Motifs 1

Motif Fill Area with motif 6 from Motif Fill Area with two motifs,
General Motifs 1
13 and 19, from Hand Stitches 2

Motif Fill Area with motif 22 from Motif Fill Area with motif 6 from Motif Fill Area with motif 6 from
General Motifs 1, QuickStitch
General Motifs 1 and
Candlewicking 1 and a 2.0mm
Autohole and a 2.0mm Satin
QuickStitch Autohole
Satin Border
Border

Motif Fill Properties
The Fill Area and Line properties for Motif Fill has tabs for setting all the properties on a
motif fill area. It appears when you click a motif fill area so that the points defining its
shape are shown, and then right-click. It also appears when you click the Fill Area and Line
button in the Options section on one of the Create tabs.
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Motif Fill — Motif 1
The Motif 1 tab is always shown first when the Motif Fill properties appear.
Use the Motif 1 tab to select the first motif and its size.

Select a motif Group, Category and pattern
Select the motif size
Flip the motif vertically or horizontally
Preserve motif Height / Width ratio

Motif
Use Motif to select the motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some
motifs are symmetrical and will have no apparent change when they are reversed.
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Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Motif Fill — Motif 2
Use the Motif 2 tab to select a second optional motif and its size.

Use Motif 2
Select this option to use a second motif in the motif fill. The second motif will be placed on
alternating lines with the first motif.

Motif
Use Motif to select the motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.
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Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Motif Fill — Spacing
Use the Spacing tab to set the spacing for the motifs.

Space the motifs regularly
Set the distance between
motifs and lines of motifs
Set the relative position of
motifs and lines of motifs

Center Motifs 1 and 2
When this option is selected the narrower of the two motifs has extra stitches added at
either side to make it the same width as the wider motif. This is so that the motifs can be
centered, or so the horizontal offset between them will remain constant.

Gap
The Horizontal gap adds or removes space between motifs along the line. The Vertical gap
adds or removes space between lines of motifs.
Set the Horizontal and Vertical gaps from -50% to +100%.

Offset
The Horizontal offset moves the motifs along each line, relative to the previous line. The
Vertical offset adjusts the position of every other line of motifs, so that it is nearer to one
line than the next or previous line.
Set the Horizontal and Vertical gaps from -50% to 50%.
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The offset is limited to 50% each way because, for instance, a 75% offset would be the same as a -25%
offset.

Motif Fill — Options
Use the Options tab to see and change the settings for fill angle, stitch type and length.

Adjust the motif angle

Select a line type
Set the stitch length

Angle
The angle of the motif fill pattern, as shown by the arrow. Set the Angle from 0 to 359
degrees.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of
stitches from 1 to 12mm in steps of 0.1mm.

Use Motif Fills in Two Petals
1

2
3
4
5
6
7
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select Motif Fill
. The Motif 1 tab of the motif fill
properties is displayed.
Set the Group to Universal and the Category to Candlewicking 1. Pattern 1 is selected automatically,
which is the desired Pattern.
Click the Spacing tab.
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Set the Horizontal Offset to 50%.

9
10
11
12

Click OK. The effect is displayed in the work area.
Select the fill area for the petal on the right, then right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select Motif Fill
.
Set the Group to Universal and the Category to General Motifs 1. Click the drop-down arrow for
Pattern, scroll up the list and select Pattern 2.
Click Apply to preview the effect. If needed, move the Fill Area and Line dialog box to the left to view
the effect.
Click the Motif 2 tab.
Click ’Use Motif 2’ so it is selected. The Motif 2 options become available.
Set the Group to Universal and the Category to General Motifs 1. Click the drop-down arrow for the
Motif 2 Pattern, scroll up the list and select Pattern 2.
Click the Spacing tab.
Set the Vertical Offset to 30%.
Click the Motif 1 tab.
Click the Mirror option for Motif 1 so it is selected. The motif will be mirrored vertically.
Click Apply to preview the effect.
Click the Options tab.
Change the Angle to 200 and select Triple as the stitch type.
Click OK. Click Life View
to see the effect, then click Cancel.
Add a motif line flower to the left petal in “Create a Flower with Motif Lines” on page 278.

13
14
15
16
17
18
19
20
21
22
23
24

Insert Motif Fill in an Appliqué Petal
1

2
3
4
5

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsApplique_Picot’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on
page 81, and added a picot motif line to in “Change Satin Line to Picot Motif Line” on page 281.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Click the edge of the petal on the right. Its nodes (points) are displayed.
In the status bar the stitch type is displayed as Satin Line Appliqué.
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In the FilmStrip the object should also be Satin Line Appliqué. You can select objects in the FilmStrip, or
press the right and left arrow keys to step through the objects in the design.
Right-click the work area to see the Fill Area and Line properties for this Satin Line.
In the Fill drop-down menu at the top left, select Motif Fill
.
It will currently be shown as No Fill.
In the Motif 1 tab set the Motif Group to Universal, and the Category to Hand Stitches 1.
Click the drop-down arrow for Pattern and select Pattern 17, a tied cross.
Click OK to close the dialog box.
Notice that the motif fill in the petal on the right is the same color as the border stitches. The motif fill
will look nice in variegated thread.
In the FilmStrip, right-click the petal in the middle (FilmStrip item number 2) and select Insert Color
Change. The Color Selection dialog box will appear.
This places the color change between the two petals.
Click Show All Thread Ranges, then click the drop-down arrow for the Thread Range and select
Robison-Anton Rayon Vari 40.
In the shade list, browse for 2370 (4CC Melody) or enter 2370 in the Find Thread box. Click OK.
This changes the color for the Motif Fill, but also changes the color of all the objects that follow it.
Right-click the Motif Fill area to open Fill Area and Line properties.
Click the Line tab.
Click (check) Insert Color Change, and then click Line Thread Color
. The Color Selection dialog
box opens.
Click the drop-down arrow for the Thread Range and select Robison-Anton Rayon 40.
Type 2275 in the Find Thread box to select 2275 (Slate Blue). Click OK.
The thread color is now a dark blue. Click OK to close the Fill Area and Line dialog box.
Click Life View
. The motif fill in the petal on the right is now shown in variegated thread, with a
blue border, but the petal on the left is variegated. It should be changed to blue. Click Cancel to close
the dialog box.
The border color change affects only the color of the border around the motif fill area. It does not affect any
other objects. So a separate color change is needed.
In the FilmStrip, ensure that the Motif Fill petal
is selected.
Right-click on the FilmStrip, then click Insert
Color Change and the Color Selection dialog
box will appear.
Click the drop-down arrow for the Thread
Range and select Robison-Anton Rayon 40.
Type 2275 in the Find Thread box to select
2275 (Slate Blue). Click OK.
Click Life View
. The borders are now all
blue, with a variegated thread motif fill area.
Click Cancel.
Add a contour fill flower to the left petal in
“Create a Contour Fill Flower” on page 215.
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Shape Fill
Shape fill areas use one of 120 different shapes. Vary the stitch density, use motif lines for
the fill and add holes.

Shape Fill Area using Shape 4
and Density 18

Shape Fill Area using Shape 66 and
Motif 1 from Hand Stitches 1

The Fill Area and Line properties for Shape Fill has tabs for setting all the properties on a
shape fill area. It appears when you click a shape fill area so that the points defining its
shape are shown, and then right-click. It also appears when you click the Fill Area and Line
button in the Options section on one of the Create tabs.

Shape Fill — Options

Select a motif for the fill
Set the stitch density for the fill
Select a shape for the fill
Use motif lines in the fill

Density
Set Density from 2 to 40. The lower the number, the closer
together the stitches and the more stitches are produced.
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Shapes
Click the drop-down arrow and select the desired shape from the list.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain line to follow the shape
selected for the fill. Click the Motif tab to choose a motif.

Shape Fill — Motif
The selected Motif is only used by the Shape Fill if the Use Motifs option is selected on the
Options tab.

Select a motif Group, Category and pattern
Set the gap between the motifs in the line
Adjust the position of the motifs in the line
Set the motif size and Height / Width ratio
Set the stitch length for the motif lines
Select a stitch type for the motif lines

Motif
Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the
motifs along the line. This is in addition to any spacing that is part of the selected motif.
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Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line.

When Fit To Line is off, the ends of each
motif are placed on the line.

When Fit To Line is on, each motif is
adjusted to fit along the line.

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif
direction. Some motifs are symmetrical and will have no apparent change when they are
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary,
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Size
Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of
stitches from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended
value for each motif.
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Use Shape Fills in Three Petals
1

2
3
4
5
6
7

8
9
10
11
12
13
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15
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Select the fill area for the petal on the right, then right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select Shape Fill
. The Options tab of the shape fill
properties is displayed.
Set Density to 20. This will create a lightly stitched pattern.
Click the drop-down arrow for Shapes and choose the five pointed star (shape number 26).

Click OK to apply the changes.
Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select Shape Fill
. The Options tab of the shape fill
properties is displayed.
Ensure the Density is set to 8.
Click the drop-down arrow for Shapes. Scroll down the list and choose the badge shape numbered
48.
Click OK.
Move the origin point
straight up the vertical grid center line until it is just above the petal.
Notice how the point of radiation changes.
Select the fill area for the petal on the left, then right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select Shape Fill
. The Options tab of the shape fill
properties is displayed.
Ensure the Density is set to 8.
Click the drop-down arrow for Shapes. Scroll down the list and choose the curvy frame numbered 65.
Click the Use Motifs option so that it is selected, then click the Motif tab.
From the Universal Group, select the Hand Stitches 1 Category.
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Scroll down the Pattern list and select pattern 11 (the closed fly stitch).

22
23
24
25

Click OK. The effect is displayed in the Create window.
Move the origin point
up so that it is just within the top right area of the petal.
Click Save
and browse to the folder Documents\mySewnet\My Designs.
Change the File name to 'PetalsShapeFill' and click Save.

26
27
28

Click Print
to print the embroidery worksheet.
Click Export Embroidery
and ensure that .vp4 is set as the file format. Click OK.
In the Save As dialog, browse to the folder Documents\mySewnet\My Designs and click Export. The
embroidery is saved as PetalsShapeFill_Exported.
There is no need to change the file name, as it is taken automatically from the design file name.
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Radial Fill
Radial fill areas
use a pattern of radiating lines from an origin point
moved. Vary the stitch density and add holes.

that can be

Radial Fill with origin moved to top of
heart

Radial Fill — Options

Set the density from 2 to 40

Density
Set Density from 2 to 40. The lower the number, the closer
together the stitches and the more stitches are produced.
The initial setting is 20.

Use a Radial Fill in a Petal
1

2
3
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79, and added a multicolor gradient fill in “Fill a Petal with a Multicolor Gradient Density
Fill” on page 192.
Click File, Preferences
and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
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Click inside the petal on the left to select the fill area. It will be shown as a Pattern Fill on the status bar.
Right-click on the work area and the Fill Area and Line dialog box will appear.
In the Fill drop-down menu at the top left, select Radial Fill
. The options in the tabbed pages
below change.
The tabbed pages in the Fill Area and Line dialog box show the properties for the currently selected Fill and
Line.
The Options tab is initially selected. Set the Density to 8. This gives a lightly stitched, but distinctive,
radial fill pattern.

Click OK. The description of the area on the status bar will change to Radial Fill.
Notice that the stitch lines of the radial fill radiate from the middle of the petal shape.

The stitch lines radiate from
the origin.
9

10
11

Move the origin to the top
right.

Click outside to view the
radial fill.

Click and drag the origin marker
of the radial fill up and to the right until it is about one grid
square from the corner of the petal.
The origin
is the start point for the repeating pattern in a pattern fill and the point from which stitches
radiate in a radial fill, shape fill or spiral fill.
Click outside the petal, so that the fill area is no longer selected. You can now see the effect of moving
the origin.
Click Zoom To Fit
.
To fill the right petal with a spiral fill, see “Fill a Petal with a Spiral Fill with Gradient Density” on page 210.
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Spiral Fill
Spiral fill areas
use a spiral pattern from an origin
constant or gradient density, and add holes.

Spiral Fill using Gradient Density

point that can be moved. Use

Spiral Fill with origin moved to top of
heart

Spiral Fill — Options
Density
The density on a spiral fill area can change over a range, or have multiple density changes
from the origin to the edge of the fill. Use Standard or Gradient density fill.
Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting.
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like
linen or satin.

Standard Density
Set the density from 2 to 80
Select Gradient fill
Set the standard Density from 2 to 80. The lower the number, the
closer together the stitches and the more stitches are produced.
The initial setting is 2.
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Gradient Density

Return to the
original settings
Add a marker
Adjustment marker
Highlighted value marker
Set the stitch density for
the chosen value marker

Delete the selected
marker

Use Gradient Density to change the density across the Spiral Fill. Set a value for the start
and end density markers for the fill, and the density gradually changes between the two
values. The start value is used at the origin of the spiral fill, and the end value is used at the
edge.
The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by
swapping the start and end values.

The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Use the marker above the gradient bar to change the gradient across the fill.

Add Marker
Click Add Marker to add a marker. The initial value for the marker will be between the
existing markers. Edit the value and move the marker as desired.
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This means that you can have any combination of density values across the fill area. Remember, a higher
value means the fill is less dense. The marker furthest to the left affects the spiral fill at the origin, then from
left to right to the edge of the spiral fill.

Remove
Click Remove to delete the highlighted marker.

Use a Gradient with a Spiral Fill
1
2
3
4
5
6
7

Open the Fill Area and Line properties dialog and click the Density tab.
Click the Gradient option. The Gradient box will become available.
Click a value maker (the marker below the gradient bar) and change the value in the Density box to
the required density value.
Click Apply to view your changes.
Move the adjustment marker above the gradient bar to vary the change in density across the fill.
Click Add Marker to add another value marker and adjustment marker.
Change the density of the fill as desired.

8

Click OK to close the Fill Area and Line properties dialog.

1

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79, and added a multicolor gradient fill and radial fill in “Fill a Petal with a Multicolor
Gradient Density Fill” on page 192 and “Use a Radial Fill in a Petal” on page 206.
Click File, Preferences
, and ensure that Color
Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set
to 5mm.
Select the fill area for the petal on the right, then
right-click to see the Fill Area and Line dialog box.
In the Fill drop-down menu at the top left, select
Spiral Fill
. The density tab of the spiral fill
options is displayed.
Select the Gradient density option.
Change the marker on the left (the start value) to
20.
Change the marker on the right (the end value) to
4.

Fill a Petal with a Spiral Fill with Gradient Density

2

3
4
5

6
7
8

210

mySewnet™ Digitizing Using Fill Areas

9
10
11
12
13

14

This will create a lightly stitched pattern at the origin of the spiral fill, shading to a more heavily stitched
pattern at the edges.
Click OK. The spiral fill is displayed in the third petal.
Click Save
and browse to the folder Documents\mySewnet\My Designs.
Change the File name to 'PetalsFill2' and click Save. The file is saved as PetalsFill2.edo.
Click Export Embroidery
and ensure that .vp4 is set as the file format. Click OK.
In the Save As dialog, browse to the folder Documents\mySewnet\My Designs and click Export. The
embroidery is saved as PetalsFill2_Exported.
There is no need to change the file name, as it is taken automatically from the design file name.
Click Print
to print the embroidery worksheet.
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QuiltStipple Fill
QuiltStipple fill areas
use stipple stitch in a curved or straight lines. Vary the gap
between stitch lines, use running or triple stitch, and add holes.

QuiltStipple Fill using a curved style

QuiltStipple Fill using a straight style

QuiltStipple Fill — Options

Select curved or straight stipple lines
Set the spacing between the stipple lines
Set the stitch length for the stipple lines

Select a stitch type for the stipple lines

Style
Choose between curved or straight.

Curved

212

mySewnet™ Digitizing Using Fill Areas

Straight

Spacing
Set the Gap to the preferred distance between lines of stitching. This also, where possible,
is the border inside the area, between the edge of the area and the fill pattern.
Set the Gap from 1 to 20mm in steps of 0.1mm. It is initially set to 5.0mm.

Stitch
Select Running or Triple stitch for stitching out the fill. Set the Length of stitches from 1 to
12mm in steps of 0.1mm. Length is initially set to 2mm.

Insert QuiltStipple Fill in a Petal
1

2
3
4
5
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsApplique_Butterfly Line’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on
page 81, and added a motif line to in “Change Satin Line to Motif Line in an Appliqué Petal” on page 281.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click along the edge of the middle petal to select the petal.
In the status bar the stitch type is displayed as Satin Line Appliqué.
In the FilmStrip the objects should also be Satin Line Appliqué. You can select objects in the FilmStrip, or
press the right and left arrow keys to step through the objects in the design.
Right-click the work area to see the Fill Area and Line properties for this Satin Line.
In the Fill drop-down menu at the top left,
select QuiltStipple Fill
.
It will currently be shown as No Fill.
In the Options tab, set the Gap in Spacing to
2.0mm.
Click OK.
In the Quick Access toolbar, click Save
and browse to the folder
Documents\mySewnet\My Designs.
Change the File name to 'PetalsApplique1'
and click Save to save your design file.
Click Export Embroidery
and ensure
that .vp4 is set as the file format. Click OK.
In the Save As dialog, browse to the folder Documents\mySewnet\My Designs and click Export. The
embroidery is saved as PetalsApplique1_Exported.
There is no need to change the file name, as it is taken automatically from the design file name.
Click File, Print. Deselect (uncheck) Print Plan View and Print Picture.
Click Print
to print the embroidery worksheet.
To change the appliqué fabric for the petals, right-click and in the Fill Area and Line dialog box click the
Appliqué tab. Click the Select Fabric button and choose a Quick Color for a fabric, or click Fabric and then
load

a fabric with the Picture Viewer.
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If desired, open the embroidery in mySewnet™ Embroidery to preview on a garment or fabric background,
as in the example.
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Contour Fill
Contour fill areas
use contour stitch lines. Vary the gap between stitch lines and the
length of the stitches, use running, double or triple stitch, and add holes.
Contour Fill, using Triple Stitch and a
3.0mm gap

Contour Fill — Options

Set the space between the
lines in the fill
Set a stitch length for the contour lines
Select a stitch type for the contour lines

Spacing
Set the Gap to the preferred distance between lines of stitching. This also is the border
inside the area, between the edge of the area and the fill pattern.
Set the Gap from 0.2 to 5mm in steps of 0.1mm. It is initially set to 2.0mm.

Stitch
Select Running, Double or Triple stitch for stitching out the fill. Set the Length of stitches
from 1 to 12mm in steps of 0.1mm. Length is initially set to 2mm.

Create a Contour Fill Flower
1

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsApplique_MotifFill’.
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Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on
page 81, and added a motif fill to in “Insert Motif Fill in an Appliqué Petal” on page 199.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Click Edit Background
.
In mySewnet™ Draw & Paint, click the Insert tab.
In the Shapes drop-down list, select Shape 49, a flower.
Click Insert Shape
.
Click and drag inside the selection box to move the flower. Position it in the larger end of the petal on
the left.
In the File menu, click Exit (or click Close in the mySewnet™ Draw & Paint window).
In mySewnet™ Digitizing, click the View tab.
Click 2D View
.
This enables you to see the picture behind the appliqué fabric.
Click the Quick Create tab.
Ensure that Fill is selected, then click the fill drop-down menu and select Contour Fill
.
Ensure that Line and Appliqué are not selected. This will create a fill area without a border or
appliqué.
Click QuickStitch™
.
Click along the edge of the flower. The Color Tolerance dialog box will appear.
Click OK to close the Color Tolerance dialog box and right-click to deselect the fill tool. The flower
head is filled with stitches that follow the contours of the petals.
Right-click the work area to open
the Fill Area and Line properties
dialog.
In Spacing on the Options tab, set
the Gap to 1.2mm. Click OK.
Click Life View
to view the
finished embroidery, then click
Cancel.
Click Save
and browse to the
folder Documents\mySewnet\My
Designs.
Change the File name to
'PetalsApplique2' and click Save.
Click Export Embroidery
and
ensure that .vp4 is set as the file
format. Click OK.
In the Save As dialog, browse to
the folder
Documents\mySewnet\My
Designs and click Export to save
the design as
PetalsApplique2_Exported.
Click Print
to print the
embroidery worksheet.
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Crosshatch Fill
Crosshatch fills are used in quilting, and to create free-standing lace.
Crosshatch Fill, using Diamond style and
an Angle of 75 degrees

Crosshatch Fill — Options
The Crosshatch Fill Properties enable you to set the gap, style, line angle, stitch type and
stitch length for the crosshatched lines of stitching in the fill. The preview changes
according to the options chosen.

Preview your settings
Select a stitch type for the
crosshatch lines
Set the stitch length for fill lines
Set the width for zigzag lines

Set the angle for one or both crosshatch lines
Select a style for the Crosshatch fill
Adjust the gap between the stitch lines

Spacing
Set the Gap to the preferred distance between lines of stitching.
Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default,
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter
Angles to create an asymmetrical crosshatch pattern, if desired.
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Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.
The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to
the same angle as the Diamond style previously used, and Angle2 is initially set to this
angle plus 90 degrees.

Stitch Type
Select a stitch type for the crosshatch fill. Choose from:
■
■
■
■

Running Stitch
Double Stitch
Double Zigzag
Triple Stitch

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Zigzag Width
Set the Zigzag width for Double Zigzag stitch from 0.1 to 6mm in steps of 0.1mm. The
initial setting is 0.6mm.
Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag
pattern to create a mesh. After embroidering on water soluble stabilizer, the mesh of stitches provides
strength when the stabilizer is washed away.

Creating and Changing Fills: Fleur de Lys Background and Base
1
2
3
4

5
6
7
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In the Quick Access toolbar, click Change Hoop
, and set the hoop to Universal, 100mm x 100mm Universal Square Hoop 1.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load or Create a Background Picture, then click Next. In the Choose
Picture page, click Load a Picture
, browse to the folder
Documents\mySewnet\Samples\Digitizing\Pics, and load the picture 'Fleur de lys.svg’.
Click Next and in the Design Size page click Enter Design Size, change the Size to 90mm, and click
Width. Click Finish to load the picture into the work area.
Click the Quick Create tab.
In the Fill Area and Line section, click the Fill drop-down menu and select Crosshatch Fill
. In the
Line drop-down menu select Satin Line
. Ensure that Appliqué
is not selected.
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In the Options section, click the Fill Area and Line button. The Fill Area and Line dialog box opens at
the Options tab for Crosshatch Fill.
In Spacing set the Gap to 2.5mm. Set Style to Diamond, and ensure the Angle for Diamond is 45.
In Stitch Type select Double Zigzag. Set Stitch Length to 2.0mm, and Zigzag Width to 0.6mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag
pattern to create a mesh. After embroidering on water-soluble stabilizer, the mesh of stitches provides
strength when the stabilizer is washed away.
Click the Line tab.
Ensure that Density is set to 4 and that Underlay is selected (checked). Set Width to 3.0mm.
These settings are for the fill area and its border. They are parts of the same object.
Click OK to close Fill Area and Line properties.
Click QuickStitch™ + AutoHole
.
Click within the circle, but outside the fleur
de lys. The dashed line will show the area
selected for the fill area, with a different
colored dashed line around the fleur de lys.
Click OK and the crosshatch fill area will
appear.
Right-click to deselect QuickStitch™ +
AutoHole.
A satin border is created around the outside of
the circle, and around the edge of the fleur de
lys (the edge of the hole).
In the FilmStrip the Crosshatch Fill area and its
borders are shown as a single object.
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Select the Crosshatch Fill area, and in the Edit tab click Break Apart .
Where there was one object (the Crosshatch Fill) there are now three
(Crosshatch Fill, and two Satin Lines). These objects can be edited individually.
Click the Satin Line in the shape of a fleur de lys at the bottom of the
FilmStrip.
Right-click, and in the context menu click Delete
. The fleur de lys satin
line will be removed from the FilmStrip.
This removes the border around the fleur de lys hole, and leaves the border
around the circle.
Click the View tab and drag the Background slider to the central point (Fade
Background
). You can now see the stitching better.

Click the Quick Create tab.
Click Line so that it is not selected.
In Options, click the Fill Area and Line button. The Fill Area and Line
dialog box opens at the Options tab.
There should be no Line tab. If a Line tab is present, close the Fill Area and
Line properties and deselect the Line button.
In Spacing set the Gap to 2.4mm.
Set Style to Parallel, and set the Angle for Parallel to 90.
In Stitch Type, ensure Double Zigzag is selected. Leave Stitch Length at 2.0mm, and Zigzag Width at
0.6mm. Click OK to close Fill Area and Line properties.
Click QuickStitch™
.
Click in the bottom of the fleur de lys. The dashed line surrounds only the base of the fleur de lys, and
does not go into the green band area.
This is not a problem as this area will be stitched separately.
Click OK in the Color Tolerance dialog box. A parallel crosshatch fill area will appear.
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Right-click to deselect QuickStitch™.
Click the Fill drop-down menu and select
Pattern Fill
. Then in the Options section
click the Fill Area and Line button. The Fill
Area and Line dialog box opens at Pattern
Fill.
Set the fill Pattern to 257 (this is in the
Gradient & Lace category).
Select (check) Gradient, then click Single
Color Gradient and set the start and end
markers to 6. (Delete any other markers.)
When a single color gradient is set with both
markers at the same number, the traveling
stitches will go around the fill area rather
than across it. This is recommended for
loosely stitched pattern fills such as this one.
Set Angle to 0 and set Compensation to 0.
Click OK to close Fill Area and Line
properties.
Underlay does not have to be adjusted as it is
automatically set to None for the gradient
density fill.
Click QuickStitch™
.
Click in the bottom of the fleur de lys and click OK in the Color Tolerance dialog box. A linear fill
appears over the area of parallel crosshatch fill.
Right-click to deselect QuickStitch™.
This combination of fill areas creates a loosely stitched ’weave’ effect that will still have strength when the
stabilizer is washed away.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a
weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine
with Pattern 258, and so on.
To create a band and feathers for the fleur de lys, see “Create the Band and Feathers for a Fleur de Lys” on
page 260.
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Curved Crosshatch Fill
Curved Crosshatch fills
use curving lines in the crosshatch, which can be used to create
a feeling of depth. They are used in quilting, and to create free-standing lace.

Curved Crosshatch Fill Properties
The Curved Crosshatch Fill properties dialog box enables you to set the curve, gap, style,
line angle, stitch type and stitch length for the curved crosshatched lines of stitching in
the fill.

Use a Motif with the fill
Select a style for the
Curved Crosshatch fill
Set the angle for one or both
curved crosshatch lines

Set the stitch length for fill lines
Select a stitch type for the
curved crosshatch lines

Set the curve for the curved crosshatch lines
Adjust the gap between the stitch lines
You can also change the curves in the crosshatch lines using the handles in the work area.

Spacing
Set the Gap to the preferred distance between lines of stitching.
Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default,
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter
Angles to create an asymmetrical crosshatch pattern, if desired.

Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill which creates a crosshatch pattern of
lines set at 90 degrees.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.
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The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to
the same angle as the Diamond style previously used, and Angle2 is initially set to this
angle plus 90 degrees.

Stitch Type
Select a stitch type for the curved crosshatch fill. Choose from:
■
■
■
■

Running Stitch
Double Stitch
Triple Stitch
Motif Line

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Curved Crosshatch
Use Lines 1 and 2 to change the curve on the crosshatch lines.
You can also change the curves in the crosshatch lines using the handles in the work area.

Lines 1
Change the position of the origin for one of the sets of curved lines.
Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In %
and for Curve Out % is 50.

Lines 2
Change the position of the origin for the other set of curved lines.
Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In %
and for Curve Out % is 50.
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Curved Crosshatch Fill — Motif
The selected Motif is only used by the Curved Crosshatch Fill if the Motif Line option is
selected on the Options tab.

Select a motif Group, Category
and pattern
Set the gap between the motifs
Adjust the position of the motifs
Set the motif size and
Height / Width ratio
Set the stitch length
Select a stitch type for the
motif lines

Motif
Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line.

When Fit To Line is off, the ends of each
motif are placed on the line.
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When Fit To Line is on, each motif is
adjusted to fit along the line.

Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary,
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Size
Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for
each motif.

Curved Crosshatch Fill in a Teardrop
1
2
3
4
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Click File, New
, or File, New Window
, and in the Express Design Wizard, select the bottom
option, Start a New Design with no Picture, then click Next twice.
In the Design Size page, set the hoop to Universal, 100mm x 100mm - Universal Square Hoop 1 and
click Finish.
Click the Quick Create tab.
Ensure that the Fill and Line buttons are selected, and that Appliqué is not selected.
In the Fill drop-down menu select Curved Crosshatch Fill, and in the Line menu select Satin Line.
In Options, click Fill Area and Line to open the Fill Area
and Line dialog box.
In the Options tab, set Gap to 3.5mm.
In the Line tab set Width to 1.5mm.
Click OK to close the Fill Area and Line dialog box.
In the Shape drop-down list, select Shape 76, a teardrop.
Click Shape
. A curved crosshatch fill area appears on
the work area in a selection box with blue handles. The
crosshatch follows the curves of the shape.
Hold down the Ctrl and Shift keys, and drag a corner
handle to enlarge the teardrop from the center so that
the teardrop is about 80mm high.
Right-click outside the selection box.
This deselects the Box Select function.
The teardrop now has four pink triangular handles.
Check that all of the pink handles are within the hoop.
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Click and drag the handle at the bottom left towards the bottom left corner of the hoop. The vertical
crosshatch lines become less curved.
Click and drag the handle at the bottom right towards the top right corner. The horizontal lines curve
towards the top.
The four handles enable you to adjust the curves of the lines in the fill. Use the handles to make the curves
in the fill follow the outline of the shape.
Right-click the fill area and select Properties in the context menu. The Fill Area and Line properties
dialog box opens.
Use the title bar on the properties dialog box to drag it one side, so that you can see the teardrop.
In Style, select Parallel, then click Apply. The fill is now curved vertical lines.
The Style options set the type of parallel or crosshatched fill. Use Angle to set the angle for the lines.
Select Square, then click Apply to return to the original style.
In Spacing, set the Gap to 4.0mm, then click Apply. The lines are now further apart.
Use Gap to set the distance between the crosshatch lines.
In Lines 1 set Curve In and Curve Out to 0%, then click Apply. The
horizontal hatching in the fill now consists of straight lines.
Setting Lines 2 to 0% as well would form a square grid. Lines 1 and 2
set the initial curve of the lines in the fill. Use the pink handles to
adjust the curves within the shape.
In Stitch Type, note that several line types are available. Select
Motif Line, then click the Motif tab.
Set the Group to Universal and the Category to Hand Stitches 1.
Pattern 1, a chain stitch pattern, is selected automatically.
Set the Height to 1.0mm. The Width will automatically change to
2.5mm because Proportional is selected.
Click Apply. The Curved Crosshatch Fill now uses a motif in the
stitch lines.
Adjust the lines in the fill further, as desired.
Use Curved Crosshatch Fill for intersecting patterns and 3D effects.
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MultiWave Fill
MultiWave Fill areas
use a wave pattern defined by a line, or lines, drawn on the fill
area. Vary the density, or use a motif for the stitch lines.

MultiWave Fill, using a density
of 15

MultiWave Fill, using a density MultiWave Fill, using a density
of 15, and a short Freehand
of 15, a Freehand MultiWave
MultiWave Line to add texture
Line, and a Hand Stitches 1,
Pattern 1 motif

Change the direction of the stitch lines, or add texture, with Freehand MultiWave Line and Point MultiWave
Line. See “Freehand MultiWave Line” on page 147.

MultiWave Fill — Options

Select a motif
Set the stitch line density for the fill
Use a motif line

Density
Set Density from 2 to 40. The lower the number, the closer
together the stitches and the more stitches are produced.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain
line to follow the line angle selected for the fill. Click the Motif tab
to choose a motif.
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MultiWave Fill — Motif
The selected Motif is only used by the MultiWave Fill if the Use Motifs option is selected on
the Options tab.

Select a motif Group, Category and pattern
Set the gap between the motifs in the line
Adjust the position of the motifs in the line
Set the motif size and Height / Width ratio
Select a stitch type for the motif lines
Set the stitch length for the motif lines

Motif
Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line.

When Fit To Line is off, the ends of each
motif are placed on the line.
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When Fit To Line is on, each motif is
adjusted to fit along the line.

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif
direction. Some motifs are symmetrical and will have no apparent change when they are
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary,
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Size
Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of
stitches from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended
value for each motif.

Echo Fill
Echo Fill
places echo lines within and around a shape. Choose from rounded, square
and diagonal corners, set the gap between the echo lines and the number of lines, and
select the stitch type and length.

Rounded corners

Square corners
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Diagonal corners
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Echo Fill — Options
The Echo Fill properties dialog box enables you to place echo lines within a shape. Set the
fill type, style, gap, stitch type and stitch length.

Place echo lines inside and/or
around a shape
Choose rounded, square or
diagonal corners for the fill

Select a stitch type for the lines

Select a stitch length for the lines
Set the Gap between the echo lines

Echo Area
Internal Fill: Fill the selected area with lines, using the chosen Gap between the lines of
stitching.
Internal Lines: Place the chosen number of lines around the inside of the selected area,
using the selected Gap.
External Lines: Place the chosen number of lines around the outside of the selected area,
using the selected Gap.
External and Internal Lines: Place the chosen number of lines around the outside and
inside of the selected area, using the selected Gap.

Echo Lines
Set the number of echo lines. The minimum number of lines is 1, and the maximum
number of lines is 30. The initial number is 5.

Spacing
Set the Gap to the preferred distance between lines of stitching.
Set the Gap from 2mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from 1, 2 or 3. For a square shape:
• 1
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will create rounded corners
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• 2

will create square corners

• 3

will create diagonal corners

Rounded corners (1) is initially selected.

Stitch type
Select a line type for the echo lines in the fill. Choose from:
• Running Stitch
• Double Stitch
• Triple Stitch

Stitch Length
Set the stitch length for the echo lines from 1 to 12mm in 0.1mm steps. The initial setting
is 2mm.

Satin Area
See “Satin Area Options” on page 243.

No Fill
For No Fill
available.

, no fill type is selected. Only the properties for the selected line are

Use this where only a line is desired.
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Manage My Fills
Use Manage My Fills
to load new pictures for fill
patterns, export an existing My Fill pattern as a picture
and delete unwanted My Fills.
If you have a design using a My Fill pattern and give it to a
friend, it is likely that their My Fill database will have different
patterns to your My Fill database. Export the My Fill pattern and
give the picture to your friend to import into their My Fill
database.

Shortcuts
■
■

Edit Tab:
Keys: Alt, E, F

Export
Use Export to save a My Fill pattern as a picture. The picture can then be copied and
imported into a friend’s My Fills.
Click Export and the Save As dialog box appears. The file name is automatically set to the
number used for the pattern in your My Fills.

The following file formats may be saved: Windows or OS2 Bitmap (.bmp), JPEG Low Quality
(.jpg), JPEG High Quality (.jpg), Tagged Image File Format uncompressed (.tif ) and
Portable Network Graphics (.png).
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Delete
To remove an unwanted My Fill pattern, select the desired pattern then click Delete. A
message will appear to ask for confirmation.
Click OK to remove the pattern.
When a My Fill pattern is deleted, any designs that used that pattern will use standard Pattern 3 until a new
pattern is chosen.

Import
Use Import to create a new My Fill based on a picture or a previously exported My Fill.
After importing a picture, that fill will be available in the My Patterns
category of the
Fill Area and Line Properties dialog. Click the Import button and an open dialog box will
appear where you can choose the picture to import.

The height and width of the picture must each be from 120 to 700 pixels.
The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format
uncompressed (.tiff, .tif ), Windows Meta File (.wmf ), Windows Enhanced Meta File (.emf )
and Windows Icon (.ico).
Click the desired picture, then click Open.
The picture is automatically converted to black and white to determine the best positions for stitch points.
Therefore, you are likely to find the best results from simple pictures drawn in black and white.

A My Fill pattern is repeated every 0.1mm for each pixel in the source picture. For example,
if your picture is 300 x 200 pixels, it will be repeated every 30mm horizontally and 20mm
vertically if the fill angle is set to 0.

mySewnet™ Digitizing Using Fill Areas

233

Use a Bee for a My Fill Pattern
1

2
3
4

5
6
7
8

9

10
11
12

13

14

15

234

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79, and added a leaf pattern and single gradient fill to in “Change a Fill Area to a Leaf
Pattern” on page 186 and “Create a Single Color Gradient Fill in a Petal” on page 190.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab and ensure that Grid size is set to 5mm.
In the color worksheet in the Design Panel, click the check
box for the fourth color (slate blue) to hide the satin borders
using that thread color. This will make it easier to select the
fill areas.
Click the Edit tab.
Click Manage My Fills
and the Manage My Fills dialog box
will appear.
Click Import and the open a file dialog box will appear.
Browse to the folder
Documents\mySewnet\Samples\Digitizing \Pics.
Simple black and white pictures are recommended. The height
and width of the picture must be between 120 and 700 pixels.
Click 'Bee.bmp', then click Open. The bee fill will be created
and a preview sample will be shown in the Manage My Fills
dialog box.
Click Close.
Select the fill area for the petal on the right, then right-click
to see the Fill Area and Line dialog box. The Options tab is displayed.
In the Pattern section, click My Patterns
. The
the first fill in the My Patterns 1 category (the bee)
is displayed.
You could also browse to view all patterns in this
category from the drop-down list.
Note that the bee design has automatically been
given pattern number 501. You could enter this
number to go directly to the bee pattern.
Set the Angle to 20, then click OK.
Alternatively, you could use the handle on the Origin
marker
to change the fill angle.
Click Design Player
. This enables you to
preview the way that the design will be stitched
out, with no markers.
Use the Play button
at the bottom left to start
playing through the stitches in the embroidery.
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Use the controls to play forwards or backwards
through the embroidery at different speeds,
jump to the start or end of the stitches, and stop
at any time.
Use the Design Player
or Life View
when you
wish to preview a design with no objects selected.
Click Cancel.
Click Display all Objects
to show the blue
petal borders.
Click Save
and browse to the folder
Documents\mySewnet\My Designs.
Change the File name to 'PetalsFill1' and click
Save to save your design file.
Click Export Embroidery
and ensure that .vp4
is set as the file format. Click OK.
The preferred file format for saving embroideries is
.vp4, as this will preserve background and appliqué
information, thread color information and notes.
In the Save As dialog, browse to the folder
Documents\mySewnet\My Designs and click
Export. The embroidery is saved as
PetalsFill1_Exported.
There is no need to change the file name, as it is
taken automatically from the design file name.
Click File, Print.
Deselect (uncheck) Print Plan View and Print Picture.
Print Plan View shows the picture with the embroidery printed over it. Print Picture prints the background
picture. These features are useful where embroidery is used to enhance a picture.
In Worksheet options, ensure that Design Scale is set to 100% and ensure that Grid and all the Print
Information boxes are checked. Click OK.
Select two pages to see both pages of the worksheet.

Click Print
to print the embroidery worksheet.
The embroidery worksheet will be printed at full size.
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Creating and Using Satin Areas

11

Satin Area
Create Satin Areas with the Satin Area functions: QuickStitch™ Satin
Multiple Satin
, Freehand Satin Area
and Point Satin Area
.

, QuickStitch™

Adjust the properties of your satin area with Satin Area Options.
Use the Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into
the current settings, to use as default for new areas of this type.

QuickStitch™ Satin
Use QuickStitch™ Satin
to fill an area with satin stitches
automatically, by clicking in a color area of the picture. If
required, use Color Tolerance to select a larger area according to
the similarity of adjacent colors.
Set stitch options before creating, or after satin areas have been
created, right-click an area and use Fill Area and Line properties
to change density, pattern and underlay, or change to another
stitch type.
You can change all visible or selected satin areas with Global Properties, or by selecting
the objects to change and changing one of them in Fill Area and Line properties. Stitch
angle lines and start and end points can be adjusted on satin areas individually.
QuickStitch™ Satin works best with relatively simple areas of the picture that do not have any complex
branches. For example, if the area has long branches or branches that double-back on each other, you
may not get the best result.
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For branching or other complex areas, use QuickStitch™ Multiple Satin. Alternatively, edit the picture to
make separate areas of any extra branches.

A tree with many branches

Left as one color, a single QuickStitch™ Satin area is
created

Use QuickStitch™ Multiple Satin areas

Or split up the branches by using different colors

Shortcuts
■
■

Quick Create Tab, Satin Area:
Keys: Alt, Q, K

Create a QuickStitch™ Satin Area
1
2
3

4
5
6
7
8
9

10

Set stitch options, then in the Quick Create tab click the QuickStitch™ Satin icon
.
Click in the color area you wish to fill with stitches.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to
confirm.
Satin stitches will appear in the area.
Repeat to place as many satin areas as desired.
Right-click to deselect, or simply select another Create tool.
Right-click the Satin Area. The Fill Area and Line properties dialog opens.
Select each satin area in turn, right-click to change the satin properties of an area and click OK.
See “Satin Area Options” on page 243.
Alternatively, to change the properties of a selection of satin areas at one time, in the FilmStrip, hold
the Ctrl key and click each of the satin areas to be changed. Then right-click one of the selected areas
and select Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line
dialog box will be applied to your selected satin areas when you click OK.
Also in the work area, if desired, move the green start
or red end
and adjust angle lines for
satin areas.
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QuickStitch™ Multiple Satin
Use QuickStitch™ Multiple Satin
to fill a branching or other
complex area with satin stitches automatically, by clicking in a
color area of the picture. If required, use Color Tolerance to
select a larger area according to the similarity of adjacent
colors.

Shortcuts
■
■

Quick Create Tab, Satin Area:
Keys: Alt, Q, M

Create a QuickStitch™ Multiple Satin Area
1
2
3

4
5
6
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Set stitch options, then in the Quick Create tab click the QuickStitch™ Multiple Satin
icon.
Click in the color area you wish to fill with stitches.
If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to
confirm.
Satin stitches will appear in the area.
Repeat to place as many satin areas as desired.
Right-click to deselect, or simply select another tool.
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Freehand Satin Area
Use Freehand Satin Area
to draw outlines to define the edge of an area filled with satin
stitch. Satin areas are best suited to shapes without branches. If there are branches that
double-back on the main part of a satin area, the satin area may not give the desired
result.
After satin areas have been created, right-click an area and use Fill Area and Line
properties to change density, pattern and underlay, or change to another stitch type.
You can change all visible or selected satin areas with Global Properties, or by selecting
the objects to change and changing one of them in Fill Area and Line properties. Stitch
angle lines and start and end points can be adjusted on satin areas individually.

Satin Area created as a strip around the
picture shape, so stitches are short
enough to leave as plain satin

Large Satin Area covering the whole
picture shape, with a pattern to break up
long stitches

If the edge of the area does not match the background picture as closely as desired, you
can move, delete and insert points on the work area.

Shortcuts
■
■

Freehand Create Tab, Satin Area:
Keys: Alt, R, T

Create a Freehand Satin Area
1
2
3

Set stitch options, then in the Freehand Create tab click the Freehand Satin Area
icon.
Draw a line around the edge of the desired area.
When the area is complete, lift the pen from the tablet (or release the mouse button). The area is
closed with a straight line back to the start point, and filled with satin stitches.
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4
5

It is recommended to draw back to the start point. However, you can also adjust the shape of the area if it is
not exactly as planned.
Continue to draw as many satin areas as desired.
Right-click to deselect the function, or simply select another Create tool.

Change Satin Area Properties
1
2
3
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Select each satin area in turn, right-click to change the satin properties of an area and click OK.
See “Satin Area Options” on page 243.
If desired, move the start
or end
and adjust angle lines for satin areas.
To change the properties of a number of satin areas at one time, in the FilmStrip, hold the Ctrl key and
click each of the satin areas to be changed. Then right-click one of the selected areas and select
Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line dialog
box will be applied to your selected satin areas when you click OK.
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Point Satin Area
Use Point Satin Area
to place points, to define the edge of an area filled with satin
stitch. Satin areas are best suited to shapes without branches. If there are branches that
double-back on the main part of a satin area, the satin area may not give the desired
result.
After satin areas have been created, right-click an area and use Fill Area and Line
properties to change density, pattern and underlay, or change to another stitch type.
You can change all visible or selected satin areas with Global Properties, or by selecting
the objects to change and changing one of them in Fill Area and Line properties. Stitch
angle lines and start and end points can be adjusted on satin areas individually.

Satin Area created as a strip around the
picture shape, so stitches are short enough
to leave as plain satin

Large Satin Area covering the whole
picture shape, with a pattern to break up
long stitches

If the edge of the area does not match the background picture as closely as desired, you
can move, delete and insert points on the work area.

Shortcuts
■
■

Point Create Tab, Satin Area:
Keys: Alt, P, T

Create a Point Satin Area
1

2

Set stitch options, then in the Point Create tab click the Point Satin Area icon
. The first point
appears automatically as a small yellow circle, which is in the same place as the last point of the
previous object.
Click to place a second point close to the first one.
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3

4
5

Continue placing points around the desired area, such as a chosen section of the background picture.
If you are following the picture, place a point every time the direction of the picture outline changes.
Curved lines are created automatically. For corners and straight edges, hold down the Shift key. To delete
the last point placed, use the Delete key.
Right-click to complete the area. Stitches will appear in the current thread color showing the satin
area.
Repeat to place as many satin areas as desired.

Change Satin Area Properties
1
2
3
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Select each satin area in turn, right-click to change the satin properties of an area and click OK.
See “Satin Area Options” on page 243.
If desired, move the start
or end
and adjust angle lines for satin areas.
To change the properties of a number of satin areas at one time, in the FilmStrip, hold the Ctrl key and
click each of the satin areas to be changed. Then right-click one of the selected areas and select
Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line dialog
box will be applied to your selected satin areas when you click OK.
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Satin Area Options
Use the Satin Area Options tab to set density, compensation, pattern and underlay for
satin areas.

Search for a pattern by number
Select an underlay type for the satin
Adjust the area’s size
Choose a Category and pattern
Set the stitch density for the satin
Click to use no pattern

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.
Add new patterns using Manage My Fills.

View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 318.

Underlay
Set the Underlay option that will be used for satin areas. Zigzag creates zigzag lines of
running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places
lines of running stitch just inside the edges of the satin areas. Use edge walk when the
satin areas have both wide and narrow sections. For very wide areas of satin, select both
underlay types.
Zigzag is initially selected.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set
Compensation from 0 to 30. The higher the number, the bolder the area appears.

Density
Set Density from 2 to 80. The lower the number, the closer
together the stitches and the more stitches are produced.
The initial setting is 4.
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Using Satin Areas: Blue Jay Embroidery
1
2
3

4

5

6

7
8
9
10
11
12
13
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15

16

17
18
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20

21
22
23
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In the Quick Access toolbar, click Change Hoop
and in the Hoop Selection dialog box set the
Hoop Group to Universal, and select 100mm x 100mm - Universal Square Hoop 1. Click OK.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
and ensure that Color Tolerance is selected
(checked).
Use Color Tolerance to see which areas will be created when using the
QuickStitch™ features. As you become more comfortable with the
software, you may wish to turn it off, depending on the quality and color
of your image.
Check to see that Tie Off Before and After Trims is selected.
Tie Off Before and After Trims inserts tie-offs between stitch areas, as
appropriate.
Click File, New
, or File, New Window
, and in the Choose
Design Type page of the ExpressDesign Wizard select Load or Create
a Background Picture, then click Next.
Click Load a Picture
and in the Picture Viewer browse to
Documents\mySewnet\Samples\Digitizing \Pics. Load the picture
Birds4.png, click OK and in the Choose Picture page click Next.
In the Rotate and Crop Picture page click Select All to leave some background around the bird, then
click Next.
Click Finish in the Design Size page. The blue jay is displayed as your background picture.
Click the Quick Create tab to open the Design window.
In the FilmStrip, right-click the color at the top and choose Properties.
In the Color Selection dialog ensure that Robison-Anton Rayon 40 is selected as the thread range.
Enter 2614 (Pro Lusty Blue) as the thread number and click
OK.
Click QuickStitch™ Satin
.
Click on the medium blue on the lower back of the jay.
The Color Tolerance dialog appears, with the lower back
area surrounded by a red and cyan line.
Click OK to confirm.
The lower back of the blue jay is now covered by a medium
blue satin area.
In the Command section of the Quick Create tab, click the
Color Change drop-down menu, and select Color
Change
.
In the Color Selection dialog, select 2522 (Bridgeport Blue)
and click OK.
Ensure that QuickStitch™ Satin
is still selected.
Click the light blue on the top of the jay’s head, then click OK in
Color Tolerance. The top of the head is filled with a pale blue
satin area.
Click on the light blue on the upper back of the jay, then click
OK in Color Tolerance. The rest of the back and the upper and
lower wing is filled with a pale blue satin area.
If it is not filled already, fill the pale blue in the lower part of the
wing with a QuickStitch™ Satin area.
Click Zoom To Rectangle
, and drag a rectangle to zoom in
on the jay’s tail.
Click the Point Create tab, and then click Satin Area
.
Hold the Shift key and click to place the first point at the top
left corner of the top pale blue tail section.
Release the Shift key and place a point in the middle of the top of this tail section. The point is round.
Round points are used for curved edges to the area.
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Hold the Shift key and place a point at the top right corner of this
section. This point is square.
Square points are used for straight sections of the edge of the area, or for
corners.
Still holding the Shift key, click to place a point at the bottom right
corner of the tail section.
Release the Shift key and place two round points for the curve at the
bottom of the tail section.
Hold the Shift key and place a square point for the bottom left corner of the tail section. This
completes the tail section.
Right-click to finish the satin area.
Hold the Shift key and click to place a first square point at the top left corner of the second pale blue
tail section.
Release the Shift key and place two round points in the middle of the top of this tail section.
Hold the Shift key and place a square point at the top right corner of this section, and then another
square point for the bottom right corner.
If you misplace a point, move the pointer over the top of that point and when the pointer changes to the
move pointer , drag it to the correct position. Then continue to place points.
Release the Shift key and place two round points for the curve at the bottom of the tail section, then
hold the Shift key to place a square point for the bottom left corner, and to finish the section.
Right-click to complete the area.
Place round and square points to create the third pale blue tail section, then right-click to finish.
Create the final pale blue tail section by placing points. Use a square point for the notch on the
bottom edge.
Right-click again to close the Point Satin Area tool.
Click the View tab, then click 2D View
to see the picture
behind the stitching in 2D, then adjust the points on the final
area as desired. You can also drag the pink hexagonal control
points on the stitch angle lines to change the angle of the
stitching.
Hold the Shift key when dragging square points, so that they
remain square.
If desired, click the Home tab to use Delete Points
to remove
points, and Insert Points
to add points.
Click the other tail sections in turn to select them, and make any
adjustments needed.
Click 3D View
to return to view the stitches in 3D, and then
click Zoom to Fit
to view the whole design.
Click the Select Last Visible icon
on the FilmStrip, to ensure that you are at the end of the design.
Click the Point Create tab.
In the Command section of the Point Create tab, click the Color Change
icon.
In the Color Selection dialog, select 2440 (Blue Ink) and click OK.
Click Zoom To Rectangle
to zoom in on the bottom of the wing.
Click Satin Area
and place points for the
satin area. Use square points for sharp
angles, and round points for curves.
Right-click to complete the area.
Note that between the feathers at the
bottom of the wing, parts of the stitching
overlap the line that you drew.
Click Undo
to remove the area that you placed.
Click the Quick Create tab, and then click QuickStitch™ Multiple Satin
.
Click the bottom of the wing, then click OK in Color Tolerance. The new satin area is created in several
sections. It follows the outline of the area with no overlap.
Use QuickStitch™ Multiple Satin when creating complex satin areas. Alternatively, create several sections
using one of the Freehand tools.
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Click Zoom to Fit
to view the whole design.
Click the beak, then click OK in Color Tolerance. The beak is created separately from the flash above.
Click Zoom To Rectangle
to zoom in around the eye.
Click the Freehand Create tab.
Click Satin Area
.
Starting at the top, draw a line around the edge of the blue part of the eye, finishing near where you
started. Then lift the pen from the tablet (or release the mouse button).
The area is closed with a straight line back to the start point, and filled with satin stitches.
Right-click to close the tool.
Adjust, add and delete points and angle lines as desired.
Click Zoom to Fit
to view the whole design.
Click the Quick Create tab, and then click the QuickStitch™ Satin
button.
Fill the remaining area on the head, and the dark blue tail sections with satin, then right-click to close
the tool.
In the Fill drop-down menu, select Pattern Fill.
Ensure that Line and Appliqué are not selected.
This will create an area of pattern fill with no border line.
Click Zoom To Rectangle
to zoom in around the legs.
Click the Point Create tab.
In the Fill Area and Line area, click Create Area or Line
.
Hold the Shift key and click to place straight lines for each of the legs. Right-click to complete each fill
area, then right-click to close the tool.
The QuickStitch™, Freehand and Point tools work exactly the same, regardless of whether you are creating
a line, fill or satin area.
Click Zoom to Fit
to view the whole design.
Click Color Change
and in the Color Selection dialog, select 2343 (Eggshell) and click OK.
Click the Quick Create tab, and then click QuickStitch™ Satin
.
Click to fill the white middle section of the wing.
Click the QuickStitch™
button, and click to fill the white area above the legs, and the small white
area above the beak.
Click QuickStitch™ + AutoHole
.
Click the white area of the face that includes the eye. The area is filled
with the eye still visible.
You can create holes in fills, but not in satin areas.
Right-click to close the tool.
Click Life View
or Design Player
to view how the blue jay
embroidery will be stitched out.
Click Save
, browse to Documents\mySewnet\My Designs and
save the embroidery design as Blue Jay.edo.
Click Export
and export the embroidery as Blue Jay_Exported.
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Creating Columns
Create columns with the Column functions. Choose from Satin Column
Satin
, Richelieu Bars
or Tapered Motifs
.

, Feathered

You can select your column type in the Create tabs before creating the fill.
Alternatively, change the column type afterwards using Fill Area and Line properties.
Use the Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into
the current settings, to use as default for new areas of this type.

Column
Select the column type from the Create tabs:
Satin Column

Richelieu Bars

Feathered Satin

Tapered Motifs

Satin stitch will 'pull up' in the direction that the stitches are sewn, so it is advisable to lay
down underlay stitches for stabilization.
You can set automatic underlay in the Column properties dialog.

Column
Use the Column functions to place one of the following column types: Satin Column
Feathered Satin , Richelieu Bars
or Tapered Motifs
.

,

The first and last pairs of points in a column are always square (control points).
Right-click the created column to change its settings, or convert it to any other column type.
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Create a Column
1
2

3

4
5
6
7

Click the Freehand Create or Point Create tab.
Set stitch options, then click the desired Column
function and click to place the first point of your
column (Point 1).
A movement stitch will be placed between the last object
in the design and this point.
Click to place Point 2 to start the other side of the
column. A line will be placed to indicate the width of
the column.
The first and last pairs of points in a column are always
square (control points).
Click to place Points 3 and 4 for the next section of the column. The first column section appears.
Repeat to place points indicating the width and position of the column.
The outline shape of the column is drawn.
Right-click to place the column, or simply select another Create tool. The
stitches for the column will appear in the work area.
Right-click a second time to deselect the function, or simply select
another Create tool.
If desired, click the column to select it, and then right-click it to open the
Column dialog. Here you can change the settings, or select a different
column type from the drop-down list.

Draw a column with Bezier Curves
1
2
3

4
5
6
7
8
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Click the Point Create tab.
Bezier Mode is only available in the Point Create tab.
Select Bezier Mode
.
Set stitch options, then click the desired Column function
and click and drag to place the first point of your column
(Point 1).
A movement stitch will be placed between the last object in
the design and this point.
Click and drag to place Point 2 to start the other side of the
column. A line will be placed to indicate the width of the column.
Click and drag to place Points 3 and 4 for the next section of the column. The first column section
appears.
Repeat to place points indicating the width and position
of the column. The outline shape of the column is drawn.
Right-click to place the column.
Right-click a second time to deselect the function.
If desired, click the column to select it, and then right-click it
to open the Column dialog. Here you can change the
settings, or select a different column type from the dropdown list.
The Bezier lines in a Column cannot be changed to a Point Line. See “Convert to Point Line” on page 296.
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Satin Column
Use Satin Column

to place a column of satin in the work area.

Place alternate points to define a column of continuous satin
(zigzag stitches that fill the column from one side to the other).
Click the Options button, or right-click a Satin Column to set
density, compensation, pattern (for wide columns) and underlay.

Shortcuts
■
■

Freehand Create, Column; Point Create, Column:
Keys: Alt, R, S; Alt, P, S

Satin Column Options
Use the Satin Column Options to set density, compensation, pattern (for columns wider
than around 8-10mm) and underlay.

Search for a pattern by number
Select an underlay type for the satin
Adjust the area’s size
Choose a Category and pattern
Use gradient density
Set the Standard density

Settings for Single & Multicolor gradient

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Feathered
Satin, Richelieu Bars and Tapered Motifs.
If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area
to change the column to a Satin Area. The Fill Area and Line
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 243.
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Click Undo

to change back to a column.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 318.
Patterns can only be used for columns wider than about 8-10 mm.

Underlay
Set the Underlay option that will be used for the satin column. Zigzag creates zigzag lines
of running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places
lines of running stitch just inside the edges of the satin column. Use edge walk when the
satin columns have both wide and narrow sections. For very wide satin columns, select
both underlay types.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set
Compensation from 0 to 30. The higher the number, the bolder the area appears. The
initial setting is 0.

Density
Set Density from 2 to 80. The lower the number, the closer
together the stitches and the more stitches are produced. The
initial setting is 4.

Gradient
Use the Gradient settings to see and change the density settings
and the color Gradient of the satin.
The color on a satin column can change over a range, or have multiple color changes
across the area. This is ideal for gradual color changes such as subtle shadow effects.
Gradient is not initially selected.

Single Color Gradient
Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker
Set the stitch density for
the chosen value marker
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Delete the selected
marker

Use Single Color Gradient to change the density across a satin column with only one color.
Set a value for the start and end density markers for the fill, and the density gradually
changes between the two values. Add multiple markers for a more complex pattern.
The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by
swapping the start and end values.

Use the adjustment marker above the gradient bar to change the gradient across the area.
Use Reset to cancel your changes and use the initial settings.
Click Add Marker to add a value marker below the gradient bar, and an adjustment marker
above the gradient bar. The initial value for the marker will be between the existing
markers. Edit the density value, and move the value and adjustment markers as desired.
This means that you can have any combination of density values across the area. A higher
value means the fill is less dense.
Density is used to change the density of the stitching. Set Density from 2 to 80. The higher
the number, the less dense the satin. The initial start marker setting is 4, and end marker
setting is 4.
Click Remove to delete the highlighted marker.

Multicolor Gradient
Set the stitch density
for the whole fill
Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the
highlighted marker

Delete the selected
marker

Use Multicolor Gradient to change the color across a satin column with only one density.
Set colors for the start and end markers for the area, and the color gradually changes
between the two values.
Use the marker above the gradient bar to change the color gradient across the area.
Use Reset to cancel your changes and use the initial settings.
Click Add Marker to add a color marker below the gradient bar, and an adjustment marker
above the gradient bar. The initial color for the marker will be the same as the currently
highlighted marker. Change the color and move the color and adjustment markers as
desired. This means that you can have any combination of colors across the area.
Use Thread Color
to change the color of the currently highlighted marker. The Color
Selection box will be displayed.
See “Color Selection” on page 89.
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Click Remove to delete the highlighted marker.
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Feathered Satin
Use Feathered Satin
to create columns of satin that are
feathered on one, or both sides.
Place alternate points to define a column of feathered satin
(zigzag stitches where the start and end points of the stitches are
random rather than all parallel).
Click the Options button, or right-click a Feathered Satin column,
to select whether one or both sides of the column will be
feathered, and set the stitch length and density.
Use feathered satin for realistic feathers or fur in animal designs, or shading in flowers. Typical shapes are
arches, semicircles, circles and ovals, and squares, rectangles and triangles are also possible.

Feather Both Sides

Feather One Side

Shortcuts
■

Freehand Create, Column; Point Create, Column:
Keys: Alt, R, D; Alt, P, D

1
2

Click the Freehand Create or Point Create tab.
Set stitch options, then click the Feathered Satin icon

■

Create Feathered Satin

3
4
5
6
7
8
9
10
11

.

To use Bezier lines instead of placing points, click to enable Bezier Mode
, then draw your Feathered
Satin column using Bezier lines. See “Draw a column with Bezier Curves” on page 248.
Click to place the first point of your feathered satin column.
A movement stitch will be placed between the last object in the design and this point.
Click to place Point 2 to start the other side of the column. A line will be placed to indicate the width
of the column.
Click to place Point 2 to start the other side of the section.
Click to place Points 3 and 4 for the first part of the feather satin column. A line will appear, showing
the stitch angle between these points.
Click to place further points for the next parts of the feather satin column.
Repeat to place as great a length of feathered satin column as desired.
Right-click to place the column, or simply select another Create tool.
Right-click again to deselect the function, or simply select another Create tool.
If desired, right-click the column and change the properties for the column. Alternatively, select
several objects in the FilmStrip and right-click one to the change the settings for all, or use Global
Properties to change the properties of all visible feathered satin or satin feathered on one side.
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Feathered Satin Options
Use the Feathered Satin Options to set density, Feather Type, and Stitch Length.

Set the density for the feathered satin
Select which side of the column to feather
Set the length of the feathering stitches

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin
Column, Richelieu Bars and Tapered Motifs.
If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area
to change the column to a Satin Area. The Fill Area and Line
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 243.
Click Undo

to change back to a column.

Density
Set Density from 2 to 40. The lower the number, the closer
together the stitches and the more stitches are produced. The
initial setting is 15.

Feather Type
Select which side of the column to feather. The available options
are Both, SideA or Side B, according to the side where the first (A) or second (B) point was
placed.

Stitch Length
Set the Length of feathering stitches from 2 to 30mm in steps of 1mm. The initial setting is
30mm.
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Feather Both Sides
Create a satin column with both edges feathered.

The start and end points of the stitches are random rather than all parallel. The final width
of the section is 2-2.5 times larger than it is for standard satin, as shown.
The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin
density may be from 2 to 40.

Feather One Side
Create a satin column with one edge feathered.

One edge is feathered, so the start and end points of the stitches on the feathered edge
are random rather than all parallel. The final width of the column is 1.5 to 1.75 times larger
than it would be for standard satin, as shown.
The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin
density may be from 2 to 40.
The side of the feathering is determined by the relative position of point 1. If desired, the
feathered side may be altered in the properties dialog.
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Richelieu Bars
Use Richelieu Bars
to place bars in the work area. Richelieu bars
are often used in lace designs.
Place alternate points to define a column of Richelieu bars (short
sections of satin perpendicular to the direction of the column).
Click the Options button to set the width and density of the satin
bars and either the number of bars or the gap between them.
To use Bezier lines instead of placing points, click to enable Bezier Mode
,
then draw your Richelieu Bars using Bezier lines. See “Draw a column with
Bezier Curves” on page 248.

Shortcuts
■
■

Freehand Create, Column; Point Create, Column:
Keys: Alt, R, B; Alt, P, B

Richelieu Bars Options
Use Richelieu Bars Options to set the width and density of the satin bars, the gap between
the bars, and the number of bars.

Set the width for the bars
Set the stitch density for the bars
Set the minimum distance
between the bars
Set the number of bars
Use a bar at both ends of
the column
Set underlay for the Richelieu bars

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin
Column, Feathered Satin and Tapered Motifs.
If no column is currently selected, this option will be grayed out.
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Convert to Satin Area
Click Convert to Satin Area
to change the column to a Satin Area. The Fill Area and Line
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 243.
Click Undo

to change back to a column.

Satin
Set the Width of the satin bars from 1mm to 6mm in steps of 0.1mm. The initial setting is
2mm.
Set the Density of the satin bars from 2 to 15. The initial Density is 4.

Method
Select a method for setting the number of bars.
Select Minimum Gap Size to set the distance between the bars from 1mm to 50mm in
steps of 1mm. The initial setting is 6mm.
Select Number of Bars to set the number of bars from 1 to 50. The initial number is 6.
Turn off Include Additional First and Last Bar if the edges of the Richelieu bar area are to be
covered in satin. This option is initially selected.

Underlay
Choose from Edge walk, Center link with zigzag return, and Web double with zigzag
return. All three options are initially selected.
■
■

■

Edge walk places lines of running stitch just inside the edges of the satin bars.
Center link with zigzag return places a central line of running stitch, with a zigzag return
line.
Web double with zigzag return places a crosshatch pattern of stitching with a zigzag
return line.
Vary the combination of underlay, depending on the type of design. It is recommended to use all three
types for free-standing lace.
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Tapered Motifs
Use Tapered Motifs
to create columns of motifs. Tapered motifs
are often used in lace designs.
Place alternate points to define a line of motifs that vary in size
according to the width of the column.
Click the Options button, or right-click a Tapered Motifs column to
set the desired motif, stitch length and either the number of motifs
or the gap between them.
To use Bezier lines instead of placing points, click to enable Bezier Mode
,
then draw your Tapered Motifs using Bezier lines. See “Draw a column with Bezier Curves” on page 248.

Shortcuts
■
■

Freehand Create, Column; Point Create, Column:
Keys: Alt, R, M; Alt, P, M

Tapered Motifs Options
Use the Tapered Motifs Options to set the motif type, stitch type, and placement method.

Select a motif and its orientation
Set a stitch type for the motifs

Set the stitch length for the motifs
Set the gap between the motifs
Number of motifs in the column
Retain proportions within column
Set the motif width
Adjust the position in the column

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin
Column, Feathered Satin and Tapered Motifs.
If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area
to change the column to a Satin Area. The Fill Area and Line
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 243.
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Click Undo

to change back to a column.

Motif
Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for
instance, if you have placed a Tapered Motifs column and wish to reverse the motif
direction. Some motifs are symmetrical and will have no apparent change when they are
reversed.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Stitches
Select Running or Triple stitch for stitching out the motifs. Set the Length of stitches from
1 to 20mm in steps of 0.1mm. Length is initially set to the recommended value for each
motif.

Method
Minimum Gap Size
The Minimum Gap is the minimum amount of extra stitching that is placed between the
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Number of Motifs
Set the number of Motifs from 2 to 50. The initial number is 6.
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Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line.

When Fit To Line is off, the ends of each
motif are placed on the line.

When Fit To Line is on, each motif is
adjusted to fit along the line.

Proportional
Use this option to keep the relative height and width of the motif in proportion when
when the column width is changed. This option is selected by default.

Width
The Width is initially set according to the chosen motif. The maximum and minimum
values for Width are individual to each motif.

Creating Columns
Create the Band and Feathers for a Fleur de Lys
1

2

3
4
5
6
7

8
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Click File, New
, or File, New Window
, and in the
Choose Design Type page of the ExpressDesign Wizard
select Load Existing Design, then click Next. In the Open
Existing design page, click Load a Design
, browse to
the folder
Documents\mySewnet\Samples\Digitizing\Edo, and load
the file 'Fleur de Lys Crosshatch and Base’.
Alternatively, use the design from “Creating and Changing
Fills: Fleur de Lys Background and Base” on page 218.
Click File, Preferences
, and ensure that Color
Tolerance is selected (checked), and that Tie Off Before
and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Click the Point Create tab.
Deselect the Fill and Appliqué buttons.
Click the Pattern Fill at the bottom of the FilmStrip.
In the Line drop-down list select Running Stitch
.
Good digitizing minimizes the use of movement stitches, which slow down the embroidery machine even if
they are trimmed automatically. We will use Running Stitch to travel to the next area of the design.
Click Create Area or Line
.

mySewnet™ Digitizing Creating Columns

9
10

11
12
13

14
15

16
17
18
19
20

21

22
23
24
25
26
27
28
29

Note the position of the Create Cursor
. This
marks the end of the last object in the design.
Move the pointer towards the Create Cursor, until
it changes to the diagonal pointer
.
The diagonal pointer indicates that the next object
will be created from the same point as the previous
one, with no movement stitch.
Hold down the Shift key and click to place a square
point at the position of the Create Cursor.
With the Shift key held down, place a point in the
right corner of the band around the fleur de lys.
Then going in a counter-clockwise direction, place
four more square points at the corners of the band,
finishing in the right corner.
The running stitch line around the band will provide
an outline preventing the satin stitches from pulling
in.
Right-click to complete the line.
In the Options area of the Create tab, click the
Column button and select Satin Column
in the
drop-down menu. The Column properties dialog
box opens at the Options tab for Satin Column.
Set Density to 4, set Compensation to 0 and set Pattern to 0.
In Underlay select both Zigzag and Edge Walk.
Click OK to close Column properties.
In the Column area, click Satin Column
. Place the first point for the satin column at the position of
the Create Cursor
, in the right corner of the band around the fleur de lys.
Place another point as close as possible to the first using the place points pointer
.
Adjust the position of the point if the move pointer
appears instead.
This places the second point for the satin column almost on top of the first.
Place two points on the opposite sides of the center of
the band, and two points next to each other in the left
corner. This will create a diamond shaped area of satin
stitch.
A minimum of four points is required to create a column.
Right-click to finish the column.
Right-click again to deselect Satin Column.
Use Zoom To Rectangle
to zoom in on the band
around the fleur de lys.
Right-click to deselect Zoom To Rectangle.
Click the View tab.
Click 2D View
. The display changes to 2D.
If desired, adjust the points for the band around the
fleur de lys.
Click the Point Create tab.
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Click Point Emboss Line
.
Hold Ctrl and place five points
to form a diamond shape within
the band around the fleur de lys.
Use the grid as a guide when
placing the points for embossing.
Right-click to finish the
embossed line.
Right-click to deselect Point
Emboss Line.
Click Zoom To Fit
.

3
2

4
1 5

Click Life View
to see the
embossed band, then click Cancel.
In the Options area of one of the Create tabs,
click the Column button and select Richelieu
Bars
in the drop-down menu. The Fill Area
and Line dialog box opens at the Options tab
for Richelieu Bars.

Set Width to 2.0mm and set Density to 4.
In Method select Number of Bars, and set the
number to 5. Deselect (uncheck) ’Include
Additional First and Last Bar’.
No additional first and last bar at either end of
the area will be needed as the ends will be
covered by a satin line.
In Underlay select all three options.
Click OK to close Column properties.
For free-standing lace it is recommended to
use all the underlay options to add stability.
Click Richelieu Bars
.
Place a point at the tip of the right feather of
the fleur de lys.
Place a second point using the place points
pointer
, as close as possible to the first.
Place a pair of points a little way down the
feather.
Place five or six more pairs of points,
following the curve of the feather.
A line should join each pair of points, making parallel lines that run across the feather. If the lines run
diagonally, click Undo
and try again, or edit the points after creation. You may optionally add more
points using Insert Points in the Home tab.
The first and last pairs of points will automatically be square (control) points for any column, including
Richelieu bars.
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Place two final corner points at the base of the feather.

47

Right-click twice to finish the bars, and to deselect Richelieu Bars.
You may wish to move points to make the curve smooth.
Ensure that Running Stitch
is selected as the Line type.
Click Create Area or Line
.
Hold Ctrl and place the first point of the line at the Create Cursor
.
With Ctrl held, place a second point where the right side of the middle feather
meets the band around the fleur de lys.
Release Ctrl and place a series of points along the right side of the middle
feather up to its tip.
This line of running stitch will later be covered by a satin border.
Right-click twice to end the line and to deselect Create Area or Line.
Click Richelieu Bars
.
Place the first point for the Richelieu Bars at the Create Cursor
;, at the tip
of the middle feather of the fleur de lys.
The settings are the same as for the right feather, so only check them if you think
they may have changed.
Place the second point as close as possible to the first.
Then place a pair of points a little way down the feather.
Place four more pairs of points, following the curve of the feather. Then place
two final corner points at the base of the feather. Right-click twice to deselect.
Although the top of the diamond is included in this area, it will not be affected as there is no stitching here.
Use Create Area or Line
to create a line of
Running Stitch
to the tip of the left feather.
Click Richelieu Bars
.
Place two square points at the tip of the left
feather of the fleur de lys. Then place five or six
pairs of round points down the feather. Place two
final corner (square) points at the base of the
feather and right-click to deselect.
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In the View tab click 3D View
to see the design in 3D.
To place an outline around the fleur de lys, see “Outline the Fleur de Lys With a Satin Line” on page 152.
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Using Lines
Lines can be created as individual parts of the design, or as a border to a fill area.

You can use Fill Area and Line properties to convert any line (or area) type to any other line or area type,
including appliqué options.

Use the QuickStitch™, Freehand Create, Point Create and Shape functions to create lines.
See “Creating Fills and Lines” on page 130.
Select the line type from the drop-down Line menu in the Quick Create, Freehand Create,
or Point Create tab.
Alternatively, right-click the line you created and change its properties in the Fill Area and Line properties
dialog. Use the work area or FilmStrip to change the position of the line and its properties, or to edit
selected lines.
To create a line without a fill, deselect the Fill button on the Create tab.

Line Types
Create individual lines using the following line types:
Running Stitch

Satin Line

Double Stitch

Motif Line

Double Zigzag

No Border Line

Triple Stitch
You can select your fill type, and the line type for the surrounding border, before creating the fill.
Alternatively, change either the fill or border type afterwards using Fill Area and Line properties.

Running Stitch

Motif Line using Pattern 2
from Hand Stitches 1.
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Running Stitch
Running stitch

is a row of small stitches going forward.

Use lines of running stitch for light markout or as underlay for satin columns and fill areas.
Running stitch is also useful for traveling stitches between sections of a design, if it can be
placed where it will be covered by later stitch objects.

Running Stitch Properties

Set the stitch length
Create a cutwork line
Select 2 or 4 cutwork needles
Create stability gaps in the cutwork line
Set the distance between the gaps
Use different fill and border colors

Length
Set the Length of Running stitch from 0.3 to 12mm in steps of 0.1mm.
The initial setting is 2mm.
If you change a running line back to standard stitching after using INSPIRA® Cutwork needles, the stitch
length will need to be altered from 0.3mm.

Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).
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Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
See “Color Selection” on page 178.
Insert Color Change is only used when the line forms the border to a fill area.

Cutwork
The cutwork needle features allow you to draw a cutting line within your design,
optimized for the INSPIRA® Cutwork Needles. Use two or four cutwork needles, and add
secure points for fabric stability.

Create Cutwork Needle Line
Enable the cutwork needle feature. By default this feature is not selected (checked).
When cutwork is selected Insert Color Change is no longer available. The stitch length is automatically set
to 0.3mm and cannot be adjusted.

Method
Choose between:
■
■

2 Cutwork Needles
4 Cutwork Needles
By default 2 needles is selected.
With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second
needle travels around the shape cutting at a different angle.
With 4 needles a more precise cutting method is used, where each needle is used for the section of the
shape that closely matches its angle. This method is recommended for more delicate fabrics.

Secure Points
Select Include Secure Points to create gaps in the cutwork needle line. By default Include
Secure Points is selected.
This allows the cut fabric to remain attached for stability while all the cutwork needle lines are created.
Afterwards it can be easily trimmed with scissors.

Set the Distance Between Secure Points from 10mm to 100mm in steps of 1mm. The initial
setting is 30mm.
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Double Stitch
Double stitch
is a row of small stitches going forward, followed by a row of small
stitches going backward, so it ends at the same point where it began.

Use double stitch for markout and to place branching outlines that need to return to their
starting points.

Double Stitch Properties

Set the stitch length from 1mm to 12mm

Use a line or a shape (a closed line)
Use a different color for the border
Set the color for the border

Length
Set the Length of Double stitch from 1 to 12mm in steps of 0.1mm.
The initial setting is 2mm.

Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
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See “Color Selection” on page 178.
Insert Color Change is only used when the line forms the border to a fill area.
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Double Zigzag
Double Zigzag stitch
is a row of small stitches going
forward, followed by a zigzag row of small stitches going
backward, so it ends at the same point where it began.
Double Zigzag is a special stitch type, recommended for lace. A running
stitch line is retraced in a zigzag pattern to create a mesh if sections are
placed together. Alternatively, use this stitch type for crosshatch fill.

Double Zigzag Properties

Set the stitch length
Set the width of the zigzag line
Use a linking stitch between sections of
Double Zigzag
Use a line or a shape (a closed line)
Use a different color for the border
Set the color for the border

Length
Set the Length of Double Zigzag stitch from 1 to 12mm in steps of 0.1mm.
The initial setting is 2mm.

Zigzag Width
Set the Width of the Zigzag part of the stitch from 0.2 to 6mm in steps of 0.1mm.
The initial setting is 0.6mm.

Include a Linking Stitch
Use a linking stitch between sections of Double Zigzag stitch.

Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
See “Color Selection” on page 178.
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Insert Color Change is only used when the line forms the border to a fill area.
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Triple Stitch
Triple stitch
is a row of small three-part stitches, each composed of one stitch going
forward, one going backward then one going forward. The stitch length can be changed
from 1mm to 12mm.

Use triple stitch for heavy markout or as heavy joining lines between sections of a design.

Triple Stitch Properties

Set the stitch length

Use a line or a shape (a closed line)
Use a different color for the border
Set the color for the border

Length
Set the Length of Triple stitch from 1 to 12mm in steps of 0.1mm.
The initial setting is 2mm.

Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
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See “Color Selection” on page 178.
Insert Color Change is only used when the line forms the border to a fill area.
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Satin Line
Satin Line
is a line of constant-width satin stitch. The width
of the line can be set from 1 to 12mm.

Satin Line Properties
Set density, width and taper for satin line.

Set the satin line width
Set the stitch density for the line
Use edge walk underlay inside each
edge of the line
Use a line or a shape (a closed line)
Use a different color for the border
Set the color for the border
Taper the ends of the satin line

Density
Set Density from 2 to 15. The lower the number, the closer
together the stitches and the more stitches are produced. The
initial setting is 4.
Embroidery on thicker fabrics usually looks better with more stitch coverage,
or a low density setting. Choose a low value such as 2 or 3 for heavy knit
fabrics, a higher value such as 5 or 6 for a light material like linen or satin.

Width
Set Width for satin border from 1 to 12mm. The initial setting is 4mm.

Underlay
Use this option to place edge walk underlay inside each edge of the satin border. Underlay
will not be generated if the Border Width is set below 2mm.
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Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
See “Color Selection” on page 178.
Insert Color Change is only used when the line forms the border to a fill area.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your satin lines.
Use these options to create mitered or pointed ends for your satin lines.

Start Point
Use these options to change the type of line beginning for the satin line. Select a taper
type, then set the angle of the taper.
■

No Taper

■

Left Taper

■

Central Point

■

Right Taper
To set the Taper Angle

, click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the satin line. Select a taper type, then
set the angle of the taper.
■

No Taper

■

Left Taper

■

Central Point

■

Right Taper
To set the Taper Angle

, click the up and down arrows or enter a number.

Motif Line
Use Motif line

to draw a line of motifs.

Use motif lines for decorative stitches and details.
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Motif Line Properties

Set the motif size and Height / Width ratio
Select a motif Group, Category and pattern
Select a stitch type for the motif line
Set the stitch length for the motif line
Adjust the position of the motifs in the line
Taper the start or end of the motif line
Use a line or a shape (a closed line)
Use a different color for the border
Set the color for the border

Set the gap between the motifs in the line

Motif
Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the
motifs along the line. This is in addition to any spacing that is part of the selected motif.
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Fit To Line
Select this option to make the shape of the motifs follow the curves of the line.

When Fit To Line is off, the ends of each
motif are placed on the line.

When Fit To Line is on, each motif is
adjusted to fit along the line.

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif
direction. Some motifs are symmetrical and will have no apparent change when they are
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary,
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical
and will have no apparent change when they are mirrored.

Size
Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of
stitches from 1 to 20mm in steps of 0.1mm. Length is initially set to the recommended
value for each motif.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your motif lines.
For Motif Lines, the Central Point option starts at the first stitch point in the first motif in
the line. The precise position of the point will vary, depending on the motif used.
Use these options to create mitered or pointed ends for your motif lines.
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Start Point
Use these options to change the type of line beginning for the Motif Line. Select a taper
type, then set the angle of the taper.
■

No Taper

■

Left Taper

■

Central Point

■

Right Taper
To set the Taper Angle

, click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the Motif Line. Select a taper type,
then set the angle of the taper.
■

No Taper

■

Left Taper

■

Central Point

■

Right Taper
To set the Taper Angle

, click the up and down arrows or enter a number.

Closed Border
Set the line as an open line or a closed line (a shape).
Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection
dialog is displayed.
See “Color Selection” on page 178.
Insert Color Change is only used when the line forms the border to a fill area.

Create a Flower with Motif Lines
1

2
3
4
5
6
7
8
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Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicFill_Motif fills'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign
Wizard” on page 79, and added two motif fills to in “Use Motif Fills in Two Petals” on page 198.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
Click the View tab, and ensure that Grid size is set to 5mm.
Click Edit Background
.
In mySewnet™ Draw & Paint, click the Insert tab.
In the Shapes drop-down list, select Shape 49, a flower.
Click Insert Shape
.
Click and drag inside the selection box to move the flower. Position it in the larger end of the petal on
the left.
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In the File menu, click Exit (or click Close in the mySewnet™ Draw & Paint window).
In mySewnet™ Digitizing, the View tab should still be open.
Click 2D View
.
This enables you to see the picture behind the fill area.
Click the Home tab.
In the work area, select the fill area for the petal on the left. It will also be highlighted in the FilmStrip.
With the blue Pattern Fill selected, click Delete
to delete it.
This removes the fill area from the petal so that we can create a flower using motif lines.
Click the Quick Create tab.
In the FilmStrip, select the blue color that was used for the fill.
Right-click in the FilmStrip and select Display Only From Start. All objects
after the blue color will be hidden. In the FilmStrip, you will be able to see a
blue color block and the violet colored fill.
In the Quick Create tab, deselect the Fill and Appliqué buttons.
In Line click the drop-down arrow and select Motif Line
.
In the Options section click Fill Area and Line. The Fill Area and Line
properties for Motif Line opens.
The line selection drop-down is grayed out (unavailable). The line type is set to
Motif Line, so only its properties are shown. After creating a line you may change
its type and properties.
Set the Motif Group to Universal, and the Category to Hand Stitches 1, Pattern 1, the desired chain
stitch pattern, is selected automatically.
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Set the Height to 1.5mm. The Width will automatically change to
3.0mm because Proportional is selected.
Click OK to close the dialog box.
Click QuickStitch™
.
Click along the edge of the flower. A dashed line of alternating
colors will appear around the flower, showing the area that is
selected for outlining with the Motif Line. Also, the Color Tolerance
dialog box will appear, with the Tolerance set to 10.
Use Color Tolerance to preview the area of the picture that defines the
new QuickStitch™ area or line. This is useful even when it is not
necessary to adjust the Tolerance value.
Click OK and a chain stitch line will appear around the flower. Rightclick to deselect the function.
You may need to click 3D View
in the View tab to see this more
clearly.
Click the Freehand Create tab.
Click Create Area or Line
. The pointer changes to a pen
.
Click and drag to draw a line from the flower up to the top right point of the petal.

Don’t worry if the line is wobbly, you will change it below.
Release the mouse button, or lift your pen from the tablet, and a chain stitch line will appear.
Right-click to deselect the function.
Select the line that you just drew and use the Zoom Bar to zoom in on the line.
Move the points (nodes) on the line to smooth it, making it into a gentle curve.
When you click on a square node it becomes round. Square nodes are used for straight sections, round for
curved sections. To make a node square, hold down the Shift key when you click on it.
If desired, use Insert Points
or Delete Points
in the Home tab to add or remove points from the
line. Right-click to deselect.
Use Life View
to preview the results, then click Cancel.
Double-click the second color (pale blue) in the color worksheet and the Color Selection dialog box
appears.
Alternatively, scroll up the FilmStrip and click the Color at the beginning of the light blue objects. Rightclick on the FilmStrip and select Properties.
Click Show All Thread Ranges, then click the drop-down arrow for the Thread Range and select
Robison-Anton Rayon Vari 40.
In the shade list, browse for 2365 (3CC Horizon) or enter 2365 in the Find Thread box. Click OK.
Click the Edit tab.
Click Display All Objects
and Zoom To Fit
.
Click Save
and browse to the folder Documents\mySewnet\My Designs.
Change the File name to 'PetalsMotif' and click Save.
Click Print
to print the embroidery worksheet.
Click Export Embroidery
and ensure that .vp4 is set as the file format. Click OK.
In the Save As dialog, browse to the folder Documents\mySewnet\My Designs and click Export. The
design is saved as PetalsMotif.
There is no need to change the file name, as it is taken automatically from the design file name.
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Change Satin Line to Motif Line in an Appliqué Petal
1

2
3
4
5
6
7
8

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicApplique’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on
page 81.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
, and ensure that Color Tolerance is selected
(checked), and that Tie Off Before and After Trims is selected.
Select the satin line for the petal on the left, then right-click to see the Fill
Area and Line dialog box.
In the Line drop-down menu at the top right, select Motif Line
. The
Line tab of the Fill Area and Line properties dialog box will appear.
Set the Motif Group to Universal, and the Category to Hand Stitches 2.
Pattern 1, the desired butterfly stitch pattern, is selected automatically.
Click Proportional so that it is no longer selected, then set the Height to
4.0mm.
Click OK. Click Life View
to see the effect, and click Cancel.
To change the inside of the middle petal to a QuiltStipple fill, see “Insert QuiltStipple Fill in a Petal” on
page 213.

Change Satin Line to Picot Motif Line
1

2
3
4
5

6
7
8

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'PetalsBasicApplique’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on
page 81.
Click the View tab, and ensure that Grid size is set to 5mm.
Click File, Preferences
, and ensure that Color Tolerance is selected (checked), and that Tie Off
Before and After Trims is selected.
In the Home tab, click to select Edit Points
.
Click the edge of the middle petal. Its nodes (points) are displayed.
In the status bar the stitch type is displayed as Satin Line Appliqué.
In the FilmStrip the objects should also be Satin Line Appliqué. You can select objects in the FilmStrip, or
press the right and left arrow keys to step through the objects in the design.
Right-click the work area to see the Fill Area and Line properties for this Satin Line.
In the Line drop-down menu at the top right, select Motif Line
. The Line tab of the motif line
properties will appear.
Set the Motif Group to Universal, and the Category to Hand Stitches 1.
mySewnet™ Digitizing Using Lines
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10
11

Click the drop-down arrow for Pattern and select Pattern 7, a buttonhole picot stitch.
Click the Fit To Line and Mirror options so they are selected. This will ensure that the shape of the
motif curves to follow the outline of the petal and the blanket stitch will be inside the picot edge.
Set the Stitch type to Triple.

12

Click OK.
Add a motif fill to the right petal in “Insert Motif Fill in an Appliqué Petal” on page 199.

1
2
3
4

In the Quick Create tab, ensure that Fill and Line are selected.
Ensure that Fill is set to Pattern Fill and Line is set to Satin Line.
Right-click the thread color in the FilmStrip and select Properties. Then set the thread to a pale color.
In the Options area, click Fill Area and Line and choose a pattern
for the Pattern Fill.
Click the Line tab and ensure that Width is set to 4mm.
Select (check) Insert Color Change, then click Line Thread
Color
and choose a medium color for the border.
Click OK to close the Fill Area and Line dialog box.
Select a shape from the drop-down list.
Click the Shape icon
. The shape is placed in the center of the
work area as a selected block.
Resize the shape as desired using the square corner handles.
Hold down Ctrl as you click and drag to resize proportionally. Hold
down Shift to resize from the center.
In the FilmStrip click the Pattern Fill shape to select it.
In the Home tab click Copy
, and then click Paste
This will place the copied shape on top of the original. Duplicate would place it slightly to one side.

Add a Triple Stitch Embellishment to a Satin Line

5
6
7
8
9
10

11
12
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Right-click the copy in the FilmStrip and select Properties from the
context menu.
In Fill, select No Fill
. The Line tab opens.
In the Line drop-down menu select Triple Stitch, then click Apply.
In the FilmStrip the second shape is now described as Triple Stitch.
This may take a few second to happen.
Note that the upper line exactly follows the line below.
Click Line Thread Color
and in the Color Selection dialog box
set the thread to a darker color.
Click OK twice to view the shape in the work area.
Click outside the design to see both lines clearly.
You could also embellish a satin line with a chain stitch or other motif
line.
Select both shapes in the FilmStrip, then in the Home tab click Group
This will keep the two lines together until Ungrouped.

.

No Border Line
No Border Line
is used where a fill area is desired without a border, for example an
area of QuiltStipple fill.
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Editing a Design

Use the Edit tab to view colors, to display and hide objects in the design, and to edit parts
of the design.
Set the properties for the selected object(s)
Set Start & End markers to display an object range
Create and manage fill patterns
Remove an enhancement from a fill area

Edit individual objects
Show selected objects
Display all objects in the design
Select objects similar to the one selected
Show only the previous or next color in the design Show and hide particular object types

After you have created an object such as a line, fill or hole, you may want to change its
properties; for example the motif size, fill pattern, appliqué fabric or stitch length. Click the
object to select it, then right-click it to change its settings in the properties dialog box. See
“Fill Area and Line Properties” on page 35.
To change an object within a group, select the object in
the FilmStrip, and then right-click it and select
Properties in the context menu.
If an object is difficult to select in the work area, select it in the
FilmStrip. Alternatively, click a nearby object in the FilmStrip and
then use the arrow keys to step through the objects until the
desired object is selected in the work area.
To change the properties of all visible objects of the selected type,
right-click in the FilmStrip and select Global Properties.

Select Objects
In mySewnet™ Digitizing, designs are made up of a
sequence of lines and areas (e.g. stitch lines, fills and
columns). Each area, line or column is defined by a
number of points that can be seen on the work area.
The selected object is highlighted in the FilmStrip in the
Design window.
To change the properties of all visible objects of the selected type,
right-click in the FilmStrip and select Global Properties.

Select a Place to Insert New Objects
To add stitch objects such as areas, lines and columns
between existing objects, select an object in the
FilmStrip or work area, then create the new object. The
new object is placed below the object that you
284

mySewnet™ Digitizing Editing a Design

Thread
Color
Bar

Object

Object
Type

Scroll
Bar

selected. If you select an object within a group, the new objects will be created as part of
that group.
Unless you choose a new color, the color of newly inserted objects will be the same as the object above
them.

Use the display options on the Edit tab or the right-click context menu to hide objects that
you do not want to change.
The color worksheet, object filters and Draw Range are also useful to isolate an object so
that it is easier to select the desired insertion point.

Insertion Markers
When a Freehand Create or Point Create tool is selected, a marker shows the location of
the last point of the preceding object. This is where new objects will be inserted:
■
■

■

When objects will be added to the end of the design, the marker is pink
.
When objects are to be inserted (i.e. the selected object is not the last object in the
design), the marker showing the final point of the selected object is green
.
When objects are to be inserted, an orange marker
in the next object in the design.

shows the position of the first point

Select an Object to Edit
In the work area, click on an individual object to show the points that make it up and
check what type it is in the Object Identification Box on the bottom right of the status bar.
The object is also highlighted in the FilmStrip. You may click the desired object in the FilmStrip and the
object will be selected on the work area.

If you click on an object in a group, the whole group will be selected and highlighted in
the FilmStrip. To select an object within that group, click on it in the FilmStrip.
To edit the shape of a selected object within a group, right-click on the work area to enter Edit Points mode.
Then adjust its shape.

After locating the desired object, click and drag its points to change the shape of the
object. In the Home tab you can insert extra points
, delete unwanted points
or
delete the object
.
Alternatively, right-click to access a dialog box to alter its properties, such as Fill Pattern or Stitch Length.

Stepping Through Designs
In Edit Points mode, use the left and right arrow keys on the keyboard to step through all
the objects in sequence. Alternatively, click an object in the FilmStrip and use the up and
down arrow keys on the keyboard to step through all the objects in sequence.
If you are in Box Select mode
, the selected object will move in the work area. Right-click on the work
area to enter Edit Points mode.
The color worksheet, object filters and Draw Range are also useful to isolate objects.
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How to Step Through Design Objects
1

2
3

4

In the Design window, ensure that Edit Points mode is selected.
In Edit Points mode the pointer is an arrow. If the Box Select pointer
can be seen, right-click to enter
Edit Points mode.
Click any object. Its points will be shown and the object type will be shown on the bottom right of the
status bar.
Use the right arrow key on the keyboard to select the next object. Its points are shown and the object
type is shown on the status bar. If you already have the last object in the design selected, it will
remain selected.
Use the left arrow key on the keyboard to select the previous object. Its points are shown and the
object type is shown on the status bar. If you already have the first object in the design selected, it will
remain selected.

Change Object Settings
How to Change Settings for a Single Object
1
2
3

Select the object in the work area or FilmStrip.
Right-click the object. The Area and Line properties dialog for the object is displayed.
In the Area and Line properties dialog make the desired changes.

1
2

Open the Design window.
To make it easier to select the desired object, use the color worksheet, or the Hide Object Types
buttons and slider bars in the Edit tab to hide other objects.
To select an object directly on the work area, click on the desired object, or click an adjacent object
then use the left and right arrow keys to step through to the required object (for example, to select a
color change).
To select an object with the FilmStrip, scroll through the FilmStrip and select the desired object, or
click any object and use the up and down arrow keys to step through the FilmStrip.
To change the properties of the selected object, right-click on the work area, or right-click on the
FilmStrip and select Properties. The properties dialog box for the object type will appear.
To change the properties of all visible objects of the selected type, right-click on the FilmStrip and
select Global Properties. (Alternatively, choose Select Similar from Visible, then Properties from the
FilmStrip context menu.) The properties dialog box for the object type will appear.
To change the properties of selected objects, hold the Ctrl key and click the desired objects in the
FilmStrip. Right-click one of the selected objects and select Properties. The properties dialog box for
the object type will appear.
To change properties of objects in only one group, choose select Similar from Group, then Properties from
the FilmStrip context menu.
To change the stitch type for the selected object, choose the desired object type from the line or fill
drop-down list in the Fill Area and Line dialog box. The properties for the new object type will appear.
Change the settings in the properties dialog box then click OK to apply the new settings. Click Cancel
if you decide not to save the new settings.
When you click OK for changing Global Properties or the properties for a number of selected objects,
all the settings in the dialog box will be applied to all visible or selected objects of that type.
Repeat as desired with other objects, then click Life View or Design Player to see the design as it will
be stitched.

Change Multiple Objects’ Settings

3

4
5
6

7

8
9
10
11
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Delete
Use Delete

to remove the currently selected object(s) from the design.

To delete commands, use the left and right arrow keys on the keyboard to step through all
the objects in sequence until the desired command is selected. Alternatively, select the
desired command using the FilmStrip.
The color worksheet, object filters and Draw Range are also useful for isolating objects.

Shortcuts
■
■

Home Tab:
Keys: Del; Alt, H, DE; Right-click FilmStrip, D

Delete an Object
1
2

Click the desired object in the work area or FilmStrip, or click near it and use the left and right arrow
keys on the keyboard until it is selected.
In the Home tab, click the Delete icon
(or press Delete on the keyboard) and the object is deleted.
If a gap is left by the deleted object, a movement stitch will be inserted.

Insert Commands
Use the FilmStrip to insert a new Color Change or Stop immediately after the selected
object. Right-click in the film strip, then select the desired option from the context menu
that appears.

Insert Color Command
Use Insert a Color Change
to insert a color change after the currently selected object.
The Color Selection dialog box appears so you can choose the new color.
See “Color Selection” on page 89.

Insert Stop Command
Use Insert a Stop

to insert a Stop command after the currently selected object.

A Stop will not be inserted if this would place two Stops together.

Change Objects’ Sequence
Objects may be moved up and down the FilmStrip with click and drag,
or with the arrow (Layout Order) buttons. This changes the order of the
objects, and hence changes the order in which the stitches are created for the final
embroidery.

Moving an Object With Click and Drag
1
2

To move an object with click and drag, click the desired object and drag it up or down the FilmStrip. A
bar moves up and down the list to show the new list position.
Release to drop the object at the desired point. Movement stitches are automatically inserted or
removed as needed.
If objects are dragged or inserted between two items in a group they will become part of that group, except
if they are inserted immediately after the group header. To insert at the beginning of the group, drag into
the middle, then move up.
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Moving an Object With the Layout Buttons
1
2

To move an object with the Layout Order buttons, click the desired object. It is highlighted in the
FilmStrip.
Click Move Backwards
to move the object one step up the FilmStrip (towards the first stitch
object in the design). A bar moves up the list to show the new position.
Move Forwards

3

will move the object one step down the FilmStrip. Move to Back

object the first to be stitched out, and Move to Front
Move the object to the desired position.

will make the

the last.

To move a selection of objects, either click the top of a sequence then hold the Shift key
and click the bottom of the desired sequence, or hold the Ctrl key and click the desired
objects. Then click the desired Layout Order button. Alternatively, use click and drag by
moving the bar up or down the list to the desired point, then release the mouse button.
If desired, use the color worksheet and Hide Object Types buttons to hide other objects. This can make it
quicker to move the desired object.

When using click and drag to move to a part of the list that is not visible, move the pointer
above the top or below the bottom of the list and the list will scroll automatically. To scroll
faster, move the pointer further above or below the list. Move the pointer back into the list
to stop scrolling.
Moving an object up and down the FilmStrip does not change the position of the object
on the work area. However, it may change the appearance of the design according to
whether or not it changes the overlap with adjacent objects.
The first color change may not be moved in the FilmStrip. Also, no object may be moved above the first
color change in the FilmStrip, except another color change. This ensures that the initial color change in the
design cannot be removed, and nothing can be moved before it, but it can be replaced.

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.

Move Forwards
Move Forwards

brings the object one step down the FilmStrip.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl + [; Right-click FilmStrip, L, F

Move Backwards
Move Backwards

brings the object one step up the FilmStrip.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl + ]; Right-click FilmStrip, L, B

Move to Front
Move to Front

288

places the object at the bottom of the FilmStrip or Group.
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Shortcuts
■
■

FilmStrip:
Keys: Ctrl + Shift + [; Right-click FilmStrip, L, N

Move to Back
Move to Back

places the object at the top of the FilmStrip or Group.

Shortcuts
■
■

FilmStrip:
Keys: Ctrl +Shift + ]; Right-click FilmStrip, L, C

Reveal Groups
Use Reveal Groups
to switch between viewing the objects within Groups in the
FilmStrip, and seeing only the Group heading rows in the FilmStrip.
Deselect Reveal Groups to aid in moving groups within the design.

Shortcut
■

FilmStrip:
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Edit Lines and Areas
The shape of a line or area can be changed by moving the points that define its outline.

To choose a different object, click it on the work area or the FilmStrip. Alternatively, use the
left and right arrow keys to step through the objects in the order they are used in the
design. When selecting an object directly on the work area, click near one of the points
that define it.
If the visible colors or the object filters are changed, the last visible object is automatically selected.
Therefore, change the view of the design before selecting the object you wish to edit. See “Viewing Pictures
and Designs” on page 85.

When the desired line or area is selected, its points can be
moved. The points are shown as small circles or squares. Some
stitch object types, such as Single Stitches have a fixed number
of points.
Square points are used for straight sections and corners. Round points are
used for curves.

Other objects, such as fill areas, running stitch and satin lines,
can have any number of points, and points may be inserted
and deleted, allowing greater control over their shapes. The
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A Single Stitch is defined
by two points

start and end points for fill and satin areas can be changed, typically to reduce the need
for trimming. Satin areas have angle lines that are used to control the satin angle.
End Marker
End
Marker

Start
Marker
Origin
Marker

Start
Marker

Fill areas have as many points as needed to
define their outlines, and also have
moveable start, end and origin markers

Stitch Angle
Lines

Satin areas have movable start and end
markers and adjustable stitch angle lines

Color change and stop commands, and alignment stitches are shown as a single point
when selected.

Move Points
The points that define the currently selected stitch object (satin
column, fill area, running stitch, etc.) are shown as small squares
and circles.
Also, the object type is shown in the FilmStrip and on the status
bar. The FilmStrip also shows the shape of stitch objects, where
relevant. The points used to start and end fill and satin areas are
shown by the start
and end
markers. Some types of fill
areas also have an origin, marked by a orange circle
(for
Pattern Fill, the marker has a handle). Satin areas also have stitch
angle lines with hexagonal ends.
To choose an object to edit, click it on the work area or the FilmStrip. Alternatively, use the left and right
arrow keys to step through the objects in the order they are used in the design. When selecting an object
directly on the work area, click near one of the points that define it.

Once the points are shown, click and drag the squares or circles to move them.
Moving the points that define a satin area may also affect the stitch angle lines, but moving the stitch
angle lines does not affect the shape of a satin area.

Edit Points
Use Edit Points
to enable the moving and editing of an object’s points if another
function is being used. Alternatively, click an object to select it and you will be in Edit
Points mode.

Shortcuts
■

Home Tab, Points; Status Bar:
mySewnet™ Digitizing Editing a Design
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■

Keys: Enter; Alt, H, E

Select and Move Points
1
2
3

In the Home tab, click Edit Points
.
Click an object in the FilmStrip, or on the work area, to select it and view its points.
Drag the points to change the shape of the object.
Moving the points that define a satin area may affect the stitch angle lines, but moving the stitch angle
lines will not affect the shape of a satin area.

Make Lines Straight or Curved
The outlines defining most types of lines and areas can have both curved and straight
sections:
To have any curves, lines must be defined by at least four points. The first point of a fill or
satin area is always a 'corner' (square) point. The first and last pair of points for a column
are always square.
To change a curve (round) point to a square point, hold down the Shift key and click the
point without moving it. When adjacent points are corners, the line between them will be
straight. This is useful if, for instance, a point was not added as a corner at the desired
place on a fill area or stitch line.

Point is a curve

Point is a corner after Ctrl + click

To change a corner point to a curve (round) point, simply click the point without moving
it. There must be at least two round points next to each other to make the lines curved, so
if there is one round point between two square points then the lines to the round point
will be straight.
If a line does not have enough points to make the desired section curved, use Insert Point
extra point to use for the curve.

to add an

Move the Start and End Points for Areas
The start and end points for fill and satin areas are shown by circular markers. The start
marker
is on the inside of the object, and the end marker
is on the outside of the
object.
Click and drag the desired marker. Move the marker to the point that you wish to use as
the new start or end point of the area. Drop at the desired point and the position of the
marker will change.
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The marker snaps to the nearest point on the edge of the object. If an area does not have a point in the
desired position, use Insert Points

to add an extra point.

Move the Origin for Areas
Some types of fill areas have an origin, marked by a orange
circle
. This is used to move the start point for the pattern
in a pattern fill, or the center point for Radial fill, Spiral fill and
Shape fill types. For a pattern fill, the origin has a handle for
adjusting the angle of the fill.
This means that in a pattern fill area you can control how the pattern is
repeated, and its angle.

For Radial fill, Spiral fill and
Shape fill areas, the origin can be
moved. This sets the start point
for the fill, such as the point from
which stitches radiate on a
Radial fill.
The origin can be moved
anywhere on the design area.
This allows you, for example, to
create several of the same types
of fill area with a common origin.
Simply move the origin to the same grid position for all the desired areas, so that the
pattern of stitches is unified across the chosen areas.

Change the Stitch Angle for Satin Areas
Satin areas have stitch angle lines that show and adjust
the angle of the stitches across the area. The stitch
angle lines have hexagonal handles at each end that
are used to adjust each line individually.
Click and drag the desired hexagonal handle. Drop at
the desired point and the position of the angle line will change. If the line does not move,
this is because the new end point is not usable. This will happen if, for example, you
attempt to force two angle lines to cross each other within the area.

Delete Angle Lines
To delete angle lines, click Delete Points
then click the hexagon at either end of the line
to be deleted. Right-click when you have finished deleting angle lines and/or points.
A satin area must have at least one angle line. Therefore, the last angle line may not be deleted.
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Insert Points
Use Insert Points

to add a new point to the currently selected line.

Points may be inserted into all line and area types except Single Stitch. With this object type Insert Points
and Delete Points are not available. For columns, a pair of points will be added.
Points may also be inserted into emboss lines and MultiWave lines.

Click the Insert Points icon , then click the position on the selected object where you
want to add the point. Also use Insert Points
to add stitch angle lines to satin areas
with click and drag.

Shortcuts
■
■

Home Tab, Points:
Keys: Ctrl + Shift + D; Alt, H, IP

Insert a Point in a Line
1
2
3

4

5
6
7

Click the desired object to show the points that make it up.
Click the Home tab.
Click the Insert Points icon
, then click the place on the outline of the object where you want to
add the new point.
The Insert Points icon is only available for objects that can have points inserted.
To add a stitch angle line to a satin area, click and drag to draw a line across the desired section of the
area. If the angle line does not appear, then it is not allowed in the place you attempted to draw it.
A stitch angle line cannot cross another stitch angle line. New lines must be added roughly parallel to the
existing lines.
Right-click to deselect Insert Points.
Click and drag to move any of the points in the object to alter its shape.
If desired, click the Insert Points icon
again and repeat.

Delete Points
Use Delete Points

to delete points from the currently selected line.

Points may be deleted from all line and area types except Single Stitch. With this object type Insert Points
and Delete Points are not available. For columns, a pair of points will be deleted.
Points may also be deleted from emboss lines and MultiWave lines.

Click the Delete Points icon , then click the points on the selected object that you want
to delete. Stitch angle lines can be removed from satin areas by clicking the hexagonal
control point at either end of the line. Right-click to finish.
You may not delete all the points for an object. A fill or satin area must have at least three points. Satin
border, motif lines and running, double and triple stitch lines must have at least two points. A satin area
must also have at least one angle line. To remove all the points for an object, use Delete

Shortcuts
■

Home Tab, Points:
Keys: Ctrl + D; Alt, H, DP

1
2

Click on an object to show the points that make it up.
Click the Home tab.

■

Delete a Point in a Line
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.

3

4
5
6

Click the Delete Points icon
, then click the points you wish to delete. They will be removed and
the object will change shape accordingly. To remove an angle line for a satin area, click the hexagonal
control point at either end of the line.
Right-click to deselect the function.
The Delete Points icon is only available for objects that can have points deleted.
Click and drag to move any of the points in the object to alter its shape.
If desired, click the Delete Points icon
again and repeat.

Convert Points and Bezier Lines
Use the Convert Points
functions to change between types of points in a line in Bezier
Mode, or to change a Point Line to a Bezier Line, or a Bezier Line to a Point Line.
For information on how to draw and adjust Bezier Lines, see “Bezier Mode” on page 149.

Shortcuts
■
■

Home Tab, Points:
Keys: Alt, H, CP

Convert Points to Corner
Use Convert Points to Corner
to change the selected point in a Bezier line to a Corner
point (a point with no handles). Right-click to deselect the function.

Shortcuts
■
■

Home Tab, Points:
Keys: Alt, H, CP, CP

Change a Bezier Mode Point to a Corner Point
1
2
3
4
5
6
7
8

Click on an object created in Bezier Mode to show the points that make it up.
Click the Home tab.
In the Convert Points
drop-down menu in the ribbon bar, select Convert Points to Corner
.
Edit Points
is no longer highlighted.
Move the pointer over one of the points in your object. The pointer changes to the Convert Points to
Corner pointer
.
Click on the point. It now has no handles, and the sections of the line by it are straight.
Click to adjust any other points that you want to change in your design.
Right-click to deselect the function.
Edit Points is highlighted again.
If desired, click the Convert Points to Corner
again and repeat.
For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 151.

Convert Points to Smooth
Use Convert Points to Smooth
to change the selected point in a Bezier line to a Smooth
point (a point with handles that can be adjusted independently). Right-click to deselect
the function.

Shortcuts
■
■

Home Tab, Points:
Keys: Alt, H, CP, CT
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Change a Bezier Mode Point to a Smooth Point
1
2
3
4
5
6
7
8

Click on an object created in Bezier Mode to show the points that make it up.
Click the Home tab.
In the Convert Points
drop-down menu in the ribbon bar, select Convert Points to Smooth
.
Edit Points
is no longer highlighted.
Move the pointer over one of the points in your object. The pointer changes to the Convert Points to
Smooth pointer
.
Click on the point. It now has two handles, and the dashed line between them is straight.
Click to adjust any other points that you want to change in your design.
Right-click to deselect the function.
Edit Points is highlighted again.
If desired, click the Convert Points to Smooth
again and repeat.
For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 151.

Convert Points to Symmetric
Use Convert Points to Symmetric
to change the selected point in a Bezier line to a
Symmetric point (a point with handles that are the same distance from the point). Rightclick to deselect the function.

Shortcuts
■
■

Home Tab, Points:
Keys: Alt, H, CP, CS

Change a Bezier Mode Point to a Symmetric Point
1
2
3
4
5
6
7
8

Click on an object created in Bezier Mode to show the points that make it up.
Click the Home tab.
In the Convert Points
drop-down menu in the ribbon bar, select Convert Points to Symmetric
.
Edit Points
is no longer highlighted.
Move the pointer over one of the points in your object. The pointer changes to the Convert Points to
Symmetric pointer
.
Click on the point. It now has two handles at an equal distance from the point, with a straight dashed
line between them.
Click to adjust any other points that you want to change in your design.
Right-click to deselect the function.
Edit Points is highlighted again.
If desired, click the Convert Points to Symmetric
again and repeat.
For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 151.

Convert to Point Line
Use Convert to Point Line to change the selected Bezier Line to a Point Line.
The change takes place immediately.
The Bezier lines in a Column cannot be changed to a Point Line. See “Draw a column with Bezier Curves” on
page 248.

Shortcut
■

Keys: Alt, H, CP, CL

1

Click on an object created in Bezier Mode.
The Bezier lines in a Column cannot be changed to a Point Line.

Change a Bezier Line to a Point Line
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2
3

4

Click the Home tab.
In the Convert Points
drop-down menu in the ribbon bar, select Convert to Point Line.
The line changes to a standard Point Create line immediately.

Curved points are added to the line when it is converted. If you change your mind, use Undo rather than
converting back.
If desired, select another object and click Convert to Point Line again to repeat.

Convert to Bezier Line
Use Convert to Bezier Line to change the selected Point Line to a Bezier Line. The change
takes place immediately.
A smoothly drawn line with the minimum of points is more likely to produce a good result.

Shortcut
■

Keys: Alt, H, CP, CC

Change a Point Line to a Bezier Line
1

2
3

Click on an object created in Point Mode.
This is an object that was created with Quick Create, Freehand Create or drawn
by placing points in Point Create.
Click the Home tab.
In the Convert Points
drop-down menu in the ribbon bar, select Convert
to Bezier Line. The line changes to a Bezier line immediately.
If you change your mind, use Undo rather than converting back.
The number of points in the Bezier line will depend on the number of points in
the original line. Delete points and adjust the handles on the remaining points
to optimize the Bezier line.
If desired, select another object and click Convert to Bezier Line again to
repeat.

Delete
Use the Delete
drop-down menu on the Edit tab to delete one
or more holes or emboss lines from the currently selected area, or one or more MultiWave
lines from the currently selected MultiWave Fill area.

Delete Hole
Use Delete Hole
to delete one or more holes from the currently selected area. Rightclick when you have finished deleting holes.

Shortcuts
■
■

Edit Tab, Object:
Keys: Alt, E, D, H
mySewnet™ Digitizing Editing a Design
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Delete a Hole in an Area
1
2
3
4
5
6

Click on a fill area containing one or more holes.
Click the Edit tab.
In the Delete drop-down menu, click Delete Hole
.
Click the hole you wish to delete. The hole is removed.
Right-click to deselect the function.
The Delete Hole icon is only available for objects that can have holes deleted.
If desired, click the Delete Hole icon
again and repeat.

Delete Emboss Line
Use Delete Emboss Line
to delete one or more embossed lines from the currently
selected area. Click any node point on the line to be deleted. Right-click when you have
finished deleting emboss lines.

Shortcuts
■
■

Edit Tab, Object:
Keys: Alt, E, D, E

Delete an Embossed Line on an Area
1
2
3
4
5
6

Click on an area containing one or more embossed lines.
Click the Edit tab.
In the Delete drop-down menu, click Delete Emboss Line
.
Click a node point on the line you wish to delete. The embossed line will be deleted.
Right-click to deselect the function.
The Delete Emboss Line icon is only available for objects that can have embossed lines deleted.
If desired, click the Delete Emboss Line icon
again and repeat.

Delete MultiWave Line
Use Delete MultiWave Line
to delete one or more MultiWave lines from the currently
selected MultiWave Fill area. Click any node point on the line to be deleted. Right-click
when you have finished deleting MultiWave lines.

Shortcuts
■
■

Edit Tab, Object:
Keys: Alt, E, D, W

Delete a MultiWave Line from a MultiWave Fill Area
1
2
3
4
5
6

Click on a MultiWave Fill area containing one or more MultiWave lines.
Click the Edit tab.
In the Delete drop-down menu, click Delete MultiWave Line
.
Click a node point on the line you wish to delete. The MultiWave line will be deleted.
Right-click to deselect the function.
The Delete MultiWave Line icon is only available for objects that can have MultiWave lines deleted.
If desired, click the Delete MultiWave Line icon
again and repeat.

Break Apart
Use Break Apart

298

to break apart a fill area with a border into a separate line and fill area.
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Use this feature to duplicate individual parts of an area, or for fine adjustments. For
example, use it to change the stitch length of an Appliqué placement line from the default
of 2.0mm.

Shortcut
■

Keys: Alt, E, B

Break Apart an Area with a Border into a Line and a Fill
1
2
3
4

Click the Edit tab.
Click on a fill area with a border.
Note that in the FilmStrip the area is listed as a single item, e.g. Pattern Fill.
Click Break Apart
. The selected area will be separated into a fill and a line, together with color
commands if the line is a different color.
If desired, select another fill area and click Break Apart again to repeat the process.

Reverse Functions
Reverse Column End to End
Reverse the order of all the points defining a column so that the start becomes the end,
and vice versa.
This option is only available when a column is selected.

Shortcut
■

Keys: Alt, E, R, E

Reverse Column Side to Side
Swap each pair of points within a column.
Thus, if a column started with a left point and ended with a right point, then all right
points would be swapped to become left points. The column would then start on the right
and end on the left.
This option is only available when a column is selected.

Shortcut
■

Keys: Alt, E, R, S

Reverse Line
Reverse the order of the points defining a line so that the start becomes the end, and vice
versa.
This option is only available when a line is selected.

Shortcut
■

Keys: Alt, E, R, L

Select a Block of Objects
The select functions on the Home tab allow you to select a block of objects. A selected
block of objects can be resized, rotated, mirrored, moved, copied and cut. You may find it
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easier to select a block when you have selected colors to display and/or changed the
range of objects that are visible.
When a block has been selected, it has a selection box around it on the work area. The
selection box has blue handles which are used to resize, rotate and flip the block.
Flip Vertical Handle
Resize
Handle
Flip
Horizontal
Handle

Rotate
Handle
Center of
Rotation

The handles are blue because you can freely manipulate the selection without changing density or stitch
length in the objects. This is because the stitches are only generated when you use Export Embroidery.

Click and drag inside the block to move it. Click and drag the square corner handles to
resize the block. Hold down the Ctrl key as you click and drag to resize proportionally.
Hold down Shift to resize from the center. Click and drag the round rotate handle to
rotate the block freely. Click and drag the center of rotation
to rotate around a different
point. Click the triangular handles to flip the block horizontally
or vertically
.
When making a selection, only objects that are completely enclosed by the selection line will be included in
the selection. You will often need to cross Running stitches to make a selection. These objects would not be
included because you have not completely enclosed them.

Inserting or Pasting a Block
When a new selection is added to a design by paste or one of the insert functions, it is
automatically selected as the current block and Box Select is activated.

Deselecting a Block
Click the work area outside a block to deselect it. The selection box around the block will
disappear. Right-click to deselect a block and also turn off the current select function.

Select Last Visible
Use Select Last Visible
on the FilmStrip to select the last object that has not been
hidden by Color Select, any of the object Filters, or the End slider.
Use Select Last Visible to ensure that new objects that you create appear at the end of your design.

Shortcut
■
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Box Select
With Box Select , click and drag to draw a rectangle around the area you want to select.
When you lift the pen or release the mouse button, the block will show you the extent of
your selection. Right-click to deselect. Only objects that are completely enclosed by the
selection line will be selected.
Use Add to Selection
From Selection

with any select function to increase the area of selected objects, or use Remove

to make the currently selected area smaller.

Box Select is also activated automatically when a block is pasted into a design.

Shortcuts
■
■

Home Tab, Select; Status Bar:
Keys: Alt, H, B

Use Box Select
1
2
3
4
5
6

If desired, use the FilmStrip, Draw Range sliders, Filters and color worksheet to hide objects so that it
is easier to see the required objects.
Click the Box Select icon
.
Click and drag to draw a rectangle around the required objects.
Lift the pen or release the mouse button when the required objects are enclosed. They will become
the current selection, indicated by a rectangle with blue handles.
If you want to make a new selection, click outside the current selection to deselect it. Then draw a
new box around the required objects.
Right-click to cancel the Box Select tool, which will also deselect any selected objects.

Point Select
With Point Select , click a series of points to create an irregular outline of straight or
curved lines around the desired area. Click Point Select and the pointer changes to the
Point select pointer . Click a series of points to create an irregular outline of straight or
curved lines around the desired area, using Ctrl+click to place a square (straight line)
point. Click and drag
to reposition an existing point. Click Delete to remove the last–
placed point. Right-click when the area is complete. The selection box will show you the
extent of the block. Point Select may be easier to use than Freehand Select for precise
selections. Click to deselect. Only objects that are completely enclosed by the selection
line will be selected.
Use Add to Selection
From Selection

with any select function to increase the area of selected objects, or use Remove

to make the currently selected area smaller.

Shortcuts
■
■

Home Tab, Select; Status Bar:
Keys: Alt, H, FP

Use Point Select
1
2
3

If desired, use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to
hide objects so that it is easier to see the required objects.
Click Point Select
. The pointer changes to the Point pointer
.
Click to place the first point for the selection. A yellow node appears.
mySewnet™ Digitizing Editing a Design
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4

5
6

7
8

Click to place a series of points around the desired area.
As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.
Use Ctrl+click to place square nodes for straight lines.
Move the pointer over one of the nodes on the line. The pointer changes to the Move Node
pointer
. Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.
If you click while the Point pointer
is active, another point will be added to the line.
When your line is as desired, right-click to surround the area with a selection box.
Right-click to deselect Point Select.

Freehand Select
With Freehand Select , click and drag to draw an irregular outline around the desired
area. When you lift the pen or release the mouse button, the area is closed automatically
with a straight line between the last pointer position and the start position. The block will
show you the extent of your selection. Right-click to deselect. Only objects that are
completely enclosed by the selection line will be selected.
Use Add to Selection
From Selection

with any select function to increase the area of selected objects, or use Remove

to make the currently selected area smaller.

Shortcuts
■
■

Home Tab, Select; Status Bar:
Keys: Alt, H, FS

Use Freehand Select
1
2
3
4
5
6

If desired, use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to
hide objects so that it is easier to see the required objects.
Click the Freehand Select icon
.
Click and drag to draw a line around the required objects. The objects inside the line will become the
current selection, indicated by a rectangle with blue handles.
The line is closed automatically in a straight line between your start point and end point. If you are
not close enough to your start point then you could leave out some desired objects by accident.
If you want to make a new selection, click outside the current selection to deselect it. Then draw a
new line around the required objects.
Right-click to cancel the Freehand Select tool, which will also deselect any selected objects.

Select All Visible
Select All Visible
is a one-click function that selects all visible objects in the design.
Right-click to deselect.

Shortcuts
■
■

302

Home Tab, Select; Status Bar:
Keys: Alt, H, SA
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Use Select All Visible
1

2
3
4

Use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to hide objects
so that only the required objects are visible. Alternatively, for selecting a single object for adjustment,
click the desired object in the FilmStrip, either right-click the FilmStrip and click Display Only Selected
so that only the chosen object is visible, or click Only Selected
in the Edit tab.
Click the Select All Visible
icon.
The currently visible objects will become the current selection, indicated by a rectangle with blue
handles.
Right-click to cancel the Select All Visible tool, which will also deselect any selected objects.

Select None
Use Select None
the hoop.

to deselect all of the objects in the work area, including any outside

Use the color worksheet and the Draw Range to select which objects are visible in the
current design. This is useful to isolate particular objects, especially if they are more than
one color, or you only wish to apply a function to part of an area.

Shortcuts
■
■

Home Tab, Select; Status Bar:
Keys: Alt, H, SN

Replace Selection
Use Replace Selection

to replace the currently selected objects with the new selection.

Replace a Selection
1
2
3

Place several objects on the work area.
Use Box Select
(or another of the selection tools) to select some of these objects.
With Replace Selection
selected, click Box Select
and select some different objects.
The new selection replaces your old selection.

Shortcuts
■
■

Home Tab, Select:
Keys: Alt, H, RS

Add To Selection
Use Add to Selection

to add the new selection to the currently selected objects.

Add to a Selection
1
2
3

Place several objects on the work area.
Use Box Select
(or another of the selection tools) to select some of these objects.
With Add to Selection
selected, click Box Select
and select some different objects.
The new selection is added to your old selection.

Shortcuts
■
■

Home Tab, Select:
Keys: Alt, H, A
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Remove From Selection
Use Remove from Selection
objects.

to remove the new selection from the currently selected

Remove from a Selection
1
2
3

Place several objects on the work area.
Use Box Select
(or another of the selection tools) to select some of these objects.
With Remove From Selection
selected, click Box Select
and select some of the objects within
your selection.
The new selection is removed from your old selection.

Shortcuts
■
■

Home Tab, Select:
Keys: Alt, H, RF

Multiple Select and Groups
Multiple Select
Use multiple select to select more than one object at a time.
In the FilmStrip, hold down the Ctrl key and click the desired objects. A selection box will
be placed around the selected objects. Alternatively, use one of the multiple select tools in
the Select area.
The selected objects are surrounded by a selection box with a solid outline, and blue
handles. Lettering, SuperDesigns and inserted embroideries retain their orange (Group)
handles. The whole selection can be scaled, rotated and mirrored.
If you click outside the selection box, the designs will become separate. Use Undo
to recreate the multiple selection.

, or select them again

Grouping Selected Objects
In mySewnet™ Digitizing, you can edit objects individually, in a selected block, or in
groups which remain as a selection after saving. To reshape or change the properties of an
individual object inside a group, select it on the FilmStrip.
When a design including groups is loaded using Insert
together, ready for moving, resizing and so on.
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or Open

, all sections will be grouped

Group
Use Group
to make a more permanent group of all the currently selected objects. Use
Group to group the objects permanently, or to make a temporary Group while moving or
editing them.
A group can be modified in the same way as a selection.
You can move, resize, mirror and rotate it.

Group
can only be used in conjunction
with one of the selection tools.
The grouped objects are surrounded by a
selection box with a solid outline, and orange
handles. The group can be scaled, rotated and
mirrored.
If you click outside the selection box, and then click one
of the objects within the group, the objects will still be
grouped.

Shortcuts
■
■

Home Tab, Group:
Keys: Alt, H, G; Right-click FilmStrip, G

Ungroup
Use Ungroup

to split the currently selected group into the objects which make it up.

Ungroup can only be used when a group is selected.

Shortcuts
■
■

Home Tab, Group:
Keys: Alt, H, U; Right-click FilmStrip, N

Select Similar from Visible
Use Select Similar from Visible
to select all visible objects with similar properties (i.e.
the same name in the FilmStrip); for example, select all Radial Fill areas, or all Satin Lines.
It will select all Pattern Fills, whether or not they have a border, but not select Pattern Fill
Appliqué areas at the same time as Pattern Fill.

Shortcuts
■
■

Edit Tab; FilmStrip Context Menu:
Keys: Alt, E, M, V; Right-click FilmStrip, V

Select Similar from Group
Use Select Similar from Group to select all objects with similar properties (i.e. the same
name in the FilmStrip) that are in the same Group.
Objects with similar properties that are in a different Group, or in no Group will not be selected.
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Shortcuts
■
■

Edit Tab; FilmStrip Context Menu:
Keys: Alt, E, M, G; Right-click FilmStrip, U

Modify a Block of Objects
Move a Block of Objects
Move a selected block using click and drag, or nudge. Click inside the block and drag it to
the required position, or use the arrow keys to nudge it into place. When a block is moved,
movement stitches are inserted before and after the block to connect it to the previous
and following objects.
If you accidentally move the center of rotation, simply click and drag inside the selection box again.

How To Move a Block of Objects
1
2
3
4

Click anywhere inside the selection and drag it to the required position. The rectangle around the
selection will be dragged with the pointer.
Lift the pen or release the mouse button to drop the selection in place. The selected objects will be
redrawn in their new location.
Alternatively, use the arrow keys to nudge the selection into position, then click outside the block to
place it.
When you move a selection, you may sometimes move the center of rotation by accident. Simply
release the center of rotation, then click and drag the selection as usual. The center of rotation will
snap back to the center of the selection when you drop the selection in its new position.

Resize a Block of Objects
Click and drag one of the blue square corner handles to resize. Hold down Ctrl as you click
and drag to resize proportionally.

How To Resize a Block of Objects
1
2
3

If you want to keep the selected objects in proportion, hold down the Ctrl key.
Click and drag any of the square resize handles.
Lift the pen or release the mouse button, and then release the Ctrl key if you used that to keep the
proportions. The selection will be redrawn at its new size.

Mirror a Block of Objects
Mirror a block of stitches vertically or horizontally using the blue flip handles on the block
selection box.

Horizontally Flip Block
Click the Flip Horizontal handle

to mirror a block horizontally.

Vertically Flip Block
Click the Flip Vertical handle
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to mirror a block vertically.
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Rotate a Block of Objects
Click and drag the rotation handle to rotate the block freely to any angle.
Flip Vertical Handle
Resize
Handle
Flip
Horizontal
Handle

Rotate
Handle
Center of
Rotation

If desired, move the center of rotation before rotating the block.
The selection box around the block is rotated around the center of rotation. The block will
be redrawn in its new position.

Move the Center of Rotation
The center of rotation
is initially shown in the middle of the block. Click on or within
the center of rotation, then drag it to any position in the design. This changes the pivot
point around which the block rotates.
When the block is moved or resized, the center of rotation is returned to the center of the block.

Rotate 45 Degrees
Use Rotate 45
to rotate the selected block of objects in 45 degree steps. If desired,
move the center of rotation
before rotating.

Shortcuts
■
■

Home Tab:
Keys: Alt, H, R4

Modify Block
Use Modify Block
to open the Modify Block dialog, where you can show and change
the size, rotation and skew of the currently selected block.
If no objects are selected, the whole design will be modified.

Shortcuts
■
■

Tools, Home Tab:
Keys: Alt, H, M, M
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Modify Block
Use the Modify Block
dialog box to show and change the
size and rotation of the currently selected block.
Modify the currently selected block as desired, then click OK
to show your changes in the work area.
Click Undo

to reverse your changes.

Size
Height and Width %
Show and change the height
the currently selected block.

and width

percentage of

The size in millimeters to which the block will be changed is
shown to the right.

Proportional
Use this option to keep the relative Height and Width in proportion when either is
changed.

Rotate
Angle
Enter an angle, from 0 to 359 degrees, in the Angle box. The preview shows the selected
angle.
If desired, move the center of rotation

before rotating.

Resize a Bicycle Design
1

2
3
4

5
6
7

8
9

308

Click File, New
, or File, New Window
, and in the Choose Design Type page of the
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page,
click Load a Design
, browse to the folder Documents\mySewnet\Samples\Digitizing\Edo, and
load the file 'Bicycle’.
Ensure the Home tab is selected, and click Box Select
.
Click and drag to draw a rectangle around the bicycle.
Release the mouse button and the bicycle is surrounded by a
selection box with blue handles.
The blue handles indicate that when the size of the design is changed it
will be resized. The stitches are recalculated to maintain the original
density.
Note the number of stitches in the design. You can see this in the
Information area on the Design panel.
Click Modify Block
. The Modify Block dialog box appears.
In the Size section, ensure Proportional is checked, then change
Height percentage
to 75%.
The Width percentage will increase by the same amount.
Click OK. The bicycle decreases in size, and the number of stitches is
reduced from 23606 to approximately 17842.
Left-click outside the select box to deselect the design.
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Scale to Fit Hoop
Use Scale to Fit Hoop
to resize the design in the work area proportionally, to fit within
the boundaries of the hoop, centered in the hoop. This is useful to resize a whole design to
fit in a different hoop, although you need to consider whether to change settings or stitch
types. For example, if you enlarge a design, it may be beneficial to add a pattern to wide
satin columns.
The whole design will be resized, including hidden areas.

Shortcuts
■
■

Home Tab, Modify Block:
Keys: Alt, H, M, S

Change Design Size
Use the Change Design Size
dialog box to alter a design
automatically to a new size, allowing for the stitch objects used.
Resize the design to the desired width or height, then click OK to
show your changes in the work area.
Click Undo

to reverse your changes.

It is not possible to resize the design to a size greater than the
selected hoop. If a larger size is entered, the design will be scaled to fit the selected hoop,
and a warning message displayed. To enlarge the design more, select a bigger hoop
before using Change Design Size.

Size
Enter the desired Width or Height in millimeters.
Select Width or Height to select the dimension to use when resizing.

Shortcuts
■
■

Home Tab, Modify Block:
Keys: Alt, H, M, C

Cut, Copy and Paste Objects
Once objects have been selected with Box Select, Point Select, Freehand Select or Select
All Visible, they can be cut and copied. Only objects that are completely enclosed by the
selection line will be selected. The selection of objects on the clipboard can be pasted as
many times as desired in the Design window, or into a separate mySewnet™ Digitizing
window.

Cut a Block of Objects
Use Cut
to cut out the selected objects and place them on the clipboard. The selection
can then be pasted back in.
Use Delete

to remove a block of objects from the design. See “Delete” on page 287.
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Shortcuts
■
■

Home Tab:
Keys: Ctrl + X; Alt, H, CU; Right-click FilmStrip, T

Copy
Use Copy
to Copy the selected objects to the clipboard, without affecting the current
selection. The selection can then be pasted back in. If no objects are selected, the whole
design will be copied.
Use Copy Embroidery to copy the whole design to another mySewnet™ Embroidery Software module.

Shortcuts
■
■

Home Tab:
Keys: Ctrl + C; Alt, H, CO; Right-click FilmStrip, C

Paste a Block of Objects
Use Paste
in the Home tab to paste the objects on the clipboard back into the design,
or into a separate mySewnet™ Digitizing window. The first object in the block is placed in
the same position on the work area after the selected object or the last visible object in
the design.
Color Changes are only transferred if they are within the copied block. If there are no Color
Changes in a pasted block then all the objects will use the thread color already in use
where the block is pasted.
Embroideries that have been copied from other mySewnet™ Embroidery Software modules may not be
pasted into mySewnet™ Digitizing, because they are not copied as objects. However, you may use Insert
Embroidery
to import embroideries from other mySewnet™ Embroidery Software modules, and you
can move a design from mySewnet™ Digitizing to another mySewnet™ Embroidery Software module with
Copy Embroidery .

Shortcuts
■
■

Home Tab, Paste drop-down:
Keys: Ctrl + V; Alt, H, PA; Right-click FilmStrip, P

Paste Into Center
Use Paste, Paste Into Center
in the Home tab to paste the objects on the clipboard into
the center of the work area. The first object in the block is placed after the selected object
or the last visible object in the design.
Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a
pasted block then all the objects will use the thread color already in use where the block is pasted.

Shortcuts
■
■
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Home Tab, Paste drop-down:
Keys: Ctrl + Shift + V; Alt, H, P, PI
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Paste and Replace
Use Paste and Replace in the Home tab Paste drop-down to paste the objects on the
clipboard, replacing the currently selected objects.
Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a
pasted block then all the objects will use the thread color already in use where the block is pasted.

Shortcuts
■
■

Home Tab, Paste drop-down
Keys: Alt, H, P, PR

Paste Into New Window
Use Paste Into New Window in the Home tab Paste drop-down to paste the objects on the
clipboard into a new window.
Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a
pasted block then all the objects will use the default thread color.

Shortcuts
■
■

Home Tab, Paste drop-down
Keys: Alt, H, P, PW

Clipboard Block
When objects are copied they are placed on the Clipboard Block
(usually called the clipboard). The selection of objects on the
clipboard can be pasted as many times as desired within
mySewnet™ Digitizing.

Duplicate
Use Duplicate
to make a copy of the selected objects, which is automatically pasted on
the work area below and to the right of the original and after the selected objects in the
stitch sequence.

Shortcuts
■
■

Home Tab:
Keys: Alt, H, DU; Right-click FilmStrip, I

Insert Embroidery
Use Insert Embroidery

to insert any embroidery into the current design.

To insert an .edo or .can design outline file, use Insert

. See “Insert” on page 114.

An inserted embroidery is automatically converted to stitch objects and placed as a group.
The first object in the group is placed after the selected object or the last visible object in
the design. The group can be moved, resized, mirrored, rotated, copied or cut.
Embroideries are inserted at the size they were created.
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To open an embroidery as a design, use File, New
Embroidery

to start a design with no picture, and Insert

to convert an embroidery to a design.

To see the name of an embroidery, position the arrow pointer over the desired thumbnail.
A label showing the file name will appear.
The following embroidery file formats may be loaded: Bernina (.art version 1, 2, 3),
Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11),
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna
(.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and
Toyota (.10*).
Files that hold color information, such as .vp4, .vp3, .vip, .hus, .shv, .dhv, .pcs, .pes, .jef, .sew
and .xxx, are shown in the nearest match to the colors in which they were created for the
selected Thread Range (set in mySewnet™ Configure). For files that do not store colors,
such as .dst, .exp and .10?, the embroidery will be shown in a default color sequence.

Shortcuts
■

Home Tab:
Keys: Alt, H, IE

1
2
3
4

Click the Insert Embroidery icon
. The Open dialog box will appear.
Browse to the desired embroideries folder.
Use the scroll bars to view all the embroideries within the folder.
Click on an embroidery to select it, then click Open to insert the embroidery into the work area.

■

How to Insert an Embroidery

The embroidery is converted to a group of objects and placed in the center of the work area.
Use Ctrl + click in the Open dialog box to insert multiple embroideries. Each embroidery will be inserted as
a separate group. Use Reveal Groups to view the inserted groups.
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Insert Lettering
Use Insert Lettering to insert lettering from any mySewnet™ Embroidery Software font
into the current design. The first object in the inserted character is placed after the
selected object or the last visible object in the design. The character is also placed as a
group so that it can be moved, resized, mirrored, rotated, copied or cut. Characters are
inserted at the selected size relative to the 'A' character in the font.

Shortcuts
■
■

Home Tab:
Keys: Alt, H, IL

Insert Lettering in a Design
1
2
3

4
5
6

In the Home tab click the Insert Lettering icon
and the Insert Lettering dialog box will appear.
Click the drop-down arrow next to the font Category and select the desired category.
Click the drop-down arrow next to the font name and select the desired font. The available characters
in the font will be highlighted in the table.
Only characters that have been created for the font may be selected.
Click the desired character and it will be shown highlighted.
Click Insert. The character will appear on the work area as a group, so you can adjust it as desired.
Alternatively, double-click to insert the character.
Repeat to place additional characters as desired.
Subsequent characters are placed to the right of the previous character, creating a line of text that can be
selected, moved and adjusted as desired.
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Insert SuperDesign
Use Insert SuperDesign
to insert a SuperDesign from the
SuperDesign sets available in mySewnet™ Digitizing.
SuperDesigns are special designs that can be resized with
constant stitch density. Some SuperDesigns are
multicolored, and the stitch type and style for many can be
changed. Alter the size, proportions, stitch type and thread
color.
Choose a Style for certain SuperDesign sets, for example the
Animals 1 set contains Natural, Sepia and Line styles.
SuperDesign sets are grouped into categories. Each set contains 9
SuperDesigns. The SuperDesign gallery shows thumbnails of all the
SuperDesigns in the currently selected SuperDesign set.

Shortcuts
■
■

Home Tab:
Keys: Alt, H, IS

Insert a SuperDesign
1
2

3
4
5

In the Home tab, click Insert SuperDesign . The Insert SuperDesign dialog box opens.
Search for a SuperDesign in the Search box (see “Search for a SuperDesign” on page 314), or choose a
SuperDesign Category from the drop-down Category menu. The preview will show the first design
set in that category.
Select a single Category, or browse All categories.
Click the drop-down arrow below the Category list, and choose a SuperDesign set, then click a design
to select it.
Set the Size in millimeters as desired, from 5mm to 200mm. This sets the height of the SuperDesign,
and the width is set proportionally.
Click Insert. The SuperDesign is inserted in the work area as a Group, leaving any existing
SuperDesigns unchanged.

Search
You can search for a SuperDesign by name, folder name, or keyword.
Enter the desired text in the Search box and press Enter. Click Clear Search to remove the
search text, and use the drop-down menu to reuse previous searches.
Click Clear Search before browsing SuperDesigns by Category.

Search for a SuperDesign
1
2
3

4
5
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In the Home tab, click Insert SuperDesign
to open the Insert SuperDesign dialog box.
Enter a search term in the Search box, for example ’christmas’, and press Enter. A gallery of search
results appears by the pointer.
Scroll down to view all of the Christmas designs. Alternatively, click the drop-down menu in the
dialog box to view the Christmas designs.
These are from Christmas categories, and single designs with a Christmas theme.
Note that the SuperDesign Category drop-down menu is not available. Click the Clear Search button
below the Search box. The most recently used category becomes available.
In the Search box enter ’dog’, then press Enter.
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8

9

10

Besides 18 household pets, there are also three pictures of a sausage in a roll (a hotdog). Searching may
sometimes produce unexpected results!
Click the Clear Search button to return to Category view.
In the Search box enter ’lion’,
then press Enter. There are ten
different Lion designs.
Place the pointer over the first
four lions in turn.
The first three are part of the
Animals set in the Appliqué
Category, and the fourth is from
Tassels. They are all named Lion.
You can search on Category or
SuperDesign name.
Place the pointer over the last
six lions.
All of these lions are from Zodiac, and are named Leo. The term "Lion" is from the keywords for these
SuperDesigns.
Click to select the first Leo, then click Insert. The lion is inserted as a group in the work area.
The Search function finds all varieties of a particular SuperDesign, there is no need to click the Style option
for a SuperDesign set individually when using Search. In the example above, the appliqué lions using Satin
Line, and the two styles of Motif Line are found.

Insert ExpressDesign
Use Insert ExpressDesign
to create a new design in the ExpressDesign Wizard. Use
ExpressDesign into Rectangle
to create a new design that is a best-fit to a rectangular
area you draw, and use ExpressDesign into Hoop
to create a new design that is a bestfit to the currently selected hoop.
Insert ExpressDesign is used to add new design elements to an existing design, but can also be used to
create the first part of a new design, or used repeatedly to compose a design from elements created in the
ExpressDesign Wizard.

See “Insert ExpressDesign” on page 49.
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Notes and Settings
Notes
Click Notes
to display the Notes, then click
Edit
to change the Notes for the currently
selected design. The Notes dialog will appear.
The Notes dialog allows free text and keywords to be
added to the Notes for the selected design. Type
additional Notes in the Notes box.
Use Ctrl+Enter to start a new line of text.
Up to 2000 characters can be entered in the Notes.

Keywords
Select Keywords for the design from the list, then
click Add to add them to the Notes for the design.

Add Notes to a Design
1
2
3
4

5
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Click Notes
. The Notes are selected in the Notes and Settings pane.
To edit the Notes, click Edit
.
In the Notes text box make your desired changes to the Notes.
Use Ctrl+Enter to start a new line of text.
To add Keywords, select the keyword from the category heading or subcategory in the scrolling list.
Then click Add.
Double-click to expand the folders until the desired keyword is highlighted. (Alternatively click on the +
sign.)
Click OK to save your amended Notes and added keywords.
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Settings
Click Settings
to display the Settings, then click
Edit
to change the Settings for the currently
selected design. The Settings dialog will appear.
Use Ctrl+Enter to start a new line of text.
Up to 2000 characters can be entered in the
Settings.
When you wish to store the settings for an area, use the ’Show
a text summary for these options
’ option on the Favorites
tab of the Fill Area and Line properties dialog.
Use Ctrl + C and Ctrl + V to Copy and Paste the text to the
Settings dialog.

Add Settings Information to a Design
1
2
3
4
5

Select the design for which you want to amend the settings. The design will be highlighted.
Click Settings
.
Click Edit
.
In the Settings text box make your desired changes to the Settings.
Use Ctrl+Enter to start a new line of text.
Click OK to save your amended Settings.

Undo and Redo
Undo
Use Undo
to reverse the last action. Unlimited Undos are possible. Every time you click
on Undo, the previous action is reversed. If you are not satisfied with the result of the
Undo, click Redo.
To remove an area that was not the last created, select it, then click Delete

.

The Zoom commands cannot be reversed using Undo.

Shortcuts
■
■

Quick Access Toolbar:
Keys: Ctrl + Z

Redo
Use Redo
to reverse the last action that was undone by Undo. If you are not satisfied
with the result of the Redo, click Undo.

Shortcuts
■
■

Quick Access Toolbar:
Keys: Ctrl + Y
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Fill and Satin Patterns
Set the Fill Pattern number for fill areas, satin areas and columns. When a pattern fill area is
first created, for example by converting from another stitch type, the initial setting is
pattern 3. Standard satin uses Pattern 0, which is not available for Pattern Fill areas.
Patterns in categories other than Standard are recommended for use in relatively large fill areas, as they
have repeating patterns which work well when 'tiled' together. Pattern 36 produces a 'satin effect' fill stitch.
The first four patterns in the Gradient & Lace category (253-256) are recommended for multicolor gradient.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a
weave effect for lace designs. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm
to combine with Pattern 258, and so on.
Animals 1 — Patterns 37 to 48

Arrows — Patterns 49 to 60

Circles 1 — Patterns 61 to 72

Circles 2 — Patterns 73 to 84

Climate — Patterns 85 to 96
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Diamonds — Patterns 97 to 108

Gradient & Lace —
Patterns 253 to 264

Hearts — Patterns 109 to 120

Leisure 1 — Patterns 121 to 132

Mosaic 1 — Patterns 133 to 144

Mosaic 2 — Patterns 265 to 276

People — Patterns 145 to 156
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Plants & Flowers 1 —
Patterns 157 to 168

Polygons — Patterns 169 to 180

Rope & Chains —
Patterns 181 to 192

Squares 1 — Patterns 193 to 204

Squares 2 — Patterns 205 to 216

Standard 1 — Patterns 1 to 12

Standard 2 — Patterns 13 to 24
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Standard 3 — Patterns 25 to 36

Transport — Patterns 217 to 228

Waves 1 — Patterns 229 to 240

Waves 2 — Patterns 241 to 252
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Preferences

15

Use Preferences
to set stitch length for single and motif stitches, and color tolerance
and screen options. When these are changed, the new settings will be remembered when
mySewnet™ Digitizing is closed and reopened.

Shortcut
■

File Menu:

General Preferences
Choose whether or not to use color tolerance, and the stitch length for single stitches
when broken up.

Color Tolerance
Selecting the Color Tolerance option causes the Color Tolerance dialog to appear when
any of the QuickStitch™ or QuickTrace functions are used. It allows parts of a picture to be
selected for filling or tracing according to how similar they are in color to the chosen color.
This option is initially selected.

Single Stitches
Break Up
Select Break Up to break long Single Stitches into Running Stitches at the length set in
Maximum Stitch Length.

Maximum Stitch Length
Set the maximum Single Stitch length from 1 to 12mm in steps of 1mm. The initial setting
is 6mm.
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Single Stitches will be broken up into stitches of this length, unless the setting is altered in the properties
box.

Creating Stitches Preferences
Select whether or not to automatically add tie stitches, the maximum stitch length for
motifs, and the stitch length for Felting Needle color effects.

Tie Off Before and After Trims
Select this option to automatically add a tie stitch before and after a Trim.
When this option is not selected, no ties are automatically added.

This option is initially selected.

Minimum Gap to Add Trim
Set the minimum gap between objects to automatically add a trim.

Maximum Stitch Length for Motif
Set the maximum length of motif stitches used in motifs from 1 to 20mm in steps of
0.1mm. The initial setting is 2mm.

Felting Needle Color Effect
Set the stitch length for Felting Needle stitches. These settings are used whenever a felting
needle color is selected in mySewnet™ Digitizing.

Break Up
Break up Felting Needle stitches into a preset minimum length.

Stitch Length
Set the stitch length for Felting Needle stitches from 0.1mm to 6.0mm in steps of 0.1mm.
The initial setting is 0.4mm.
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Printing

16

In different parts of the program you can print a design template, a picture background, or
a drawing.

Print: Design Window
Use the Print options for the Design window to choose what to print. Any combination of
embroidery worksheet, plan view and an individually printed picture can be selected.
The Print Setup button presents a Print Setup dialog box, where you specify the printer
and its connection.

Print worksheets
Choose scale, grid & flip
Select information

Print a plan of the project
Print the background picture
Select measurement units
Preview the printout
At least one of the main print options, Print Worksheet, Print Plan View or Print Picture, must be selected or
there will be nothing to print. If none of these options is selected, the Print button will be grayed out
(unavailable).

Shortcuts
■

QuickAccess Toolbar:

Print
Click Print to open the Print page and print the project. See “Print” on page 327.

Worksheet
Select whether to print a worksheet, and the information to be printed on the worksheet,
such as the Dimensions, Color Information, Notes and Technical Information. In addition,
the scale may be altered and a grid turned on or off.

Print Worksheet
Select this option to print a worksheet for the embroidery. Use the Worksheet Options to
alter the appearance and contents of the printed worksheet.
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Design Scale
Select 25%, 50%, 75% or 100% scaling when printing your embroidery. This is how large
the embroidery will print compared to the real size of a stitched out embroidery. Use a
reduced Design Scale if you want to ensure that the worksheet fits on one page. Use the
Print Preview on the right to see how many pages will be printed.

Grid
This determines whether or not a grid will be printed with the embroidery. If you turn this
off you will still get a rectangle representing the hoop.

Flip design for felting or reverse embroidery
Flip the embroidery for being stitched in reverse, or for felting effects.

Print Information
This determines what additional information is printed. All items are selected initially.

Dimensions
The size of the embroidery and the stitch count.

Hoop
The hoop used for the embroidery.

Color Information
The sequence of thread colors used and, if available, the thread specification (range and thread
number). Stop Commands and their text (where present) are also shown.

Decoration Information
Information on the decorations used in mySewnet™ Embroidery, and their size, color and
number.

Notes and Settings
Any notes or settings that are included with the embroidery.

Export Options
The Export options used for the embroidery, as set in the Export dialog box.

Technical Information
The distance of each edge of the embroidery from the center of the embroidery.

Plan
Select whether to print a Plan View, and choose how to print the embroidery when you
print the plan view. Use the plan view as a guide for aligning the embroidery to the
picture.

Print Plan View
Select this option to print a plan view of the picture, with either the whole embroidery or
the alignment stitches printed over the picture. When stitching out, use the plan view as a
guide for aligning the embroidery to the picture.
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Print Whole Embroidery
The whole embroidery will be printed on the plan view. If there are alignment stitches
under the embroidery, they may be obscured by the embroidery.

Print Alignment Stitches Only
Only the alignment stitches (if present) in the first color block in the embroidery will be
printed. If the alignment stitches will be obscured by the rest of the embroidery, choose
Print Alignment Stitches Only. Otherwise, it is generally better to choose Print Whole
Embroidery.

Picture
Print Picture
Select this option to print a page that shows only the picture.
When you are ready to print the picture onto printable fabric or an iron-on transfer, select
only this option. That is, deselect Print Worksheet and Print Plan View. This is so that you
can load your printer with the printable fabric or transfer, without printing the worksheet
or plan view first.
The picture can optionally be flipped and/or have the colors faded by 50%.

Flip Picture for Iron-On Tee Shirt Transfer
Use this option if you are printing onto iron-on transfer paper, instead of printing directly
onto the fabric. This is typically used for transferring the picture to a tee-shirt. Using ironon transfer paper flips the picture, so use this option to flip it back again, ensuring that the
picture is correctly orientated when it is ironed onto the tee-shirt.

Fade Picture
Use this option to fade the picture by 50%, if desired. This will make the threads stitched
over the picture stand out.
Fade Picture affects both the plan view and the individually printed picture.

Align Picture To
Use this option to position the printed picture on your printable fabric or transfer paper. If
you have a small picture, you can use this option to conserve the printable media by
moving the printed picture to the top or bottom of the page. Alternatively, use center
alignment to make hooping up easier.
Choose from Center, Top or Bottom. Use Print Preview to verify the size and position if you
have already printed on the other part of the media.

Units of Measurement
Set the Units of Measurement for the Dimensions and Technical Information to mm or
inches, as desired.
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Print Setup
Click the Print Setup button to see the Print Setup dialog box that is used to select the
printer, what paper to use and the paper orientation.

Print Setup
This is displayed when you click the Print Setup button in the Print dialog box. Use Print
Setup to select the destination printer and its connection.

Printer
Select the printer you want to use.

Paper Size
Select the size of paper that the embroidery is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Orientation
Choose Portrait or Landscape. Generally, you should not need Landscape for the standard
hoop sizes as the embroidery is rotated automatically by the print process when you print
an embroidery that uses a Rotated hoop.

Properties
Displays a dialog box that provides additional printing choices, specific to the type of
printer you have selected.

Print
Print the embroidery displayed on the mySewnet™ Digitizing preview. Other information,
such as the Dimensions, Color Information, Notes and Technical Information is printed
depending on the choices made in Page Setup. The scale may also be altered and a grid
turned on or off in Page Setup. If possible, the hoop will be printed with the same
orientation as on the screen. If a horizontal hoop is too wide to fit on the paper at the
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Design Scale chosen in Page Setup then the hoop will be rotated 90 degrees when it is
printed.
The Print dialog box appears, where you may specify number of copies, the destination
printer, and other printer setup options.

Printer
Select the printer you want to use.

Properties
Displays a dialog box where you can make additional choices about printing, specific to
the type of printer you have selected.

Print to File
When this option is checked, you will be prompted for a file name after you click OK. The
print job will then be saved with the file name you specify and can be sent to the printer at
a later time.
This is an advanced Windows® printing option.

Print Range
Select the range of pages you wish to print.

Copies
Select the number of Copies you wish to print. If you choose to print more than one copy,
you can choose to Collate the copies.
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Troubleshooting

17

Error Messages
Acquiring and Loading Pictures
"Problem with scanner or camera software."
This message will appear when trying to use your scanner or digital camera if the device
has not been installed correctly. Close mySewnet™ Digitizing, follow the manufacturer's
instructions for the WIA-compliant device, then reopen mySewnet™ Digitizing and try
again.

"Scanner or camera is in use by another application."
This message will appear when trying to use your scanner or digital camera if another
graphics program is already open that uses the WIA-compliant device. Close mySewnet™
Digitizing and the other graphics program, then reopen mySewnet™ Digitizing and try
again.

"Your scanner or camera is no longer available for use. Close this program,
plug in and switch on your scanner or camera, and run this program
again."
This message will appear if the connection to your scanner or digital camera has a
problem. Close mySewnet™ Digitizing, check the connections to your scanner or digital
camera, then reopen mySewnet™ Digitizing and try again.

"Failure to acquire picture due to unknown causes."
This message will appear in certain circumstances when trying to use your scanner or
digital camera, for example if the cable is disconnected during the scan or download.
Close mySewnet™ Digitizing, check the connections to your scanner or digital camera,
then reopen mySewnet™ Digitizing and try again.

"Could not load picture file."
This message could appear if the desired picture is not where the module expects it to be,
for example if it was loaded from a USB stick, then closed and the USB stick removed. It
could also appear if the file you are attempting to load is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.

"Part of this file is a raster image and cannot be loaded."
This message could appear when loading certain types of Corel® Draw files, that include
raster images. If not enough of the picture is visible, try saving in another format, and
reload.
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"This file version cannot be opened. Save as CDR version 7 - 13, then try
again."
This message could appear when loading certain types of Corel® Draw files. Try saving
from Corel® Draw in a different version file, then reload.

Preparing Pictures
"You must select an area first, before applying the crop tool."
Use the Box Select feature to select an area of the picture around which you wish to crop
the background.

"Cannot rotate - picture will be bigger than 2000 x 2000 pixels if rotated to
this extent."
When rotating a picture, certain angles could make the picture larger than the maximum
allowed. If this message appears, either rotate the picture to a different angle, or reduce
the size of the picture, then try again.

"Please enter an integer between 16 and 2000."
When resizing a picture, the largest size available is 2000 x 2000. If you enter dimensions
smaller than 16 or larger than 2000 pixels, this message will appear. Choose a different size
and try again.

"Not enough memory to save undo data."
This message may appear if you are using a large picture and your computer's memory or
hard disk space is relatively low. Close other programs and try again.

Loading Designs
"The data is not in the correct format."
This message appears if an .edo file cannot be loaded. For example, it might have the
extension .edo, yet not be a proper design outline file.

"Error. Could not load can file."
This message appears if a .can file cannot be loaded. For example, it might have the
extension .can, yet not be a proper design outline file.

Using the ExpressDesign Wizard
"Some areas were too thick to be traced."
This message may appear when creating an Express Trace design if the final picture has
thick areas of solid color. Some or all parts of the design may not be created. Try using
options in the wizard, on the Outline Finder and Expander page and/or the Monochrome
Threshold page, to ensure the outlines are not too thick. Cancel the wizard, adjust the
picture so that the outlines are easier to isolate with Monochrome Threshold, then open
the picture in the ExpressDesign Wizard again.

330

mySewnet™ Digitizing Troubleshooting

Choosing Thread Colors
"The color xx has been found in your database, but the thread color is not
exactly the same."
This message appears if the Thread Range and Color Number of the selected color are
identical to those in your thread database, but some aspect of the color is different. It
could be a different material or weight, or have additional colors as a variegated thread.
This could happen if the design you are attempting to edit was supplied by someone with
a different version of the color, for instance if they have edited it in MyThreads, or if they
have a later version of the thread database. If you click OK, the color will be replaced with
the near match. You can alter it to any other color if desired. If you click Cancel, the color
will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™
Embroidery Software, use Smart Update in mySewnet™ Configure.

"Could not find xx in your database. Matching to closest thread in yy."
This message appears if the Thread Range of the selected color is not found in your thread
database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. If you click OK, the color will be
replaced with the nearest match in the Import Thread Range you have set in mySewnet™
Configure. You can alter it to any other color if desired. If you click Cancel, the color will not
be changed. To import the new color from an embroidery if it is a MyThreads color, use
mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™ Embroidery
Software, use Smart Update in mySewnet™ Configure.

"Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."
This message appears if there is a problem with your thread database. You will be unable
to choose a thread color. First close all the modules of the mySewnet™ Embroidery
Software, close down your computer and restart. If this does not clear the problem, restore
a backup with Restore MySettings, if you have created one using Backup MySettings in
mySewnet™ Configure. Otherwise, you either need a new version of the thread database,
or a repair install of your mySewnet™ Embroidery Software software. To check for the
latest updates for the mySewnet™ Embroidery Software, use Smart Update in mySewnet™
Configure.
If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\mySewnetSystem:
■
■

User.sqlite
System_cdb2.sqlite
This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your mySewnet™ Embroidery Software software USB stick in your computer and rerun the installation. When the choice appears, select the "Modify or remove" option and
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click Next. In the next screen, select Repair and click Next. Continue with the installation
and follow the on-screen instructions. When the installation is complete, the thread
database will be restored to its original installation state. This means that the MyThreads
database will have the default set of threads.
This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check
Smart Update in mySewnet™ Configure after repairing the installation.

"Error: Please select a valid thread."
This message appears if you attempt to click OK in the Color Selection dialog box when
MyThreads is selected as the thread range and MyThreads is empty.
To prevent this message appearing again, use mySewnet™ Thread Cache to add at least
one thread to MyThreads.

QuickTrace Areas
"This is not an appropriate use of this tool. Areas of the image may be too
wide."
This happens when you use QuickTrace to follow an outline in the picture and then
QuickTrace finds a part of the outline that is very thick. This can be caused by excessively
broad outlines or by selecting too much of the picture with a high Color Tolerance value.
In this case, QuickTrace does not know where to trace the outline as the problem part of
the outline is more like a fill area. Use a lower Color Tolerance value, or use the editing
functions in the Picture window to make the outline thinner or break up the outline so
that the wide parts are isolated from the rest of the outline.

Creating and Using My Fills
"Cannot load My Fills picture. The width and height must be between 120
to 700 pixels."
This message appears if the picture being imported in the Manage My Fills function is
outside the required size range. Resize in an image editing program such as Windows®
Paint.

"Error. Unable to locate MyFills.mdb."
This message usually means that the My Fills database has been deleted or corrupted. This
may be corrected by first attempting to Restore MySettings.
To Restore MySettings, you must have previously saved a copy of MySettings with Backup
MySettings. Click Restore MySettings in mySewnet™ Configure and select the desired
backup to restore. See the online help in mySewnet™ Configure for more information.
If the error still appears, then repair the installation. First, delete the file named
'MyFills.mdb' from ProgramData\VSMSoftware\mySewnetSystem.
This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If
the file is not present then this is the reason for the error. The file name may simply be shown as 'MyFills'.
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Put your mySewnet™ Embroidery Software software USB stick in your computer and rerun the installation. When the choice appears, select the "Modify or remove" option and
click Next. In the next screen, select Repair and click Next. Continue with the installation
and follow the on-screen instructions. When the installation is complete, the My Fills
database will be restored to its original installation state. This means that the My Fills
database will be empty. If you had any My Fills, you will need to import them again.

Choosing Motifs
"Please choose a valid motif pattern."
This message appears if you try to select a motif from My Motifs, and all the motifs have
been deleted from My Motifs. Use mySewnet™ Draw & Paint to add at least one motif to
My Motifs.

Using Shape Fill Areas
"Error. Shapes database is corrupt or missing."
This message usually means that the shape database has been accidentally moved,
deleted or corrupted. This may be corrected by repairing the installation.
This error does not prevent mySewnet™ Digitizing from starting. However, you will not be able to use the
relevant functions until this is resolved.

To correct this, start the installation for your mySewnet™ Embroidery Software software,
then choose the Repair option.
If the problem persists, delete the file named 'BorderShapes.bdr' from
ProgramData\VSMSoftware\mySewnetSystem, and then use the Repair option again.
This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If
the file is not present then this is the reason for the error.

Repair an Installation of the mySewnet™ Embroidery Software
1
2
3
4

Put your mySewnet™ Embroidery Software software USB stick in your computer and re-run the
installation. (If you downloaded your software, double-click on the mySewnet™ Applications file.)
When the choice appears, select the "Modify or remove" option and click Next.
In the next screen, select Repair and click Next.
Continue with the installation and follow the on-screen instructions.
When the installation is complete, the shapes database will be restored.

Resizing Designs
"Design has been reduced in size to fit the hoop."
This message is displayed if an attempt has been made to resize a design using Change
Design Size to a size larger than the current hoop. The design will be resized to fit the
hoop, as with Scale Fit Hoop. To enlarge the design further, select a bigger hoop before
resizing.
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Inserting Embroideries and Characters
"Cannot open embroidery."
This message appears if the desired embroidery is not where the module expects it to be,
for example if an embroidery was loaded from a USB memory stick, then closed and the
memory stick removed. The message would appear if you tried to load the embroidery
from the Recent Files list on the File menu.

"Unrecognized file format."
This message appears if the embroidery you are attempting to load is corrupt. For
example, it might have the extension .vp4, yet not be a proper Husqvarna Viking / Pfaff
embroidery.

"Embroidery is corrupt."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Embroidery XY coordinates incorrect."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Embroidery not created using licensed software."
This message may appear if you attempt to load an embroidery created in third-party
software. Such embroideries may cause unpredictable results.

"Error. Cannot open Font File."
This message appears if the font that you have selected is not available. The most likely
reason is that it is already open in the optional mySewnet™ Font Digitizing module. Close
mySewnet™ Font Digitizing, then try again. This could also happen if you opened
mySewnet™ Digitizing, then accidentally moved or deleted the font from the relevant
category folder in ProgramData\VSMSoftware\mySewnetSystem\Fonts. Close mySewnet™
Digitizing, make sure the file is in the folder, then try again.

"Error. Font file is corrupt."
This message appears when trying to select a character if the font is corrupt. Reinstall the
font.

Using Groups
"To move a group of objects to the back of the design, the first object
must be a color change"
This message is displayed when Move to Back of Design is used to place an object other
than a color change at the beginning of a design. The first object in a design must always
be a color change, or a group that starts with a color change. Ensure that the first object in
the selection to be moved is a color change.
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Creating Stitches
"Fill object is too complicated."
This message may appear if a QuickStitch™ or Freehand fill area is too complex for the
stitch generation functions, usually because the fill area is very small. This may happen, for
example, if a design has small areas and is then further reduced in size.
To help find the area, check the progress bar that appears when stitches are created. This
shows how far through the design the object is, and can be used as an approximate guide
for setting the slider bars on the Edit tab. If desired, also use the filters to hide other object
types. Use the FilmStrip to step through the objects quickly. Look for small areas in the
remaining visible objects, and adjust as necessary.

Saving Files
"Error saving picture."
This message appears on attempting to save the picture and the picture is not saved. For
example, if you attempt to overwrite an existing picture that is read only or if you attempt
to save the picture to a read only location such as a CD-ROM.

Exporting Files
"Embroidery is too large or is not in the hoop."
This message appears if an embroidery you are trying to Export is outside the selected
hoop or larger than will fit in it. For example, with the 100mm x 100mm hoop selected, an
embroidery smaller than 100mm x 100mm might be placed partially outside the work
area when you click Export. This message would then appear. Move the design completely
within the four blue corners of the work area and try again.

"Cannot export design."
This message appears if you try to use the Export function when there is no stitch
information to export (such as when there are only Stop commands in the design).

"Cannot save file."
The program cannot save the file. Ensure that the disk where you are trying to save the
design is not write-protected, then try again.

"You can’t save here. Please choose another location."
This message appears if, for instance, you have loaded an embroidery from a CD-ROM and
then attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you
will not be able to save the embroidery.

"Design too large for export format."
Certain formats are limited to the size of hoop used on their specific embroidery machine,
for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size this message would appear.
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"Unrecognized file extension."
This message appears if you type an incorrect extension that does not belong to any
embroidery file types in the File Name box when trying to save a file.

"Design File is read-only. Cannot continue."
This will happen if you attempt to open a design that has been set as read-only, or is readonly because it is stored on a CD-ROM. If the design file is on your hard disk as read-only
then you must change its properties in Windows® Explorer so that it is no longer read-only.
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then
change the properties so that they are no longer read-only. (Windows® Explorer Help has
information on the read-only attribute.)

"Filename already exists. Do you want to replace it?"
This happens when you are doing a Save As on the .edo design outline file and you have
given the name of a file that is already there. It also happens when you are saving a stitch
file and the file already exists. Click Yes or No as appropriate. You may have to replace a
stitch file several times if you are creating stitch files to stitch out tests of your design.

"Disk is write-protected. File not saved"
This will happen if you try to save a file to a floppy disk that has the write-protect tab open.
Either take out the floppy disk and close the write-protect tab, or use a different floppy
disk.

Miscellaneous
"Error. Not enough memory to perform operation."
This message will appear when system resources are low. Close other programs and try
again. If this does not work, try restarting your computer.
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Other Topics
Screen Appearance
"Some of the icons in the Ribbon bar are 'grayed out'."
Certain icons (for example Cut on the Home tab) are only highlighted once a design is
shown on the screen. Also, when there is a design on the screen, some functions that
might cause a mismatch between the size of the design and the size of the picture are not
available in the Picture window.

"I have changed grid color and spacing and now I wish to return to the
original settings."
Use mySewnet™ Configure to change the grid color. Follow the instructions in mySewnet™
Configure and select Blue Gray (RGB values 100, 102, 153) from the standard color dropdown on the Grid Color button.
Use the Size setting on the View tab to change the grid spacing. Set the Grid Size to 10.

"I have changed the screen background color and now I wish to return to
the original light blue."
Use mySewnet™ Configure to change the background color. Follow the instructions in
mySewnet™ Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

"I am looking for the origin of my fill area, but there is no orange circle."
The origin is usually shown as an orange circle. It may be a different color, depending the
underlying picture or background colors. Also, the origin can be moved anywhere on the
work area. Try Zoom To Fit to see the whole work area.

Loading Designs
"When I insert a design outline file (.can) created in a different version of
the software, some motif fill areas are blank."
If your design contains motif fill areas using My Motifs created in 5D or 4D Design Creator,
the My Motifs will not initially be present, and therefore cannot be used in the mySewnet™
Embroidery Software. Use Backup MySettings in 5D or 4D Configure, then restore
MySettings in mySewnet™ Configure. Then, in mySewnet™ Digitizing, re-select the My
Motif for the motif fill area in your design.

"I cannot see thumbnails for my design outline files."
Thumbnails can only be seen for .edo design outline files, they cannot be seen for .can
design outline files from 5D and 4D Design Creator. Use Insert to view the contents of a
.can file.
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Loading Pictures
"When I view some pictures before opening them in the preview Window
of the Open dialog box they appear blue."
Pictures saved in .jpg format from Adobe® Photoshop® with non-image data may appear
blue in the preview window. This does not affect the way they appear on the mySewnet™
Digitizing screen. To avoid this, if you use Adobe® Photoshop® to save .jpg files, make sure
to check the Exclude non-image data box. If you do not have access to this program and
have received this type of file, open the picture and re-save it in another program such as
Paintshop Pro. This automatically removes the non-image data.

"I loaded a small picture, and it has too many jagged lines."
Although the program automatically doubles the size of a picture if its height and width
are less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan
the picture.

"The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in."
The From Scanner or Camera option may not be available, even though you have installed
and connected a scanner/camera, if it does not support Windows Image Acquisition
(WIA). If your scanner/camera supports a different image acquisition system, e.g. TWAIN,
create a .png or .jpg file of the image in My Pictures, and load it from there.

Scanning
"What DPI setting should I use to scan a picture for creating a design?"
The correct DPI (dots per inch) setting will depend on the size of the picture to be
scanned. The desired picture size is approximately 1500 X 1500 pixels. To achieve this take
the size of your artwork in inches, such as 8" x 7", and divide the longest side into 1500. In
the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner should then be 188
DPI, and this will produce a picture that is about 1500 x 1310 pixels.

Using the ExpressDesign Wizard
"My picture already has outlines, but some outlines are not traced
properly when I create an Express Trace embroidery."
This can happen if the outlines in your original picture are only one pixel wide. For
example, there may be gaps or missing sections of the outline. If this happens, select Find
Outlines on the Outline Finder and Expander page and ensure Expand is set to 1. This will
thicken all the outlines so that they are traced correctly.

"The preview picture is blank or almost blank on the Express Trace
Options or Express Border Options page."
This may happen if the outlines in the picture are only one pixel wide after the
Monochrome Threshold page.
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For Express Trace, return to the Outline Finder and Expander page, select Find Outlines
and ensure Expand is set to 1.
For Express Border, first click Picture Options and set the Area Sensitivity to High. If this
does not have the desired effect, return to the Monochrome Threshold page and adjust
the slider so that more of the picture within the desired areas turns black. If this also
selects unwanted parts of the picture, you may need to remove the unwanted areas in a
picture editor.

"My picture only makes a rectangular border when I create an Express
Border."
This can happen with a picture that has a border or background that is black or very dark,
especially if the background or border cannot be removed with Monochrome Threshold.
For pictures with a dark border, it should be possible to remove the border on the Rotate
and Crop Picture page of the ExpressDesign Wizard. If this is not possible, edit the picture
to remove the border or change the border color.
For pictures on a dark background, use an image editor to invert the colors in the picture
or change the background color to a light color.
After editing the picture, load it again in the ExpressDesign Wizard.

"Why can’t I click Finish on the Fabric and Stitch Type Options page?"
If you change the options on the Fabric and Stitch Type Options wizard page, you must
click Refresh Preview before you can click Finish to place the embroidery in the work area.
The Finish button is not available until the preview has been refreshed.

Importing Embroideries
"Some of the satin sections in my imported or inserted embroidery are
now fill areas."
Some wide areas of satin may be imported as fill areas, depending on their size in the
embroidery. This is because any area that is very wide is assumed to be a fill area. Also, any
satin that has a fill pattern will be imported as a fill area.

Freehand, Point or QuickStitch™ Areas
"When I create stitches one of my fill areas doesn't fill completely with
stitches."
Try changing the angle of orientation. Even one degree can be enough to allow the
artificial intelligence of the program to fill the object. Another possibility is to move the
start point slightly.

"The fill shape created with QuickStitch™ when I click inside the area is not
the one I want."
The pictures used should have well differentiated color areas, which may be solid or
stippled, to fill easily. Clipart is excellent for this purpose. If there is a gap where the same
mySewnet™ Digitizing Troubleshooting

339

color flows into another area, the fill will not work as expected. If Color Tolerance is
switched off then switch it on in Preferences. Color Tolerance will then allow you to
preview any area for QuickStitch™ functions, which should reveal any problems with color
areas in the picture. You can then alter the picture in the Picture window. Alternatively, use
the Freehand or Point functions to place the Fill Area.

"More of the picture than I want is selected for QuickStitch™ when I click
inside a small color area."
QuickStitch™ will not create an area from part of the picture that is very small or very thin.
This is because the area will either have insignificantly few stitches, or it is not wide
enough for stitches to go across it. Try editing your picture to enlarge the area, so that it is
big enough to be used as a QuickStitch™ area. Alternatively, use single or running stitches.
For thin lines, use QuickTrace.

"I am looking for the origin of my fill area, but there is no orange circle."
The origin is usually shown as an orange circle. It may be a different color, depending the
underlying picture or background colors. Also, the origin can be moved anywhere on the
work area. Try Zoom To Fit to see the whole work area.

Appliqué Areas
"I want to change the stitch length for my appliqué placement lines."
In an appliqué piece, the stitch length in the appliqué placement lines is initially set to
2.0 mm. To change the stitch length for the placement lines, select the appliqué piece,
then in the Edit tab click Break Apart. The appliqué piece is broken up into its constituent
stitch lines, fabric and Stop commands. Adjust the placement lines as desired.

Fill Areas using My Fills
"I have loaded a design that uses a My Fill pattern, but the fill area is
showing a plain pattern."
This will happen if you delete a pattern from your My Fill database and then load a design
that uses the pattern. The pattern will use system pattern 3 instead of the deleted My Fill
pattern. Either import the deleted pattern picture again, then select it in the My Patterns
area of Fill Properties, or choose a different pattern.

"I have a design from a friend and the My Fill pattern for a fill area is
different on my computer."
When you have a design from somebody else that contains a fill area with a My Fill pattern,
it is likely that their My Fill database will have different patterns to your My Fill database.
You must obtain the exported My Fill pattern and import it into your My Fill database, then
select the correct pattern in the My Patterns area of Fill Properties.
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"When I insert a design outline file (.can) created in a previous version of
the software, some fill areas are blank."
If your design contains fill areas using My Fills created in 5D or 4D Design Creator, the My
Fills will not initially be present, and therefore cannot be used, in the mySewnet™
Embroidery Software. Use Backup MySettings in 5D or 4D Configure, then restore
MySettings in mySewnet™ Configure. Then, in mySewnet™ Digitizing, re-select the My
Pattern for the fill area in your design.

Freehand or QuickStitch™ Motif Fill Areas
"When I use motif fill areas, the design takes a long time to appear."
On slower computers, large or complex motif fill areas may take some time to draw,
particularly if there are holes in the area. This may be noticeable when you create new
motif fill areas and when you return to the Design window from another mySewnet™
Embroidery Software module.

QuickStitch™ Borders
"The border shape created with QuickStitch™ when I click inside the area
is not the one I want."
The pictures used should have well differentiated color areas, which may be solid or
stippled, to fill easily. Clipart is excellent for this purpose. If there is a gap where the same
color flows into another area, the fill will not work. If Color Tolerance is switched off then
switch it on in Preferences. Color Tolerance will then allow you to preview the border,
which should reveal any problems with color areas in the picture. You can then alter the
picture in the Picture window. Alternatively, use the Freehand or Point Create functions to
place the satin border.

"A QuickStitch™ line has a double layer of stitching in one section."
If border areas run into each other, two layers of stitching will be produced by the
QuickStitch™ border functions. To avoid this, split the colors on the picture in the Picture
window. For example, put a visual 'end point' for each border area. Alternatively, use the
Satin Line Trace function.

Editing the Design
"I am trying to change colors for some objects but they don’t appear on
the color worksheet in the Design Panel."
Colors for multicolor gradient density are only visible when Design Property Colors is
selected in the Design Panel. Select Design Property Colors to see the colors, and change
them there, or by selecting the pattern fill area and changing its properties. Similarly, the
border color for a fill plus border area can be edited on the color worksheet or on the line
tab in the properties box.
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"I have inserted a new point and moved an outline but there is still an
outline in the old position."
Some functions in the Quick Create tab create more than one outline at a time, such as,
Double and Quadruple Trace. For example, Quadruple Trace puts lines of triple and
running stitches directly on top of each other. This means that if you want to add and
move a new point to change a Quadruple Trace then you will have to do so twice, once for
each of the lines.

"I have pasted a block but it is not the original color."
A color change is only copied when it is part of the selected block. If you paste a block that
does not start with a color change then it will use the color that is active at the point
where the block is pasted. If you want to preserve the color, either copy the relevant color
change or use the FilmStrip to insert the desired color.

"I lose my selected block when I move the Start or End slider bar."
This happens because you could move the slider bar so that part of the selected block
would be hidden. This is avoided by automatically deselecting the block.

"I did not select all the objects I wanted with Box, Point or Freehand
Select."
Objects must be fully enclosed by the selection line to be selected as part of a block. If
even the smallest part of an object is outside the line then it will not be selected.

"I have created satin line with Satin Line Trace but I can't change the width
of it all at once."
Use the FilmStrip and/or slider bars to hide all objects except the satin borders and
traveling running stitch used to create the trace. Select any satin line object in the trace,
then right-click in the FilmStrip and select Global Properties. The Satin Line properties
dialog box will appear. Make adjustments as desired and click OK. The new properties will
be applied to all visible satin lines. Alternatively, if working within a group, use Select
Similar from Group to apply the settings to all other objects of the same stitch type within
the group.

"Color Tolerance does not show me all the lines that will be traced by a
QuickTrace function."
The dashed line used by Color Tolerance only shows the outside of the area that is
selected by the current Color Tolerance value. Simply try the QuickTrace function and if
the result is not satisfactory then Undo the result and retry the trace with a higher Color
Tolerance.

"There is no underlay under a fill area."
Underlay is set to none when you select Gradient or Multi-Gradient Density for a pattern
fill area. This is because the underlay stitching will spoil the effect of Gradient or MultiGradient Density. If you change an area from gradient density to Standard density, reset
the Underlay if desired.
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"Why did my fill areas vanish when I selected the Columns filter?"
Fill areas surrounded by a satin line will be hidden when the Columns filter is used, as well
as Columns and Satin Lines.

Converting Objects
"When I try to convert my area to a satin area, it does not seem to work."
If an area is too small or the outline of the area crosses itself, it may not always convert to a
satin area. If the area is very small, adjust the outline to increase the size of the area. If the
outline of the area crosses itself, adjust the outline to prevent this.
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Design Window
Ribbon Tabs
File Tab/Menu
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New

Clear the screen ready to create or load a new design.
Ctrl + N

New Window

Open an additional mySewnet™ Digitizing window.
Ctrl + Shift + N

Open

Open an existing design, replacing the design on the screen.
Ctrl + O

Recent

Open recently used designs.

Insert

Insert an existing design into your current project.
Ctrl + I; Alt + 1

Save

Save the design with the same name.
Ctrl + S; Alt, 2

Save As

Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Export

Save the embroidery in the current window as a flattened .vp4 file, or in
an alternative embroidery format.
Ctrl+ E; Alt, 4

Export Appliqué
Pieces

Save or print appliqué outlines ready for cutting by a fabric cutter or
INSPIRA™ Cutwork Needles.
Ctrl + Shift + E

Send

Send the selected embroidery to the mySewnet™ Cloud, or to the
connected machine or computer.
Ctrl + K

Print

Set printing options, preview and print the selected design(s) and
background.

Preferences

Set the stitch and screen options.

Configure

Open mySewnet™ Configure.

Exit

Close the current window and prompt to save new and changed
designs.
Alt + F4
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Home Tab
Clipboard
Copy

Copy the selected objects to the clipboard, without affecting the
current selection.
Ctrl + C; Alt, H, CO, CO
Copy Embroidery
Copy the design as an embroidery for use in another mySewnet™
Embroidery Software module.
Ctrl + Shift + C; Alt, H, CO, CE

Paste

Paste the objects on the clipboard back into the design.
Ctrl + V; Alt, H, P, PA
Paste Into Center
Paste the objects on the clipboard into the center of the work area.
Ctrl + Shift + V; Alt, H, P. PI
Paste and Replace
Paste the objects on the clipboard, replacing the currently selected
objects.
Alt, H, P, PR
Paste Into New Window
Paste the objects on the clipboard into a new window.
Alt, H, P, PW

Cut

Cut out the selected objects and place them on the clipboard.
Ctrl + X; Alt, H, X

Duplicate

Make a copy of the selected objects, which is automatically pasted on
the work area below and to the right of the original.
Alt, H, DU

Delete

Delete the selected object or the last object in the design.
Delete; Alt, H, DE

Select
Box Select

Select a block of objects by drawing a rectangle.
Alt, H, B

Freehand Select

Select a block of objects by drawing a line around the required objects.
Alt, H, FS

Point Select

Select a block of objects by clicking a series of points to create an
irregular outline of straight or curved lines around the required
objects.
Alt, H, FP

Select All Visible

Select all visible objects as a single block.
Ctrl + A; Alt, H, SA

Select None

Deselect all of the objects in the work area, including any outside the
hoop.
Ctrl + Shift + A; Alt, H, SN

Replace
Selection

Replace the currently selected designs with the new selection.
Alt, H, RS

Add To
Selection

Add the new selection to the currently selected designs.
Alt, H, A
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Remove From
Selection

Remove the new selection from the currently selected designs.
Alt, H, RF

Group

Group selected objects together so they may be moved, resized or
scaled and rotated together.
Alt, H, G
Ungroup
Ungroup a selected group so that each object may edited
independently.
Alt, H, U

Rotate 45

Rotate the selected block of objects by 45 degrees.
Alt, H, R4

Modify Block

Show and change the size and rotation of the currently selected block.
Alt, H, M, M
Scale to Fit Hoop
Resize the design in the work area proportionally to fit within the
boundaries of the hoop.
Alt, H, M, S
Change Design Size
Alter the design automatically to a new size allowing for the stitch
objects used.
Alt, H, M, C

Points
Edit Points

Use Edit Points to enable the moving and editing of an object’s points
if another function is being used.
Return; Alt, H, E

Insert Points

Add a new point to the currently selected line.
Ctrl + Shift + D; Alt, H, IP

Delete Points

Delete points from the currently selected line.
Ctrl + D; Alt, H, DP

Convert Points
and Bezier Lines
Convert Points to Corner
Change the selected point in a Bezier line to a Corner point.
Alt, H, CP, CP
Convert Points to Smooth
Change the selected point in a Bezier line to a Smooth point.
Alt, H, CP, CT
Convert Points to Symmetric
Change the selected point in a Bezier line to a Symmetric point.
Alt, H, CP, CS
Convert to Point Line
Change the selected Bezier Line to a Point Line.
Alt, H, CP, CL
Convert to Bezier Line
Change the selected Point Line to a Bezier Line.
Alt, H, CP, CC

Insert
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Insert

Insert outline designs (.edo and .can files) into the current design by
name or number.
Ctrl + I; Alt, H, IN

Insert
Embroidery

Insert embroidery files by name or number.
Alt, H, IE

Insert Lettering

Insert lettering from mySewnet™ Embroidery Software fonts.
Alt, H, IL

Insert
ExpressDesign
ExpressDesign into Rectangle
Create a design automatically to fit in the selected area.
Alt, H, IR, IR
ExpressDesign into Hoop
Create a design automatically to fit in the hoop.
Alt, H, IR, IH
Insert
SuperDesign

Insert a SuperDesign from the SuperDesign sets available in
mySewnet™ Digitizing
Alt, H, IS

Hoop
Change Hoop

Choose the hoop size you wish to use in mySewnet™ Digitizing.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Life View

Show how an embroidery exported from the project will look in 3D
with real-world perspective. Create a picture or video of your design.
Ctrl + L; Alt 9; Alt, H, L

Design Player

Play through the stitches in the embroidery as if they were being
stitched from an exported embroidery. Create a picture or video of
your design.
Ctrl + J; Alt 0; Alt, H, J
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Quick Create Tab
Command
Color Change

Insert a Color Change after the currently selected object.
Alt, Q, C, C
Pick Color
Choose a color from the background picture to set a new thread
color.
Alt, Q, C, P
Quick Colors
Click one of the Quick Colors to set a new thread color.

Fill Area and Line
Fill

Create a fill.
No Filll
No fill type is selected.
Alt, Q, F, N
Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, Q, F, P
Motif Fill
Create a fill area with one or two motif stitches in a repeating
pattern.
Alt, Q, F, M
Shape Fill
Create a fill area where the stitching lines follow one of 120 shapes,
using motif lines if desired.
Alt, Q, F, S
Radial Fill
Create a fill area that radiates out from the center.
Alt, Q, F, R
Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, Q, F, L
QuiltStipple Fill
Create a stippled fill area.
Alt, Q, F, Q
Contour Fill
Create a fill area that follows the contours of the outline.
Alt, Q, F, C
Crosshatch Fill
Create a crosshatched fill area.
Alt, Q, F, X
Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, Q, F, H
MultiWave Fill
Create a MultiWave fill area.
Alt, Q, F, U
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Echo Fill
Create an Echo fill area.
Alt, Q, F, E

Line

Create a line or border.
No Border Line
No border line is placed around the Fill Area.
Alt, Q, L, N
Running Stitch
Create a border of running stitches (small consecutive stitches).
Alt, Q, L, R
Double Stitch
Create a border of double stitch (small stitches going forward,
followed by small stitches going backward).
Alt, Q, L, D
Double Zigzag
Create a line of small stitches going forward, followed by zigzag
stitches going backward.
Alt, Q, L, Z
Triple Stitch
Create a border of triple stitch (small three-part stitches, each
composed of one stitch going forward, one going backward then
one going forward).
Alt, Q, L, T
Satin Line
Create a border of satin stitches of constant width.
Alt, Q, L, S
Motif Line
Create a border of motif stitches.
Alt, Q, L, M

Appliqué

Use appliqué for the area.
Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué
fabric.
Alt, Q, A, F

QuickStitch™

Fill the selected area with stitches automatically.
Alt, Q, Q

QuickStitch™ +
AutoHole

Fill the selected area with stitches and create holes automatically.
Alt, Q, H

Shape

Select one of 120 shapes to draw as a fill area with or without a
border, or as a closed line, on the work area.
Alt, Q, S; Alt, Q, P

Enhance
QuickStitch™
Hole

Insert a hole automatically in the selected fill area.
Alt, Q, U

Emboss Line
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Freehand Emboss Line
Draw one or more embossed lines of needle points over the
selected object(s).
Alt, Q, E, F
Point Emboss Line
Place points to define one or more embossed lines of needle points
over the selected object(s).
Alt, Q, E, P
MultiWave Line
Freehand MultiWave Line
Draw one or more MultiWave lines within the selected MultiWave
Fill object.
Alt, Q, W, F
Point MultiWave Line
Place points to define one or more MultiWave lines within the
selected MultiWave Fill object.
Alt, Q, W, P

Trace
Trace
Double Trace
Create a layer of double stitch, with running stitch where necessary,
automatically following the selected line.
Alt, Q, T, D
Quadruple Trace
Create a layer of running and a layer of triple stitches automatically
following the selected line.
Alt, Q, T, Q
Satin Line Trace
Create satin stitches of fixed width automatically following the
selected line.
Alt, Q, T, S
Motif Line Trace
Create a line of motif stitches automatically following the selected
line.
Alt, Q, T, M

Satin Area
QuickStitch™ Satin
Create a satin area automatically in the selected area.
Alt, Q, K
QuickStitch™ Multiple Satin
Create a multiple part satin area automatically in the selected areas.
Alt, Q, M

Options
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Fill Area and Line

Open the options dialog for the fill area and line.
Alt, Q, OF

Satin Area

Open the options dialog for the satin area.
Alt, Q, OS

Quick Create from
Background

Create a design using the current background picture.
Alt, Q, B
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Freehand Create Tab
Command
Color Change

Insert a Color Change after the currently selected object.
Alt, R, C, C
Pick Color
Choose a color from the background picture to set a new thread
color.
Alt, R, C, P
Quick Colors
Select one of the 32 Quick Colors.

Single Stitch

Insert Single Stitches of variable length.
Alt, R, N

Alignment Stitch

Insert an alignment stitch.
Alt, R, G

Stop

Insert a Stop after the currently selected object.
Alt, R, P

Fill Area and Line
Fill

Create a fill.
No Filll
No fill type is selected.
Alt, Q, F, N
Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, R, F, P
Motif Fill
Create a fill area with one or two motif stitches in a repeating
pattern.
Alt, R, F, M
Shape Fill
Create a fill area where the stitching lines follow one of 120 shapes,
using motif lines if desired.
Alt, R, F, S
Radial Fill
Create a fill area that radiates out from the center.
Alt, R, F, R
Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, R, F, L
QuiltStipple Fill
Create a stippled fill area.
Alt, R, F, Q
Contour Fill
Create a fill area that follows the contours of the outline.
Alt, R, F, C
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Crosshatch Fill
Create a crosshatched fill area.
Alt, R, F, X
Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, R, F, H
MultiWave Fill
Create a MultiWave fill area.
Alt, R, F, U
Echo Fill
Create an Echo fill area.
Alt, R, F, E

Line

Create a line or border.
No Border Line
No border line is placed around the Fill Area.
Alt, Q, L, N
Running Stitch
Create a border of running stitches (small consecutive stitches).
Alt, R, F, R
Double Stitch
Create a border of double stitch (small stitches going forward,
followed by small stitches going backward).
Alt, R, F, D
Double Zigzag
Create a line of small stitches going forward, followed by zigzag
stitches going backward.
Alt, R, F, Z
Triple Stitch
Create a border of triple stitch (small three-part stitches, each
composed of one stitch going forward, one going backward then
one going forward).
Alt, R, F, T
Satin Line
Create a border of satin stitches of constant width.
Alt, R, F, S
Motif Line
Create a border of motif stitches.
Alt, R, F, M

Appliqué

Use appliqué for the area.
Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué
fabric.
Alt, R, A, F

Create Freehand
Area or Line

Fill an area with stitches by drawing a line around it.
Alt, R, R

Enhance
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Freehand Hole

Cut out holes within the selected fill area, by drawing outlines to
define the holes.
Alt, R, H

Freehand
Emboss Line

Draw one or more embossed lines of needle points over the
selected object(s).
Alt, R, E

Freehand
MultiWave Line

Draw one or more MultiWave lines within the selected MultiWave
Fill object.
Alt, R, W

Column
Freehand Satin
Area

Draw an outline to create a satin area.
Alt, R, T

Satin Column

Place alternate points to define a column of satin.
Alt, R, S

Feathered Satin

Place alternate points to define a column of feathered satin.
Alt, R, D

Richelieu Bars

Place alternate points to define a column of Richelieu bars (short
sections of satin perpendicular to the direction of the column).
Alt, R, B

Tapered Motifs

Place alternate points to define a line of motifs that vary in size
according to the width of the column.
Alt, R, M

Options

354

Fill Area and Line

Open the options dialog for the fill area and line.
Alt, R, OF

Satin Area

Open the options dialog for the satin area.
Alt, R, OS

Column

Open the options dialog for the column. Choose from: Satin
Column, Feathered Satin, Richelieu Bars and Tapered Motifs.
Alt, R, OC
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Point Create Tab
Command
Color Change

Insert a Color Change after the currently selected object.
Alt, P, C, C
Pick Color
Choose a color from the background picture to set a new thread
color.
Alt, P, C, P
Quick Colors
Select one of the 32 Quick Colors.

Single Stitch

Insert Single Stitches of variable length.
Alt, P, N

Alignment Stitch

Insert an alignment stitch.
Alt, P, G

Stop

Insert a Stop after the currently selected object.
Alt, P, P

Fill Area and Line
Fill

Create a fill.
No Filll
No fill type is selected.
Alt, Q, F, N
Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, P, F, P
Motif Fill
Create a fill area with one or two motif stitches in a repeating
pattern.
Alt, P, F, M
Shape Fill
Create a fill area where the stitching lines follow one of 120 shapes,
using motif lines if desired.
Alt, P, F, S
Radial Fill
Create a fill area that radiates out from the center.
Alt, P, F, R
Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, P, F, L
QuiltStipple Fill
Create a stippled fill area.
Alt, P, F, Q
Contour Fill
Create a fill area that follows the contours of the outline.
Alt, P, F, C
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Crosshatch Fill
Create a crosshatched fill area.
Alt, P, F, X
Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, P, F, H
MultiWave Fill
Create a MultiWave fill area.
Alt, P, F, U
Echo Fill
Create an Echo fill area.
Alt, P, F, E

Line

Create a line or border.
No Border Line
No border line is placed around the Fill Area.
Alt, Q, L, N
Running Stitch
Create a border of running stitches (small consecutive stitches).
Alt, P, L, R
Double Stitch
Create a border of double stitch (small stitches going forward,
followed by small stitches going backward).
Alt, P, L, D
Double Zigzag
Create a line of small stitches going forward, followed by zigzag
stitches going backward.
Alt, P, L, Z
Triple Stitch
Create a border of triple stitch (small three-part stitches, each
composed of one stitch going forward, one going backward then
one going forward).
Alt, P, L, T
Satin Line
Create a border of satin stitches of constant width.
Alt, P, L, S
Motif Line
Create a border of motif stitches.
Alt, P, L, M

Appliqué

Use appliqué for the area.
Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué
fabric.
Alt, P, A, F

Create Point Area
or Line

Fill an area with stitches by placing points around it.
Alt, P, R

Enhance
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Point Hole

Cut out holes within the selected fill area, by placing points to
define the holes.
Alt, P, H

Point Emboss
Line

Place points to define one or more embossed lines of needle points
over the selected object(s).
Alt, P, E

Point MultiWave
Line

Place points to define one or more MultiWave lines within the
selected MultiWave Fill object.
Alt, P, W

Satin Area
Point Satin Area

Place points to create a satin area.
Alt, P, T

Enhance
Satin Column

Place alternate points to define a column of satin.
Alt, P, S

Feathered Satin

Place alternate points to define a column of feathered satin.
Alt, P, D

Richelieu Bars

Place alternate points to define a column of Richelieu bars (short
sections of satin perpendicular to the direction of the column).
Alt, P, B

Tapered Motifs

Place alternate points to define a line of motifs that vary in size
according to the width of the column.
Alt, P, M

Options
Bezier Mode

Enable line creation in Bezier Mode.
Alt, P, BM

Fill Area and Line

Open the options dialog for the fill area and line.
Alt, P, OF

Satin Area

Open the options dialog for the satin area.
Alt, P, OS

Column

Open the options dialog for the column. Choose from: Satin
Column, Feathered Satin, Richelieu Bars and Tapered Motifs.
Alt, P, OC
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Edit Tab
Display Range
Draw Previous
Color Block

Step through the color blocks in reverse order.
Alt, E, P

Draw Next Color
Block

Step through the color blocks one at a time.
Alt, E, N

Display All
Objects

Display all objects and commands in the design.
Alt, E, A

Draw Range

The upper slider bar sets the Draw From Start object. The lower
slider bar sets the Draw To End object. Move the appropriate slider
bar to change the start or end object. Objects are not displayed
when the color block containing the objects is hidden.

Only Selected

Show only the currently selected object.
Alt, E, Y

Only From Start

Show only the currently visible objects from the start to the
selected object.
Alt, E, S

Only To End

Show only the currently visible objects from the selected object to
the end of the design.
Alt, E, E

Hide Object Types
Lines

Show and hide Running, Double and Triple Stitches, Tapered Motifs
and Motif Lines.
Alt, E, HL

Fills

Show and hide pattern fill areas, motif fill areas and shape, radial,
spiral, QuiltStipple, contour and crosshatch fill areas.
Alt, E, HF

Satin Areas

Show and hide satin areas.
Alt, E, HA

Columns

Show and hide Satin Columns, Richelieu bars, feathered satin and
satin lines.
Alt, E, HC

Single Stitches

Show and hide Single Stitches and Alignment Stitches.
Alt, E, HS

Stops and
Colors

Show and hide Color Change and Stop commands.
Alt, E, HP

Groups

Show and hide Groups and all their contents.
Alt, E, HG

Appliqués

Show and hide Appliqué areas.
Alt, E, HQ

Object
Delete
Delete Hole
Delete one or more holes from the currently selected area.
Alt, E, D, H
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Delete Emboss Line
Delete one or more embossed lines from the currently selected
area.
Alt, E, D, E
Delete MultiWave Line
Delete one or more MultiWave lines from the currently selected
MultiWave fill area.
Alt, E, D, W
Break Apart

Break a complex object into its constituent parts.
Alt, E, B

Reversal
Reverse Column End to End
Reverse the order of all the points defining a column so that the
start becomes the end and vice versa.
Alt, E, R, E
Reverse Column Side to Side
Swap each pair of points within a column.
Alt, E, R, S
Reverse Line
Reverse the order of the points defining a line so that the start
becomes the end, and vice versa.
Alt, E, R, L
Manage My Fills

Load new pictures for fill patterns, export an existing My Fill pattern
as a picture and delete unwanted My Fills.
Alt, E, F
Select Similar from Visible
Select all visible objects with similar properties.
Alt, E, M, V
Select Similar from Group
Select all objects with similar properties that are in the same Group.
Alt, E, M, G

Properties

Display the properties for the selected object.
Alt, E, O

Global
Properties

Change the properties of all visible objects of a selected type.
Alt, E, G
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View Tab
Grid
Show Grid

Show or hide the background grid, and set its size.
Show Grid: Alt, V, G; Size: Alt, V, S

Get Length

Measure the distance between any two points on the work area.
Alt, V, L

Background
Edit Background

Load, create or edit a background picture in mySewnet™ Draw & Paint
Alt, V, E

Fade

Use the slider to Hide, Fade or Show the background image.

View Mode
3D View

View objects as embroidery stitches.
Ctrl + T; Alt, V, 3

2D View

View objects as individual stitches with no shading.
Ctrl + R; Alt, V, 2

Object View

View the outline of the objects in the design.
Ctrl + R; Alt, V, O

Hoop
Change Hoop

Choose the hoop size you wish to use in mySewnet™ Digitizing.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Panels
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Show Design
Panel

Show the Design Panel.
Alt, V, D

Show FilmStrip

View the Filmstrip.
Alt, V, F
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Help Tab
Help Topics

List help topics.
F1; Alt, L, H

About mySewnet™
Digitizing

Display module information, version number and copyright.
Alt, L, A
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Design Window — FilmStrip
FilmStrip Items
Thread Color Bar
The color bar shows the color of each object, even when the Color Changes are hidden.

Object
Each object is represented graphically. Markers are shown for Color Changes, Alignment
Stitches and Stops. A Color Change also shows a thread sample. All other object types
show the shape of the objects as black outlines.

Object Type
The name of the object type is shown.

Layout Order
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Move Forwards

Bring one step closer to the front of the design.

Move Backwards

Bring one step closer to the back of the design.

Move to Front

Place at the front of the design.

Move to Back

Place at the back of the design.

Reveal Groups

Switch between viewing the objects within Groups in the FilmStrip,
and seeing only the Group heading rows in the FilmStrip.

Select Last Visible

Select the last object that has not been hidden by Color Select, any
of the object Filters, or the End slider.
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FilmStrip Context Menu
Display Only
Selected

Show only the currently selected object or group of objects.

Display Only From
Start

Display only the visible objects from the start of the design to the
selected object. Hence, all objects after the selected object are
hidden.

Display Only To
End

Display only the visible objects from the selected object to the end
of the design. Hence, all objects before the selected object are
hidden.

Display All Objects

Display all objects and commands in the design.

Cut

Cut out the selected objects and place them on the clipboard.
Ctrl + X

Copy

Copy the selected objects to the clipboard, without affecting the
current selection.
Ctrl + C

Paste

Paste the objects on the clipboard back into the design.
Ctrl + V

Duplicate

Make a copy of the selected objects, which is automatically pasted
on the work area below and to the right of the original.

Delete

Delete the selected object or the last object in the design.
Del.

Insert Color
Change

Insert a Color Change after the currently selected object. The Color
Selection dialog box appears so you can choose the new color.

Insert Stop

Insert a Stop after the currently selected object.

Group

Group selected objects together so they may be moved, resized or
scaled and rotated together.

Ungroup

Ungroup a selected group so that each object may edited
independently.

Select Similar
from Visible

Select all visible objects with similar properties.

Select Similar
from Group

Select all objects with similar properties that are in the same Group.

Properties

Show the properties dialog box for the selected object.

Global Properties

Show the properties dialog box for the selected type of object, to
change the properties of all visible objects of that type.

Layout Order
Move Forwards
Bring one step closer to the front of the design.
Ctrl + [; Alt, L, F
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Move Backwards
Bring one step closer to the back of the design.
Ctrl + ]; Alt, L, B
Move to Front
Place at the front of the design.
Ctrl +Shift + [; Alt, L, N
Move to Back
Place at the back of the design.
Ctrl + Shift + ]; Alt, L, C

Design Window — Design Panel
Design Information
Stitch Count
Height

: The Stitch Count of the embroidery.

: The Height of the embroidery.

Width

: The Width of the embroidery.

Colors

: The number of colors in the embroidery.

Color Select
A worksheet panel showing the color blocks in the design. It is used to change the thread
color and add thread or needle effects, show which color blocks are visible and turn the
display of color blocks on and off.
Use Design Property Colors
to show or hide thread colors in the Color Select area that
are part of an object’s property; for example, colors in multigradient density fill areas or
satin columns.

Notes
Enter up to 2000 characters in the Notes for information and keywords about the design.

Settings
Enter up to 2000 characters in the Settings for information on the techniques used for the
design.

Edit
Click Edit to update the Notes or Settings by using the dialog box.

Clipboard Block
The Clipboard Block shows the current selection that can be pasted into the work area.

Overview Window
The overview window gives a small overview of the whole work area for the current
embroidery and background.
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Toolbars
Quick Access Toolbar
Insert

Insert an existing design into your current project.
Ctrl + I; Alt, 1

Save

Save the design with the same name.
Ctrl + S; Alt, 2

Save As

Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Export

Save the design in the current window as a flattened .vp4 file, or in an
alternative embroidery format.
Ctrl+ E; Alt, 4

Print

Print the selected design(s) and background. To set page options, use
File, Print.
Ctrl + P; Alt, 5

Change Hoop

Choose the hoop size you wish to use in mySewnet™ Digitizing.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Undo

Undo the last action.
Ctrl + Z; Alt, 7

Redo

Redo the previously undone action.
Ctrl + Y; Alt, 8

Life View

Show how an embroidery exported from the project will look in 3D
with real-world perspective.
Ctrl + L; Alt, 9; Alt, H, L

Design Player

Play through the stitches in the embroidery as if they were being
stitched from an exported embroidery.
Ctrl + J; Alt, 0; Alt, H, J
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Status Bar
Use the Select Tools on the Status Bar to select objects in your design.
Edit Points

Use Edit Points to enable the moving and editing of an object’s points if
another function is being used.

Box Select

Select a block of objects by drawing a rectangle.

Freehand Select Select a block of objects by drawing a line around the required objects.
Point Select

Select a block of objects by clicking a series of points to create an irregular
outline of straight or curved lines around the required objects.

Select All Visible Select all visible objects as a single block.
Ctrl + A
Select None

Deselect all of the objects in the work area, including any outside the hoop.
Ctrl + Shift + A

Use the Zoom Commands on the Status Bar to navigate around designs.
Zoom To
Rectangle

Increase magnification of an area of the design.
Ctrl + 0

Zoom To Fit

Fit work area to screen.
Ctrl + 9
100%
Display picture at 100% magnification.
Ctrl + 1
200%
Display picture at 200% magnification.
Ctrl + 2
400%
Display picture at 400% magnification.
Ctrl + 3
800%
Display picture at 800% magnification.
Ctrl + 4
75%
Display at 75% magnification.
Ctrl + 5
50%
Display at 50% magnification.
Ctrl + 6
25%
Display at 25% magnification.
Ctrl + 7
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Zoom Out

Decrease magnification.
Ctrl + -

Zoom In

Increase magnification.
Ctrl + =
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Index
Numerics
2 Cutwork Needles .......................................... 267
2D View ...................................................................85
3D View ...................................................................85
4 Cutwork Needles .......................................... 267
45 Degree Rotate ............................................. 307
A
Abbreviation
Thread Name..............................................89
About
mySewnet Digitizing ................................. 4
Acquire Picture.................................................. 169
Acrobat Reader® .................................................... 3
Add
Quick Color Theme................................ 174
Add To Selection............................................... 303
Advisor ....................................................................69
Align Picture To ................................................. 326
Alignment
Stitches ................................................. 33, 44
Alignment Stitch Style.................................... 181
Alignment Stitches .......................................... 181
Crosses....................................................... 181
Alignment Stitches Only................................ 326
Angle .......................................................... 187, 198
Background Picture..................... 164, 170
Block Rotation......................................... 308
Fill ................................................................ 187
Fill Pattern................................................. 187
For Satin Areas ........................................ 293
Angle Line
Delete......................................................... 293
Last.............................................................. 293
Angle Lines............................................... 291, 293
Animals 1 — Patterns 37 to 48.................... 318
Animated Demo ............................................... 108
Apart
Break........................................................... 298
Appliqué..................................... 33, 36, 159, 172
Fabric................................................ 159, 180
Options.........................................................76
Appliqué Pieces
Export......................................................... 123
Appliqué Selection .......................................... 159
Area
Get Length Of.......................................... 104
Make Block from Visible....................... 302
Traveling Stitches Outside.................. 189
Types .............................................................28
Work................................................................. 7
Area and Line Properties ..................................35
Area Properties ....................................................35
Area Sensitivity .....................................67, 72, 75
Areas ........................................................................46
Fill ...................................................................29
Motif Fill........................................................29
Move Origin ............................................. 293
Move Start and End Points ................. 292
Remove All Background Color .............66
Satin....................................................... 31, 97
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Tie Off Between Automatically ..........323
Arrow Keys...........................................................291
Arrows — Patterns 49 to 60 ..........................318
AutoHole
QuickStitch™ +.........................................137
Automatically
Remove Background Color ................... 66
Tie Off Between Areas...........................323
B
Background........................................................... 86
Keep and Remove Parts ......................... 20
Name...........................................................167
Quick Create from...................................134
Remove Main Only................................... 66
Size...............................................................166
Wizard...............................................162–167
Background Color ............................................... 66
Automatically Remove ........................... 66
Current.......................................................... 66
Pick................................................................. 66
Remove All Areas ...................................... 66
Background Colors
Remove Multiple....................................... 67
Backgrounds and Dark Borders ..................... 22
Backwards
Move..................................................101, 288
Bar
Ribbon .............................................................5
Scroll............................................................100
Status ...............................................................8
Thread Color...................................100, 362
Title ............................................................. 5, 7
Zoom...........................................................112
Bars
Richelieu ....................................................256
Basic Color Order ................................................ 65
Bells........................................................................115
Bezier Mode ................................................ 28, 149
Convert Points .........................................295
Black Lines ............................................................. 67
Block
Clipboard...................................................311
Deselect .....................................................300
Draw Next.................................................... 95
Draw Previous ............................................ 95
Horizontally Flip ......................................306
Insert or Paste ..........................................300
Make from Visible Area .........................302
Modify.........................................................308
Rotation Angle.........................................308
Vertically Flip ............................................306
Block of Objects
Copy ............................................................310
Cut................................................................309
Mirror ..........................................................306
Modify.........................................................306
Move............................................................306
Nudge .........................................................306
Paste ............................................................310
Resize ..........................................................306
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Rotate......................................................... 307
Select.......................................................... 299
Blue ....................................................................... 177
Blue Handles ...................................................... 300
Border
Express.................................................. 48, 51
Satin Width..................................................42
Type ...............................................................74
Border Properties
Satin............................................................ 274
Borders
Satin...............................................................33
Borders and Backgrounds................................22
Bottom ................................................................. 326
Bottom Left Corner.......................................... 182
Bottom Right Corner....................................... 182
Boundaries
Between Color Areas ...............................57
Strong Color........................................ 21, 57
Boundaries Between Color Areas..................57
Box Select............................................................ 301
Break Apart......................................................... 298
C
Camera................................................................. 169
Category...................... 195, 196, 202, 228, 276
Curved Crosshatch Fill.......................... 224
Font............................................................. 313
Center
Paste Into .................................................. 310
Center Alignment............................................. 326
Center Motifs 1 and 2 ..................................... 197
Center of Rotation ................................. 306, 307
Central Point ............................................ 275, 278
Change
Color ....................................................87, 178
Existing Thread Color.....................89, 178
Fill Properties........................................... 143
Hoop..............................................................61
Object Settings ....................................... 286
Picture During Design Creation...........17
Satin Area Properties .................. 240, 242
Sequence of Objects................... 101, 287
Stitch Angle for Satin Areas................ 293
Thread...........................................................65
Change All To........................................................65
Change Design Size......................................... 309
Character
Insert .......................................................... 313
Choose
Design Type ................................................51
New Thread Color .................................. 176
Object to Edit .......................................... 291
Picture.................................................53, 168
Pictures for ExpressDesign Wizard......18
Thread Colors .............................................64
Choose Picture
Background Wizard ............................... 162
Circles 1 — Patterns 61 to 72 ....................... 318
Circles 2 — Patterns 73 to 84 ....................... 318
Clean a Picture .....................................................19
Click and Drag in FilmStrip ........................... 287
Climate — Patterns 85 to 96 ........................ 318
Clipboard Block............................................ 7, 311
Close mySewnet Digitizing ............................... 4
Closed Border25, 266, 268, 270, 272, 275, 278
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Color
Automatically Remove Background .. 66
Background ................................................ 66
Bar ................................................................100
Change Existing Thread ............... 89, 178
Choose New Thread...............................176
Commands.................................................. 98
Current Background ................................ 66
Edit...............................................................175
False............................................................... 67
Information...............................................325
Last Thread................................................103
Models ........................................................177
Order ............................................................. 65
Paste ............................................................176
Pick....................................................... 87, 178
Pick Background ....................................... 66
Select...........................................................364
Selection ...............................................64, 89
Strong Boundaries ............................21, 57
Thread..........................................72, 74, 176
Thread Preview...................................67, 70
Color Areas
Distinctive Boundaries............................ 57
Remove All Background......................... 66
Color Bar...............................................................362
Color Block
Draw Next.................................................... 95
Draw Previous ............................................ 95
Color Change.............................................. 87, 178
Insert .................................................103, 287
Marker........................................................... 89
Properties ..................................................179
Color Change and Stop...................................287
Color Changes
Gradual......................................................... 21
Color Selection Dialog ...................................... 89
Color Tolerance ........................................130, 322
Off................................................................... 27
On................................................................... 26
Color Tolerance and QuickStitch™ ..............131
Color Tolerance and QuickTrace ..................131
Color Worksheet.................................................. 93
Colors ....................................................................364
Choose Thread........................................... 64
Dialog Box .................................................176
Number of ................................................... 64
Remove Multiple Background ............. 67
Column .................................................................247
Continuous ...............................................247
Create Satin...............................................247
Column Properties.............................................. 39
Command
Insert Color .....................................103, 287
Insert Stop.......................................103, 287
Commands............................................................ 33
Color and Stop........................................... 98
Insert ...........................................................287
Using ...........................................................178
Compensation ..................................................... 41
Fill .................................................................187
Satin Area ..................................................243
Connected Outlines ........................................... 21
Constant Width Satin......................................... 71
Context Menu ....................................................363
Continuous Column.........................................247

Continuous Satin.................................... 249, 261
Contour
Fill ...................................................................30
Contour Fill Options ........................................ 215
Convert
Object Types ...............................................46
Convert Points................................................... 295
Convert Points to Corner............................... 295
Convert Points to Smooth............................. 295
Convert Points to Symmetric....................... 296
Convert to Bezier Line .................................... 297
Convert to Point Line...................................... 296
Convert to Satin Area...................................... 249
Copies
Print Number........................................... 328
Copy
Block of Objects...................................... 310
Color ........................................................... 175
Embroidery .............................................. 116
Objects....................................................... 309
Corner Mitering ................................................ 145
Create
Designs ...................................................... 113
Embroideries ..............................................47
Freehand............................................27, 265
New Designs...............................................15
QuickStitch™ and QuickTrace26, 130, 159
QuickStitch™ Satin Area....................... 236
Satin Column........................................... 247
Create Cursor ..................................................... 261
Create Freehand Area or Line ...................... 143
Create Point Area or Line............................... 144
Create Window.................................................. 6, 8
Creating Shapes...................................................27
Crop
Picture................................................... 22, 55
Picture for Fabric .................................... 164
Crop Box .............................................................. 170
Crop Picture
Load Picture Wizard .............................. 170
Crosses
Alignment................................................. 181
Place on Picture...................................... 181
Crosshatch
Curved ....................................................... 222
Fill ...................................................................30
Crosshatch Fill Properties.............................. 217
Current Background Color...............................66
Curved.................................................................. 212
Curved Crosshatch Fill.............................31, 222
Properties ................................................. 222
Curved Lines ...................................................... 292
Custom Color..................................................... 177
Cut
Block of Objects...................................... 309
Objects....................................................... 309
Cutwork ............................................................... 267
Cutwork Needle.........................................92, 267
Cutwork Needle Line ...................................... 122
D
Dark Borders and Backgrounds .....................22
Decoration Information................................. 325
Delete ............................................................66, 233
All....................................................................66
Angle Lines............................................... 293
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Emboss Line..............................................298
Hole .............................................................297
My Fill Pattern ..........................................233
Object ...............................................103, 287
Point ............................................................294
Quick Color Theme.................................176
Wave Line ..................................................298
Demo.....................................................................108
Density.................................................................... 41
Fill Properties............................................188
Gradient .................................188, 209, 250
Normal..............................................188, 208
Radial Fill....................................................206
Satin Area ..................................................243
Satin Border ..............................................274
Shape Fill..........................................201, 227
Deselect Block....................................................300
Design
Change Picture During Creation......... 17
Choices ............................................................2
Choose Type ............................................... 51
Edit...............................................................284
Files ................................................................ 11
Fit to Hoop .................................................. 61
Information........................ 70, 72, 75, 108
Load............................................................... 78
Load Existing .......................................48, 52
Load with Drag and Drop ....................116
Open Existing............................................. 78
Scale ............................................................325
Transfer Elements ...................................115
With no Picture...................................48, 52
Design at Different Sizes .................................. 47
Design Information ..........................................364
Design Player......................................................106
Video Speed..............................................110
Design Property Colors...................................179
Design Size ............................................................ 61
Enter .............................................................. 63
Design Size and Creating Embroideries ..... 47
Design Underlay.................................................. 69
Designing with mySewnet™ Digitizing14, 24
Designs
Create..........................................................113
Find ................................................................ 80
Grouping....................................................304
How To Create New.................................. 15
Manage ......................................................113
Open............................................................114
Open Recently Used ..............................116
Save .............................................................117
Step Through............................................285
Use Existing................................................. 16
View ............................................................... 85
Desktop Shortcuts.................................................4
Detail Level in Picture........................................ 67
Details
Enhance ....................................................... 19
Interior.......................................................... 59
Diagonal Corners
Echo Fill ......................................................231
Diamond
Curved Crosshatch Fill ..........................222
Diamonds — Patterns 97 to 108 .................319
Different Sizes ...................................................... 47
Digital Camera ...................................................169
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Dimensions ........................................................ 325
Direct USB Connection .................................. 126
Direct USB Settings ......................................... 128
Display
All................................................................. 102
All Objects ...................................................95
From Start..........................................96, 102
Selected..............................................96, 102
To End .................................................96, 102
Display Picture .....................................................23
Distance
Between Secure Points ........................ 267
Double Stitch
Properties ................................................. 268
Double Stitch - Stop - Satin ........... 36, 76, 172
Double Trace...................................................... 140
Double with Zigzag Return .......................... 270
Double Zigzag................................................... 270
Drag and Drop to Load Design ................... 116
Draw
All Objects ...................................................95
Back to Start Point ............. 143, 145, 240
Freehand Mode ...............................27, 132
Next Color Block........................................95
Outline ................................... 143, 145, 239
Previous Color Block ................................95
Range ............................................................95
Draw a Circle in Bezier Mode ....................... 150
Draw a Flower using Bezier Curves............ 154
Draw Range........................................................ 358
Dual Thread ...........................................................90
Duplicate............................................................. 311
E
Echo
Fill ...................................................................30
Echo Area ............................................................ 230
Echo Fill...................................................... 229, 230
Echo Lines........................................................... 230
Edge
Feathered.....................................................44
Edit
Choose Object ........................................ 291
Color ........................................................... 175
Design........................................................ 284
Object Outlines....................................... 290
Page ............................................................ 358
Quick Color Theme................................ 176
Select Object ........................................... 285
Edit a Bezier Line .............................................. 151
Edit Background ..................................................86
Edit Points ........................................................... 291
Edit Window
FilmStrip .................................................... 362
Effects......................................................................90
Hand Stitch............................................... 181
Special...........................................................43
Emboss
Freehand................................................... 146
Point ........................................................... 146
Emboss Line
Delete......................................................... 298
Embroideries
Design Size and Creating.......................47
Insert .......................................................... 311
Embroidery
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Copy ............................................................116
Express...................................................48, 51
Files ................................................................ 11
Navigate.....................................................111
On Heavy Knit Fabric . 41, 188, 208, 274
On Linen......................... 41, 188, 208, 274
On Satin.......................... 41, 188, 208, 274
On Thick Fabric ............ 41, 188, 208, 274
On Twill......................................................... 41
Print Whole ...............................................326
Use to Enhance the Picture ................... 23
Enclosed Shapes in Picture.............................. 59
End ........................................................................... 43
End Marker ................................................291, 292
End Point....................................................275, 278
End Point for Area.............................................292
Enhance
Details ........................................................... 19
Enhance the Picture with Embroidery ........ 23
Enter Angles
Curved Crosshatch Fill ..........................223
Enter Design Size ................................................ 63
Enter Size ........................................................13, 62
Error Messages...................................................329
Existing Design
Load........................................................48, 52
Open.............................................................. 78
Existing Designs .................................................. 16
Existing Thread Color............................... 89, 178
Exit.....................................................................4, 128
Expand.................................................................... 57
Expand Pixel-Thin Lines .................................... 67
Expander
Outline Finder ............................................ 57
Explorer ................................................................116
Export..........................................................118, 232
Export Appliqué Pieces...................................123
Export Options...................................................325
Express Border ..............................................48, 51
Options......................................................... 74
Pictures for .................................................. 21
Express Embroidery ....................................48, 51
Options......................................................... 64
Pictures for .................................................. 20
Express Trace .................................................48, 51
Options......................................................... 71
Pictures for .................................................. 21
ExpressDesign Wizard .......................... 1, 16, 48
Choose Pictures......................................... 18
Insert From.................................................. 49
Optimize Pictures ..................................... 18
Stitch Objects Created ............................ 34
F
Fabric....................................................................... 69
Appliqué ....................................................180
Embroidery on Heavy Knit41, 188, 208,
274
Embroidery on Thick . 41, 188, 208, 274
Rotate and Crop Picture .......................164
Fabric Advisor....................................................... 69
Fabric and Stitch Type Options ...................... 69
Fade Picture ........................................................326
False Color ............................................................. 67
Favorites ................................................................. 37
Feather

Both Sides................................................. 255
Top............................................................... 255
Feather Both Sides........................................... 253
Feather One Side.............................................. 253
Feathered
Edge...............................................................44
Feathered Satin................................................. 253
Feathers
Fleur de Lys .............................................. 260
Felting Needle ......................................................92
Felting Needle Color Effect........................... 323
File
Formats.........................................................10
Name .......................................................... 114
File Menu............................................................. 344
File Tab ................................................................. 344
Files
Design...........................................................11
Embroidery .................................................11
Picture...........................................................10
Sample............................................................ 3
Files of Type........................................................ 114
Fill
Angle .......................................................... 187
Contour ........................................................30
Crosshatch...................................................30
Curved Crosshatch ................................ 222
Echo ...........................................30, 229, 230
MultiWave....................................................30
Multiwave ................................................. 227
Point ........................................................... 144
Prefer .............................................................69
QuickStitch™............................................ 136
QuiltStipple.................................................30
Radial.............................................................29
Satin Effect ........................................43, 318
Shape ............................................................29
Spiral..............................................................30
Fill + AutoHole
QuickStitch™............................................ 137
Fill and Satin Patterns ........................................42
Fill Area
Properties Dialog ......................................35
Traveling Stitches Around................... 189
Fill Areas .................................................................29
Fill Options
Contour ..................................................... 215
QuiltStipple.............................................. 212
Radial.......................................................... 206
Shape ......................................................... 201
Spiral........................................................... 208
Fill Pattern........................................................... 318
Fill Properties
Change ...................................................... 143
Density....................................................... 188
Options...................................................... 187
Pattern ....................................................... 185
Fill Stitches.............................................................97
FilmStrip ........................................7, 99, 180, 362
Choose Object ........................................ 291
Click and Drag......................................... 287
Context Menu ......................................... 363
Items....................................................99, 362
Move Up and Down.............................. 287
Options...................................................... 102
Select Object ........................................... 100
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Find
Designs......................................................... 80
Outlines.................................................21, 57
Thread........................................................... 90
Finder and Expander ......................................... 57
Finding Information..............................................2
Finish ................................................................63, 78
First Visible Object ..................................101, 288
Fit Design to Hoop.............................................. 61
Fit Motif To Line
Curved Crosshatch Fill ..........................224
MultiWave Fill.......................203, 228, 277
Tapered Motifs.........................................260
Fit To Hoop ............................................................ 50
Fit To Rectangle ................................................... 49
Fleur de Lys
Feathers......................................................260
Flip Block
Horizontally ..............................................306
Vertically ....................................................306
Flip design for felting or reverse embroidery325
Flip Picture for Iron-On Tee Shirt Transfer 326
Foam
Puffy............................................................... 90
Font
Category ....................................................313
Name...........................................................313
Format
JPEG............................................................... 57
Formats of Files.................................................... 10
Forwards
Move..................................................101, 288
Freehand ..............................................................131
Create with........................................ 27, 265
Emboss .......................................................146
Features...........................................................1
Pictures for .................................................. 22
Select...........................................................302
FreeHand Area or Line.....................................143
Freehand Create ........................................ 27, 132
Freehand MultiWave Line ..............................147
Freehand Satin Area...............................239, 241
Fur
Feathered Satin .......................................253
G
Gap.........................................................................197
Minimum .....................202, 224, 228, 276
Patch in Pictures........................................ 19
General Considerations .................................... 18
Get Length...........................................................104
Getting Started .......................................................1
Global Properties ...................................... 44, 103
Glow in the Dark................................................108
Gradient
Multicolor ........................................191, 251
Gradient — Patterns 253 to 264..................319
Gradient Density ...........................188, 209, 250
Gradual Color Changes..................................... 21
Green.....................................................................177
Grid ................................................................ 86, 325
Group ..........................................................103, 305
Curved Crosshatch Fill ..........................224
Grouping Selected Objects ...........................304
Groups
Using ...........................................................304
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Hand Stitch Effects........................................... 181
Handles are Blue............................................... 300
Hearts — Patterns 109 to 120...................... 319
Heavy Knit Fabric ..................41, 188, 208, 274
Height................................................................... 364
Height and Width..... 195, 196, 203, 229, 277
Curved Crosshatch Fill.......................... 225
Tapered Motifs ........................................ 260
Help............................................................................ 2
Help Tab............................................................... 361
Hide Object Types...............................................97
Hole
Delete......................................................... 297
QuickStitch™............................................ 138
Home Tab ............................................................ 345
Hoop ..................................................................... 325
Change .........................................................61
Fit Design to................................................61
Fit To ..............................................................50
Selection ......................................................12
Splitting..................................................... 120
Hoop Group .................................................. 12, 62
Hoop Selection Dialog ......................................12
Hoop Size ....................................................... 12, 62
Horizontally Flip Block.................................... 306
How To
Change Object Settings ...................... 286
Create New Designs.................................15
HSL ........................................................................ 177
Hue Saturation Luminance (HSL)
Color Model ............................................. 177
I
Import .................................................................. 233
Inches ................................................................... 104
Include Secure Points ..................................... 267
Included in My Hoops ............................... 12, 62
Information
Color ........................................................... 325
Design..................................70, 72, 75, 108
Finding............................................................ 2
Print ............................................................ 325
Readme and Technical .............................. 3
Technical ................................................... 325
Insert..................................................................... 114
Character .................................................. 313
Color Command ........................... 103, 287
Commands............................................... 287
Embroideries ........................................... 311
ExpressDesign............................................49
Point ........................................................... 294
Select Object ........................................... 284
Stop Command ............................ 103, 287
Insert Lettering ................................................. 313
Insert or Paste Block........................................ 300
Interior Details......................................................59
Iron-On Tee Shirt Transfer.............................. 326
J
Join Neatly .......................................................... 145
JPEG Format..........................................................57
K
Keep and Remove Parts of Background .....20
Keep Original Picture.........................................18
Kern................................................... 203, 229, 277
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Curved Crosshatch Fill ..........................225
Keys
Left and Right Arrow .............................291
L
Lace
Richelieu Bars...........................................256
Tapered Motifs.........................................258
Lace — Patterns 253 to 264 ..........................319
Last
Angle Line .................................................293
Thread Color.............................................103
Visible Object .................................100, 290
Last Visible
Select...........................................................300
Layout Order...................................101, 288, 362
Left and Right Arrow Keys .............................291
Left Taper ...................................................275, 278
Leisure 1 — Patterns 121 to 132..................319
Length
Of Area........................................................104
Stitch ............................................................. 42
Lettering
Insert ...........................................................313
Life View ...............................................................107
Limit
Offset...........................................................198
Line
Fit Motif To...................203, 224, 228, 277
Properties .................................................... 35
Linen.......................................... 41, 188, 208, 274
Lines......................................................................... 46
Black .............................................................. 67
Echo.............................................................230
Expand Pixel-Thin ..................................... 67
Motif .............................................................. 33
Reduce Thick .............................................. 67
Stitch Angle ....................................291, 293
Straight or Curved ..................................292
Load
Design........................................................... 78
Load a Picture................................................48, 51
Load Design with Drag and Drop ...............116
Load Existing Design ..................................48, 52
Look In ..................................................................114
Luminance...........................................................177
M
Main Background Only ..................................... 66
Main Toolbar .......................................................365
Make Lines Straight or Curved.....................292
Manage
Designs.......................................................113
My Fills ........................................................232
Manage Threads.................................................. 89
Marker ..................................................................... 43
Color Change ............................................. 89
End .....................................................291, 292
Snap.............................................................293
Start ...................................................291, 292
Match Placement Line......................37, 77, 173
Maximum Recommended Stitch Length
Satin............................................................... 31
Measure
Background ..............................................104
Embroidery ...............................................104
Measurement Units..........................................326

Measurements
Units............................................................ 104
Menu
File ............................................................... 344
FilmStrip Context ................................... 363
Messages............................................................. 329
Method
QuickTrace...................................................71
Millimeters.......................................................... 104
Minimum Gap ............................... 202, 228, 276
Curved Crosshatch Fill.......................... 224
Minimum Significant Stitch Length .......... 122
Mirror............................ 196, 197, 203, 229, 277
Block of Objects...................................... 306
Curved Crosshatch Fill.......................... 225
Mitered Corners and Closed Shapes ......... 145
Mitered End.............................................. 275, 277
Mode
Draw in Tablet ............................................27
Pan............................................................... 112
Modify Block ...................................................... 308
Modify Block of Objects................................. 306
Monochrome Threshold...................................59
Mosaic — Patterns 133 to 144..................... 319
Mosaic — Patterns 265 to 276..................... 319
Motif...........................................44, 202, 228, 276
Curved Crosshatch Fill.......................... 224
Fit To Line.................... 203, 224, 228, 277
MultiWave Fill .......................................... 228
Multiwave Fill .......................................... 228
Tapered Motifs ........................................ 259
Motif 1 ........................................................ 195, 196
Motif 2 ........................................................ 196, 197
Motif Fill Areas......................................................29
Motif Fill Properties ......................................... 194
Options...................................................... 198
Patterns ................................. 195, 196, 197
Motif Line
Properties ................................................. 276
Quick Trace ............................................... 142
Motif Lines .............................................................33
Motifs
Center 1 and 2......................................... 197
Tapered...................................................... 258
Use..................................................... 202, 227
Move
Backwards ...................................... 101, 288
Block of Objects...................................... 306
Center of Rotation ....................... 306, 307
Forwards ......................................... 101, 288
Origin ......................................................... 144
Origin for Areas....................................... 293
Points.......................................................... 291
Start and End Points for Areas........... 292
To Back............................................. 102, 289
To Front............................................ 102, 288
Up and Down FilmStrip ....................... 287
Move Down...........................................................65
Move Up .................................................................65
Multicolor Gradient ............................... 191, 251
Multipart Hoops
Splitting..................................................... 120
Multiple Background Colors ...........................67
Multiple Selected Objects............................. 104
MultiWave
Fill ...................................................................30
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MultiWave Fill .....................................................227
MultiWave Line
Freehand....................................................147
Point ............................................................149
My Fills
Manage ......................................................232
Remove Unwanted Patterns...............233
My Hoops........................................................12, 62
mySewnet Configure
Show Measurements.............................104
mySewnet™.........................................................124
mySewnet™ Cloud Sync Tool........................129
mySewnet™ Machine ......................................125
mySewnet™ Options........................................128
mySewnet™ Thread Cache .............................. 89
MyThreadRanges ................................................ 89
MyThreads ..................................88, 89, 178, 179
N
Name
Background ..............................................167
File................................................................114
Font..............................................................313
Navigate Embroidery.......................................111
Neat Join ..............................................................145
Needle
Cutwork......................................................267
New.......................................................................... 49
New Design
How To Create............................................ 15
With no Picture...................................48, 52
New Thread Color .............................................176
New Window ........................................................ 49
Next Color Block.................................................. 95
No Change............................................................. 67
No Taper .....................................................275, 278
None
Select...........................................................303
Normal Density........................................188, 208
Notes ......................................... 80, 316, 325, 364
Design Page..............................................364
Nudge
Block of Objects ......................................306
Number of
Colors ............................................................ 64
Number of Bars..................................................257
O
Object..........................................................100, 362
Choose to Edit..........................................291
Delete................................................103, 287
First Visible ......................................101, 288
How To Change Settings......................286
Last Visible.......................................100, 290
Select for Insert .......................................284
Select in FilmStrip...................................100
Select to Edit ............................................285
Type ...................................................100, 362
Object Outlines
Edit...............................................................290
Object Properties................................................ 40
Object Types ......................................................... 25
Convert......................................................... 46
Object View........................................................... 86
Objects
Change Sequence ........................101, 287
Copy ............................................................309
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Copy Block................................................ 310
Created in ExpressDesign Wizard........34
Cut............................................................... 309
Cut Block ................................................... 309
Display All ....................................................95
Filter...............................................................97
Grouping................................................... 304
Mirror Block.............................................. 306
Modify Block ............................................ 306
Move Block............................................... 306
Nudge Block ............................................ 306
Paste ........................................................... 309
Paste Block ............................................... 310
Resize Block.............................................. 306
Rotate Block............................................. 307
Select.......................................................... 284
Select Block.............................................. 299
Step Through in Order ......................... 291
Offset .................................................................... 197
Limit............................................................ 198
Online Help ............................................................. 2
On-screen Pointers ............................................... 9
Open ..................................................................... 114
Designs ...................................................... 114
Existing Design ..........................................78
Recently Used Designs......................... 116
Optimize Pictures
ExpressDesign Wizard .............................18
Optimize Stitch Length.................................. 122
Options
Appliqué ......................................................76
Contour Fill............................................... 215
Express Border ...........................................74
Express Embroidery .................................64
Express Trace ..............................................71
Fabric and Stitch Type .............................69
Fill Properties........................................... 187
FilmStrip .................................................... 102
Motif Fill Properties ............................... 198
Multiwave Fill .......................................... 227
Picture..................................67, 72, 75, 326
Plan ............................................................. 325
QuiltStipple Fill ....................................... 212
Radial Fill ................................................... 206
Shape Fill................................................... 201
Spiral Fill .................................................... 208
Worksheet ................................................ 324
Order
Layout .............................................. 101, 288
Order of Stitch Types..........................................65
Orientation .................................................... 13, 62
Hoop..............................................................12
Print Setup................................................ 327
Origin.............................................................43, 291
Move................................................. 144, 293
Original Picture ............................................ 18, 59
Other Topics ....................................................... 337
Outline
Draw ....................................... 143, 145, 239
Finder and Expander ...............................57
Outlines
Connected...................................................21
Edit .............................................................. 290
Find ........................................................ 21, 57
Overlap Start and End Points....................... 145
Overview Window ................................................ 7
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Page
Edit...............................................................358
Page Setup ..........................................................324
Pan Mode.............................................................112
Paper
Size...............................................................327
Source.........................................................327
Parallel
Curved Crosshatch Fill ..........................222
Parts of Software Window ..................................5
Paste
Block............................................................300
Block of Objects ......................................310
Objects .......................................................309
Paste and Replace.............................................311
Paste Color...........................................................176
Paste Into Center...............................................310
Paste Into New Window..................................311
Paste Picture .............................................163, 169
Paste To All...........................................................176
Patch Gaps in Pictures....................................... 19
Pattern ................195, 196, 202, 228, 243, 276
Curved Crosshatch Fill ..........................224
Fill .................................................................318
Fill Properties............................................185
Remove Unwanted My Fill...................233
Pattern 36 Satin Effect Fill ...................... 43, 318
Patterns
1 to 12 (Standard 1)................................320
109 to 120 (Hearts).................................319
121 to 132 (Leisure 1) ............................319
13 to 24 (Standard 2) .............................320
133 to 144 (Mosaic)................................319
145 to 156 (People) ................................319
157 to 168 (Plants & Flowers 1)..........320
169 to 180 (Polygons) ...........................320
181 to 192 (Rope & Chains).................320
193 to 204 (Squares 1) ..........................320
205 to 216 (Squares 2) ..........................320
217 to 228 (Transport) ..........................321
229 to 240 (Waves 1) .............................321
241 to 252 (Waves 2) .............................321
25 to 36 (Standard 3) .............................321
253 to 264 (Gradient) ............................319
253 to 264 (Lace).....................................319
265 to 276 (Mosaic)................................319
37 to 48 (Animals 1) ...............................318
49 to 60 (Arrows).....................................318
61 to 72 (Circles 1) ..................................318
73 to 84 (Circles 2) ..................................318
85 to 96 (Climate) ...................................318
97 to 108 (Diamonds)............................319
Fill and Satin ............................................... 42
Motif Fill Properties............195, 196, 197
Pause Machine...................................................180
PDF Guides...............................................................3
People — Patterns 145 to 156......................319
Percentage Zoom .............................................112
Perspective Correction.................. 55, 165, 171
Photochromic Threads....................................108
Photograph........................................................... 57
Photographs ......................................................... 21
Pick
Background Color..................................... 66
Color .................................................... 87, 178

Thread Color ...............................................65
Picture .....................................................................86
Acquire ...................................................... 169
Align To...................................................... 326
Background Wizard ............................... 162
Change During Design Creation .........17
Choose................................................53, 168
Clean Up.......................................................19
Crop .....................................................22, 170
Detail Level..................................................67
Display ..........................................................23
Enclosed Shapes in...................................59
Fade ............................................................ 326
Files ................................................................10
Flip for Iron-On Tee Shirt Transfer .... 326
For New Design .........................................48
Keep Original..............................................18
Options................................67, 72, 75, 326
Original .........................................................59
Paste ................................................. 163, 169
Print ............................................................ 326
Proportions .................................................18
Rotate and Crop ........................................55
Scan .....................................................54, 169
Share........................................................... 109
Size .................................................................22
Size in Pixels................................................79
Source ...........................................................67
Start New Design with None ........ 48, 52
Use Embroidery to Enhance .................23
View .....................................................53, 168
View for Background ............................ 162
Picture and Thread Color List..........................65
Picture Viewer.................................................... 168
Pictures ...................................................................17
Dark Borders and Backgrounds ...........22
For Express Border....................................21
For Express Embroidery..........................20
For Express Trace.......................................21
For ExpressDesign Wizard......................18
For QuickStitch™ .......................................22
For QuickStitch™ and Freehand...........22
Formats...................................................... 169
Patch Gaps...................................................19
Printing .........................................................23
Stippled ........................................................22
View ...............................................................85
Pixel Size.................................................................79
Pixel-Thin Lines ....................................................67
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